Contents

Send Us Your Comments ................................................................................................................ xvii

Preface .................................................................................................................................................. xix

1 Introduction

Oracle Financial Services Overview ........................................................................................................ 1-1
OFS Applications ............................................................................................................................ 1-2
Logging In to OFS .......................................................................................................................... 1-3
Menus and Toolbars ........................................................................................................................ 1-4

Menus ........................................................................................................................................... 1-4

File Menu .................................................................................................................................. 1-4
Edit Menu .................................................................................................................................. 1-6
Process Menu .............................................................................................................................. 1-6
Setup Menu ................................................................................................................................. 1-7
Options Menu ............................................................................................................................... 1-7
Tools Menu .................................................................................................................................. 1-8
Window and Help Menus ............................................................................................................... 1-8
Status Bar .................................................................................................................................. 1-8

Toolbars ........................................................................................................................................ 1-9

Horizontal Toolbar ...................................................................................................................... 1-9
Vertical Toolbar ........................................................................................................................... 1-11

2 The Transfer Pricing Concept

Traditional Approaches to Transfer Pricing .................................................................................. 2-1
A New Approach to Transfer Pricing ................................................................. 2-3
How Matched Rate Transfer Pricing Works .................................................. 2-5
Remaining Term Method for Transfer Pricing ............................................... 2-6
Measuring Rate Risk ....................................................................................... 2-8

3 Transfer Pricing Methods

Cash Flow Methods ........................................................................................ 3-1
   Weighted Average Cash Flow (WACF) .......................................................... 3-2
   Zero Coupon Pricing (ZCP) ............................................................................ 3-3
   Performing a Rate Lookup ............................................................................ 3-5
   Endpoints .................................................................................................... 3-5
   How to Quality-Control Your Answers ....................................................... 3-6
   How to Understand Your Answers .............................................................. 3-7
   Viewing Results in the Process_Cash_Flows Table .................................... 3-7
   Investigating the Results of an Unexpected Transfer Rate ....................... 3-8

Mid-Period Repricing .................................................................................... 3-19
   General Processing Steps ........................................................................... 3-19

4 Overview of the Process

What is an Historical Rates Table? ................................................................. 4-1
Defining Your Historical Rates Table ........................................................... 4-1
   Interest Rate Codes .................................................................................... 4-1
   Terms to Define for each Interest Rate Code ............................................ 4-2
   Historical Rates Input Frequency ............................................................... 4-2
   Numbering Schemes for Interest Rate Codes ............................................ 4-2
Updating Your Historical Rates Table ........................................................... 4-3
   Initial Creation of Historical Rates Table ................................................ 4-3
   Regular Maintenance of Historical Rates Table ......................................... 4-3

Leaf Fields .................................................................................................. 4-3
   The Purpose of Leaf Fields ....................................................................... 4-3
   Leaf Fields used in Transfer Pricing ........................................................... 4-3
   Product Leaf ID .......................................................................................... 4-4
   Common Chart of Accounts Leaf ID ............................................................ 4-4
   Organizational Leaf ID .............................................................................. 4-5
   How to Assign Leaf Values ....................................................................... 4-5
Data Filter ID ....................................................................................................................................... 4-6
Reconciling the Data .......................................................................................................................... 4-6
  Selecting Data for Reconciliation Reports ...................................................................................... 4-6
Transfer Pricing ID ........................................................................................................................... 4-7
  Accounts with Related Instrument Data ......................................................................................... 4-7
  Ledger-Only Accounts ................................................................................................................. 4-7
Prepayment ID .................................................................................................................................. 4-7
Transfer Pricing Processing ID ......................................................................................................... 4-7
Quality Controlling the Answers ...................................................................................................... 4-8
  Reviewing the Historical Rates Table ............................................................................................ 4-8
  Reviewing the Transfer Rates and Matched Spreads for Each Account ...................................... 4-8
  Reviewing the Processing Errors .................................................................................................... 4-8
  Reviewing the Impact on the Funding Center ................................................................................ 4-8
Reprocessing Erroneous Accounts ................................................................................................. 4-8
  Refining Your Processing Filter ID ................................................................................................. 4-9
Advanced Transfer Pricing Concepts ............................................................................................... 4-9
  Remaining Term Basis .................................................................................................................... 4-9
  Option Costs and Liquidity Premiums ........................................................................................... 4-9
  Breakage Charges .......................................................................................................................... 4-9

5 Overview of IDs

Creating an ID ..................................................................................................................................... 5-2
Opening an Existing ID ......................................................................................................................... 5-3
Closing and Saving an ID ..................................................................................................................... 5-4
  Save As ............................................................................................................................................ 5-4
  Rename ......................................................................................................................................... 5-4
Deleting an ID ..................................................................................................................................... 5-5
  Delete a Group of IDs ...................................................................................................................... 5-5
Leaf Setup .......................................................................................................................................... 5-6
  Creating a Leaf Setup Dialog Box .................................................................................................... 5-7
Aggregation Methods for Financial Elements .................................................................................... 5-10
  Average Method ............................................................................................................................ 5-10
  Accrual Method .............................................................................................................................. 5-11
  Sum ................................................................................................................................................ 5-11
  First ................................................................................................................................................ 5-12
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last</td>
<td>5-12</td>
</tr>
<tr>
<td>Selecting an Aggregation Method</td>
<td>5-12</td>
</tr>
<tr>
<td><strong>Tree-Related IDs</strong></td>
<td></td>
</tr>
<tr>
<td>Tree-Related IDs</td>
<td>5-13</td>
</tr>
<tr>
<td>Hints on Editing Tree-related IDs</td>
<td>5-13</td>
</tr>
<tr>
<td><strong>Importing and Exporting Data</strong></td>
<td></td>
</tr>
<tr>
<td>Importing and Exporting IDs</td>
<td>5-13</td>
</tr>
<tr>
<td>Individual ID Import/Export</td>
<td>5-14</td>
</tr>
<tr>
<td>Dependent ID Import/Export</td>
<td>5-15</td>
</tr>
<tr>
<td>Group Import/Export</td>
<td>5-16</td>
</tr>
<tr>
<td>Export an ID with Group Import/Export</td>
<td>5-17</td>
</tr>
<tr>
<td>Export an ID from the File Menu</td>
<td>5-18</td>
</tr>
<tr>
<td>Rules, Limitations, and Hints</td>
<td>5-21</td>
</tr>
<tr>
<td><strong>OFSA ID Dependencies</strong></td>
<td>5-22</td>
</tr>
<tr>
<td><strong>Processing an ID</strong></td>
<td>5-23</td>
</tr>
<tr>
<td><strong>Server Status</strong></td>
<td>5-23</td>
</tr>
<tr>
<td>Using the Server Status Update Dialog Box</td>
<td>5-24</td>
</tr>
<tr>
<td>View Your jobs or All</td>
<td>5-24</td>
</tr>
<tr>
<td>Stop Job</td>
<td>5-24</td>
</tr>
<tr>
<td>Insert Test Request</td>
<td>5-24</td>
</tr>
<tr>
<td>Remove YOUR Finished Jobs</td>
<td>5-24</td>
</tr>
<tr>
<td>Server Polling Indicator</td>
<td>5-25</td>
</tr>
<tr>
<td>The Status Display</td>
<td>5-25</td>
</tr>
<tr>
<td>Changing a Password</td>
<td>5-27</td>
</tr>
<tr>
<td><strong>Spreadsheet Control Bar</strong></td>
<td>5-27</td>
</tr>
<tr>
<td>Increment Methods</td>
<td>5-27</td>
</tr>
<tr>
<td>Interpolation in Auto Increment</td>
<td>5-29</td>
</tr>
<tr>
<td>Increment a Range of Values</td>
<td>5-29</td>
</tr>
<tr>
<td><strong>6 Batch ID</strong></td>
<td></td>
</tr>
<tr>
<td>Defining a Batch ID</td>
<td>6-1</td>
</tr>
<tr>
<td>Processing a Batch ID</td>
<td>6-2</td>
</tr>
<tr>
<td>Editing a Batch ID</td>
<td>6-3</td>
</tr>
<tr>
<td><strong>7 Configuration ID</strong></td>
<td>7-1</td>
</tr>
</tbody>
</table>
8  Data Filter ID

Creating and Defining a Data Filter ID ................................................................. 8-1
  Defining Filter Types and Criteria .................................................................... 8-3
    Filter Type ................................................................................................. 8-4
    Filter Criteria ......................................................................................... 8-4
    Filter Criteria Rules ............................................................................... 8-5
    Implied Filter Criteria ............................................................................. 8-6
  Null Values in the Database ....................................................................... 8-6
Running a Data Filter ID .................................................................................. 8-7
Editing a Data Filter ID .................................................................................... 8-7
Using Data Filters on Multiple Tables ................................................................. 8-7
Reviewing a Data Filter ID Example ................................................................. 8-8

9  Data Verification ID

Creating and Defining a Data Verification ID ...................................................... 9-1
Running a Data Verification ID ........................................................................... 9-3
  Edit Spreadsheet On/Off ........................................................................... 9-4
  What the Results Show .............................................................................. 9-4
Editing a Data Verification ID .......................................................................... 9-4
Reviewing a Data Verification ID Example ...................................................... 9-5

10  Formula ID

Using the Formula ID Window .......................................................................... 10-2
  Operators and Operands .............................................................................. 10-3
  Function Types and Functions ..................................................................... 10-4
    Mathematical Functions ......................................................................... 10-4
    Date Functions ...................................................................................... 10-7
    String Functions .................................................................................... 10-9
    Other Functions ..................................................................................... 10-9
  Constants .................................................................................................. 10-10
  Tables and Output Columns ..................................................................... 10-10
    Output Columns (Data Elements) ........................................................... 10-11
  Formula Box ............................................................................................. 10-11
  Edit Options ............................................................................................. 10-11
Null Values in the Database........................................................................................................ 10-12
Formula ID Creation Hints........................................................................................................ 10-13
Creating a Formula ID ............................................................................................................. 10-14
Editing a Formula ID............................................................................................................... 10-14
Reviewing Formula ID Examples............................................................................................. 10-15

11  Group Filter ID
Creating and Defining a Group Filter ID .................................................................................. 11-1
Editing a Group Filter ID........................................................................................................... 11-3

12  Prepayment ID
Create a Prepayment ID........................................................................................................... 12-2
Prepayment Calculation Methods............................................................................................. 12-3
   Constant Calculation Method............................................................................................... 12-3
      Defining the Constant Calculation Method ..................................................................... 12-3
      Defining the Market Rate ............................................................................................... 12-4
      Defining the Prepayment Rate ...................................................................................... 12-4
      Seasonality ..................................................................................................................... 12-6
   Prepayment Table Calculation Method............................................................................... 12-6
      Defining the Prepayment Table Calculation Method ................................................... 12-7
      Defining the Market Rate ............................................................................................... 12-8
      Defining the Term .......................................................................................................... 12-8
      Defining the Prepayment Table ...................................................................................... 12-8
      Seasonality ..................................................................................................................... 12-10
   Arctangent Calculation Method ........................................................................................... 12-11
      Defining the Arctangent Calculation Method ............................................................... 12-14
      Defining the Market Rate ............................................................................................... 12-15
      Defining the Term .......................................................................................................... 12-15
      Defining the Prepayment Rate ...................................................................................... 12-16
      Seasonality ..................................................................................................................... 12-17
Edit a Prepayment ID............................................................................................................... 12-18

13  Prepayment Table ID
Creating a New Prepayment ID Table .................................................................................... 13-1
Prepayment Table Structure and Drivers................................................................. 13-2
  Table Structure........................................................................................................ 13-2
  Age/Term Drivers.................................................................................................... 13-2
  Interest Rate Drivers............................................................................................... 13-3
Defining the Dimensions......................................................................................... 13-3
Adding a Second Dimension to the Table.............................................................. 13-6
Adding a Third Dimension to the Table................................................................. 13-7
Editing Dimensions................................................................................................. 13-9
Deleting Dimensions............................................................................................... 13-9
Adding Prepayment Rates to the Table................................................................. 13-10

14 Rate Index ID
  Create a Rate Index ID.......................................................................................... 14-1
  Defining a Rate Index ID...................................................................................... 14-2
    Example: A Defined IRC.................................................................................... 14-4

15 SQL Talk
  SQL Talk Privileges.............................................................................................. 15-1
  Using SQL Talk..................................................................................................... 15-2
    Using Multiple SQL Talks Simultaneously....................................................... 15-2
    Creating Stored Procedures............................................................................. 15-3
  Limitations to the Spreadsheet Display and Processing Time.......................... 15-3
    Maximum Number of Rows and Columns Displayed...................................... 15-3
      Maximum Number of Rows.......................................................................... 15-3
      Maximum Number of Columns.................................................................... 15-3
    Optimizing Processing Time.......................................................................... 15-3

16 Transfer Pricing ID
  Defining a Transfer Pricing ID............................................................................. 16-1
    Method Types..................................................................................................... 16-2
      Cash Flow Pricing......................................................................................... 16-3
      Moving Averages......................................................................................... 16-4
    Straight Term.................................................................................................... 16-5
    Spread From Interest Rate Code..................................................................... 16-6
Spread From Note Rate ................................................................. 16-8
Unpriced Account ........................................................................ 16-8
Redemption Curve ...................................................................... 16-10
More on Mid-Period Repricing .................................................. 16-11
Specifying Option Cost Calculation Methods .......................... 16-12
Edit a Transfer Pricing ID .......................................................... 16-12
Transfer Pricing ID Examples ..................................................... 16-13

17  Transfer Pricing Processing ID

Defining a Transfer Pricing Processing ID .................................. 17-1
Calculations Page ........................................................................ 17-2
Inputs Page .................................................................................. 17-3
Process Tables Page ................................................................. 17-5
Propagation Page ........................................................................ 17-6
Process Mode Page ..................................................................... 17-9

Processing a Transfer Pricing Processing ID ........................... 17-10
Editing a Transfer Pricing Processing ID ................................. 17-11

18  Tree Filter ID

Creating a New Tree Filter ID .................................................... 18-2
Using the Tree Filter ID Window ............................................... 18-3
Rollup Tree Pane ................................................................. 18-3
Display Level Pane ............................................................... 18-4
Edit Menu ................................................................................. 18-4
Options Menu ............................................................................ 18-6
Tree Menu ................................................................................ 18-8
Save the ID ............................................................................... 18-10

Editing a Tree Filter ID ............................................................. 18-10
Example: Creating and Defining a New Tree Filter ID ............. 18-11

19  Tree Rollup ID

Creating a New Tree Rollup ID ..................................................... 19-2
Using the Tree Rollup ID Window .............................................. 19-3
Rollup Tree Pane ................................................................. 19-3
20 User-Defined Payment Pattern

Payment Pattern Structure ................................................................. 20-1
  Payment Phases ................................................................................. 20-3
    Payment Method ............................................................................. 20-4
    Value ............................................................................................... 20-5
  Absolute Patterns ............................................................................... 20-5
  Relative Patterns ............................................................................... 20-7
  Split Patterns .................................................................................. 20-8

Defining a Payment Pattern ............................................................... 20-9
  Creating Payment Phases for an Absolute Payment Pattern .......... 20-10
  Creating Payment Phases for a Relative Payment Pattern .......... 20-12
  Splitting a Payment Pattern ......................................................... 20-13
    Split Pattern Example ................................................................. 20-14

Editing a Payment Pattern ................................................................. 20-16

Deleting a Payment Pattern ............................................................... 20-17

21 User Defined Repricing Pattern

Repricing Pattern Structure .............................................................. 21-1
  User Defined Repricing Pattern ...................................................... 21-1
    Repricing Pattern User Interface ................................................. 21-2
  User Defined Repricing Event ....................................................... 21-2
    Repricing Event User Interface .................................................. 21-3
    Event Detail ................................................................................. 21-5

Defining a Repricing Pattern ............................................................... 21-7

Editing a Repricing Pattern ............................................................... 21-8
### 22 Cash Flow Calculations

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument Level Modeling</td>
<td>22-1</td>
</tr>
<tr>
<td>Modeling Flexibility Defined by Instrument Data</td>
<td>22-2</td>
</tr>
<tr>
<td>Daily Cash Flows</td>
<td>22-2</td>
</tr>
<tr>
<td>Event-Driven Logic</td>
<td>22-2</td>
</tr>
<tr>
<td>Financial Elements</td>
<td>22-2</td>
</tr>
<tr>
<td>Conventions Used in This Chapter</td>
<td>22-3</td>
</tr>
<tr>
<td>Cash Flow Calculation Process</td>
<td>22-3</td>
</tr>
<tr>
<td>- Initialization of Data</td>
<td>22-4</td>
</tr>
<tr>
<td>- Determine Account Type of Instrument</td>
<td>22-4</td>
</tr>
<tr>
<td>- Initialize Interface Data</td>
<td>22-5</td>
</tr>
<tr>
<td>- Interest Credited</td>
<td>22-5</td>
</tr>
<tr>
<td>- Rate Compounding Basis</td>
<td>22-6</td>
</tr>
<tr>
<td>- User Defined Payment Patterns</td>
<td>22-6</td>
</tr>
<tr>
<td>- User Defined Repricing Pattern</td>
<td>22-6</td>
</tr>
<tr>
<td>- Initialize Cash Flow Data</td>
<td>22-7</td>
</tr>
<tr>
<td>- Static Characteristics</td>
<td>22-7</td>
</tr>
<tr>
<td>- Dynamic Characteristics</td>
<td>22-8</td>
</tr>
<tr>
<td>- Triggers</td>
<td>22-8</td>
</tr>
<tr>
<td>- Initializing Schedule Records</td>
<td>22-9</td>
</tr>
<tr>
<td>- Amortization Code 800</td>
<td>22-9</td>
</tr>
<tr>
<td>- Amortization Code 801</td>
<td>22-9</td>
</tr>
<tr>
<td>- Amortization Code 802</td>
<td>22-9</td>
</tr>
<tr>
<td>- Initializing Pattern Records</td>
<td>22-10</td>
</tr>
<tr>
<td>- Single Timeline Patterns</td>
<td>22-10</td>
</tr>
<tr>
<td>- Example</td>
<td>22-10</td>
</tr>
<tr>
<td>- Multiple Timeline Patterns (Payment Patterns Only)</td>
<td>22-11</td>
</tr>
<tr>
<td>- Modeling Start and End Dates</td>
<td>22-11</td>
</tr>
<tr>
<td>- Additionally Derived Data</td>
<td>22-12</td>
</tr>
<tr>
<td>- Initialization of Adjustable Rate Instruments for Transfer Pricing</td>
<td>22-12</td>
</tr>
<tr>
<td>- Percent Sold Adjustment</td>
<td>22-13</td>
</tr>
<tr>
<td>- Process Modeling Events</td>
<td>22-13</td>
</tr>
<tr>
<td>- Payment Calculation Event</td>
<td>22-14</td>
</tr>
</tbody>
</table>

Deleting a Repricing Pattern

---

21-8
Static Information - Conventional Adjustable and Payment Patterns ...................... 22-14
Additional Information - Adjustable Neg-Am: ............................................................ 22-14
Event Trigger - Transfer Pricing ................................................................. 22-14
Event Triggers - Conventional Adjustable and Conventional Payment Patterns 22-14
Event Triggers - Adjustable Neg Am ................................................................. 22-15
Payment Calculation Steps.................................................................................. 22-15
Payment Event ........................................................................................................ 22-17
  Static Information ......................................................................................... 22-17
  Dynamic Information ..................................................................................... 22-18
  Event Triggers ............................................................................................... 22-18
  Additional Assumption Information ............................................................... 22-18
Payment Event Steps.......................................................................................... 22-18
  Rate per Payment -- Accrual Adjustment ......................................................... 22-19
  Accrual Factor Codes...................................................................................... 22-19
  Rate per Payment -- Compounding Adjustment ................................................. 22-19
  Rate per Payment - Stub and Extended Payment Adjustment ......................... 22-20
  Percent of Original Payment ........................................................................ 22-20
  Percent of Current Payment .......................................................................... 22-21
  Percent of Current Balance ........................................................................... 22-21
  Percent of Original Balance ......................................................................... 22-22
  Absolute Value ............................................................................................... 22-22
Interest in Advance Calculations ........................................................................ 22-25
Prepayment Event ............................................................................................. 22-26
  Static Information ......................................................................................... 22-26
  Dynamic Information ..................................................................................... 22-26
  Additional Assumption Information ............................................................... 22-26
  Event Trigger ............................................................................................... 22-27
Prepayment Event Steps..................................................................................... 22-27
Reprice Event ...................................................................................................... 22-33
  Notes About Reprice Event ......................................................................... 22-34
  Reprice Steps ............................................................................................... 22-34
Additional Processing Events ............................................................................ 22-39
  Deferred Amortization Calculation Steps......................................................... 22-39
Market Value Calculation .................................................................................. 22-42
  Market Value Calculation Steps .................................................................. 22-43
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accumulation Methods</td>
<td>22-45</td>
</tr>
<tr>
<td>Accumulation Methods for Financial Elements</td>
<td>22-45</td>
</tr>
<tr>
<td>Average Method</td>
<td>22-46</td>
</tr>
<tr>
<td>Accrual Method</td>
<td>22-46</td>
</tr>
<tr>
<td>Sum Method</td>
<td>22-47</td>
</tr>
<tr>
<td>At First Method</td>
<td>22-47</td>
</tr>
<tr>
<td>At Last Method</td>
<td>22-47</td>
</tr>
<tr>
<td>Detail Cash Flow Data</td>
<td>22-47</td>
</tr>
<tr>
<td>Event Use Code Values</td>
<td>22-51</td>
</tr>
<tr>
<td>Financial Element Calculations</td>
<td>22-52</td>
</tr>
<tr>
<td>Rule of 78s Example</td>
<td>22-55</td>
</tr>
</tbody>
</table>

## 23 The Migration Process

<table>
<thead>
<tr>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assumptions</td>
<td>23-1</td>
</tr>
<tr>
<td>Requirements for Successful Migration</td>
<td>23-2</td>
</tr>
<tr>
<td>TP Configuration ID</td>
<td>23-2</td>
</tr>
<tr>
<td>Product Leaf</td>
<td>23-3</td>
</tr>
<tr>
<td>Transfer Pricing ID</td>
<td>23-3</td>
</tr>
<tr>
<td>Data Filter ID</td>
<td>23-4</td>
</tr>
<tr>
<td>Migration and Leaf Setup</td>
<td>23-5</td>
</tr>
<tr>
<td>Offset Org Unit</td>
<td>23-8</td>
</tr>
<tr>
<td>Transfer Pricing Processing ID</td>
<td>23-8</td>
</tr>
<tr>
<td>Standards for the LEDGER_STAT Table</td>
<td>23-9</td>
</tr>
<tr>
<td>WATR and Charge/Credit Rows</td>
<td>23-10</td>
</tr>
<tr>
<td>Migration Mechanics and the Virtual Memory Table</td>
<td>23-11</td>
</tr>
<tr>
<td>Example of Transfer Rate Migration</td>
<td>23-12</td>
</tr>
<tr>
<td>Phase One: INSTRUMENT Table Accumulation</td>
<td>23-14</td>
</tr>
<tr>
<td>Phase Two: LEDGER_STAT Accumulation and Processing</td>
<td>23-14</td>
</tr>
<tr>
<td>Direct TP Migration</td>
<td>23-17</td>
</tr>
<tr>
<td>Unpriced Accounts</td>
<td>23-17</td>
</tr>
<tr>
<td>WATR (FinElem 170)</td>
<td>23-19</td>
</tr>
<tr>
<td>Charge/Credit for Funds (FinElem 450)</td>
<td>23-19</td>
</tr>
<tr>
<td>Migration of Transfer Rates Under Remaining Term Methodology</td>
<td>23-20</td>
</tr>
<tr>
<td>Migration of Option Costs</td>
<td>23-20</td>
</tr>
<tr>
<td>Migration Tips</td>
<td>23-21</td>
</tr>
</tbody>
</table>
A  Transfer Pricing Error Messages

B  Fiscal Year Information

FISCAL_YEAR_INFO Configuration for a Fiscal Year ................................................................. B-1
  Start_Month Column ............................................................................................................. B-1
  Fiscal_Period Column ........................................................................................................ B-2
Year-To-Date Calculations Affected by a Fiscal Year Configuration ................................. B-2
Viewing the Start_Month and Fiscal_Period Values in the FISCAL_YEAR_INFO Table... B-3
Examples of Calendar and Fiscal Year Configurations ....................................................... B-3
  Using a Calendar Year Configuration .................................................................................. B-4
  Using a Fiscal Year Configuration with a 12-Month Duration ........................................... B-4
  Using a Fiscal Year Configuration with a 6-Month Duration ............................................. B-5
Using the Undo Function with a Fiscal Year Configuration ............................................. B-6

Glossary

Index
Send Us Your Comments

Part No.  A80991-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document title and part number, and the chapter, section, and page number (if available). You can send comments to us in the following ways:

- Electronic mail - fsdocmail@us.oracle.com
- FAX - (650) 506-7200   Attn: Oracle Financials Documentation Manager
- Postal service:
  Oracle Corporation
  Oracle Financials Documentation Manager
  500 Oracle Parkway
  Redwood Shores, CA  94065
  USA

If you would like a reply, please give your name, address, telephone number, and (optionally) electronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.
Preface

This reference guide describes the features of Oracle Transfer Pricing. This preface describes the following information about the reference guide:

- Intended audience
- Organization
- Report-related changes
- Related documents
- Conventions
- Customer support information

Intended Audience

Oracle Transfer Pricing is designed for use by finance professionals within the financial services industry. Therefore, this guide assumes you are familiar with terms and concepts related to transfer pricing. It also assumes that Oracle Transfer Pricing has already been installed on your client/server system.
This reference guide is organized into the following chapters:

Chapter 1  Transfer Pricing is introduced, including information on logging in and using the main interface.

Chapter 2  The transfer pricing concept and the remaining term method are discussed.

Chapter 3  An overview of cash flow methods and mid-period repricing used in Transfer Pricing is presented.

Chapter 4  This chapter provides an overview of the transfer pricing process.

Chapter 5  Transfer Pricing ID and various methods are described.

Chapter 6  This chapter discusses defining, processing, and editing a batch ID.

Chapter 7  This chapter discusses how to define a configuration ID.

Chapter 8  Data filters are discussed in detail, including how to create, define, run, edit and use them.

Chapter 9  Data Verification ID is defined. Editing the ID is also covered.

Chapter 10 Use of the Formula ID window is discussed, along with creating and editing formula IDs.

Chapter 11 Group Filter ID is defined. Editing the ID is also covered.

Chapter 12 This chapter discusses how to create and edit a prepayment ID, and presents various prepayment calculation methods.

Chapter 13 Prepayment ID tables are discussed, including how to create and edit them.

Chapter 14 Creating and editing a rate index ID is discussed.

Chapter 15 This chapter presents SQL talk and its impact on spreadsheets and processing time.

Chapter 16 Defining and editing a transfer pricing ID is discussed.

Chapter 17 This chapter covers defining and processing a transfer pricing processing ID.

Chapter 18 Report Runner Dialog and its usage are described.

Chapter 19 Creating, using, and editing a tree rollup ID is discussed.
This reference guide also contains a glossary and an index.

Report-Related Changes

Oracle Discoverer is the recommended reporting tool for OFSA release 4.5. Discoverer is fully integrated with the following OFSA products:

- Oracle Financial Data Manager Balance & Control
- Oracle Performance Analyzer
- Oracle Risk Manager
- Oracle Transfer Pricing

This release supports both Oracle Discoverer and the reporting tool used in previous releases. You can find information about both reporting tools in the following documents:

<table>
<thead>
<tr>
<th>Reporting Tool</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Discoverer</td>
<td>Oracle Discoverer User Guide</td>
</tr>
<tr>
<td></td>
<td>Oracle Discoverer Administrator Guide</td>
</tr>
<tr>
<td>Oracle Portfolio Analyzer</td>
<td>Oracle Portfolio Analyzer Reference Guide</td>
</tr>
</tbody>
</table>

Report-related chapters and appendixes have been removed from OFSA reference guides and moved to the Oracle Portfolio Analyzer Reference Guide. Such chapters and appendixes include:

- Report ID
For information about installing and configuring Transfer Pricing, see the Oracle Financial Data Manager Installation and Configuration Guide.

If you have installed other OFSA applications, refer to their reference guides.

For information about the Financial Data Manager database, which supports Transfer Pricing and all other OFSA applications, refer to these publications:

- Oracle Financial Data Manager Administration Guide
- Oracle Financial Data Manager Data Dictionary
Conventions

This reference guide uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical ellipsis</td>
<td>Vertical ellipsis points in an example mean that information not</td>
</tr>
<tr>
<td></td>
<td>directly related to the example has been omitted.</td>
</tr>
<tr>
<td>Horizontal ellipsis</td>
<td>Horizontal ellipsis points in statements or commands mean that</td>
</tr>
<tr>
<td></td>
<td>parts of the statement or command not directly related to the example</td>
</tr>
<tr>
<td></td>
<td>have been omitted.</td>
</tr>
<tr>
<td>Boldface type</td>
<td>Boldface type in text indicates a term defined in the text, the</td>
</tr>
<tr>
<td></td>
<td>glossary, or in both locations.</td>
</tr>
<tr>
<td>Bold monospace</td>
<td>Bold monospace type in text indicates information that you type in.</td>
</tr>
<tr>
<td>Italic</td>
<td>Italic emphasize a word or phrase.</td>
</tr>
<tr>
<td>Angle brackets</td>
<td>Angle brackets enclose user-supplied names (for example, &lt;Branch Name&gt;).</td>
</tr>
<tr>
<td>Brackets</td>
<td>Brackets enclose function and terminal keys. In common syntax,</td>
</tr>
<tr>
<td></td>
<td>brackets denote one or more optional items.</td>
</tr>
<tr>
<td>Braces</td>
<td>Braces are used to denote variables, and in command syntax, a choice</td>
</tr>
<tr>
<td></td>
<td>within a mandatory item.</td>
</tr>
<tr>
<td></td>
<td>Example of command syntax:</td>
</tr>
<tr>
<td></td>
<td>Example of choices:</td>
</tr>
<tr>
<td></td>
<td>[EXIT]</td>
</tr>
<tr>
<td>Arrow</td>
<td>This arrow indicates a menu path.</td>
</tr>
</tbody>
</table>

Symbols

- Bullets indicate a list of items or topics.

1. Numbered lists are used for sequential steps in completing a procedure.

Orientation of Procedures

Procedures in OFSA reference guides are generally menu-driven rather than command- or icon-driven. Only occasionally is a reference to a toolbar or mouse action necessary because the action has no menu equivalent. If you prefer to use the toolbar icons, refer to Chapter 1, “Introduction.”
Notes, Cautions, and Warnings
Certain information may be set off in boxes for purposes of emphasis:

- **Note** refers to interesting but incidental information about the product or information that may be important but of lesser degree than a Caution or Warning.
- **Caution** indicates the possibility of damage to a product, system, or data.
- **Warning** refers to a situation that is potentially hazardous to people.

Customer Support Information

Product support is available through Oracle Support Services. Contact your project manager for information about using the support options offered in your geographic region. These options may include the following:

- MetaLink (which provides online access to information about Technical Libraries, Patches, TARs, and Bugs and is available at metalink.oracle.com)
- Telephone support
Transfer Pricing is the industry standard for Matched Rate Transfer Pricing your entire balance sheet. Matched Rate Transfer Pricing measures the accurate value of all sources and uses of funds for an institution. Transfer Pricing calculates a transfer rate at the lowest possible level of detail, the transaction record level, thereby allowing the measurement of interest profitability at this level.

You can apply various methods of transfer pricing to any account, from high level assumptions to transfer pricing each OFSA generated cash flow. Transfer Pricing combines advanced methodologies with a flexible and easy to interpret reporting approach to ensure accurate results.

A transfer priced balance sheet is merely the beginning. Results can be accessed by a performance reporting tool (Performance Analyzer) to measure total profitability. They can be accessed in a budgeting and planning tool (Budgeting and Planning), and also can be accessed in an Asset/Liability Model (Risk Manager).

**Oracle Financial Services Overview**

You can use Oracle Transfer Pricing as a standalone application or as part of the Oracle Financial Services (OFS) group of applications. As with all the other OFS applications, however, the Oracle Financial Data Manager provides the foundation for Transfer Pricing.
OFS Applications

OFS applications form a comprehensive decision support solution that significantly enhances transfer pricing, budgeting and planning, risk management, and performance measurement functions across a financial institution.

Oracle Financial Data Manager
Oracle Financial Data Manager (FDM) is a standalone data warehouse with prepackaged data elements for the financial services industry. FDM is also the foundation for the OFS applications. It provides the database structures necessary to support the individual business applications.

FDM includes Oracle Financial Data Manager Balance & Control, Oracle Financial Data Manager Administration, Oracle Financial Data Manager/Discoverer Integrator, and Oracle Financial Data Manager Rate Manager.

Oracle Financial Data Manager Balance & Control
Balance & Control validates, corrects, and aggregates data from the FDM.
Oracle Financial Data Manager Administration  FDM Administration manages the FDM, providing security and maintenance capabilities.

Oracle Financial Data Manager/Discoverer Integrator  Discoverer Integrator integrates the FDM database with Oracle Discoverer, which provides ad hoc reporting, analysis, and Web publishing capabilities.

Oracle Financial Data Manager Rate Manager  FDM Rate Manager manages interest rate, exchange rate, and currency information for the FDM.

Oracle Budgeting & Planning
Budgeting & Planning provides performance-based planning. It integrates cash flow balance sheet and net income forecasting capabilities with the scalability and customizable framework of Oracle Financial Analyzer, part of the Oracle Express group of data access and analysis tools.

Oracle Transfer Pricing
Transfer Pricing calculates a transfer rate for each account and a charge or credit for funds for each asset or liability.

Oracle Performance Analyzer
Performance Analyzer provides comprehensive and flexible cost and equity allocations. It measures product, business unit, and customer profitability.

Oracle Risk Manager
Risk Manager forecasts cash flows, interest income, and market value in order to manage rate risk.

Oracle Customer Householding
Customer Householding provides a fully scalable parallel-processing engine for customer data loading and cleansing, customer relationship linking, customerization, householding, and data aggregation within FDM.

Logging In to OFS

To log in to any OFS application, double-click the appropriate OFS icon from Windows. The OFS Login dialog appears.

In Windows NT or Windows 95, you can run multiple OFS applications, but you should run each application in its own memory space.
Menus and Toolbars

You can use menus or the toolbar icons to activate Transfer Pricing options.

Menus

A typical OFS menu bar consists of the following menu options:

- File
- Edit
- Process
- Setup
- Options
- Tools
- Window
- Help

File Menu

The options of the File menu are used primarily for file management. This includes creating new files, opening existing files, saving, deleting, and renaming files. This menu also contains commands for printing IDs and dialogs, and for exiting the application.

Save  Select Save to save IDs as you are creating or modifying them. You are prompted to confirm the save.

You should save your work every few minutes. From the File menu select Save, or click the Save icon (which resembles a floppy disk) on the toolbar.

Delete  Select Delete to remove the open and active ID from the disk. You are prompted to confirm the deletion.

If you want to delete more than one open ID, make each ID active by clicking anywhere within the dialog window and delete it.

Delete Group  To delete a group of IDs, complete the following steps. Each ID does not need to be open and active for you to delete the entire group.

1. From the file menu, select Delete Group. The Delete Group window appears.
2. From the ID Type list, select the type of ID that you want to delete. All IDs of this type appear in the list below the ID Type list.

3. Select the IDs you want to delete, and select the Add button to list them in the ID Type/ID Name box.

4. Repeat steps 1 and 2 for as many ID types as required. You can select and delete multiple IDs of multiple types all at once. The following table describes other features of the Delete Group window.

<table>
<thead>
<tr>
<th>Selection Buttons</th>
<th>Four buttons control the movement of IDs between the ID list box and the Selected IDs box.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select Add to add the ID to the Selected IDs box. Select Select All to select all the IDs of the chosen type.</td>
</tr>
<tr>
<td></td>
<td>Select Remove to remove an ID from the list you have made in the Selected IDs box.</td>
</tr>
<tr>
<td></td>
<td>Select Remove All to remove all of them from the Selected IDs list.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Order Buttons</th>
<th>To change the order of IDs in the Selected IDs box, select an ID and click the up or down Order arrows located below the list box.</th>
</tr>
</thead>
</table>

| ID Information    | You can view various data about each ID before you delete it. Select any ID name in the ID list box, and click the right mouse button. An information box for that ID appears. |

5. When your list of IDs is complete, select Remove All to delete the group of IDs.

**Import/Export Group** Refer to Chapter 5, "Overview of IDs" for a full discussion of this menu option.

**Dependencies** Refer to Chapter 5, "Overview of IDs" for a full discussion of this menu option.

**Print** Select Print to print the open and active ID or dialog. Select Yes to proceed, or No to cancel the print job.

**Print Group** To print a group of IDs, complete the following steps. It is not required that each ID in the group is open in order to print the entire group.

1. From the File menu, select Print Group.
2. Select the type of ID you want to print from the ID Type list. All IDs of this type appear in the list below the ID Type list.

3. Select the IDs that you want to print, and select the Add button to list them in the Selected IDs box.

4. Repeat steps 2 and 3 for as many ID types as required. You can select multiple IDs of multiple types.

5. To change the order of the listed IDs in the Selected IDs list box, select an ID and click the up or down Order arrows below the list.

6. When your list of IDs is complete, click OK to proceed with the group print.

7. Click Yes to proceed or No to cancel the print job.

**Edit Menu**

Use the Edit menu options to copy and move material from place to place, and to delete spreadsheet rows.

**Search** Use the Search option to locate a specific leaf value. There are three search options:

- **Search Field** Specify Leaf Value or Description.
- **Search String** Type in the Leaf Value or Description.
- **Search Options** Choose Case Sensitive if you want your search to match the string exactly as you entered it. Select Continue Searching... if your search begins part way down the tree (at the cursor location) but you also want to search above.

Click OK to begin the search. When the search is complete and successful, the search dialog closes and the found leaf ID is highlighted. If the search string is not found, an error message appears.

**Process Menu**

The Process menu contains the following options:

- Run
- Server Status
- SQL Talk
**Run** Select this option to begin any process.

**Server Status** Use this option to check the status of the processes running on the server.

**SQL Talk** For information regarding the SQL Talk option, refer to Chapter 15, "SQL Talk".

**Setup Menu**

The Setup menu contains one option: Leaves.

**Leaves** To access the Leaf Setup dialog, select Leaves from the Setup menu.

With Leaf Setup, you can view, edit, insert, renumber, or delete any Leaf Value from any Leaf Type in the database. For further information about the Leaf Setup dialog, refer to Chapter 5, "Overview of IDs".

**Options Menu**

Use the Options menu to set up preferred screen displays, and to change users’ passwords.

**ToolBar** This is a “toggle” option, that is, it turns the display of the toolbar on and off. When the option is “on,” a check mark is displayed.

**Status Bar** This is a “toggle” option, that is, it turns the display of the status bar on and off. When the option is “on,” a check mark is displayed.

**Customize ID Toolbar** You can customize the vertical toolbar using this option. For more information, see the section “Toolbars” later in this chapter.

**Change Password** Use this option to change the password for the Current User of this OFS application. When you select Change Password, the Change User Password dialog appears.

**Login name** The name of the current user appears here.

**Current password** This box appears blank. Enter the current password for the current user. Asterisks appear as you type, for security reasons.
Menus and Toolbars

**New password**  This box appears blank. Enter the new password for the current user. Asterisks appear as you type, for security reasons. Click OK to execute the change. Click Cancel to cancel the operation and close the dialog.

**Tree Bar**  This is a dialog box with a listing of accounts. When you open certain IDs, the dialog appears with the Floating Tree Bar:

On the Floating Tree Bar, select the account (or product) for which you would like to define a method. After you have selected an account you can close the Floating Tree Bar.

**Control Bar**  For information about the Control Bar, refer to Chapter 5, "Overview of IDs"

**Tools Menu**
Use the Tools menu to start the Discoverer applications: Oracle Discoverer User Edition, Oracle Discoverer Administration Edition, and Discoverer Integrator. The Tools menu is always present. If an application in not installed, however, its name is grayed out and it is not available for use.

**Window and Help Menus**
The Window menu options are for managing windows and icons, and for moving the cursor between windows.

The Help menu options are the topics for Help information for this OFS application. Both of these options operate under standard Windows guidelines.

**Status Bar**
Across the bottom of the screen is the Status Bar, where information about current operations is displayed. Position the pointer on any Toolbar icon to display the name of the icon on the Status Bar.
Toolbars

The horizontal and vertical toolbars are panels of icons that support shortcuts for menu commands and IDs.

Horizontal Toolbar

The horizontal toolbar provides shortcuts to menu commands. Following is the horizontal toolbar and the function each icon activates. You cannot customize this toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>New</td>
</tr>
<tr>
<td>2</td>
<td>Open</td>
</tr>
<tr>
<td>3</td>
<td>Save</td>
</tr>
<tr>
<td>4</td>
<td>Print</td>
</tr>
<tr>
<td>5</td>
<td>Delete</td>
</tr>
<tr>
<td>6</td>
<td>Close</td>
</tr>
<tr>
<td>7</td>
<td>Print Group</td>
</tr>
<tr>
<td>8</td>
<td>Delete Group</td>
</tr>
<tr>
<td>9</td>
<td>Group Import/Export</td>
</tr>
<tr>
<td>10</td>
<td>Run</td>
</tr>
<tr>
<td>11</td>
<td>Report Runner</td>
</tr>
<tr>
<td>12</td>
<td>Transform Data</td>
</tr>
<tr>
<td>13</td>
<td>Set Up Leaves</td>
</tr>
<tr>
<td>14</td>
<td>Discoverer User Edition</td>
</tr>
<tr>
<td>15</td>
<td>Discoverer Administration Edition</td>
</tr>
</tbody>
</table>

New: Create a new ID or pattern
Open: Open an existing ID or pattern
Save: Save an ID or pattern
Print: Print results
Delete: Delete an ID or pattern
Close: Close an ID or pattern
Print Group: Print a group of IDs
Delete Group: Delete multiple IDs
Group Import/Export: Import or export multiple IDs
Run: Run an ID
Report Runner: Run an active report
Transform Data: Run transformation on selected data
Set Up Leaves: Define user-defined and system leaves
Discoverer User Edition: Open the user edition of Discoverer
Discoverer Administration Edition: Open the administration edition of Discoverer
Two additional icons appear on the horizontal toolbar in Risk Manager and Transfer Pricing.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User-Defined Payment Pattern</td>
</tr>
<tr>
<td>2</td>
<td>User-Defined Repricing Pattern</td>
</tr>
</tbody>
</table>

**Note:** The Discoverer icons (14, 15, and 16) are always present. If an application is not installed, however, its icon is grayed out and it is not available for use.
Vertical Toolbar
The Vertical toolbar provides shortcuts to the IDs to which you have access in the application. Space limitations may restrict the icons that you see on the screen. However, you can customize the toolbar for your specific needs.

To customize the vertical toolbar, do the following:

1. From the Options menu, select Customize ID Toolbar.
   The Customize ID Toolbar window appears.
2. Locate the icon you want to add, delete, or move.
   Use the scroll bar on the Customize ID Toolbar window to find the icon that you want to add to the vertical toolbar. Or find the icon on the vertical toolbar you want to delete or move.
3. Add, delete, or move the icon.
   To add an icon to the toolbar, select and then drag the icon from the Customize ID Toolbar window to the vertical toolbar.
   To delete an icon, drag the icon from the toolbar to the Customize ID Toolbar window.
   To change the order of your icons, drag them individually from one location on the toolbar to another.
A transfer price for funds is an interest rate representing the value of those funds to the company. The purpose of a transfer price for funds is to provide a benchmark that allows one to judge whether the yield on a loan, for instance, is great enough to cover not only credit risk and operating cost, but also the cost of acquiring the funds that are needed to lend. Similarly, a transfer price for funds allows one to compare the total cost of each source of funds relative to other funding opportunities that are available to the company. In effect, a transfer price is used to measure the profit contribution of an asset or liability.

<table>
<thead>
<tr>
<th>Asset</th>
<th>Liability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less Transfer Cost Funds/Spread on Assets</td>
<td>Less Cost of Funds/Spread on Liability</td>
</tr>
<tr>
<td>Less Operating Cost/Profit Contribution</td>
<td>Less Operating Cost/Profit Contribution</td>
</tr>
</tbody>
</table>

Recognizing the value of funds transfer pricing, most larger banks have incorporated this into their performance measurement systems for years. However, the volatility of interest rates is forcing most banks to change transfer pricing methodologies that simply do not work in the current environment. This section discusses the traditional approaches to transfer pricing, and shows why these approaches do not work today. Then, both a description of the methodology that is being used by an increasing number of banks (matched rate transfer pricing), and an explanation of how this methodology overcomes the major shortcomings of the traditional approaches are provided.

**Traditional Approaches to Transfer Pricing**

Traditional approaches to transfer pricing used a single transfer rate and applied this rate to the net volume of funds generated or consumed by a business unit. Until
In the 1960s the single rate used in transfer pricing systems was generally the average cost of funds for the bank. This rate was used primarily for loan pricing. If the yield on a loan was higher than the average cost of funds for the bank, then the loan had a positive spread. As a result, many banks would make the loan. Over time, the problem with this approach became obvious — regulated low rate deposits (DDA and Savings Accounts) held the average funds cost for many banks at a level well below the cost of the new funds being raised to support new lending volumes.

Spreads on new volumes were not anywhere near what had been expected; and indeed, the low average cost of funds tempted many banks to under-price loans, sometimes to the point where the true spreads on new volumes were negative.

**Potential Dangers**

So for many banks using the average cost approach to transfer pricing, even a stable rate environment was potentially dangerous since the balance sheet could grow while earnings dropped.

Recognizing that the use of an average funds cost could result in unprofitable growth, most banks concluded they should use a transfer price reflecting their real cost of incremental funds. Typically, these banks used the cost of 30 or 90 day certificates of deposit as the cost of marginal funds. They assumed using marginal funds would make it almost impossible to unknowingly add volume at a negative spread, and they were correct, at least when interest rates remained stable.

**Rate Risk Trap**

Unfortunately, the single, marginal funds transfer rate created problems for at least one of two possible reasons. The first was that the use of such a rate led some financial institutions into a rate risk trap. In the 1960s and 1970s, because the yield curve was normal, long term assets offered the largest spreads against a 30 or 90 day transfer rate. So some banks, and virtually the entire savings and loan industry, happily borrowed short and lent long. Interest rates rocketed in 1979 and into the 1980s, with well-known results... the margin disappeared!

Most banks were able to avoid the extreme interest rate risk exposure which nearly destroyed the savings and loan industry. But the use of a single, marginal transfer rate created a second problem that did affect most banks. It undermined the credibility of performance measurement systems.

Most line of business managers found that their bottom lines would fluctuate wildly with interest rates. Since market interest rates were obviously beyond the control of line managers, profit goals for their units were increasingly viewed with skepticism. This skepticism was reinforced when the newly formed Asset/Liability
Management Committee severely cut back the volumes of new, fixed rate loans that could be booked, even though these loans had the largest spreads over the transfer rate.

Lost Managerial Value
The result was that there was no generally accepted (or politically acceptable) manner for determining where a bank made money. So business unit profitability reporting lost its managerial decision-supporting value.

In summary, while the traditional approaches to transfer pricing were acceptable when interest rates were relatively stable, they lost most of their decision-supporting value once rates became more volatile.

A New Approach to Transfer Pricing
As the traditional transfer pricing systems crumbled under their own weight, the industry began to search for a new approach. The best solution was developed and implemented by a few leading financial institutions in 1979 and 1980. This approach, called Matched Rate Transfer Pricing, uses multiple transfer rates. Assets and liabilities are given transfer rates that reflect their specific maturity and repricing characteristics.

Matched Rate Transfer Pricing resolves the three major problems that were inherent in traditional methodologies:

- Matched rate transfer pricing clearly shows whether new volumes have a positive spread by using a marginal rate. This eliminates the potential for inadvertent unprofitable growth.
- Potential rate risk traps are clearly identified well in advance by using a marginal rate. Further, the exposure of a bank to interest rate risk is identified and measured in a manner that makes it easier to manage.
- Matched rate transfer pricing ensures that the performance measurement system is consistent, fair, and credible by using a transfer rate that reflects real funding opportunities that are currently available to the bank.

Matched rate transfer pricing accomplishes these objectives by dividing spread into three components - credit spread, funding spread, and rate risk spread. These can be illustrated most easily by using the example of a retail financial institution that borrows short and lends long (such as a savings and loan association). The financial institution relies on a retail customer base for low cost funds, meaning funds that have lower interest rates than funds purchased in money markets. The retail funds
are usually in the form of short term certificates of deposit that cost 100 basis points less than purchased funds with similar maturity.

The loans, meanwhile, have a yield much higher than the financial institution would pay for funds having the same maturity. This example assumes that the rate on consumer loans is 200 basis points higher than the cost of similar maturity funding.

**Less Expensive Than Alternatives**

The funds are 100 basis points less than other alternatives, while the loan yields 200 basis points more that matched funding costs. Of course, if the financial institution funds the longer term consumer loan with the shorter term deposits, then the spread is even larger than 300 basis points.

The added spread results from taking interest rate risk (for instance, borrowing short and lending long). The three components of spread can be seen by plotting the loan and deposit against the yield curve.

As the savings and loan industry learned, the portion of total spread derived from taking interest rate risk can be volatile.

**Stabilizing Margins**

By using transfer rates that divide spread into these three components, matched rate transfer pricing solves the problems that resulted from traditional approaches. Business units that lend or gather funds are given transfer rates that act to stabilize margins. In effect, the spread on an asset or liability is fixed at a known level when the volume is booked. Future swings in interest rates will not affect the spread on business that is being done today. That means the bottom line for a business unit only reflects that business and factors subject to line management control.

Further, since the transfer rate reflects realistic lending and funding opportunities, the bottom line for each business unit represents a fair basis for performance measurement. If, over time, some types of loans do not consistently provide a yield enough higher than bonds to cover operating costs and credit risk, then there is no good reason to continue making those loans. It would be more profitable to buy bonds, or to find other, more profitable lending opportunities. This is the reason many banks no longer make small installment loans. Similarly, if the operating costs of gathering low cost consumer deposits is too large, it may be more economical to purchase funds in money markets. This explains the growing number of branch closures, as well as the imposition of higher and higher minimum balances on some types of consumer deposits.
Identifying Exposure to Risk

In addition to helping line managers make profit-based decisions, matched rate transfer pricing is unique in the fact that it clearly identifies the exposure of a bank to interest rate risk, and shows the current earnings impact of that exposure. By giving matched rates to all assets and liabilities generated by business units, matched rate transfer pricing removes interest rate risk from the measurement of business unit profitability. The risk exposure, and the current earnings impact of this exposure, are revealed in a new profit center called Treasury. (More detail on how the internal accounting for this works is included in the next section.) By isolating the risk in a separate business unit, banks have found that the risk becomes increasingly manageable.

In summary, then, matched rate transfer pricing works well as a lynch-pin of decision-supporting performance measurement in an environment of volatile interest rates. It provides an approach to performance measurement that meets the needs of both line managers (consistency, fairness, controllability) and executive managers (accuracy, flexibility). The industry has recognized these benefits, resulting in an increasing number of financial institutions that have either implemented, or are in the process of implementing performance measurement systems based on matched rate transfer pricing.

How Matched Rate Transfer Pricing Works

While matched rate transfer pricing requires more accounting discipline than traditional transfer pricing approaches, it is a relatively straightforward process. This section will provide a general description of how the matched rate transfer pricing process works.

Matched rate transfer pricing is applied in a very logical manner, using standard principles of dual-entry accounting. To see how it works, suppose a loan officer wants to make a loan, and is now trying to decide on its pricing. He will be given a cost of funds that reflects the maturity and repricing characteristics of his loan. If it is to be a long-term, fixed rate loan, he will be quoted the cost of the long-term funds that the bank could use to match that loan. If the loan is to be short term, the loan officer will be quoted a short-term rate. Obviously, then, if the yield curve is normal, the transfer rate for a short term loan will be less than the rate for a long-term loan. The loan officer will then figure out how to price the loan to attain a target spread over the quoted cost of funds.

When the loan is booked, two things happen. First, the business unit of the loan officer books a “shadow liability” equal in volume to the size of the loan, having a cost which equals the transfer rate that was quoted. This accounting transaction
balances the books of the business unit, and locks in a spread as long as the loan stays on the books.

At the same time, the books of the corporation must be balanced. To do this, a matched rate transfer pricing process would create a “shadow asset” with equal size and rate to the shadow liability. This shadow asset would be housed in a separate business unit, usually Treasury.

The same type of accounting would be applied to liabilities. When this is completed the bank has divided profits into the three components: lending profit, deposit gathering profit, and rate risk profit. These three components add up to the total profit of the company.

That is all there is to matched rate transfer pricing. Line officers get a rate quote representing either the cost of the funds they want to lend, or the value of the deposits they are gathering. The spread between this quoted rate and the interest rate on the asset or liability is fixed at a known level and maintained for the life of the asset or liability.

The Treasury area takes on responsibility for the volatility in spread which traditional transfer pricing methodologies left in the business units. This volatility, which will show up in the bottom line of the Treasury area, can be managed in several ways. For example, Treasury could maintain a discretionary portfolio of assets and liabilities with the sole purpose of offsetting the risk that has been transferred from other business units. Treasury could also use an off balance sheet transaction, such as swaps and futures, to hedge risk.

In summary, then, matched rate transfer pricing simply attaches a transfer rate to all assets and liabilities when they are booked, using a standard, double entry approach to accounting. This transfer rate remains constant over the life of the asset or liability, stabilizing the spread for the line of business.

**Remaining Term Method for Transfer Pricing**

**Evaluating Rate Risk Profits**

As described earlier, one component of the interest margin for your institution is the rate risk profit (or loss). The rate risk profit is derived by subtracting all credits for funds (funding center expense) from all charge for funds (funding center income).

A net positive number implies that part of your interest margin is due to any rate bets (or rate risk) your institution has taken in the past. A negative number implies that you have incurred a loss due to rate risk.
Embedded Versus Current Rate Risk

The total rate risk profit (or loss) figure is made up from two sources: Current Rate Risk Profit and Embedded Rate Risk Profit. Current Rate Risk Profit is the result of rate risk inherent in your current exposure. This can be actively managed through an effective Asset/Liability Management Process. Embedded Rate Risk Profit, however, is the result of interest rate bets you took in the past. You can no longer manage this component of earnings. The only way to change this impact is to wait it out.

Example: Embedded Versus Current Rate Risk

Here is a simple example to illustrate the concept of embedded rate risk. Let’s take a hypothetical “bank” on day 1, raises $1,000 in the form of a 1 year Certificate of Deposit at 4%. Suppose the wholesale alternative to 1 year funds costs 5.00%, so the Matched Transfer Rate is 5.00%.

The bank then lends the $1,000 in the form of a 5 year non-amortizing (bullet) loan at 10%. The cost of 5 year wholesale funds is 8%.

The following chart shows the components of the bank’s interest margin at Day 1:

<table>
<thead>
<tr>
<th>Income Statement Component</th>
<th>Rate</th>
<th>Transfer Rate</th>
<th>Spread</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>10.00%</td>
<td>8.00%</td>
<td>2.00%</td>
</tr>
<tr>
<td>Liability</td>
<td>5.00%</td>
<td>4.00%</td>
<td>1.00%</td>
</tr>
<tr>
<td>Funding Center Spread</td>
<td>3.00%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Net Interest Margin</td>
<td>6.00%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Now, suppose over the course of the next year, interest rates rise by 200 basis points. At that point the bank, eager to eliminate future rate risk, issues a new 4 year $1,000 CD at 8.5%. The 4 year Transfer Rate is now 9.5%.

The following chart describes the components of the interest margin for the bank after one year:
We see that although the bank is now perfectly matched from a current rate risk perspective (a 4 year bullet loan funded by a 4 year CD) it is losing a 150 basis points in the rate risk center. Why?

On day 1 the bank took a rate bet by funding short. The bet was that one year from today they would be able to raise 4 year funds at less than the cost of funding the original 5 year loan - or 8%. Since the 4 year transfer rate at day 1 was 7%, when interest rates went up by 200 basis points - the bank got hammered.

Although the net interest margin of the bank is still 150 basis points, they could have locked in a 300 basis point net interest margin for 5 years on day 1 if they had not taken a rate bet by issuing a 5 year CD.

This is embedded rate risk. There is nothing the bank can do, except wait, to eliminate this 150 basis point hit on $1,000.

### Measuring Rate Risk

#### How to Measure Current Rate Risk

Current Rate Risk can be measured by Transfer Pricing your entire balance sheet as if it were originated today. In other words, everything should be transfer priced based upon its remaining term. Under this method, a 5 year CD with 1 year until maturity would receive the same transfer rate as a 3 year CD with 1 year left.
How to Measure Embedded Rate Risk

The Total Rate Risk Profit is made up of Embedded Rate Risk and Current Rate Risk. Therefore:

\[ \text{Embedded Rate Risk} = \text{Total Rate Risk Result} - \text{Current Rate Risk Result} \]

Why is Measuring Embedded Rate Risk Important?

One might ask "If nothing can be done about embedded rate risk, why is it important to measure?" The answer to this question is simple. If you can identify the impact of embedded rate risk, you can plan for what lies ahead.

For example, if you had a large profit in the funding center due to embedded rate risk, and were unaware of this, you would be lulled into a false sense of security. You would, in fact, be in for a rude awakening when this source of profit evaporates.

Conversely, if you were experiencing a large loss in the funding center due to embedded rate risk, and you were able to measure it, you might take less drastic actions to "correct the problem."
This chapter discusses the standard Cash Flow Methods and Mid-Period Repricing methodology.

**Cash Flow Methods**

The Cash Flow Methods discussed in this section are:

- Duration
- Weighted Average Cash Flow
- Zero Coupon Pricing

**Duration**

The Duration method uses the MacCauley duration formula as follows.

\[
\text{Duration} = \frac{\sum_{n=1}^{N} \left[ \frac{CF_n}{(1+r)^m} \times t_n \right]}{\sum_{n=1}^{N} \left[ \frac{CF_n}{(1+r)^m} \right]}
\]

In this formula:

- \(N\) = Total number of payments from Start Date until the earlier of repricing or maturity
- \(CF_n\) = Cash flow (such as regular principal, prepayments, interest) in period \(n\)
- \(r\) = Periodic coupon rate on Instrument (Current Rate / Payments per Year)
Cash Flow Methods

\[ m = \text{Remaining Term to Cash Flow} / \text{Active Payment Frequency} \]

\[ tn = \text{Remaining Term to Cash Flow} n, \text{expressed in years} \]

The duration formula calculates a single term, that is, a point on the yield curve used to transfer price the instrument that is analyzed. Transfer Pricing calculates duration based on the cash flows of the instrument as determined by the characteristics defined in the data and using your specified prepayment rate, if applicable.

**Notes**

1. Current Rate is defined as Current Net Rate if the processing option “Model with Gross Rates” is not selected and Current Gross Rate if the option is selected. The current rate is used as the discount rate for each cash flow.

2. Remaining Term to Cash Flow is the difference between the date of each cash flow and the modeling start date for that instrument (which varies by pricing basis; see the following diagram).

**Weighted Average Cash Flow (WACF)**

This method builds on the theoretical concepts of duration. As shown earlier, duration calculates a weighted-average term by weighting each time period, \( n \), with the present value of cash flow (discounted by the rate on the instrument) in that period. Since the goal of WACF method is to calculate a weighted average transfer rate, it weighs the transfer rate in each period, \( y_n \), by the present value for the cash flow of that period. Furthermore, the transfer rates are weighted by an additional component, \( time \), to account for the length of time over which a transfer rate is applicable. The time component accounts for the relative significance of each strip cash flow to the total transfer pricing interest income/expense. The total transfer pricing interest income/expense on any cash flow is a product of that cash flow, the transfer rate, and the term. Hence, longer term cash flows will have relatively larger impact on the average transfer rate. The WACF method can be summarized by the following formula:

\[
\bar{y} = \frac{\sum_{n=1}^{N} \left[ y_n \times \frac{CF_n}{(1 + r)^m} \times t_n \right]}{\sum_{n=1}^{N} \left[ \frac{CF_n}{(1 + r)^m} \times t_n \right]}
\]
In this formula:

\[ N = \text{Total number of payments from Start Date until the earlier of repricing or maturity} \]

\[ CF_n = \text{Cash flow (such as regular principal, prepayments, interest) in period } n \]

\[ r = \text{Periodic coupon rate on Instrument (Current Rate / Payments per Year)} \]

\[ m = \text{Remaining Term to Cash Flow } n / \text{Active Payment Frequency} \]

\[ t_n = \text{Remaining Term to Cash Flow } n, \text{ expressed in years} \]

\[ y_n = \text{Transfer rate in period } n \]

**Zero Coupon Pricing (ZCP)**

This method takes into account common market practices in valuing fixed rate amortizing instruments. For example, all Treasury strips are quoted as discount factors. A discount factor represents the amount paid today to receive $1 at maturity date with no intervening cash flows (that is, zero coupon). The Treasury discount factor for any maturity (as well as all other rates quoted in the market) is always a function of the discount factors with shorter maturities. This ensures that no risk-free arbitrage exists in the market. Based on this concept, one can conclude that the rate quoted for fixed rate amortizing instruments is also a combination of some set of market discount factors. Discounting the monthly cash flows for that instrument (calculated based on the constant instrument rate) by the market discount factors generates the par value of that instrument (otherwise there is arbitrage).

ZCP starts with the assertion that an institution tries to find a funding source that has the same principal repayment factor as the instrument being funded. In essence, the institution strip funds each principal flow using their funding curve (that is, transfer pricing yield curve). The difference between the interest flows from the instrument and its funding source the net income of that instrument.

Next, ZCP tries to ensure consistency between the original balance of the instrument and the amount of funding required at origination. Based on the transfer pricing yield used to fund the instrument, the ZCP solves for a single transfer rate that would amortize the funding in two ways:

- Its principal flows match those of the instrument
- The PV of the funding cash flows (that is, the original balance) matches the original balance of the instrument.
ZCP uses zero coupon factors (derived from the original transfer rates, see example below) because they are the appropriate vehicles in strip funding (that is, there are no intermediate cash flows between origination date and the date the particular cash flow is received). The zero coupon yield curve can be universally applied to all kinds of instruments.

This approach yields the following formula to solve for a weighted average transfer rate based on the payment dates derived from the instrument’s payment data.

Zero Coupon Pricing $\bar{y} =$

$$100 \times \left[ \frac{B_0 - \sum_{n=1}^{N} (B_{n-1} \times DFTP_n) + \sum_{n=1}^{N} (B_n \times DFTP_n)}{\sum_{n=1}^{N} (B_{n-1} \times DFTP_n)} \right] \times \frac{1}{p}$$

In this formula:

- $B_0 =$ Beginning balance at time, 0
- $B_{n-1} =$ Ending Balance in previous period
- $B_n =$ Ending Balance in current period
- $DFTP_n =$ Discount factor in period n based on the TP yield curve
- $N =$ Total number of payments from Start Date until the earlier of repricing or maturity
- $p =$ Payments per year based on the payment frequency; (for example, monthly payments gives $p=12$)
Example

Deriving Zero Coupon Discount Factors from Monthly Pay TP Rates:

<table>
<thead>
<tr>
<th>(a) Term in Months</th>
<th>(b) Monthly Pay Transfer Rates</th>
<th>(c) Monthly Transfer Rate (Monthly Factor)</th>
<th>(d) PV of Interest Payments</th>
<th>(e) Denominator (1 - PV of Int Pmt)</th>
<th>(f) ZeroCoupon Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3.400%</td>
<td>0.283%</td>
<td>1.002833</td>
<td>0.000000</td>
<td>1.000000</td>
</tr>
<tr>
<td>2</td>
<td>3.500%</td>
<td>0.292%</td>
<td>1.002917</td>
<td>0.002908</td>
<td>0.997092</td>
</tr>
<tr>
<td>3</td>
<td>3.600%</td>
<td>0.300%</td>
<td>1.003000</td>
<td>0.005974</td>
<td>0.994026</td>
</tr>
</tbody>
</table>

Performing a Rate Lookup

A rate lookup is performed to derive a transfer rate for any date/term combination.

**Date Used:** Transfer Pricing accesses the yield curve from the date of your lookup. If no match is found, it uses the first date prior to the date of your lookup.

**Term Used:** Transfer Pricing selects the term on the yield curve on an exact number of days basis, calculated by subtracting the cash flow date from the transfer pricing date, which may be the as-of-date, the last reprice date, or the origination date depending on the method and the instrument characteristics. If the yield curve term is expressed in months or years, the term must be converted to a days basis, as follows:

- If Multiplier = M, Term in Days = Term in Months * 30.42
- If Multiplier = Y, Term in Days = Term in Years * 365

The rate is then derived from the yield curve by performing linear interpolation between two points on a yield curve that the lookup term falls between.

**Endpoints**

- If the term < shortest point then the rate = the shortest point.
- If the term > longest point then the rate = the longest point.
- If the date for the lookup > dates available then the lookup is on the last date for the yield curve.
If the date for the lookup < dates available then the lookup is on the first date for the yield curve.

Example

<table>
<thead>
<tr>
<th>Date</th>
<th>1 D</th>
<th>1 M</th>
<th>3 M</th>
<th>1 Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/1995</td>
<td>2.00</td>
<td>3.00</td>
<td>4.00</td>
<td>5.00</td>
</tr>
<tr>
<td>01/15/1995</td>
<td>2.10</td>
<td>3.10</td>
<td>4.10</td>
<td>5.10</td>
</tr>
<tr>
<td>01/31/1995</td>
<td>2.20</td>
<td>3.20</td>
<td>4.20</td>
<td>5.20</td>
</tr>
<tr>
<td>02/28/1995</td>
<td>2.30</td>
<td>3.30</td>
<td>4.30</td>
<td>5.30</td>
</tr>
</tbody>
</table>

Date/Term Combinations for Lookup:

<table>
<thead>
<tr>
<th>Date</th>
<th>Lookup Term</th>
<th>Yield Curve Date Used</th>
<th>Term Before</th>
<th>Term After</th>
<th>Rate</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/07/1995</td>
<td>60 days</td>
<td>01/01/1995</td>
<td>1 M</td>
<td>3 M</td>
<td>3.50</td>
<td>Rate is approximately half way between 3 M (91.26 Days) and 1 M (30.42 Days).</td>
</tr>
<tr>
<td>11/30/1967</td>
<td>182 days</td>
<td>01/01/1995</td>
<td>3 M</td>
<td>1 Y</td>
<td>4.33</td>
<td>3 Mo Rate + (182 Days - 91.26 Days) * (1 Yr Rate - 3 Mo Rate) / (365 Days - 91.26 Days) (such as 1/3rd of the Way between 3 M and 1 Y).</td>
</tr>
<tr>
<td>03/15/1995</td>
<td>2 Y</td>
<td>02/28/1995</td>
<td>1 Y</td>
<td>None</td>
<td>5.30</td>
<td>Uses last point on Yield Curve.</td>
</tr>
</tbody>
</table>

How to Quality-Control Your Answers

The following table lists some steps you can take to quality control your answers.

<table>
<thead>
<tr>
<th>Report to Run</th>
<th>What to Look For</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stratification by Transfer Rate</td>
<td>Look for any transfer rate &lt;= A selected Value (E.g. 3.00) or &gt;= another value (like 12.00)</td>
</tr>
<tr>
<td>Stratification by Matched Spread</td>
<td>Look for large (positive or negative) matched spreads. (for example, &gt;= 4.00 or &lt;= -2.00)</td>
</tr>
<tr>
<td>Stratification of Fixed Rate Instruments by Origination Date and Term with Weighted Average Transfer Rate and Matched Spreads as Columns</td>
<td>Look for General pattern to reflect the Transfer Pricing Yield Curves for each origination date</td>
</tr>
</tbody>
</table>

Oracle Transfer Pricing Reference Guide
If any of the reports provide strange answers, use data filters, reporting, and/or data verification to investigate the answers further.

**How to Understand Your Answers**

The first question to ask yourself to validate a suspect transfer rate is: “Are the cash flows correct?” To make this determination, you can view all of the cash flows for that instrument record, by selecting the Write Cash Flow option in the Processing ID. By selecting this option, you can write out all the cash flow or repricing events that occur for the first five instrument records processed for a given processing run. Each of the records has all the relevant financial elements populated in the Process_Cash_Flows table.

**Viewing Results in the Process_Cash_Flows Table**

The following columns make up the Process_Cash_Flows Table:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result_sys_id</td>
<td>Key column that corresponds to the SYS_ID_NUM of the Transfer Pricing Processing ID. All cash flow results for your processing run are stored with the same Result_sys_id value. To determine the value of the Result_sys_id, see Step 2, below, Determining the Result_Sys_ID value</td>
</tr>
<tr>
<td>Record_sequence</td>
<td>The processing order of the records</td>
</tr>
<tr>
<td>Cash_flow_sequence</td>
<td>The order of the events (such as cash flows, repricings)</td>
</tr>
<tr>
<td>Scenario_num</td>
<td>The scenario number assigned in the forecast rates assumption (used in Risk Manager)</td>
</tr>
<tr>
<td>Financial_elem_id</td>
<td>The numeric code describing a piece of financial information described in the row of results data</td>
</tr>
<tr>
<td>ID_number</td>
<td>The unique record identifier for the instrument record(s) processed</td>
</tr>
</tbody>
</table>
Investigating the Results of an Unexpected Transfer Rate

1. Define and Process a TP Processing ID

Define and Process a TP Processing ID that processes just the instrument record(s) (up to five records) that you would like to investigate. Click the Write Cash Flow option.

2. Determine the Result_Sys_ID value

Under the File Open Dialog...

Click the right mouse button to view the Sys_id_num for your TP Processing ID as defined in Step 1.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash_flow_date</td>
<td>The date of the event</td>
</tr>
<tr>
<td>Cash_flow_cd</td>
<td>The code identifying the event. The code can be any combination of the following base codes: 1=1st; 2=payment; 4=reprice; 8=intease period; 16=not in tease period; 32=as of date. For example, 22 is the combination of 2,4, and 16.</td>
</tr>
<tr>
<td>Float_value</td>
<td>The value assigned to each financial element</td>
</tr>
<tr>
<td>Product_leaf_node</td>
<td>The Transfer Pricing product leaf number</td>
</tr>
<tr>
<td>Org_leaf_node</td>
<td>The organizational unit leaf number</td>
</tr>
</tbody>
</table>
3. Create a Data Filter ID to view Only your Process_Sys_ID from Process_Cash_Flows

4. Use a Data Verification ID to View Results in Process_Cash_Flows

   In your Data Verification ID, remember the following:
   - Your Table Name should be Process Cash Flows
   - Select your data filter defined in Step 3
   - You will find it easier to sort your view by relevant columns
     (Suggestion: If only one instrument record was processed, sort by Financial Element ID, Cash Flow Date, Cash Flow Code. If more than one instrument record was processed, sort by ID Number, Financial Element ID, Cash Flow Date.)
   - Reorder the Columns in the Defined view
     (Suggestion: ID Number, Organizational Leaf Node, Product Leaf Number, Financial Element ID, Cash Flow Code, Cash Flow Date, Float Value, etc.)
Your data looks like this:

<table>
<thead>
<tr>
<th>ID_NUMBER</th>
<th>database type</th>
<th>precision</th>
<th>scale</th>
<th>Cash Flow Code</th>
<th>Cash Flow Date</th>
<th>Float Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>07-02-1994</td>
<td>52947.704442</td>
<td>137003.970144</td>
</tr>
<tr>
<td>2</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>03-03-1994</td>
<td>916042.912629</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>04-04-1994</td>
<td>76937.000900</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>05-05-1994</td>
<td>722707.428125</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>06-06-1994</td>
<td>629515.516668</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>07-07-1994</td>
<td>636553.504546</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>08-08-1994</td>
<td>559083.569504</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>09-09-1994</td>
<td>561186.554442</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>10-10-1994</td>
<td>536613.140176</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>11-11-1994</td>
<td>494202.266460</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>12-12-1994</td>
<td>463628.571253</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>01-01-1995</td>
<td>43250.65054</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>02-02-1995</td>
<td>48035.950586</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>03-03-1995</td>
<td>500951.95074</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>04-04-1995</td>
<td>359095.942931</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>05-05-1995</td>
<td>359974.423443</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>06-06-1995</td>
<td>316348.320165</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>100</td>
<td>1</td>
<td>0</td>
<td>07-07-1995</td>
<td>556254.361374</td>
<td></td>
</tr>
</tbody>
</table>

The description for each financial element can be found by selecting the Financial Element ID Leaf Type under Leaf Setup:
Hints

1. “Weighted” Financial Elements

Any financial element that, when evaluated across multiple records, or leaf values, requires a weighted average, is represented as the PRODUCT of the true value times the associated balance. For example, the Ending Net Rate (Financial Element 120) is actually stored in Process_Cash_Flows as Ending Net Rate * End Balance (Financial Element 100). The following table describes the financial elements that have a “Weighting Column:”

<table>
<thead>
<tr>
<th>Code</th>
<th>Financial Elements ID</th>
<th>Weighting Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>End Balance</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Ending Gross Rate</td>
<td>By End Bal</td>
</tr>
<tr>
<td>120</td>
<td>Ending Net Rate</td>
<td>By End Bal</td>
</tr>
<tr>
<td>130</td>
<td>Ending Transfer Rate</td>
<td>By End Bal</td>
</tr>
<tr>
<td>140</td>
<td>Average Bal</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>Average Gross Rate</td>
<td>By Avg Bal</td>
</tr>
<tr>
<td>160</td>
<td>Average Net Rate</td>
<td>By Avg Bal</td>
</tr>
<tr>
<td>Code</td>
<td>Financial Elements ID</td>
<td>Weighting Column</td>
</tr>
<tr>
<td>------</td>
<td>-------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>170</td>
<td>Average Transfer Rate</td>
<td>By Avg Bal</td>
</tr>
<tr>
<td>180</td>
<td>Prepay Runoff</td>
<td></td>
</tr>
<tr>
<td>190</td>
<td>Principal Runoff</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Unscheduled Principal Runoff</td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>Total Runoff</td>
<td></td>
</tr>
<tr>
<td>220</td>
<td>Total Runoff Gross Rate</td>
<td>By Runoff Bal</td>
</tr>
<tr>
<td>230</td>
<td>Total Runoff Net Rate</td>
<td>By Runoff Bal</td>
</tr>
<tr>
<td>240</td>
<td>Total Runoff Transfer Rate</td>
<td>By Runoff Bal</td>
</tr>
<tr>
<td>250</td>
<td>Repricing Balance</td>
<td></td>
</tr>
<tr>
<td>260</td>
<td>Before Repricing Gross Rate</td>
<td>By Repricing Bal</td>
</tr>
<tr>
<td>270</td>
<td>After Repricing Gross Rate</td>
<td>By Repricing Bal</td>
</tr>
<tr>
<td>280</td>
<td>Before Repricing Net Rate</td>
<td>By Repricing Bal</td>
</tr>
<tr>
<td>290</td>
<td>After Repricing Net Rate</td>
<td>By Repricing Bal</td>
</tr>
<tr>
<td>300</td>
<td>Before Reprice Transfer Rate</td>
<td>By Repricing Bal</td>
</tr>
<tr>
<td>310</td>
<td>After Reprice Transfer Rate</td>
<td>By Repricing Bal</td>
</tr>
<tr>
<td>320</td>
<td>Fully Indexed Gross Rate</td>
<td>By End Bal</td>
</tr>
<tr>
<td>330</td>
<td>Fully Indexed Net Rate</td>
<td>By End Bal</td>
</tr>
<tr>
<td>340</td>
<td>New Add Balance</td>
<td></td>
</tr>
<tr>
<td>350</td>
<td>New Add Gross Rate</td>
<td>By New Add Bal</td>
</tr>
<tr>
<td>360</td>
<td>New Add Net Rate</td>
<td>By New Add Bal</td>
</tr>
<tr>
<td>370</td>
<td>New Add Transfer Rate</td>
<td>By New Add Bal</td>
</tr>
<tr>
<td>380</td>
<td>Roll Add Balance</td>
<td></td>
</tr>
<tr>
<td>390</td>
<td>Roll Add Gross Rate</td>
<td>By Roll Add Bal</td>
</tr>
<tr>
<td>400</td>
<td>Roll Add Net Rate</td>
<td>By Roll Add Bal</td>
</tr>
<tr>
<td>410</td>
<td>Roll Add Transfer Rate</td>
<td>By Roll Add Bal</td>
</tr>
<tr>
<td>430</td>
<td>Interest Cash Flow</td>
<td></td>
</tr>
<tr>
<td>435</td>
<td>Interest Cash Flow - Gross</td>
<td></td>
</tr>
<tr>
<td>437</td>
<td>Interest Cash Flow - T-Rate</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Financial Elements ID</td>
<td>Weighting Column</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>440</td>
<td>Interest Accrued</td>
<td></td>
</tr>
<tr>
<td>445</td>
<td>Interest Accrued - Gross</td>
<td></td>
</tr>
<tr>
<td>450</td>
<td>Charge/Credit</td>
<td></td>
</tr>
<tr>
<td>455</td>
<td>Non Interest Income</td>
<td></td>
</tr>
<tr>
<td>457</td>
<td>Non Interest Expense</td>
<td></td>
</tr>
<tr>
<td>480</td>
<td>Interest Credited</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>WARM</td>
<td>By Ending Balance</td>
</tr>
<tr>
<td>510</td>
<td>Annual Prepayment Rate</td>
<td>By Balance before Prepay</td>
</tr>
<tr>
<td>515</td>
<td>Balance Before Prepay</td>
<td></td>
</tr>
<tr>
<td>520</td>
<td>Deferred End Balance</td>
<td></td>
</tr>
<tr>
<td>530</td>
<td>Deferred Average Balance</td>
<td></td>
</tr>
<tr>
<td>540</td>
<td>Deferred Runoff</td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>Period Cap Balance</td>
<td></td>
</tr>
<tr>
<td>560</td>
<td>Period Cap Effect - Rate</td>
<td>By Period Cap Bal</td>
</tr>
<tr>
<td>570</td>
<td>Period Cap Effect - Amount</td>
<td></td>
</tr>
<tr>
<td>580</td>
<td>Life Cap Balance</td>
<td></td>
</tr>
<tr>
<td>590</td>
<td>Life Cap Effect - Rate</td>
<td>By Life Cap Bal</td>
</tr>
<tr>
<td>600</td>
<td>Life Cap Effect - Amount</td>
<td></td>
</tr>
<tr>
<td>610</td>
<td>Tease Balance</td>
<td></td>
</tr>
<tr>
<td>620</td>
<td>Tease Effect - Rate</td>
<td>By Tease Bal</td>
</tr>
<tr>
<td>630</td>
<td>Tease Effect - Amount</td>
<td></td>
</tr>
<tr>
<td>640</td>
<td>Neg-Am Balance</td>
<td></td>
</tr>
<tr>
<td>650</td>
<td>Neg-Am Interest</td>
<td></td>
</tr>
<tr>
<td>710</td>
<td>Market Value</td>
<td></td>
</tr>
<tr>
<td>720</td>
<td>Duration</td>
<td>By Market Value</td>
</tr>
</tbody>
</table>
2. Cut and Paste to a Spreadsheet

   It is helpful to use a spreadsheet to reconcile the answers against validated answers (such as Excel, Lotus 123 or others). Copy the results from Process_Cash_Flows and paste them into the spreadsheet.

3. If the Cash Flows Look Incorrect...

   If the cash flows do not behave as expected, this signifies that something in the instrument data (or your assumptions) is data other than expected. The matrix shown in Cash Flow Columns Used in Calculations helps in determine the relevant columns from the instrument data to investigate.

Use a Data Verification ID to View the Instrument Data

Define a Data Verification ID with the following columns to view the relevant cash flow columns for Transfer Pricing. Select them all from the Portfolio Table, so that you can use the same ID against any instrument Table.

- Amortization Type Code
- Repricing Frequency
- Origination Date
- Last Repricing Date
- Next Repricing Date
- As of Date
- Next Payment Date
- Maturity Date
- Payment Frequency
- Payment Frequency Multiplier
- Original Par Balance
- Last Reprice Date Balance
- Original Payment Amount

---

Note: As you become more experienced with Transfer Pricing, you may find it easier to select data through raw SQL statements through SQL Talk.
- Current Payment Amount
- Current Rate
- Remaining Number of Payments
- Remaining Term

**Cash Flow Columns Used in Calculations**

The following matrix defines the Cash Flow Columns used in various situations:

<table>
<thead>
<tr>
<th>Pricing Basis</th>
<th>Last Repricing Date (Standard)</th>
<th>Last Repricing Date (Standard)</th>
<th>Current Date (Remaining Term)</th>
<th>Current Date (Remaining Term)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repricing Frequency</td>
<td>Fixed</td>
<td>Adjustable</td>
<td>Fixed</td>
<td>Adjustable</td>
</tr>
<tr>
<td>Model Start Date</td>
<td>Origination Date</td>
<td>Last Repricing Date</td>
<td>As of Date</td>
<td>As of Date</td>
</tr>
<tr>
<td>Cash Flow Begin Date</td>
<td>Origination Date</td>
<td>Next Payment Date</td>
<td>Next_Payment_date</td>
<td>Next_Payment_date</td>
</tr>
<tr>
<td></td>
<td>+ Payment Frequency</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cash Flow End Date</td>
<td>Maturity Date</td>
<td>Next Repricing Date</td>
<td>Maturity_Date</td>
<td>Next_Repricing_Date</td>
</tr>
<tr>
<td>Balance</td>
<td>Org_Par_Bal * (1-Percent Sold)/100</td>
<td>If LRD_Balance* (1-Percent_Sold) /100 &lt; 0, then, LRD_Balance* (1-Percent_Sold)/100, otherwise, use 1,000,000 (see Note 1 below.)</td>
<td>Cur_Par_Bal * (1-Percent Sold)/100</td>
<td>Cur_Par_Bal * (1-Percent Sold)/100</td>
</tr>
<tr>
<td>Payment</td>
<td>Org_Payment_Amt * (1-Percent Sold)/100</td>
<td>If LRD Balance is valid, cur_payment otherwise it is computed. LRD Balance is considered invalid if it is equal to cur_par_balance and payments occurred between the last reprice date and the next payment date.</td>
<td>Cur_Payment * (1-Percent Sold)/100</td>
<td>Cur_Payment * (1-Percent Sold)/100</td>
</tr>
</tbody>
</table>
If the Cash Flows Look Correct

If the Cash Flows look correct, then the problem is isolated. The reason for the resulting transfer rate is in the “Rate Lookup” section of the calculations. In other words, taking the resulting cash flows and applying them to the methods for each Cash Flow Transfer Pricing Method resulted in unexpected answers.

Below are examples of how the financial elements relate to the different formulas for Transfer Pricing and how the cash flows are weighted.

### Duration Method

The financial formula for duration, repeated from above, is:

\[
\text{Duration} = \frac{\sum_{n=1}^{N} \left[ \frac{CF_n}{(1 + r)^m} \times t_n \right]}{\sum_{n=1}^{N} \left[ \frac{CF_n}{(1 + r)^m} \right]}
\]
Restated in plain language:

**Duration** = \( \frac{\text{Sum (Discounted Cash Flow } \times \text{ Term to Cash Flow in Years)}}{\text{Sum (Discounted Cash Flow)}} \)

Where:

Discounted Cash Flow = Financial Element 710 (Market Value of each cash flow)

Term to Cash Flow in Days = Cash Flow date (at time = \( n \)) - Model Start Date

Model Start Date = Date of funding decision: Date at which to apply rate lookup. (See Matrix above).

To compute the duration from the Results of Process_Cash_Flows, you need the following information:

- Cash_Flow_Date Column
- Float_Value Column
- Only look at Rows with Financial Element = 710
- Determine Model Start Date from Matrix above.

Once you have computed the duration in Days, perform a rate lookup with the Date = Model Start Date, and the Term = Computed Duration in Days.

### Weighted Average Cash Flow Method

**Weighted-Average Transfer Rate** = \( \bar{y} = \frac{\sum_{n=1}^{N} y_n \times \frac{CF_n}{(1+r)^m} \times I_n}{\sum_{n=1}^{N} \left[ \frac{CF_n}{(1+r)^m} \times I_n \right]} \)

Restated in plain language:

Weighted Ave CF Transfer Rate =

\[ \text{Sum (Discounted Cash Flow } \times \text{ Term to Cash Flow in Years } \times \text{ Cash Flow Transfer Rate)} / \text{Sum(Discounted Cash Flow } \times \text{ Term to Cash Flow in Years)}, \text{ where:} \]

Discounted Cash Flow = Financial Element 710 (Market Value of each cash flow)
Cash Flow Transfer Rate = Rate lookup for each cash flow based on Model Start Date and Term to Cash Flow

Term to Cash Flow is calculated as the difference between the cash flow date and the transfer pricing date.

**Zero Coupon Method:**

Zero Transfer Rate per pmt freq = \[ \bar{y} = \]

![Math equation]

Restated in plain language:

Numerator = Initial Beginning Balance - Sum (Beginning Balance before each cash flow) Zero Coupon Factor for each cash flow) + Sum (Ending Balance after each cash flow) Zero Coupon Factor for each cash flow)

Denominator = (Beginning balance before each cash flow) Zero Coupon Factor for each cash flow)

Annual Transfer Rate = (Numerator/Denominator) * 100 / payments per year

Where:

Ending Balance after each cash flow = Financial element 100 (Ending Balance at time = n)

Zero Coupon Factor = Rate lookup on the assigned transfer pricing yield curve using Date = Model

Start Date, Term = Remaining Term to Cash Flow

Initial Beginning Balance = Balance from the record

Beginning Balance before each CF = Financial element 60
Notes

- Remember, when using the Zero Discount Method the transfer pricing Yield Curve is used to calculate discount factors (such as 99.0000, 98.7500, and so on).
- Remember to keep track of the financial elements you are viewing. The most commonly used financial elements are 100 (Ending Balance), 190 (Principal Runoff), 430 (Net Interest) and 710 (Market Value).

Mid-Period Repricing

This option applies to Adjustable rate instruments only (such as reprice_freq < > 0) when the Pricing Basis is not Remaining Term (that is the Remaining Term Pricing Basis is not selected in the Transfer Pricing Processing ID). Mid-Period Repricing applies to four transfer pricing methods: Straight Term, Spread from Interest Rate Code, Spread from Note Rate, and Redemption Curve.

For the Spread from Interest Rate Code and Redemption Curve methods, the Assignment Date must equal Last Repricing Date in order to choose Mid-Period Repricing. For those two methods, when you select Mid-Period Repricing, Risk Manager changes the Assignment Date to Last Repricing Date if any other Assignment Date type has been selected.

General Processing Steps

If you select the Mid-Period Repricing option, Transfer Pricing performs the following process:

1. Computes Transfer Rate for the current repricing period.
2. If the computed last repricing date is greater than the beginning of the processing month, rolls back to the prior repricing date.
3. Computes the Prior Period Transfer Rate.
4. Repeats steps 2 - 3 as necessary.
5. Computes the Final Transfer Rate by weighting the results (from current and previous repricing periods) by average balances and days.
6. Applies the Final Transfer Rate to the instrument record.

Typical Calculations/Diagram

The typical situation involving Mid-Period repricing can be diagrammed as follows:
If an instrument reprices during the current processing month, then there are multiple repricing periods spanning the current month (in our example, there are two). The typical calculation will roll back the repricing dates by the repricing frequency until the Prior Last Repricing Date (Prior LRD) <= Beginning of Month.

In the example, taking the steps described above, the computation works as follows:

1. Compute Transfer Rate for current repricing period.

   Transfer Pricing Term: Next Reprice Date - Last Reprice Date
   Transfer Pricing Date: Last Reprice Date
   Number of Days at that Rate: End of Month + 1 - Last Reprice Date

   **Note:** If the Computed Next Reprice Date (the next repricing date for a given repricing period) is less than or equal to the End of Month, then the Number of Days calculation uses the Computed Next Reprice Date in place of End of Month. In other words, Number of Days equals the Minimum (End of Month + 1, Computed Next Reprice Date) - Maximum (Beginning of Month, Computed Last Reprice Date).

The example assumes a Straight Term method. The logic for the computation of the transfer rates for each method is as follows:
2. If the computed last repricing date is greater than the beginning of the processing month, roll back to prior repricing date.

   Last Repricing Date is greater than the Beginning of the Processing month, Roll Back as follows:

   Reset Computed Next Reprice Date = Last Reprice Date

   Reset Computed Last Repricing Date = Last Repricing Date - Reprice Freq (Prior LRD)

3. Compute Prior Period Transfer Rate.

   **Transfer Pricing Term:** Last Reprice Date - Prior LRD

   **Transfer Pricing Date:** Prior LRD

   **Number of Days at that Rate:** Last Reprice Date - Beginning of Month

* See the following logic for computing a current rate from a prior period. In the first period read from the Cur_Net_Rate column; for additional periods, need to reprice.

Redemption Curve

<table>
<thead>
<tr>
<th>Method</th>
<th>Date for Rate Lookup</th>
<th>Term(s)</th>
<th>Interest Rate Code</th>
<th>Spread</th>
</tr>
</thead>
<tbody>
<tr>
<td>Straight Term</td>
<td>Beginning_of_Reprice_Period</td>
<td>Transfer_Pricing_Term</td>
<td>Specified in TP ID</td>
<td>n/a</td>
</tr>
<tr>
<td>Spread from Interest Rate Code</td>
<td>Beginning_of_Reprice_Period (adjust by Lag Term in TP ID)</td>
<td>Specified in TP ID</td>
<td>Specified in TP ID</td>
<td>Specified in TP ID</td>
</tr>
<tr>
<td>Spread from Note Rate</td>
<td>Beginning_of_Reprice_Period</td>
<td>Transfer_Pricing_Term</td>
<td>Interest_Rate_Code from Record</td>
<td>Specified in TP ID</td>
</tr>
</tbody>
</table>

Note: If the Computed Last Reprice Date (the last repricing date for a given repricing period) is greater than the Beginning of Month, then the Number of Days calculation uses Computed Last Reprice Date in place of the Beginning of Month. In other words, Number of Days equals Minimum (End of Month + 1, Computed Next Reprice Date) - Maximum (Beginning of Month, Computed Last Reprice Date).

4. Repeat steps 2 - 3 as necessary.
Only one iteration is needed because Prior LRD is less than the Beginning of the Month.

5. Compute the Final Transfer Rate by weighting the results (from current and previous repricing periods) by average balances and days.

\[
\frac{\left(\text{CUR\_TP\_PER\_ADB} \times \text{Cur Period Transfer Rate} \times \text{Cur Period Days}\right) + \sum \left(\text{PRIOR\_TP\_PER\_ADB} \times \text{Prior Period Transfer Rate} \times \text{Prior Period Days}\right)}{\left(\text{CUR\_TP\_PER\_ADB} \times \text{Cur Period Days}\right) + \sum \left(\text{PRIOR\_TP\_PER\_ADB} \times \text{Prior Period Days}\right)}
\]

The calculation implies the following assumptions:

- CUR\_TP\_PER\_ADB is the balance applying since the last reprice date
- PRIOR\_TP\_PER\_ADB is the balance applying to all prior repricing periods

6. Apply the Final Transfer Rate to the instrument record.

Exceptions to Typical Calculations

Teased Loan Exception
The Teaser_End_Date is the first repricing date. This overrides all other values for last_reprice_date and next_reprice_date. During the Teased Period, then, the Computed Last Repricing Date equals the Origination Date and the Computed Next Reprice Date equals the Teaser_End_Date. Consequently:

1. If the Teaser_End_Date is greater than the As_of_Date, the Mid-Period Repricing Does not apply. The logic to compute the Transfer rate is based upon term equal to the teaser_end_date - origination_date, date equals the origination_date.

2. When rolling backwards by repricing frequency, if the Teaser_End_Date is greater than the Computed Last Repricing Date, Transfer Pricing computes the transfer rates for that period based on the teased loan exception.

Origination Date Exception
Transfer Pricing makes an assumption during the calculation that if the origination date occurred during the processing month, the calculation of the number of days (used for weighting), originated on the 1st day of the month. This is a safe assumption because the PRIOR\_TP\_PER\_ADB value shows this instrument was not on the books for the entire month. Because the PRIOR\_TP\_PER\_ADB value is used in computing the weighted average transfer rate, this impact is measured. If
Transfer Pricing were to shorten the number of days (which is also used in the weighted average calculation), it would double-count the impact.

**Example**

<table>
<thead>
<tr>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nov 1 - Nov 10</td>
<td>Nov 11 - Nov 20</td>
<td>Nov 21 - Nov 30</td>
</tr>
<tr>
<td>Loan Balance = 0</td>
<td>Loan Balance = 100</td>
<td>Loan Balance = 100</td>
</tr>
<tr>
<td>Transfer_Rate = 0</td>
<td>Transfer_Rate = 6%</td>
<td>Transfer_Rate = 8%</td>
</tr>
<tr>
<td>Days = 10</td>
<td>Days = 10</td>
<td>Days = 10</td>
</tr>
<tr>
<td>Weighting Balance = 50 = PRIOR_TP_PER_ADB</td>
<td>Weighting Balance = 50 = PRIOR_TP_PER_ADB</td>
<td>Weighting Balance = 100 = CUR_TP_PER_ADB</td>
</tr>
</tbody>
</table>

**Note:** The Cumulative average daily balance for period 1 plus period 2 is 50.

The calculation is:

\[
(6\% \times 50 \times 20 \text{ days}) + (8\% \times 100 \times 10 \text{ days}) / (50 \times 20 \text{ days} + 100 \times 10 \text{ days}) = 7\%
\]

If we were to remove period 1 from the equation the incorrect answer would have been...

\[
(6\% \times 50 \times 10 \text{ days}) + (8\% \times 100 \times 10 \text{ days}) / (50 \times 10 \text{ days} + 100 \times 10 \text{ days}) = 7.33\%
\]

... which is incorrect.

**Spread From Note Rate Computations**

In order to calculate a transfer rate using the Spread From Note Rate for the last repricing period, Transfer Pricing reprices an instrument record based on the historical rates ID (it computes the rate as of the last repricing date).

The following table shows the process cash flow calculations performs in computing a rate, to determine if they are applicable for Transfer Pricing Spread From Note Rate computations. Those that are not applicable imply that the performance cost of that option outweighs the additional accuracy.
<table>
<thead>
<tr>
<th>No.</th>
<th>Step In Cash Flow Logic</th>
<th>Applicable?</th>
<th>Explanation/Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Determine rate Associated with Interest Rate Code</td>
<td>Yes</td>
<td>Rate Lookup Based on Computed Last Reprice Date.</td>
</tr>
<tr>
<td>2</td>
<td>Add Margin to Raw Rate (Continue to call this the Raw Rate below)</td>
<td>Yes</td>
<td>Raw Rate + Margin (ignores Tease Rate).</td>
</tr>
<tr>
<td>3</td>
<td>Update current Transfer Rate if modeling with Transfer Rates</td>
<td>No</td>
<td>Only applicable for computation of forecasted transfer rate in Risk Manager.</td>
</tr>
<tr>
<td>4</td>
<td>Apply rounding codes</td>
<td>Yes</td>
<td>See cash flow code documentation.</td>
</tr>
<tr>
<td>5</td>
<td>Apply rate change minimum</td>
<td>Yes</td>
<td>If Absolute Value (Raw Rate - Current Rate) &lt; Rate Change Minimum, Raw Rate = Current Rate.</td>
</tr>
<tr>
<td>6</td>
<td>Set Value of Fully Indexed Rate</td>
<td>No</td>
<td>n/a</td>
</tr>
<tr>
<td>7a</td>
<td>Calculate Tease Effect</td>
<td>No</td>
<td>n/a</td>
</tr>
<tr>
<td>7b</td>
<td>Check Periodic Caps and Floors</td>
<td>No</td>
<td>Periodic Rate Caps are a function of prior rates, so Transfer Pricing would have to go back to origination and recompute all rates. This is equivalent to the cash flow methods and would add significantly to calculation speed and complexity of understanding the answers.</td>
</tr>
<tr>
<td>7c</td>
<td>Check Lifetime Caps and Floors</td>
<td>Yes</td>
<td>If Raw Rate &lt; Rate Floor Life and Rate Floor Life &gt; 0, set Raw Rate = Rate Floor Life.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If Raw Rate &gt; Rate Cap Life and Rate Cap Life &gt; 0, set Raw Rate = Rate Cap Life.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(Note: from step 2 Raw Rate includes the margin)</td>
</tr>
<tr>
<td>8</td>
<td>Update Current Rate</td>
<td>No</td>
<td>Just need to update the transfer rate - not the current rate. It can be computed from scratch for all prior repricings.</td>
</tr>
<tr>
<td>9</td>
<td>Update Next Repricing Date</td>
<td>No</td>
<td>Only used for forecasts in Risk Manager.</td>
</tr>
<tr>
<td>10</td>
<td>Trigger Payment Recalculation</td>
<td>No</td>
<td>Only used in cash flow calculations.</td>
</tr>
</tbody>
</table>
Defining and Updating Your Historical Rates Table

The goal of Transfer Pricing is to assign an historical cost of funds to all sources and uses of funds on your balance sheet. A lot of analysis goes into deriving the precise cost of funds for any particular account or instrument. Regardless of your Transfer Pricing approach, however, the cost of funds is based on actual historical rates.

What is an Historical Rates Table?

The historical rate used to transfer price a particular account may be market interest rates (such as FHLB advance rates), some spread to a market interest rate (like a spread to the Treasury Yield Curve), a derived Transfer Pricing Yield Curve, or a more complex derived rate (such as a 12 month moving average of the 12 month transfer rate). All such actual historical rates must be stored in your Historical Rates Table.

Defining Your Historical Rates Table

At the outset of a transfer pricing implementation you must construct your Historical Rates Table to satisfy all of your requirements for the storage of historical actual interest rates. As there is only one reality when it comes to historical actuals, this one table is accessed by all applications that require the use of historical actual rates, like Transfer Pricing and Risk Manager, and any rates analysis tool. Consequently, you must give careful consideration to the following components when defining your Historical Rates Table.

Interest Rate Codes

There are several types of interest rate codes that you may want to store in your historical rates table:
Terms to Define for each Interest Rate Code

Each Interest Rate Code can be defined as a Yield Curve (rates for many terms), or simply as a Single Rate (only one term). For each interest rate code, you should define the appropriate points that need to be input for each one. Currently, the rate for all points not explicitly defined on a Yield Curve is interpolated linearly between the terms of the nearest two points.

Historical Rates Input Frequency

For each interest rate code you can independently define the frequency with which rates are input. For example, you may want to input daily, weekly, or monthly rates. Transfer Pricing will access the nearest rate just before the date at which it is instructed to search in the Historical Rates Table.

Numbering Schemes for Interest Rate Codes

Interest Rate Codes can be defined with any 3-digit numbering scheme you desire. You should keep the following suggestions in mind when defining Historical Rates:

- See the Oracle Financial Services Data Dictionary for the code assignments for OFSA interest rate codes. You may want to use the OFSA numbering convention for Rates defined in the Oracle Financial Services Data Dictionary.
- Interest Rate Codes are displayed by numerical order when presented in any list. You may want to reserve a section for Transfer Rate Interest Rate Code and another for Market Interest Rate Codes.

<table>
<thead>
<tr>
<th>Type of Interest Rate Code</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Market Interest Rates</td>
<td>Treasury Yield Curve</td>
</tr>
<tr>
<td></td>
<td>FHLB Advance Curve</td>
</tr>
<tr>
<td></td>
<td>Prime</td>
</tr>
<tr>
<td>Pure Transfer Pricing Yield Curve</td>
<td>Transfer Pricing Yield Curve</td>
</tr>
<tr>
<td>Spreads</td>
<td>Option Costs</td>
</tr>
<tr>
<td></td>
<td>Liquidity Premiums</td>
</tr>
<tr>
<td></td>
<td>Average Spread to Prime</td>
</tr>
<tr>
<td>Derived Rates</td>
<td>12 month moving average of 12 month rate</td>
</tr>
<tr>
<td></td>
<td>Transfer Pricing Yield Curve with layered options</td>
</tr>
</tbody>
</table>
Updating Your Historical Rates Table

There are two occasions for which you will need to update your Historical Rates Table:

Initial Creation of Historical Rates Table
The first time you create your Historical Rates Table your major task is to locate sources for historical actual rates. The most efficient process is to format these rates for upload into the historical rates database.

Regular Maintenance of Historical Rates Table
On an on-going basis, you need to update your Historical Rates Table with actual rates. Depending on how many Interest Rate Codes you have defined, and your specific process for creating actuals, you can choose the most convenient method to update your table. If you are updating a large number of rates, you can import them into Transfer Pricing from an external spreadsheet. For fewer rates, you might prefer to enter them directly using Historical Rates ID interface in Transfer Pricing.

Leaf Fields

The Purpose of Leaf Fields
Leaf Fields are those used to define a hierarchical segmentation of your data. The data elements in such a field, or the leaves, can be used in constructing the hierarchy, or tree. The leaf fields define the type of tree that can be constructed, such as an organizational unit leaf, a product type leaf, etc.

Leaf Fields used in Transfer Pricing
The following three leaf fields are used in any Transfer Pricing process:

- Product Leaf ID
- Common Chart of Accounts Leaf ID
- Organizational Leaf ID

These three leaf types are described in the following sections.
Product Leaf ID

The Transfer Pricing Product Leaf ID is the key product bracket that allows you to define the Transfer Pricing Methodology for your accounts. All Transfer Pricing methods are assigned at the Transfer Pricing Product Leaf ID level.

This does not imply that all transaction records within one Transfer Pricing Product ID leaf value will receive the same transfer rate. Many of the transfer pricing methods assign unique transfer rates to each transaction record. What this does imply, however, is that within one Transfer Pricing Product Leaf ID value, you cannot transfer price one transaction record with the Duration method, and a second with the Moving Average method. Your Transfer Pricing Product Leaf values should be assigned with this in mind.

The Transfer Pricing Product Leaf ID must be specified in the Configuration ID. You can choose from any of your Product Leaf ID columns, including the Common Chart of Accounts Leaf ID.

Common Chart of Accounts Leaf ID

The Common Chart of Accounts Leaf ID is the key Product Leaf ID which ensures integration across all OFSA modeling applications. A few characteristics define a Common Chart of Account Leaf ID:

1. The Common Chart of Accounts level is the lowest level of detail that exists across all product leaf brackets. In other words, all Product Leaf IDs must map back to the Common Chart of Accounts Leaf ID. The Common Chart of Accounts Leaf ID will serve as the key tie between the Ledger Data and the Instrument Data. The Ledger is the “Financial Reality” and therefore all product leaf breakouts must be able to tie back to the Ledger data.

2. This is the level at which all-in profitability can be measured. For example, a complete income statement (including interest income or expense, charge or credit for funds, fee income, allocated expenses, and so on) can be generated for each Leaf in the Common Chart of Accounts.

3. The Common Chart of Accounts Leaf ID is defined in the implementation of your database. All users must use the same Common Chart of Accounts Leaf ID.

Common Chart of Accounts Leaf ID Example

Suppose the balances for all Adjustable Rate Mortgages are captured in one account on the Ledger. In Transfer Pricing, however, we may need to make a distinction between Treasury Loans and Adjustable Loans tied to other market indexes. For another OFS application, we may need to make an additional Loan-to-Value split.
These breakouts are relevant for specific modeling purposes and the breakouts are possible by using Instrument data. But this level does not exist on the Ledger, and therefore all-in profitability cannot be viewed at this level. It is below the Common Chart of Accounts Level.

Additionally, the Common Chart of Accounts level may be at a higher level than the Ledger Level. For instance, the Ledger may have hundreds of Cash & Due Accounts. For all modeling purposes, however, the distinction between these accounts is irrelevant. In this case, the Common Chart of Accounts Level groups all Cash & Due Accounts into one leaf value. A graphical example is shown here:

<table>
<thead>
<tr>
<th>Transfer Pricing Product ID</th>
<th>General Ledger Account ID</th>
<th>Treasury Manager Product ID</th>
<th>Common CQA ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mortgage Loans</td>
<td>Cash &amp; Due</td>
<td>Mortgage Loans</td>
<td>Cash &amp; Due</td>
</tr>
<tr>
<td>Adjustable</td>
<td>Fixed</td>
<td>Adjustable</td>
<td>Fixed</td>
</tr>
<tr>
<td>Treasury</td>
<td>Other</td>
<td>Due from Bank A</td>
<td>Due from Bank B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Treasury</td>
<td>Other</td>
</tr>
<tr>
<td>10% LTV</td>
<td>20% LTV</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Organizational Leaf ID**

All Transfer Pricing results (such as Charges/Credits for Funds) are generated for each unique combination of Common Chart of Accounts and Organizational Leaf values. Your Organizational Leaf ID values should be the lowest level of Organizational detail at which you want to measure Organizational profitability.

As with all leaf columns, the leaf values must be at a sufficient level to completely segment your entire balance sheet. For example, if your cost center values are overlapping across Banks, you will want to concatenate the Bank value with the cost center value to establish a numbering scheme that uniquely identifies all Organizational entities.

The Organizational Leaf ID must be specified in the Configuration ID.

**How to Assign Leaf Values**

Leaf Values may be assigned in the extract process, or, like any OFSA field, can be modified by using Balance and Control Data Correction Processing IDs.
Data Filter ID

The OFSA database may contain data that you must exclude from a monthly Transfer Pricing process. The database may contain data from months prior to the as-of-date, it may contain data in multiple states of aggregation, and the ledger data may contain information irrelevant to the transfer pricing process.

All of this data can be excluded by defining a Data Filter ID which excludes all extraneous data, thereby including all of your relevant data. This Data Filter ID should be used in all of your processes impacting the results - your standard Transfer Pricing Processing ID, your Reports, and your feed to a performance reporting tool.

Reconciling the Data

Reconciliation is the process of comparing the information carried in the instrument table to the General Ledger.

The goal of the Transfer Pricing Process is to transfer price your entire balance sheet, as represented on the General Ledger. Many ledger accounts have corresponding data in the instrument tables. In such instances, the balances from the instrument data must be compared with the corresponding ledger balances.

The reconciliation process involves defining a level at which some piece of information is to be compared between the instrument data and the General Ledger data - carried in the Ledger/Stat Table. That level can be one dimension (like reconcile for each General Ledger account number) or multiple dimensions (such as reconcile for each General Ledger account number within each business unit).

The most common type of reconciliation is to compare the ending balance of instrument data to the General Ledger ending balances. The data carried in the database is a snapshot of the portfolio as of a given date (as-of-date). Consequently, comparing the ending balances from the instrument table versus the General Ledger ending balances measures the degree to which the extracted data is in balance with, or reconciles to, the General Ledger.

Once the variances between the instrument table information and the Ledger/Stat information are known, they should be corrected to at least within an acceptable threshold.

Selecting Data for Reconciliation Reports

The data that goes into the Reconciliation reports will be all the Ledger/Stat records and the Instrument Records that pass your Processing Data Filter ID. Make sure the
Transfer Pricing Processing ID

Overview of the Process

Processing Data Filter ID that you use for your Reconciliation Process is the same one you use in your Transfer Pricing Processing ID.

Transfer Pricing ID

Accounts with Related Instrument Data

Some Ledger Accounts, such as mortgages and commercial loans, have related instrument data in the database. For these accounts, you can use any transfer pricing method in transfer pricing the account. The instrument data is transfer priced, and the transfer rates from the instrument data is weighted by the instrument ending balances and applied to the ledger data.

Ledger-Only Accounts

Many Ledger Accounts, such as, cash, other assets, and equity, have no associated instrument data. For such accounts you must transfer price the Ledger Data directly with a method that does not rely on term or cash flow information, provided by instrument data.

Prepayment ID

A Prepayment ID is used to define Prepayment Assumptions, for example, any payment ahead of what is contractually scheduled, for use with OFSA cash flow calculations.

The three cash flow transfer pricing methods available in Transfer Pricing, (Weighted Term, Duration, and Zero Discount Factors), utilize the Cash Flow generation capabilities of OFSA.

A unique feature of the Cash Flow generation capabilities of OFSA is that there is complete separation of the actual data (instrument data) and the assumptions (prepayment assumptions). This allows for the changing of assumptions without having to modify the instrument data in any way.

Transfer Pricing Processing ID

A Transfer Pricing Processing ID is the mechanism by which you launch any processing request. It incorporates a Processing Filter ID, which defines which data
Quality Controlling the Answers

As the Transfer Pricing Process is an accounting exercise, you must take some careful steps to quality control the results.

Reviewing the Historical Rates Table

When rates for any new periods are added to the Historical Rates Table, you should review them by printing the Historical Rates Table.

Reviewing the Transfer Rates and Matched Spreads for Each Account

After assigning a Transfer Rate for each account, you should generate a detailed Transfer Rate/Matched Spread report (at the Product Leaf Level within each Organizational Unit Leaf) to ensure that:

1. Every account has been assigned a Transfer Rate
2. The Matched Spread for each account is believable.

Reviewing the Processing Errors

When you run a Transfer Pricing Processing ID, and errors are encountered, error messages are recorded in the Process_Errors table in the Error_Description column. The ID_Number and the Process_Sys_ID of the record also appear on the same record with all messages. For more information, see Appendix A, "Transfer Pricing Error Messages".

Reviewing the Impact on the Funding Center

After ensuring that each account has been assigned a believable Transfer Rate, you should review the Funding Center Impact by generating a Funding Center Impact Report for your institution and comparing it to the results from prior periods for believability and analysis.

Reprocessing Erroneous Accounts

After reviewing your results, you might discover accounts whose answers are not valid and need to be reprocessed.
If reprocessing of a portion of your instrument data is needed, make sure that you reprocess an entire Common Chart Of Accounts ID. Otherwise, you may damage your overall results. Failure to reprocess an entire COA ID will cause the entire common chart of accounts to be cleared before being rewritten.

If any of the records being reprocessed are used as the basis for Unpriced Accounts, those Unpriced Accounts also should be rerun.

**Refining Your Processing Filter ID**

The method for reprocessing only a subset of your accounts is to create a new Processing Filter ID that includes only the accounts that you wish to reprocess. Be sure to use your Standard Processing Filter ID as a source for your new filter.

**Advanced Transfer Pricing Concepts**

**Remaining Term Basis**

To transfer price based upon the remaining term basis, define a Transfer Pricing Processing ID with the Processing Options switch set to Remaining Term. You should also review the assumptions made in the Transfer Pricing ID to ensure that they will accurately assign the appropriate Remaining Term Transfer Rate to the accounts.

This process updates the Remaining Term Transfer Rate column in the database instead of the Transfer Rate column.

**Option Costs and Liquidity Premiums**

You may want to incorporate Option Costs and/or Liquidity Premiums into your transfer pricing results. The current approach for doing so is to create an Interest Rate Code that incorporates the relevant Option Costs and/or Liquidity Premiums for your particular account.

A future enhancement to Transfer Pricing will provide the ability to layer in Option Costs and/or Liquidity Premiums in the Transfer Pricing ID, without having to derive Interest Rate Codes that combine all sources in one.

**Breakage Charges**

An appropriate method of addressing Breakage Charges in Transfer Pricing is under review and will be incorporated in a future version of Transfer Pricing.
An Oracle Financial Services Application identification (OFSA ID) is a type of dialog box that supports the set up of assumptions information, reporting specifications, or processing specifications. With OFSA IDs, you have the flexibility to define as many types of assumptions, report specifications, or processing specifications as needed.

You can use an ID immediately after creating it and then discard it without saving it. You can also save it and then modify and resave it under another name for use in other OFS applications.

This chapter presents the following topics:

- Creating an ID
- Opening an Existing ID
- Closing and Saving an ID
- Deleting an ID
- Leaf Setup
- Tree-Related IDs
- Importing and Exporting Data
- OFSA ID Dependencies
- Processing an ID
- Server Status
- Spreadsheet Control Bar
Creating an ID

To create an ID, perform the following steps:

1. From the File menu, select New.
   A list of the IDs available for the product you are using appears.

2. From the list, select the ID you want to create and define.
   The New ID dialog box appears.

3. Select or type in each field, as required, using the following descriptions as a reference:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>The folder default is set in Configuration ID. Until you set a new default in Configuration ID, the default option is &lt;INDIVIDUAL&gt;. This means that the user who logged on is the only user who can access this ID. You can make the ID available to a folder of users. If the user who logged on is a member of any folders, you can select the Folder options dialog box to view a list of those folders. Select a folder for this ID to make it available to all members of the folder. Select &lt;ALL&gt; to make it available to everyone.</td>
</tr>
<tr>
<td>Name of ID</td>
<td>Type a name for the new ID. When naming IDs, use alphanumeric characters only. Use an underscore (_) rather than a space.</td>
</tr>
</tbody>
</table>
Opening an Existing ID

To open an existing ID, perform the following steps:

1. From the File menu, select Open.
   
   A list of IDs available for the product you are using appears.

2. From the list, select the type of ID you want to open.
   
   The Select ID dialog box appears.

3. Select or type in each field, as required, using the following descriptions:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Type up to 60 characters describing the purpose of the ID. The description appears in the ID dialog box and is useful if others access the ID. This is an optional field.</td>
</tr>
<tr>
<td>Permission</td>
<td>Read/Write is the default. The individual ID creator always has Read/Write capability.</td>
</tr>
<tr>
<td></td>
<td>Read Only becomes an available option only when a folder has been selected as the folder logon option.</td>
</tr>
</tbody>
</table>

**Note:** Some IDs require additional information, such as leaf type or reporting currency. Select or type this information, as required.

4. Click OK to continue, or click Cancel at any time to cancel the operation and exit the dialog box.
4. Click OK to continue, or click Cancel at any time to cancel the operation and exit the dialog box.

Closing and Saving an ID

From the File menu, select Close to close an open ID.
From the File menu, select Save to save your ID.

Save As

You can copy IDs by saving them under a new name. Perform the following steps to copy an ID:
1. Select the ID that you want to copy.
2. From the File menu, select Save As....
The New ID dialog box appears.
3. Type a folder name and description for the ID and any other data required, and click OK.
The ID is copied and saved under the new name. The original ID remains unaltered.

Rename

To rename an ID, perform the following steps:
1. Open the ID that you want to rename.
2. From the File menu, select Rename.
The Rename ID dialog box appears.
3. Type a new name and description for the ID and any other data required, and click OK.
The ID is saved under the new name.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable ID</td>
<td>Use the list to select the ID you want to open. (If you know the name of the ID, you can type the first letter of the ID to reach that portion of the alphabetized list, scroll down and select it.)</td>
</tr>
</tbody>
</table>
Deleting an ID

You can change the folder using this function, but only if the ID is actually renamed. This function does not perform a check for duplicate ID names in the folder.
You can also use Rename to change the Read/Write status for an ID.

Deleting an ID

To delete an ID, perform the following steps:

1. Open the ID that you want to delete.
2. From the File menu, select Delete.
   
   A Delete Confirmation dialog box appears.
3. Click Yes to confirm your decision, or click No to cancel the operation.

Delete a Group of IDs

To delete a group of IDs, perform the following steps:

1. From the File menu, select Delete Group.
   
   The Delete Group dialog box appears.
2. From the ID Type list, select the Type of ID.
   
   All IDs of that type appear in the large dialog box below it.
3. Select the IDs that you want to delete, and click Add to display them in the selected IDs list.
   
   You can continue to select different ID types and add them to the selected IDs select list for deletion.

---

**Caution:** Do not delete the active Configuration ID.

When you create an ID, it has a set of assumptions. These assumptions are based on a specific modeling horizon, which is defined in the active Configuration ID. If the assumptions are based on a Configuration ID that does not exist, the data produced is inaccurate.

---

a. To select multiple IDs of any type, hold down the Shift key while you click on them.
b. To select all IDs of a chosen type, select Select All.

c. To remove all IDs from the selected IDs list, click Remove All.

d. Use the arrow buttons to change the position of an ID in the selected IDs list.

e. Select the ID you want to move, and use the up or down arrow to move it up or down one position. IDs are deleted in the order that they appear in the list.

4. When you have selected all IDs for deletion, select Run from the Process menu. The Confirm Group Delete dialog box appears.

5. Click Yes to delete the IDs, or click No to cancel the operation.

---

Note: You cannot import or export IDs while Group Delete is open.

---

Leaf Setup

With Leaf Setup you can view, edit, insert (or, in other words, create), renumber, or delete any leaf value from any leaf type in the database.

Leaf type and leaf column are synonymous. A leaf type is any column registered in the database as a leaf column. For example, GL Account ID, Org Unit ID, Common COA ID, and Financial Element ID are all leaf types.

Leaf values compose the next highest level of categorization above detail account level. This level is known as the leaf level and provides the foundation for the structure of a Tree Rollup ID.

Leaf capacity is 200,000 leaves. This increased capacity enables institutions to model increasingly complex profitability scenarios.

---

Note: You can display as many as 16,000 leaves at a time.
Creating a Leaf Setup Dialog Box

To create a Leaf Setup dialog box, perform the following steps:

1. From the Setup menu, select Leaves.
   
The Leaf Setup dialog box appears.

2. To view, edit, renumber, delete, or add any leaf value, select the leaf type that you want from the Leaf Type list.

3. Search for the leaf value that you want.
   
   You can search for a leaf value either by using Leaf Value or Leaf Description. Leaf Value is the default. Because you can display a maximum of 16,000 leaves at a time, Leaf Value is recommended when you do not know the exact leaf value or description.
   
   a. If you select Leaf Value, type the From and To Leaf Values in the Range of Leaf Values and then click Display.

   **Note:** To search for an exact match, type the value in both the From and To fields.

   The Leaf Value and Leaf Description lists for the range that you specified appear.
b. If you select Leaf Description, type the description in the Search String field and click a Search Option, if appropriate.

The Leaf Value and Leaf Description lists for the description that you specified appear.

4. To edit a Leaf Value or Leaf Description, select the Leaf Value that you want to edit and then select the Edit button.

The Edit Leaf Info dialog box appears.
To edit leaf information, select the appropriate Check to Edit options, make your changes, and click OK.

To renumber a leaf value, select the leaf value that you want to renumber and then click the Renumber button.

Note: All non-common Chart of Accounts (COA) leaves need to be tied to the detail leaf. The detail leaf determines the account type and accrual basis.
The Renumber Leaf Value dialog box appears.

7. Type the new number in the New Leaf Value field and then click OK.

8. To delete a leaf value, select the leaf value that you want to delete and then click the Delete button.
   The Confirm Leaf Delete dialog box appears.

9. Click Yes to delete the leaf value, or click No to cancel the operation.

10. To add a new leaf value, select the leaf type to which you want to add and then click the Insert button.
    The Enter New Values dialog box appears.

11. Type in the Leaf Value and Description and, depending on the leaf type, any other information about the new leaf.

12. Click OK to add the leaf value, or click No to cancel the operation.

### Aggregation Methods for Financial Elements

Aggregation methods are applied to the summary financial information calculated at each event in order to generate financial element data for each modeling period.

The five different aggregation methods are:

- Average
- Accrual
- Sum
- First
- Last

Following are descriptions of the five aggregation methods.

#### Average Method

The average method calculates an average value (for example, Average Balance, Average Net Rate) over a modeling period. The calculation sums up the daily values and divides by the number of days in the modeling period.

\[
\text{Daily Average Balance} = \frac{\sum \text{(Daily Balance)}}{\text{days in modeling period}}
\]

All simulated events (originations, payments, prepayments, and repricings) are assumed to occur at the end of the event date. This implies that the balance and
rate on the day of an event is counted as the value prior to any changes made by the event. Changes made influence the value of the next day.

**Accrual Method**

The accrual method determines how much accrual has occurred over the modeling period. The accrual method is determined by the code value in the detail record. Interest-in-advance instruments calculate interest accruals from the current payment date to the next payment date. Interest-in-arrears instruments calculate interest accruals from the current payment date to the previous payment date.

The interest cash flow is divided by the number of days between these two dates to determine a daily accrual for each day within the modeling term. Daily interest accruals are summed by modeling period.

**Daily Interest Accrual = Interest Cash Flow / number of days in payment**

The example below demonstrates an interest accrual for an arrears record:

**Example:**

<table>
<thead>
<tr>
<th>Payment Date</th>
<th>Interest Cash Flow</th>
<th>Days in Payment</th>
<th>Daily Accrual</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 15</td>
<td>950</td>
<td>31</td>
<td>30.64</td>
</tr>
<tr>
<td>February 15</td>
<td>900</td>
<td>31</td>
<td>29.03</td>
</tr>
<tr>
<td>March 15</td>
<td>850</td>
<td>28</td>
<td>30.36</td>
</tr>
</tbody>
</table>

**Modeling Period End Date**

<table>
<thead>
<tr>
<th>Modeling Period End Date</th>
<th>Accrual Calculation</th>
<th>Interest Accrual</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 31</td>
<td>15 days @ 30.64 + 16 days @ 29.03</td>
<td>924.08</td>
</tr>
<tr>
<td>February 28</td>
<td>13 days @ 29.03 + 15 days @ 30.36</td>
<td>832.79</td>
</tr>
</tbody>
</table>

**Sum**

The sum method adds together all financial element values associated with events occurring during the modeling period.

**Principal Runoff = Σ(Principal Runoff)**
First
The first aggregation method determines the value from the first event within a
modeling period (for example, Beginning Balance).

Last
The last aggregation method determines the value from the last event within a
modeling period (for example, Ending Balance).

Selecting an Aggregation Method
To select an Aggregation Method, perform the following steps:
1. From the Setup menu, select Leaves.
The Leaf Setup dialog box appears.
2. From the Leaf Type list, select the leaf type you want.
3. Search for the leaf value that you want.
   You can search for a leaf value either by using Leaf Value or Leaf Description.
   a. If you select Leaf Value, type the From and To Leaf Values in the Range of
      Leaf Values and then click Display.

   Note: To search for an exact match, type the value in both the From and To fields.

   The Leaf Value and Leaf Description lists for the range that you specified
   appear.

   b. If you select Leaf Description, type the description in the Search String field
      and select a Search Option, if appropriate.
      The Leaf Value and Leaf Description lists for the description that you
      specified appear.

4. From the Leaf Value and Leaf Description lists, select a leaf value and then click the Edit button.
The Edit Leaf Info dialog box appears.

5. From the Check to Edit list, select Aggregation Method if it is not already selected.
6. Select an Aggregation Method and then click OK.

Tree-Related IDs

Many OFSA IDs function in the context of leaf columns. An example is the definition of modeling assumptions (such as Transfer Pricing methods or prepayments) on the basis of a Product ID (or product segmentation).

Examples of tree- or leaf-related IDs include the Tree Rollup ID, Tree Filter ID, Transfer Pricing ID, and Prepayment ID. Tree Rollup IDs, for example, enable the user to drill-down to an appropriate level before making an assumption. The user can drill-down to the level of detail needed for the particular purpose.

The OFS applications in which these and similar IDs function include Performance Analyzer, Risk Manager, Transfer Pricing, and Balance & Control.

Hints on Editing Tree-related IDs

When editing Tree Rollup ID and Tree Filter ID, you can use the Options and Tree menus to format the appearance of your ID. For example, you can change typeface or specify which branches are to be included in the rollup. You can use the Edit menu to search for a specific node within the tree structure. For more information about these menus, see Chapter 18, "Tree Filter ID" and Chapter 19, "Tree Rollup ID".

Importing and Exporting Data

You can use IDs for importing and exporting data in Performance Analyzer:

Note: You must configure the ODBC drivers before you can import and export IDs. Also, you can load Ledger Stat records using the server side process only. For more information about these topics, refer to the Oracle Financial Services Installation and Configuration Guide.

Importing and Exporting IDs

You can use import/export functionality of OFSA to:

- transport IDs from one FDM database to another
- maintain external backup copies of key IDs
Importing and Exporting Data

- load data into FDM from an external database (.DBF) source

OFSA provides two methods of importing and exporting IDs:

- Individual ID import/export
- Dependent ID import/export

**Individual ID Import/Export**

IDs that do not contain other embedded IDs, such as Leaf Characteristics ID and Transfer Pricing ID, are imported and exported using the Individual ID method. These IDs are exported into a dBase file with the .DBF extension and can be imported only from a dBase file with the .DBF extension.

---

**Note:** Table ID and Allocations ID are an exception to this rule because they use Individual ID import/export. They may also contain other embedded IDs. Dependencies are not exported along with Table IDs or Allocations IDs. You must export all dependencies separately.

---

Individual ID import/export is available for the following IDs:

- Table ID
- Allocation ID
- Leaf Characteristics ID
- Transfer Pricing ID
- Historical Rates ID
- Discount Rates ID
- Maturity Strategy ID
- Pricing Margin ID
- Forecast Rates ID
- Result Detail ID
- Transaction Strategy ID
- Forecast Balance ID
- Prepayment ID
The Individual ID method of import replaces an existing ID of that type in the import database. You cannot import an ID using the Individual ID method without replacing an existing ID.

**Caution:** To avoid losing existing IDs, create a new ID of the type being imported or use Save As from the File menu to create a copy of the existing ID before import.

To import an ID, open the ID that you want to overwrite and select File -> Import.

**Dependent ID Import/Export**

IDs that contain other embedded IDs, such as Correction Processing ID, are imported and exported using the Dependent ID method. This method ensures that any dependent IDs required for correct operation of the exported ID are included in the export process.

Dependent ID import/export is available for the following IDs:

- Data Filter ID
- Tree Rollup ID
- Tree Filter ID
- Formula ID
- Correction Rule ID
- Correction Processing ID
- Group Filter ID

Any ID that is exported using the Dependent ID method creates a dBase file with the .CAT extension and one or more dBase files with extensions listed in the table below. Although the extensions differ from the standard .DBF, these files all use the dBase format. Importing these IDs requires that all files created in the export process reside in the same directory. Dependent ID import/export uses the following file extensions:

<table>
<thead>
<tr>
<th>ID or Data Type</th>
<th>File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog of IDs</td>
<td>.CAT</td>
</tr>
<tr>
<td>Filter ID</td>
<td>.FLT</td>
</tr>
</tbody>
</table>
If a tree rollup ID that contains leaves not in leaf setup is imported, you receive a warning. If you elect to continue, the ID is imported but the leaves are not added to the leaf setup. You can use the Synchronize Instruments function to synchronize the Rollup ID with the leaf setup.

**Group Import/Export**

Use the Group Import/Export dialog box to import or export multiple IDs of various types. To import or export a batch of IDs, perform the following steps:

1. From the File menu, select Group Import/Export.

   The Group Import/Export dialog box appears. The Group Import/Export dialog box resembles a spreadsheet, where each row represents one import or export operation.

2. Select Insert Rows without highlighting any rows to add a row to the top of the spreadsheet.

---

<table>
<thead>
<tr>
<th>ID or Data Type</th>
<th>File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Leaves</td>
<td>.LF</td>
</tr>
<tr>
<td>Level Description</td>
<td>.LEV</td>
</tr>
<tr>
<td>Node Description</td>
<td>.NOD</td>
</tr>
<tr>
<td>Report Columns</td>
<td>.RCL</td>
</tr>
<tr>
<td>Correction Rule ID</td>
<td>.COR</td>
</tr>
<tr>
<td>Error Assignments</td>
<td>.ASS</td>
</tr>
<tr>
<td>Correction Processing ID</td>
<td>.PRC</td>
</tr>
<tr>
<td>Tree Filter ID</td>
<td>.TFT</td>
</tr>
<tr>
<td>Tree Rollup ID</td>
<td>.ROL</td>
</tr>
<tr>
<td>Formula ID</td>
<td>.FOR</td>
</tr>
<tr>
<td>Group Filter ID</td>
<td>.FGL</td>
</tr>
</tbody>
</table>

**Note:** If a dependent ID import fails during processing, change the file name extension from .DBF to its original form and extension and reprocess.
If any rows are highlighted, selecting Insert Rows adds an equivalent number of rows immediately before the highlighted section.

3. Select Delete Rows to remove any highlighted rows from the spreadsheet.

If no rows are highlighted, selecting Delete Rows removes the first row from the spreadsheet.

You can use the Group Import/Export columns as follows:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Done</td>
<td>As IDs are imported or exported, a red check mark appears in the dialog box indicating that the job is complete.</td>
</tr>
<tr>
<td>Action</td>
<td>Click Import or Export for each ID on your list.</td>
</tr>
<tr>
<td>File Type</td>
<td>The only file type that you can select for Import or Export is dBase.</td>
</tr>
<tr>
<td>ID Type</td>
<td>Use the list to select ID types available for import or export.</td>
</tr>
<tr>
<td>ID Name</td>
<td>Use the list to view previously selected ID types. This field is active when exporting an ID or when importing an ID with the Individual ID method. When importing with the Dependent ID method, &lt;not required&gt; appears in the dialog box.</td>
</tr>
<tr>
<td>PC File Name</td>
<td>Double click in this field to open Select Import File if you are importing an ID or Select Export File if you are exporting an ID.</td>
</tr>
</tbody>
</table>

From the Process menu, select Run to run Group Import/Export.

OFSA processes the rows on your spreadsheet in sequential order, starting with the first row.

**Export an ID with Group Import/Export**

To export an ID using the Group Import/Export dialog box, perform the following steps:

1. Click Export in the Action list.
2. Select the ID Type and ID Name you want to export.
3. Double-click in the PC File Name cell to display the Select Export File dialog box.
4. Type a valid file name for the export and click OK.
   Individual ID exports must use .DBF as their file extension. Dependent ID exports must use .CAT as their file extension. If the file name that you have selected is not valid, you must select a new file name.

5. From the Process menu, select Run to run Group Import/Export.
   OFSA processes the rows on your spreadsheet in sequential order, starting with the first row.
   If the export file name that you have chosen already exists and the file is not read-only, you are asked if you want to overwrite the existing file.

6. Click Yes to replace the existing file with your export file.

7. Click No to cancel the export process and select a different name for your export file.

Export an ID from the File Menu
To export an ID using the Export option in the File menu, perform the following steps:

1. Open the ID that you want to export.

2. From the File menu, select Export.
   The Export ID dialog box appears.

3. Click Browse to bring up the same Select Export File dialog box used for exporting with Group Import/Export.

4. Type a valid file name in the export data File Name dialog box.
5. Click OK to export your ID.

Import an ID with Group Import/Export

To import an ID using the Group Import/Export dialog box, perform the following steps:

1. From the File menu, select Import/Export Group.
   The Group Import/Export dialog box appears.

2. Click Import in the Action dialog box.

3. Select the ID Type of the ID that you want to import.

   Caution: Individual ID import overwrites the ID listed in ID Name with the contents of the imported ID. As a result, you lose any information contained in the ID being overwritten. If you do not want to lose any existing IDs, create a new ID of the type being imported or use Save As from the File menu to create a copy of the existing ID before import.

4. If the ID Type that you select relies on the Individual ID import method, select an existing ID to overwrite in the ID Name dialog box.

   If the ID Type you select relies on the Dependent ID import method, <not required> appears in the ID Name dialog box.

5. Double-click in the PC File Name dialog box.

   The Select Import File dialog box appears.
The Select Import File dialog box looks and functions almost the same as the Select Export File dialog box. The primary difference is in the file name validity check that is performed before you are returned to the Group Import/Export dialog box. A file name is valid only if it has the necessary file extension, .DBF for Individual ID imports and .CAT for Dependent ID imports, and if it is found in the designated directory. If a file does not have the necessary file extension, or if it is not found, you must select a new file name.

If you import an ID that uses the Dependent ID method, you are importing the original ID along with any embedded IDs used in its functionality. You import these IDs with the same <Name>/<Group> combination that they had in the original database.

6. From the Process menu, select Run to process all the rows on your Group Import/Export spreadsheet.

If any of the <Name>/<Group> combinations for the IDs you are importing (or for any IDs embedded in your imported IDs) are already being used in your import database, the Import Warning dialog box appears. The Import Warning dialog box offers you three options of how to proceed when the ID you are importing or one of its dependent IDs already exists in your import database:

- **Rename**
  To change the <Name>/<Group> combination of the ID that you are importing so it does not conflict with any IDs already present in the import database. After typing a new <Name>/<Group> combination for the ID that you are importing, click OK to continue with the import.

- **Use Existing**
  To use the existing ID in the database with the same <Name>/<Group> combination as the ID that you are importing. You can use Use Existing when you need to import multiple IDs that share one dependency ID.

- **Cancel**
  To cancel the import process. Selecting Cancel before all the rows in the Group Import/Export dialog box have been processed generates the Import Warning dialog box.

  Click Yes to stop the Group Import/Export process. Click No to skip the current row on the Group Import/Export dialog box and continue processing the subsequent rows in sequential order.

  In either case, all IDs imported prior to your clicking Cancel remain in the import database.
Importing and Exporting Data

Import an ID from the File Menu
To import an ID using the Import option in the File menu, perform the following steps:

1. Open the ID that you want to import.

   **Caution:** Individual ID import overwrites the ID listed in ID Name with the contents of the imported ID. As a result, you lose any information contained in the ID being overwritten. If you do not want to lose any existing IDs, create a new ID of the type being imported or use Save As from the File menu to create a copy of the existing ID before import.

2. From the File menu, select Import.
   The Import ID dialog box appears.

3. Select Browse to bring up the same Select Import File dialog box used for importing with Group Import/Export.

4. Type a valid file name in the import data File Name dialog box.

5. Click OK to import your ID.
   If your import uses the Individual ID method, you overwrite the open ID with the contents of the ID you are importing. As a result, you lose any information contained in the ID being overwritten.

6. If you encounter the Import ID dialog box, refer to the end of the previous section, "Export an ID with Group Import/Export," for instructions on how to proceed.

Rules, Limitations, and Hints
The Import/Export function is limited in scope. Keep in mind the following rules and limitations:
If an ID is imported and the <Group> it was created in does not exist in the import database, the ID is placed in the default <Group> specified in the Configuration ID.

Group Import/Export works only between databases that have identical structures. Different versions of the applications may use different database structures.

Correction Processing IDs using the OFSA Cash Flow Edits cannot be imported. When importing an ID of a given type, at least one ID of that type must already exist in the database or the import fails. No error message is displayed.

---

**Note:** Some .DBF files may require structural changes to import correctly into your FDM database. Before importing a non-OFSA .DBF into a particular database, export a similar type of ID to .DBF from that database. In your external database application, compare its structure to the non-OFSA file you want to import. Correct any structural differences in the non-OFSA file, and try the import it. If you experience problems, contact Oracle Support Services.

---

**OFSA ID Dependencies**

OFSA IDs often depend on other IDs for some or all of their data or usefulness. For example, a Transformation ID may depend on a particular Filter ID to select and focus data in a meaningful way. The Filter ID may have been created especially for that transformation and named in the transformation set up dialog box when the Transformation ID was created. If that Filter ID is deleted, then the transformation becomes unusable.

---

**Caution:** Consider OFSA ID Dependencies when you delete an ID. Deleting an ID may deprive a dependent ID of its meaning.

---

OFSA provides a Dependencies option in the File menu that enables you to view the dependencies factors of any active ID. This option shows both primary and secondary dependencies. For example, a Data Filter ID dependency may include a Processing ID as a primary dependency and a Batch ID as secondary dependency (depending on the Processing ID).
Also, when you select Delete ID or Delete Group of IDs, OFSA automatically checks for any dependencies, and enables you to review them before the deletion takes place. When you attempt to delete an ID, however, note that only primary dependencies are listed in the warning.

Note: Select Dependencies from the File menu if you plan to delete unfamiliar IDs.

Processing an ID

To process an ID, select Run from the Process menu. In most cases, the process proceeds immediately, without further prompting from the system.

Server Status

Most OFS applications can launch calculation-intensive software processes on a server. The server runs the process in the background, freeing the client PC to do other activities. Also, the server is often more powerful and can finish the process more quickly than the client PC.

When a server process is launched by an OFS application, the job request first is processed by RQ, the special OFS application that monitors OFSA server processing. RQ enters the job in a special table, and sends the job to the server. RQ then monitors the progress of the job on the server until it has completed, logging that information in its table.

When an OFS application launches a server job, the Server Status Update dialog box appears. Getting its data from RQ, the dialog box displays the progress of your server jobs or, optionally, displays all jobs on the server. Also, you can terminate any of your processes that are running on the server.

In Oracle Financial Data Manager (FDM) Administration, the capabilities of the Server Status Update dialog box have been expanded. The Server Status Update dialog box:

- enables you to terminate any job running on the server, not just those jobs you have launched yourself
- incorporates a test function to validate the ADMN - RQ - SERVER links
- provides a housekeeping capability, enabling you to delete completed jobs from the RQ table
Using the Server Status Update Dialog Box

To open the Server Status Update dialog box, select Server Status from the Process menu. The Server Status Update dialog box appears.

View Your jobs or All
- See your jobs
  Select this option to view the status of your own server jobs.
- See all jobs
  Select this option to view the status of all jobs running on the server.

Stop Job
Select any of your own server jobs, and select this option to stop it. This function is not a Pause. Once stopped, the job cannot be continued. You must restart it from its source application. This option does not cancel jobs that have not begun execution.

Note: In this OFS application, the Server Status Update dialog box enables you to stop your own server jobs only. In Oracle Financial Data Manager (FDM) Administration, the dialog box enables you to cancel any job running on the server.

Insert Test Request
This option starts a simple job to ping the server, testing network connections and protocols. Select Stop Job to halt the test, and select Remove YOUR Finished Jobs to delete the job from the display. If the test fails, the Cannot Launch Request error message appears.

Remove YOUR Finished Jobs
Select this option to delete all finished jobs from the display. The Request Clean Up verification box appears when the jobs have been removed. You click OK to close it.

Caution: Selecting Remove YOUR Finished Jobs does not halt processing of a server job in progress. The job is deleted from the display (and from the RQ table) but continues to run to completion on the server.
Server Polling Indicator
At the left side of the dialog box is a blue wheel that moves up and down the dialog box. The wheel indicates that OFSA is polling the database.

The Status Display
Through this interface you can monitor active server jobs.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Description</td>
<td>Name of the ID being processed</td>
</tr>
<tr>
<td>Table Name</td>
<td>Name of the table being processed against</td>
</tr>
<tr>
<td>Step/Page</td>
<td>Step or Page being processed</td>
</tr>
<tr>
<td>Host</td>
<td>Not currently implemented</td>
</tr>
<tr>
<td>Record</td>
<td>Number of records being processed</td>
</tr>
<tr>
<td>User</td>
<td>User’s login name</td>
</tr>
<tr>
<td>Title</td>
<td>Description or status of the process</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates whether or not the job has completed</td>
</tr>
<tr>
<td>Job Return Status</td>
<td>Indicates successful process or an error code. Possible return codes include:</td>
</tr>
<tr>
<td></td>
<td>■ Making request (Indicates that the client has made a request to the server, but it has not yet been acted upon)</td>
</tr>
<tr>
<td></td>
<td>■ No INI found (Indicates that, on startup, the server process could not find the server ini file. This file should be located in the same directory as RQ (usually /bin/rq under the OFSA install directory). Either the file does not exist (being deleted or moved after RQ started) or it is not readable (someone changed the modes on the file)</td>
</tr>
<tr>
<td></td>
<td>■ None: Running (Job is currently running)</td>
</tr>
<tr>
<td></td>
<td>■ Failed on Fork (Normally indicates that RQ was unable to execute the requested application. This can occur if the path in the server ini file is incorrect (for example, the OFSA software suite is not installed normally or is moved after it is installed). This message could also indicate that the permissions on the executable are incorrect.)</td>
</tr>
</tbody>
</table>
### Server Status

<table>
<thead>
<tr>
<th>Interface</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>None: Canceled</td>
<td>Indicates the process has been canceled, either from the client or from the server, with signal 1, 2, or 15 (SIGHUP, SIGINT, or SIGTERM, respectively).</td>
</tr>
<tr>
<td>Job Return Number</td>
<td>Job returned an unrecognized status</td>
</tr>
<tr>
<td>Normal</td>
<td>Indicates the job terminated normally</td>
</tr>
<tr>
<td>Bad Usage</td>
<td>Indicates that the subprocess failed to start because the parameters were not passed correctly. With the current releases of OFSA, this should not happen.</td>
</tr>
<tr>
<td>Session Failure</td>
<td>Indicates that the application was not able to create a session. Check the server log file for additional information.</td>
</tr>
<tr>
<td>No memory</td>
<td>Indicates that the server application ran out of memory</td>
</tr>
<tr>
<td>Internal Error</td>
<td>Indicates that some error occurred within the server application. This is normally a database error. Check the server log file for additional information.</td>
</tr>
<tr>
<td>Connect Failure</td>
<td>Connect Failure (Indicates that the server process was unable to connect to the database. An incorrect user/password is probably the reason. Check the log file for more information. This can occur if the password is changed after starting up the application but before running a server process.)</td>
</tr>
<tr>
<td>Rights Violation</td>
<td>Rights Violation (Indicates that the specified user does not have the proper rights to run the program. This can occur if an administrator changes the rights for a user after the user started a client application but before the server application is launched.</td>
</tr>
<tr>
<td>Signaled: &lt;number&gt;</td>
<td>Indicates that the process stopped running due to a signal. Check the log file for additional information. The number shown is the negative of the number that caused the process to halt. The most common number is -11.</td>
</tr>
</tbody>
</table>

| Request Date                  | Date and time when request is inserted into OFSA Request Queue. The date and time are from the client PC.                                                                                           |
| Start Date                    | Date when OFSA Request Queue launches process                                                                                                                                                       |
Changing a Password

To change your password, perform the following steps:

1. From the Options menu, select Change Password.
   
   The Change Password dialog box appears, with your login name (such as the name of the current Oracle Financial Data Manager (FDM) Administration user) at the top.

2. Type your current password.
   
   For security reasons, asterisks appear instead of the characters you type.

3. Type your new password, and then click OK.
   
   You are prompted to confirm the new password.

4. Retype the password exactly as you did the first time.

5. Click OK when you are done, or click Cancel at any time to close the Change Password dialog box and return to the main window.

   **Note:** OFSA passwords are case-sensitive. When you log on to the database via any OFS application, you must type your password exactly as you typed it here.

Spreadsheet Control Bar

The Spreadsheet Control Bar, available through the Stratification ID, automatically calculates and enters incremental ranges of data into your spreadsheets, such as for interest rates or amounts. The Spreadsheet Control Bar offers five incremental methods for automatically calculating ranges of data.

Increment Methods

Following are descriptions of the five Increment Methods and their uses:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
<td>Time when OFSA Request Queue launches process</td>
</tr>
<tr>
<td>End Date</td>
<td>Date and time when process completes</td>
</tr>
<tr>
<td>Priority</td>
<td>Processing priority in order of importance or urgency</td>
</tr>
</tbody>
</table>
Increment by Value
The increment is applied as a constant value amount (such as 1.00 or -1.50) that is cumulatively added to the value of the Start Value. Type an Increment Value and then click Run.

Increment by Percent
The increment is calculated as a cumulative percentage increase over the Start Value (with 100 percent specified by the value 100). Type an Increment Value and then click Run.

Add to by Value
A constant amount is added to the current value of each of the values in the ID. (For example a value of 1.5 adds 1.500 percent to each value.) This increment does not accumulate. Type an Increment Value and then click Run.

Add to by Percent
Each value is increased by a constant percentage over its current value (with a 100 percent increase specified by the value 100). This increment does not accumulate. Type an Increment Value and then click Run.

Interpolate
Interpolate inserts into the From/To columns an evenly-divided series of values calculated between a Start and End value, leaving the selected first and last row values intact. Type a Start Value and an End Value and then click Run.

When the interpolation is Run, the results are as follows:
The interpolated values from the 10-to-30 range are evenly distributed between the original values of 0 (selected row 2) and 30 (selected row 5). The To column values also have been correctly interpolated.

**Interpolation in Auto Increment**

Interpolation enables you to create interpolated buckets based on a start- and end-value. This method does not update the end value specified in the Auto Increment dialog box, however. You must manually enter that value.

**Increment a Range of Values**

To automatically increment a range of values, perform the following steps:

1. From the horizontal tool bar, select the Spreadsheet Control Bar icon to open the Control Bar

   **Note:** You can move the dialog box to another, perhaps more convenient, location on your window. Place your mouse pointer in the Control Bar's title bar, and hold the left mouse button while you drag the dialog box to a new location.

2. Select a range of values in the spreadsheet.
In the Control Bar, the value from the first row in your selected column is transferred to the Control Bar’s Start Value dialog box:

The Method list is at the top of the Control Bar. It displays Inc by Value when it becomes active. From the Method list, you can open a list of five increment Methods.

3. Select the increment method that you want to use and then click Run from the Process menu.
A Batch ID enables you to perform batch processing of multiple IDs such as Processing ID or Transformation ID. With a Batch ID, you can group time-consuming tasks for processing after hours or on weekends.

This chapter presents the following topics:

- Defining a Batch ID
- To process a Batch ID, perform the following steps:
- Editing a Batch ID

### Defining a Batch ID

To define a Batch ID, perform the following steps:

1. From the File menu, select New -> Batch ID.

   The New Batch ID dialog box appears.

2. Complete each field, as required.

   **Note:** For security reasons, Batch IDs are application-specific. You cannot use a Batch ID defined in one Oracle Financial Services (OFS) application in another OFS application. Accordingly, Batch IDs cannot have the same name, even though they appear in different OFS applications.

3. When you are done, click OK.

   The ID Type dialog box appears.
For more detailed information about defining IDs, refer to the ID Type information that follows and to the “Overview of IDs” chapter.

**ID Type**
When you select an ID type from the list, all the predefined IDs of that type are listed in the ID Type window.

**ID Information Dialog**
To locate the ID or IDs that you want, view summary information by selecting an ID and clicking the right mouse button. The ID Information dialog box opens. When you have finished viewing the data, click OK.

**Selected IDs Window**
Select the IDs you want to batch process and click Add. The ID names appear in the ID Name list. To select multiple IDs, hold the Shift key while selecting ID names. To add all of the IDs in your list, click Select All. When you have selected all the IDs you want to batch process, click Add. To remove an ID from the ID Names list, select the ID and click Remove. To remove all IDs from the ID Names list, click Remove All.

**Start Date and End Date**
These settings select the period in which you want the allocations or IDs to process. If you select Current Date, the system adopts the default As of Date. Choosing specific Start and End dates overrides the default As of Date.

**Order of Process Arrows**
The IDs are processed in the order in which they are listed in the Selected IDs window. To change the order, select an ID and use the up or down arrows to change its location in the list. When the order is correct, select Run from the Process menu.

**Processing a Batch ID**
You can process Batch IDs in serial or parallel mode.

In serial mode, each ID is processed one after another. Serial mode is the default setting.

In parallel mode, all IDs in Batch ID are run concurrently. Parallel processing may lengthen your processing time.
Note: If any IDs are dependent on other IDs, or if IDs access any of the same data, you cannot run parallel processing.

To enable parallel processing, you must modify your OSF.ini file. The appropriate parameter value in the [PARALLEL_BATCH_SERVER_PROCESSING] section of the .ini file must be changed to 1.

To process a Batch ID, perform the following steps:

1. Select Run from the Process menu. A spreadsheet window shows the status of each of the IDs being run.

   Note: Processes that run on the server may show a complete status before they have actually completed. To check the status of processes running on the server, select Server Status from the Process menu.

2. Select Save from the File menu.

Editing a Batch ID

To edit a Batch ID, perform the following steps:

1. From the File menu, select Open -> Batch ID.
   The Select Batch ID dialog box appears.

2. Select the ID you want to edit.

3. With the ID open, make your changes following the principles described in “Defining a Batch ID.”

4. Select Save from the File menu.

You can use the Save As option in the File menu to save your edited ID under a new name.
Editing a Batch ID
The Configuration ID allows you to set basic default values for Transfer Pricing work sessions. Multiple Configuration IDs can be created and saved, each for a different use, or for different individuals or groups of users. The dialog is a simple form in which you “fill in the blanks.” The prerequisites to its use are an understanding of the principles of Transfer Pricing and the requirements of your organization.

**Define a Configuration ID**

To define a Configuration ID, click the New icon on the horizontal toolbar, then click the Configuration ID icon on the vertical toolbar. Alternatively, from the File menu, choose New, and select Configuration. The New Configuration ID dialog appears. Proceed as described in Chapter 5, “Overview of IDs”. The Configuration ID dialog appears.
Define a Configuration ID

Company Name
Enter the Institution or Heading you want to appear at the top of any Report.

As of Date
The As of Date should match the As Of Date on the data you wish to process. OFSA uses this as an implied filter during processing, for example, it only processes data corresponding with the As Of Date in your active Configuration ID.

1. Enter the date you want to use in the As Of Date edit box. An alternative to typing in the date is to double-click in the date box to open the OFSA Calendar.

2. Change the year and month by clicking the Decrease arrow (on the left) or Increase arrow (on the right).

3. Now click the day for the date you are setting. The selected day turns red.

4. When you are done, choose OK.

Note: If a Configuration ID is assigned to a group of users, anyone in that group can edit the Configuration ID. Those changes impact all users in the group. Therefore, it is recommended that each user create his or her own Configuration ID.
Define a Configuration ID

The date you select is entered in the date box, and the calendar closes. Choose Cancel to abort the process, close the calendar, and return to the Configuration ID dialog.

Data Directory
Type the directory you want to use as a default directory for exporting reports and ID’s to disk. Click the Browse button if you want to select a directory without typing it in the Data Directory box. This is where Transfer Pricing writes any files you choose to save apart from the database in which you are working.

Activate
Each user can have one active Configuration ID at a time. Click the Activate button to make the displayed Configuration ID the active ID for the current user. You can save a Configuration ID without making it the active configuration.

Permission Settings
Permission Settings shows the default permission setting for IDs you create or rename when this configuration is active. You can change whether other users can read and write to (edit or change) the IDs, or whether they can only read them.

Group Name
This option lists the Groups to which the logged-in user has access. Enter the Group affiliation that you want to appear as the default when you create, rename (Save As) or copy an ID. For more information on group affiliations, see the chapter Overview of IDs earlier in this Guide. For a full discussion of OFSA groups, see the chapters Overview of System Administration, and Users and Groups Dialog, in the Oracle Financial Services System Administration Guide.

Organizational Unit Leaf
The Organizational Unit Leaf is used when “migrating” the Transfer Rates to the General Ledger. The Common Chart of Accounts ID is matched with the Org Leaf ID to determine which cost center gets allocated the cost of funds at the General Ledger. This configuration option selects which leaf to use as the Org Leaf. The choices are offered in the drop-down list.

Note: If an obsolete leaf type is specified, the application will not run.

Configuration ID 7-3
Define a Configuration ID

Product Leaf
The Product Leaf configuration differentiates products for Transfer Pricing purposes. This is the finest level of detail for which Transfer Pricing Assumptions may be made (see Chapter 16, "Transfer Pricing ID" and Chapter 12, "Prepayment ID"). The choices are offered in the drop-down list.

Charge/Credit Accrual Factor
Select the accrual factor to be applied when calculating cost of funds. The cost of funds is calculated by multiplying the balance times the assigned Transfer Rate times the Charge/Credit Accrual Factor. For each product being transfer priced, the accrual basis choices are:

Leaf Basis

<table>
<thead>
<tr>
<th>Leaf Basis</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Applies no accrual basis.</td>
</tr>
<tr>
<td>30/360</td>
<td>Applies the accrual basis calculation of 30 days divided by 360 days.</td>
</tr>
<tr>
<td>Actual/360</td>
<td>Applies the accrual basis calculation of number of days in the month divided by 360 days.</td>
</tr>
<tr>
<td>Actual/Actual</td>
<td>Applies the accrual basis calculation of number of days in the month divided by number of days in the year.</td>
</tr>
<tr>
<td>30/365</td>
<td>Applies the accrual basis calculation of 30 days divided by 365 days.</td>
</tr>
<tr>
<td>30/Actual</td>
<td>Applies the accrual basis calculation of 30 days divided by the number of days in the year.</td>
</tr>
<tr>
<td>Actual/365</td>
<td>Applies the accrual basis calculation of number of days in the month divided by 365 days.</td>
</tr>
</tbody>
</table>

Compounding Method
Select the compounding method to be applied for Cash Flow Transfer Pricing Methodology. The choices are Semi-annual or Annual compounding methods.
Define a Configuration ID

Processing Error Message Limits

**Total**
Type in (or click the spinner arrows) to specify the total number of error messages you want written to the Process_Errors table in the database. For example, if you type in 100, the Process_Errors table holds the first 100 error messages that result from running your Transfer Pricing Processing ID.

**Per Item**
Type in (or click the spinner arrows) to specify the number of times you want to see each unique error message in the Process_Errors table. For example, if you type in 10, the Process_Errors table will hold 10 records for each unique error message that results from running your Transfer Pricing Processing ID.

---

**Note:** Each user should establish his own Configuration ID for maintenance purposes.
A Data Filter ID enables you to narrow the focus of your data for processing. It specifically targets the data you want to include or exclude for processing by another ID.

This chapter discusses the following topics:

- Creating and Defining a Data Filter ID
- Running a Data Filter ID
- Editing a Data Filter ID
- Using Data Filters on Multiple Tables
- Reviewing a Data Filter ID Example

Creating and Defining a Data Filter ID

Use the following instructions to create and define a Data Filter ID. See Chapter 5, "Overview of IDs" for further explanation about ID creation and maintenance.

To create a Data Filter ID, perform the following steps:

1. From the File menu, select New -> Data Filter ID to display the New Data Filter ID dialog box.
2. Type the name for the ID in the Data Filter ID field.
3. Type a description for the ID in the Description field.
4. Select the permissions for the ID.
5. Click OK to continue, or click Cancel to exit.

The Data Filter ID dialog box appears.
6. Select the instrument to include in your Data Filter ID from the list of instruments. The instrument types are specific to your particular database. The three types of instruments are:

- **Portfolio**  
The Portfolio instrument type enables you to create a cross-instrument data filter. Portfolio fields are common to all instruments. All other instrument selections automatically narrow your focus to just that instrument type. If the filter criteria are the same for all instrument tables (for example, As of Date or Branch Code), you can use Portfolio as the instrument. If the filter criteria are different for all applicable instrument tables (such as Current Net Book Balance), define the filter criteria for the first instrument table, and then select the next instrument table from the instrument list and define its criteria, and so on.

- **Multiple Tables**  
The Multiple Tables type instrument enables you to create a single data filter on multiple instrument tables. You must define the filter criteria for each instrument.

- **Formula**  
The Formula instrument type enables you to filter data against a selection derived from a predefined Formula ID.
7. Type or change the description of the purpose of the Data Filter ID.

8. Select one or more columns from the Columns box, and click Add to copy your selections to the Defined Filter box.

   The Defined Filter box displays the columns that you use to define filter criteria. To remove a column from the Defined Filter box, select it and click Remove. To remove all the columns, click Remove All.

9. Click on the first column in the Defined Filters box and select the Filter Type appropriate for that column. Then, enter the criteria appropriate for that column in the lower part of the dialog box. Repeat this step for each column in the Defined Filter box. See "Defining Filter Types and Criteria" in the following section for an explanation of the different types of filters and criteria that you can use with Data Filter IDs.

10. Save the ID.

**Defining Filter Types and Criteria**

The filter criteria options appear on the lower half of the dialog box when you select a column in the Defined Filter box and select a Filter Type. The criteria options change depending on the column and the type of filter that you select.
Filter Type
The five filter types differ based on the type of column you select. If the column represents a code, you can select a filter type of Code Values, Another Column, or Formula ID. If the column represents a numeric field or date field (a non-code field), you can select a filter type of Ranges, Specific Values, Another Column, or Formula.

Specific Values
This filter type presents the Values column. You can enter up to 60 specific values.

Ranges
This filter type offers From and To columns to enter ranges. You can enter the number of ranges that you want directly or use the spinner arrows to change the number of ranges dynamically. You can enter a maximum of 60 ranges.

Another Column
This filter type compares the selected column to another column.

Formula
This filter type compares a column to a value derived from a Formula ID.

Code Values
This filter type enables you to define specific code values for selection.

The filter type determines what criteria characteristics appear for the column that you select.

Filter Criteria
Criteria options change depending on the Filter Type that you select. The data must meet the definitions that you define in the filter criteria for each selected column. Otherwise, the data cannot pass the filter. For example, you may have two columns defined as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Filter Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Balance</td>
<td>&gt; 100,000</td>
</tr>
<tr>
<td>Current Rate</td>
<td>&gt; 8.00</td>
</tr>
</tbody>
</table>

These columns indicate that a record must have a Current Balance greater than 100,000 and a Current Rate greater than 8.00 in order to pass the filter.
Include/Exclude  After defining the specific Ranges or Values, you must choose whether you want to include or exclude the data that meets the defined criteria.

Operators  You use operators for the filter types Another Column and Formula. The choices are:

- =
- <>
- <
- >
- >=

After you have selected the operator, select the column or Formula ID as appropriate to complete the equation.

Code Values  When you select Code Values as the filter type, the codes for the selected column appear in the Unselected Codes box. You can use the buttons to identify the codes you want to include or exclude in the filter.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Moves the highlighted codes to the Selected Codes box</td>
</tr>
<tr>
<td>Remove</td>
<td>Moves the highlighted codes in the Selected Codes box to the Unselected Codes box</td>
</tr>
<tr>
<td>Select All</td>
<td>Moves all the codes to the Selected Codes box</td>
</tr>
<tr>
<td>Remove All</td>
<td>Moves all selected codes to the Unselected Codes box</td>
</tr>
</tbody>
</table>

Filter Criteria Rules

In order to get the results you want, you must define complete information in the Data Filter IDs. Complete information requires the following:

- Thorough Definitions
  
  You must thoroughly define the criteria for each column that you include in the data filter. All values, ranges, other column names, and formulas must be complete. If you specify that you want to filter on five specific values and then complete only the criteria for the first one, you can still save that Filter ID. However, an error message appears if you try to run an ID that uses the incomplete Filter ID.
Creating and Defining a Data Filter ID

- Order of Processing

You can control the order of the application of the filter criteria (such as the order of the Columns in the Defined Filter box) by using the directional arrow buttons to the right of the Defined Filter box.

**Note:** The end result of the filter is not dependent on the order of the application of the filter criteria. Each row must pass all criteria.

- Implied Filter Criteria

Besides the filter criteria that you have defined, the following filter criteria may be automatically included in a process that you generate:

- As of Date

Although the Oracle Financial Data Manager (FDM) database can contain data from an unlimited number of as-of-dates, most Oracle Financial Services (OFS) applications automatically filter only those rows from the as-of-date that you define in the active Configuration ID.

- Row Level Security

Your system administrator may limit the rows to which you have access.

- Null Values in the Database

A null value in a column in the database is a column that has no data. You should take all necessary steps to avoid having null columns in the database for the following reasons:

- Any null value accessed in a formula results in a null value. For example:

<table>
<thead>
<tr>
<th>Column X</th>
<th>Column Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>null</td>
</tr>
</tbody>
</table>

If we define a formula as X + Y, the answer is 150 + null = null. All operations (such as +, -, /, *, ^) are handled in this same manner.

- You cannot define a filter to recognize null values. The Data Filter ID assumes that the database does not have any null values. Consequently, you cannot define a Data Filter ID to isolate all rows with a null value in a given column.
You can identify null values by using an SQL statement to select all rows WHERE <Column> IS NULL.

**Running a Data Filter ID**

Running the Data Filter ID generates an SQL statement but does not execute the statement. The application executes the SQL statement when you run an ID using the Data Filter ID.

To process a Data Filter ID, complete the following steps:

1. From the Process menu, select Run.
   - The SQL statement that your Data Filter ID generates displays in a window.
2. Review the SQL statement to check the results of your Data Filter ID.
3. Click OK to close the SQL statement window.

**Editing a Data Filter ID**

To edit a Data Filter ID, perform the following steps:

1. From the File menu, select Open -> Data Filter ID.
   - The Select Filter ID dialog box appears.
2. Select the ID you want to edit.
3. Make your desired changes.
4. Save the ID.

**Using Data Filters on Multiple Tables**

A Data Filter ID can contain criteria from different tables. Each line in the Defined Filter box is a part of the filter that can stand alone as its own filter. Also, each line or part of the defined filter can reference a different table.

A part of the filter can reference Portfolio as the table name. Portfolio is a proxy for whatever table the current ID is referencing. For example, if the ID using the Filter
ID is a Data Correction ID, the application replaces Portfolio with the name of whatever table the Data Correction ID is correcting. The application may or may not apply each line of the filter to the data in a table.

The application applies the filter line if either of the following conditions is true:

- The table you name explicitly in the filter is the same as the table that the application is processing
- The table in the filter is Portfolio and the table the application is processing contains the referenced Portfolio field

The application does not apply the filter line if either of the following conditions is true:

- The table explicitly named in the filter is different from the table that the application is processing
- The table in the Data Filter ID is Portfolio and the table the application is processing does not contain the referenced Portfolio column

The examples in the following table demonstrate these rules. The Table and Column combination represents the filter. An X indicates that the application applies the filter to the table during processing.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Commercial Loans Table</th>
<th>Ledger Stat Table</th>
</tr>
</thead>
</table>
| Table: Commercial Loans  
Column: Current Gross Book Balance | X |
| Table: Ledger Stat  
Column: Month 1 | |
| Table: Portfolio  
Column: Original Term to Maturity | X |
| Table: Portfolio  
Column: Organizational Unit ID | X | X |

**Reviewing a Data Filter ID Example**

This example demonstrates how to create a data filter that includes only adjustable rate mortgages. You can create a Data Verification ID using the new Data Filter ID that verifies the margins on your adjustable rate mortgages. See Chapter 9, "Data Verification ID" for more information.
To create the data filter, perform the following steps:

1. From the File menu, select New -> Data Filter ID.
   The New Data Filter ID dialog box appears.

2. Type MTG_ARM in the Data Filter ID field.

3. Type Adjustable Rate Mortgages in the Description field.

4. Click Read/Write as the permissions.

5. Click OK.
   The Data Filter ID dialog box appears.

6. Select Mortgages from the instrument list.

7. In the Columns box, select Interest Rate Code, and click Add.
   The Interest Rate Code column appears in the Defined Filter box.

8. Select Interest Rate Code in the Defined Filter box.
   This activates the Filter Type options. Code Values appears as the first choice because you have selected a code-type column.

9. Select No Index from the Unselected Codes box, and then click Add.
   The selection appears in the Selected Codes box.

10. Click Exclude These Codes in the Codes options box.
11. Select Process -> Run to verify the SQL statement.
12. Save and close the ID.

When you create the Data Verification ID and apply this Data Filter ID, it limits the view to adjustable rate mortgages only.
When you need to edit or verify the data in a database, you often need to view that data at the lowest level possible: the row and column level. The Data Verification ID enables you to define the specific table, columns, and rows you want to view.

The results of the Data Verification ID appear in the form of a virtual spreadsheet that displays a maximum of 32,000 records. Because databases may be much larger than this, you should use predefined Data Filter IDs to narrow your focus on the database. Refer to Chapter 8, "Data Filter ID" for instructions on how to create a Data Filter ID.

This chapter discusses the following topics:

- Creating and Defining a Data Verification ID
- Running a Data Verification ID
- Editing a Data Verification ID
- Reviewing a Data Verification ID Example

Creating and Defining a Data Verification ID

Use the following instructions to create and define a Data Filter ID. See Chapter 5, "Overview of IDs" for further explanation about ID creation and maintenance.

To create a Data Verification ID, perform the following steps:

1. From the File menu, select New -> Data Verification ID to display the New Data Verification ID dialog box.
2. Type name for the ID in the Data Verification ID field.
3. Type a description for the ID in the Description field.
4. Select the permissions for the ID.

5. Click OK to continue or Cancel to exit.

The Data Verification ID dialog box appears.

6. From the Table Types list, select the type of table with which you want to work. Your selection determines which tables are available in the Tables list.

7. From the Table list, select the table with which you want to work.

   **Note:** The Data Verification ID does not support Risk Manager result detail tables.

8. From the Filter ID list, select the Data Filter ID or Group Filter ID for the subset of data you want to view.

   **Note:** The virtual spreadsheet displays up to 32,000 records. If the records you want to view are outside this range, you must refine your filter (Data Filter ID or Group Filter ID) to narrow the focus of your view.

9. Select up to three columns in the Sort By box to define the sort order you want.

10. In the Columns box, select the columns you want to include in your view and click Add.
The columns move to the Defined View box.

- To add all the columns to the Defined View box, click Select All and then click Add.
- To delete a column from the Defined View, select the column and click Remove.
- To remove all the columns from the Defined View, click Remove All.

**Note:** If a column name contains a substring that includes the name of another column (such as, Remaining Term and Remaining Term Multiplier), then you must add the column with the shorter name to the defined view first.

11. Use the arrows next to the Defined View box to organize the columns in the order you want to see them.

   Each click of an arrow moves the selected columns one position. Raising a column in the list moves it to the left in the spreadsheet.

12. Save the ID.

**Running a Data Verification ID**

To view the results of your Data Verification ID definitions, complete the following steps:

1. Select the Run option from the Process menu.
2. Review the results.

![Edit Spreadsheet On/Off](Image)

**Edit Spreadsheet On/Off**

The Edit spreadsheet On/Off option is available only in Oracle Financial Data Manager Balance and Control. If this feature is on, you can edit the data at row level. The yellow pencil icon with the red X over it indicates that the Oracle Financial Services (OFS) application does not allow editing.

**What the Results Show**

In the View window, all values display as they are stored in the database. For example, the view displays code values numerically, not with the code value translation. This is essential for quality control of the data. If you have invalid codes, simply displaying an invalid code description is not sufficient. The actual code value is necessary for determining the source of the problem.

**Editing a Data Verification ID**

To edit a Data Verification ID, perform the following steps:

1. From the File menu, select Open -> Data Verification ID.
   
   The Select Data Verification ID dialog box appears.

2. Select the Folder and Data Verification ID you want to edit.

3. Make your desired changes.
Reviewing a Data Verification ID Example

This example creates a Data Verification ID to verify the margins on adjustable rate mortgages. To include only adjustable rate mortgages in the table view, you must first create a Data Filter ID (MTG_ARM) that meets these characteristics. See Chapter 8, "Data Filter ID" for instructions on creating the Data Filter ID for this example.

To create the Data Verification ID, perform the following steps:

1. Select New -> Data Verification ID.
2. Select <ALL> for Folder.
3. Type ADJ_RT_MTG_MAR in the Data Verification ID field.
4. Type Verify Adj Rt Mtg Margins as the description.
5. Select Read/Write for Security.
6. Click OK.
   
   The Data Verification ID dialog box appears.
7. Select Client Data Tables Table type.
8. Select the Mortgages table.
9. Select Interest Rate Code, Product Type Code, Margin, and Current Gross Rate from the Columns box.
10. Click Add to include these columns in the Defined View box.
11. In the Filter box, select MTG_ARM.
12. Select Interest Rate Code from the first Sort By box to view the margins based on the interest rate code.
13. Run the Data Verification ID to view and verify the results.
Reviewing a Data Verification ID Example
A Formula ID is a user-defined tool that supplements other IDs and enables you to further and more flexibly manipulate data. Formula IDs have three different uses:

- To specify a calculated column that the Oracle Financial Services (OFS) application derives from other columns in the database
- To calculate assignments in data correction
- To create calculated conditions in data and relationship filters.

For example, you want to calculate a weighted average rate that requires a calculation involving total net balance and the current rate on each individual account. You can use a Formula ID to define this calculation.

The OFS applications handle a Formula ID like any database column. The applications display all Formula IDs under the Formula selection in the instrument table lists, however.

This chapter discusses the following topics:

- Using the Formula ID Window
- Creating a Formula ID
- Editing a Formula ID
- Reviewing Formula ID Examples
Using the Formula ID Window

The Formula ID window comprises elements that you use to build formulas.

The formula elements are:

- Operators and Operands
- Function Types and Functions
- Constants
- Tables and Output Columns

Only those formula elements that you can add logically at the next point of a formula are available for use. The OFS application disables or hides the formula elements that are not applicable.
You use the formula elements as you need them. For example, you may need a formula to calculate the weighted average of your commercial loans. You must first select Mathematical as the function type and WAvg as the function before you select the columns under the Commercial Loans table. However, you can build a formula that does not require a function. It may need only operators and operands.

The following sections describe the formula elements and provide basic information on how to use them.

**Operators and Operands**

Operators and Operands are displayed as buttons across the top of the Formula ID window.

The operands available are left parenthesis, right parenthesis, and comma. Parentheses group segments of a formula to make logical sense. The comma separates statements of a function.

The mathematical operators available are:

- +
- -
- *
- /
- =
- >
- <
- <>
- >=
- <=

You can use these operators to apply mathematical operators to the formula.

Add enables you to add the currently highlighted database column or operator to build the formula.
Function Types and Functions

You select the type of function for your formula from the Type list. The choices are:

- Mathematical Functions
- Date Functions
- String Functions
- Other Functions

The type of function you select determines the choices available in the Function box. These unique functions of the Formula ID enable you to perform various operations on the data. The following tables list each available function. Detail on the operations of each function follows the table in which it appears.

Mathematical Functions

When you select Mathematical as the function type, you can use the following 11 functions from the Functions box:

<table>
<thead>
<tr>
<th>Function</th>
<th>Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Value</td>
<td>ABS()</td>
</tr>
<tr>
<td>Ceiling</td>
<td>CEILING()</td>
</tr>
<tr>
<td>Greatest</td>
<td>GREATEST(column or expression, column or expression)</td>
</tr>
<tr>
<td>Least</td>
<td>LEAST(column or expression, column or expression)</td>
</tr>
<tr>
<td>Maximum</td>
<td>MAX()</td>
</tr>
<tr>
<td>Minimum</td>
<td>MIN()</td>
</tr>
<tr>
<td>Natural Log</td>
<td>LN(number)</td>
</tr>
<tr>
<td>Power</td>
<td>POWER(coefficient, exponent)</td>
</tr>
<tr>
<td>Round</td>
<td>ROUND (number, precision)</td>
</tr>
<tr>
<td>Sum</td>
<td>SUM()</td>
</tr>
<tr>
<td>Weighted Average</td>
<td>WAvg (column being averaged, weight column)</td>
</tr>
</tbody>
</table>

The following descriptions provide detailed information about the mathematical functions, including examples.
**Absolute Value:** Returns the positive value of the database column

Example: \( \text{ABS}(-3.5) = 3.5. \)

ABS function syntax:

\[ \{ \text{ABS( } \} \text{ followed by } [\text{EXPR1 without any embedded or outermost left-right parentheses pair} \text{ followed by } \} ] \]

For example, \( \text{ABS}(F), \text{ABS}(F + C), \text{ABS}(F + C * R + F) \) are possible. However, \( \text{ABS}((F + C + R)), \text{ABS}((F + (\text{MAX} + \text{CEILING}))) \) are not possible.

**Ceiling:** Rounds a value to the next highest integer

Example: 3.1 becomes 4.0, 3.0 stays the same

Syntax: Ceiling(column or expression)

**Greatest:** Returns the greater of 2 numbers, formulas, or columns

Syntax: Greatest(column or expression, column, or expression)

**Least:** Returns the lesser of 2 numbers, formulas, or columns

Syntax: Least(column or expression, column or expression)

**Maximum:** Returns the maximum value of a database column

Syntax: Max(Column)

**Minimum:** Returns the minimum value of a database column

Syntax: Min(Column)

---

**Note:** You cannot use the Maximum and Minimum functions as calculated columns or in Data Correction Rules. The Maximum, Minimum, Sum, and Weighted Average functions are multi-row formulas. They use multiple rows in calculating the results.

---

**Natural Log:** Returns the natural logarithm of a number

Natural logarithms are based on the constant \( e \) (2.71828182845904).

Syntax: LN(number) where number is the positive real number for which you want the natural logarithm

Examples:
LN(86) equals 4.454347
LN(2.7182818) equals 1

**Power**: Raises one value to the power of a second
Syntax: Power(x, y) returns x raised to the power of y
POWER function syntax:
{POWER(} followed by {EXPR1 without any embedded or outermost left-right parentheses pair followed by {,} followed by {EXPR1 without any embedded or outermost left-right parentheses pair} followed by { )}

**Valid examples**:
\[
\begin{align*}
\text{POWER}(F, R) \\
\text{POWER}(F + C \times R, F / R)
\end{align*}
\]

**Invalid examples**:
\[
\begin{align*}
\text{POWER}((F/R), F + R) \\
\text{POWER}((F + C), (C \times R)) \\
\text{POWER}(F + \text{POWER}, R) \\
\text{POWER}(\text{MAX}, C)
\end{align*}
\]

**Round**: Rounds a value to a number of decimal places
Syntax: Round(x, n) returns x rounded to n decimal places

**Sum**: Sums the total value of a database column. Sum is a multi-row function, in contrast to +, which adds 2 or more values in a given row (not column)
Syntax: Sum(Column).

**Weighted Average**: Takes a weighted average of one database column by a second column
Syntax: WAvg(Column A, Column B)
Example:
\[
\text{WAvg(DEPOSITS.CUR_NET_RATE,DEPOSITS.CUR_BOOK_BAL)}
\]
WAvg cannot appear in any expression.
If you have two formulas called F1 and F2, both of which are WAvg functions, then you can form a third formula F3 as F1 + F2. If F3 is chosen as a calculated column, then an error message appears and the SQL code is not generated for
that column. This is similar for nested WAvg functions if F3 is WAvg and it has F1 or F2 or both as its parameters.

Date Functions
Four functions are available when you select Date as the function type:

<table>
<thead>
<tr>
<th>Function</th>
<th>Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Build Date</td>
<td>BUILDDATE(CCYY,MM,DD)</td>
</tr>
<tr>
<td>Go Month</td>
<td>GOMONTH(date, number of months)</td>
</tr>
<tr>
<td>Month</td>
<td>MONTH(number)</td>
</tr>
<tr>
<td>Year</td>
<td>YEAR(date)</td>
</tr>
</tbody>
</table>

The following descriptions provide detailed information about the date functions, including examples.

**Build Date**: Requires three parameters, (CCYY,MM,DD) (century and year, month, day). It returns a valid data and enables you to build a date from components.

Caution: If the parameters are entered incorrectly, the date is invalid.

Example: BuildDate(95,11,30) is invalid (invalid century). BuildDate(1995,11,30) is valid.

**Go Month**: Advances a date by x number of months.

Syntax: GOMONTH(Date column, Number of months to advance)

Example:

GOMONTH(DEPOSITS.ORIGINATION_DATE, DEPOSITS.ORG_TERM)

Go Month does not know the calendar. For example, it cannot predict the last day of a month. Typical functionality is illustrated in the following table:

<table>
<thead>
<tr>
<th>Date Column</th>
<th># of Months</th>
<th>GOMONTH</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/31/94</td>
<td>1</td>
<td>2/28/94</td>
<td>Because 2/31/94 does not exist</td>
</tr>
<tr>
<td>1/15/94</td>
<td>2</td>
<td>3/15/94</td>
<td>Exactly 2 months:15th to 15th</td>
</tr>
</tbody>
</table>
GOMONTH function syntax:

\{GOMONTH( } followed by \{F | C | R} followed by {}, followed by \{EXPR1 without any embedded or outermost left-right parentheses pair\} followed by {)}

Valid examples:

GOMONTH(F, F + R + C)
GOMONTH(F, R)

Invalid examples:

GOMONTH(F + (R + C), MAX)
GOMONTH((F * C), F)

GOMONTH followed by {+ | -} followed by \{F | C | R} is the only expression possible with GOMONTH.

Month: Month(x) returns the month in x, where x is a numbered month.

Month(Column) returns the month in the column, where the column is a date column.

Examples:

Month(9) returns September.
Month(Origination Date) returns the month of the origination date.

Year: Year(x) returns the data for year x.

Year(Column) returns the year in the column, where the column is a date column.

Example: Year(Origination Date) returns the year of the origination date.
String Functions
Only one function is available when you select String as the function type:

<table>
<thead>
<tr>
<th>Function</th>
<th>Notation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trim All</td>
<td>ALLTRIM()</td>
<td>Trims leading and following spaces, enabling the software to recognize numbers (entered in All Trim) as a numeric value, which can then be used in calculating</td>
</tr>
</tbody>
</table>

Other Functions
Two functions are available when you select Other as the function type:

<table>
<thead>
<tr>
<th>Function</th>
<th>Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>If statement</td>
<td>IF(logical_test, value_if_true, value_if_false)</td>
</tr>
<tr>
<td>Lookup</td>
<td>LOOKUP(original table column,lookup table column, return column)</td>
</tr>
</tbody>
</table>

The following descriptions provide detailed information about the other functions, including examples.

**If:** Use *If, then* logic in a formula. The syntax for the If function is:

\[
\text{IF(Condition, Value if True, Value if False)}
\]

Example:

\[
\text{If(LEDGER\_STAT.Financial= 110, LEDGER\_STAT.Month 1 Entry,0)}
\]

IF function syntax:

\[
\{\text{IF( }\text{EXPR2} \text{ followed by } \{> \mid < \mid <> \mid = \mid >= \mid <=\} \text{ followed by } \text{EXPR2} \text{ followed by } \{\text{EXPR} \text{ followed by } \text{EXPR} \text{ followed by } \text{EXPR}\} \text{ n} \text{ followed by } \)}\]

where n = 1, 2, 3, ....

The IF function should always have odd number of parameters separated by commas. The first parameter is an expression followed by a relational operator, which is in turn followed by an expression.

For example, \[
\text{IF()((MAX + SUM) >= 30), F, POWER) is valid.}
\]

**Note:** Avoid embedding multiple individual formulas in subsequent formulas. This can create an invalid formula.
Using the Formula ID Window

**Lookup**: Enables you to assign values equal to values in another table for data correction.

LOOKUP function syntax:

\[ \text{Lookup}(O1,L1,O2,L2,...,On,Ln,R) \]

where

- \( O \) = Column from Original table
- \( L \) = Column from Lookup table
- \( R \) = Column to be Returned

So the previous statement would read:

where \( O1=L1 \) and \( O2=L2 \ldots \) Returned value \( R \)

LOOKUP function should always have an odd number of parameters separated by commas and with a minimum of 3 parameters.

**Valid examples:**

- \( \text{LOOKUP}(F, R, R) \)
- \( \text{LOOKUP}(F, R, F, F, F) \)

**Invalid examples:**

- \( \text{LOOKUP}(F) \)
- \( \text{LOOKUP}(F, R) \)
- \( \text{LOOKUP}(F + R, (F + R), \text{MAX}) \)

---

**Note**: Lookup is used exclusively for data correction.

---

**Constants**

The Constant box enables you to apply a constant value to the formula. You type a value into the box and click Insert Constant to insert the value of a constant into the formula.

---

**Tables and Output Columns**

The Tables box enables you to select the table that holds a specific database column you want to include in a formula. Once you select a table, the application displays the columns associated with that table in the Output Columns box.
You can use the Formula table to access any previously defined formulas.

**Output Columns (Data Elements)**
To use a column (a data element) in the formula, select that column and then click Add in the Operand box, or double-click on the column name to add it to the formula.

**Formula Box**
The Formula box displays the formula as you create it.

**Edit Options**
The Edit box and option buttons provide full control of formula editing.

**Clear**
The Clear option clears the entire formula box of all logic.

**Delete**
The Delete option deletes the parts of the formula that you select. Select the formula element that you want to delete and click Delete.

**Note:** You cannot delete any portion of a formula if the deletion results in leaving an invalid formula.

**Insert**
The Insert option inserts operators, operands, or constants into the formula at the cursor position. To insert an element, complete the following steps:
Using the Formula ID Window

1. Place your cursor in the formula where you want to insert an element, and click Insert.
2. Select the item you want to insert. Double-click a column or function, or click the operator button and then click Add.
   Your insertion element appears in the Edit box for verification.
3. Press Insert again.
   A warning dialog appears.
4. Click Yes to insert, or click No to reselect your insertion element. You can click Cancel to cancel the operation.

   **Note:** You cannot insert expressions, operators, or constants that result in leaving an invalid formula.

**Replace**
The Replace option replaces a formula element that you select. To replace a formula element, complete the following steps:

1. Select the formula element that you want to replace, and click Replace.
2. Select the replacement item. Double-click a column or function, or click the operator button and then click Add.
   Your replacement element appears in the Edit box for verification.
3. Click Replace again.
   A warning dialog appears.
4. Click Yes to confirm the replacement, or click No, and reselect your replacement element.
5. Click Cancel to cancel the operation.

   **Note:** You cannot replace a selected element that results in leaving an invalid formula.

**Null Values in the Database**
A null value in a column in the database is a column that has no data. You should take all necessary steps to avoid having null columns in the database for the following reasons:
Any null value accessed in a formula results in a null value. For example:

<table>
<thead>
<tr>
<th>Column X</th>
<th>Column Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>null</td>
</tr>
</tbody>
</table>

If we define a formula as X + Y, the answer is 150 + null = null. All operations (such as +, -, /, *, ^) are handled in this same manner.

You cannot define a filter to recognize null values. The Data Filter ID assumes that the database does not have any null values. Consequently, you cannot define a Data Filter ID to isolate all rows with a null value in a given column.

**Note:** Null <> 0, so filtering on 0 does not return rows with null values.

You can identify null values by using an SQL statement to select all rows WHERE <Column> IS NULL.

**Formula ID Creation Hints**

The Formula ID is a flexible method for creating formulas. Consequently, you have the potential to define a formula that does not make sense. Consider the following recommendations when creating a Formula ID:

- Do not use a column out of context. For example, do not use a character field in a numeric calculation.
- Each formula should contain only columns from the same database table (except for certain Ledger_Stat table columns).
- An implied filter exists when creating a Formula ID with columns in the LEDGER_STAT table. LEDGER_STAT table formulas include if/else decode logic based on the Configuration ID as of date.

Example: If the formula is Month_01 - 100, a filter includes Year_S equal to the as of date/year. This formula works as follows:

Year_S = 1994, then Month_01 - 100, else 0.
Creating a Formula ID

Use the following instructions to create and define a Formula ID. See Chapter 5, "Overview of IDs" for further explanation about ID creation and maintenance.

To create a Formula ID, perform the following steps:

1. From the File menu, click New.
   A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.
   The New Formula ID dialog box appears.

3. Type the name for the ID in the Formula ID field.

   **Note:** Formula ID Names cannot contain spaces or special characters, such as dash (-) or slash (/).

4. Select Folder.

5. Type in the Formula ID and Description fields, as required.

6. Select the permission level of the ID, as required.
   Read/Write is the default.

7. Click OK to continue.
   The Formula ID window appears.

8. Build the formula using the formula elements.

   See "Using the Formula ID Window" in this chapter for information on using the formula elements in the Formula ID window.

9. Save the ID.

Editing a Formula ID

To edit a Formula ID, perform the following steps:

1. From the File menu, click Open.
   A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.
Reviewing Formula ID Examples

The Select Formula ID dialog box appears.
3. Type the name of or select the ID and Formula ID that you want to edit.
4. Click OK to continue.
The Formula ID window appears.
5. Make the editorial changes.
6. When you finish the editing, save the ID.

Reviewing Formula ID Examples

The following four examples demonstrate how you can use the Formula ID to achieve various results.

Example 1 Use *If, Then* Logic to Determine Average Daily Balance

The following steps create a Formula ID that calculates the Average Daily Balance for January from the Ledger Stat table.
1. From the File menu, click New.
   A list of the IDs that are available for the product you are using appears.
2. Select the Formula ID.
   The New Formula ID dialog box appears.
3. Select All from the Folder.
4. Type JAN_ADB in the Formula ID field.
5. Type Avg Dly Bal-Jan in the Description field.
6. Click Read/Write.
7. Click OK to continue.
   The Formula ID window appears.
8. Select Ledger Stat from the Tables box.
9. Select Other from the Type box.
10. Double-click If from the Functions box.
11. Select Financial Element ID from the Output Columns box and click Add in the Operand box.
12. Click the = (equal operator) from the Operand box.
13. Type 140 in the Constant box, and then click Insert Constant.
14. Click the , (comma operand) from the Operand box.
15. Select Month_01 from the Output Columns box and click Add in the Operand box.
16. Click the , (comma operand) from the Operand box.
17. Type 0 in the Constant box, and then click Insert Constant.
18. Click the ) (close parenthesis operand) from the Operand box.

**Example 2 Current Net Book Balance**
The following steps create a Formula ID that calculates the current net book balance for Commercial Loans. This ID multiplies the current gross book balance by the percent owned (Gross Book Balance \* Percent Owned):

Note: The Oracle Financial Data Manager (FDM) database carries the percent sold, so the percent owned must be calculated.

1. From the File menu, click New.
   A list of the IDs that are available for the product you are using appears.
2. Select the Formula ID.
   The New Formula ID dialog box appears.
3. Select All from the Folder.
4. Type **CL_NETBKBAL** in the Formula ID field.
5. Type **CL Net Book Bal** in the Description field.
6. Click Read/Write.
7. Click OK to continue.
   The Formula ID window appears.
8. Select Commercial Loan from the Tables box.
9. Select Current Gross Book Balance from the Output Columns box, and then click Add in the Operand box.
10. Click the \* (multiply operator) from the Operand box.
Reviewing Formula ID Examples

11. Click the ( (open parenthesis operand) from the Operand box.
12. Type 100 in the Constant box and then click Insert Constant.
13. Click the – (minus operator) from the Operand box.
14. Select Percent Sold from the Output Columns box, and then click Add in the Operand box.
15. Click the ) (close parenthesis operand) from the Operand box.
16. Click the / (divide operator) from the Operand box.
17. Type 100 in the Constant box, and then click Insert Constant.
18. Click the ) (close parenthesis operand) from the Operand box.

Example 3 Average Current Net Book Balance
The following steps create a Formula ID that calculates the average current net book balance for each row in a Commercial Loan Stratification Report:

1. From the File menu, click New.  
   A list of the IDs that are available for the product you are using appears.
2. Select the Formula ID.  
   The New Formula ID dialog box appears.
3. Select All from the Folder.
4. Type CL_AVGNETBK in the Formula ID field.
5. Type CL Avg Net Bk Bal in the Description field.
6. Click Read/Write.
7. Click OK to continue.  
   The Formula ID window appears.
8. Select Commercial Loan from the Tables box.
9. Select Mathematical from the Type box.
10. Double-click WAvg in the Functions box.
11. Select Current Net Book Balance from the Output Columns box, and then click Add in the Operand box.
12. Click the , (comma operand) from the Operand box.
13. Select Record Count from the Output Columns box, and then click Add in the Operand box.

14. Click the ) (close parenthesis operand) from the Operand box.

**Example 4  Weighted Average Current Net Rate**
The following steps create a Formula ID that calculates the weighted average current net rate for each row in a Commercial Loan Stratification Report.

1. From the File menu, click New.
   A list of the IDs that are available for the product you are using appears.

2. Select the Formula ID.
   The New Formula ID dialog box appears.

3. Select All from the Folder.

4. Type CL_AVGNETRATE in the Formula ID field.

5. Type **CL Avg Cur Net Rate** in the Description field.

6. Click Read/Write.

7. Click OK to continue.
   The Formula ID window appears.

8. Select Commercial Loan from the Tables box.

9. Select Mathematical from the Type box.

10. Double-click WAvg in the Functions box.

11. Select Current Net Rate from the Output Columns box, and then click Add in the Operand box.

12. Click the , (comma operand) from the Operand box.

13. Select Current Net Book Balance from the Output Columns box, and then click Add in the Operand box.

14. Click the ) (close parenthesis operand) from the Operand box.

15. Save and close the ID.
The Group Filter ID enables you to group multiple data filters into a single ID. Using this ID, you can combine complex data groups in a single operation.

This chapter presents the following topics:
- Creating and Defining a Group Filter ID
- Editing a Group Filter ID

### Creating and Defining a Group Filter ID

To create a Group Filter ID, complete the following steps:

1. From the menu bar select File -> New -> Group Filter ID to display the New Group Filter dialog box.
2. From the Group list, select a group.
3. In the Group Filter ID field, type a descriptive title for the ID.
4. (Optional step) In the Description field, type a description that informs the user of the purpose of the ID.
5. In the Permission box, click either the Read/Write or Read Only button.
6. Click OK.

The Group Filter dialog box appears.
7. From the Filter Type list, select Data Filter.

8. From the Filter ID list, select a predefined Filter ID and click Add. The selected Filter ID appears in the Group Filter List box.

9. Repeat step 8 until you have selected all the Filter IDs that this Group Filter ID requires. When you finish, all the selected Filter IDs appear in the Group Filter List box.

10. Save the Group Filter ID.
Editing a Group Filter ID

To edit a Group Filter ID, complete the following steps:

1. From the menu bar, select File -> Open -> Group Filter ID to display the Select Group Filter ID dialog box.

2. From the Group Filter ID list, select the filter you want to edit and click OK. The selected Group Filter ID appears.

3. Edit the Group Filter ID using the Add, Remove, Replace, and Clear buttons. Use these buttons to perform the following functions:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Filter ID from the Filter ID list to the Group Filter List</td>
<td>select the desired Filter ID from the Filter ID list and click Add.</td>
</tr>
<tr>
<td>Remove a Filter ID from the Group Filter List</td>
<td>select the Filter ID you want to remove and click Remove.</td>
</tr>
</tbody>
</table>
| Replace a Filter ID in the Group Filter List with a new Filter ID | 1. Select a new Filter ID from the Filter ID list  
2. Select the Filter ID in the Group Filter List that you want to replace and  
3. Click Update.                                           |
| Clear all Filter IDs from the Group Filter List         | click Clear List.                                                                                                                          |

4. Save your edits.
This chapter explains the function and use of Prepayment IDs within cash flow processing of Transfer Pricing. The following topics are included:

- Creating Prepayment IDs
- Defining Calculation Methods and Other Assumptions
- Editing IDs

With the Prepayment ID function, you specify assumptions about prepayment rates for specific products. Prepayments are paid by either accelerating principal payments or refinancing. Once the assumptions are defined, they are stored in the system by the individual product leaf. The Transfer Pricing module uses the assumptions detailed in the ID to calculate cash flows.

There are three methods to calculating prepayments:

- Constant
- Prepayment Table
- Arctangent

One ID can contain more than one method of calculation for different products. A single product, however, is assigned using only one method within an ID; one leaf, one calculation method.
Create a Prepayment ID

When a new Prepayment ID is created, the Prepayment ID screen appears with six separate sections available for the input of assumptions.

These sections are:

- Calculation Method
- Cash Flow Treatment
- Market Rate Definition
- Associated Term
- Prepayment Rate Definition
- Seasonality

Your ability to enter assumptions within each of the last five section fields vary depending on the chosen calculation method.

For example, when selecting a constant calculation method, the Market Rate Definition options are unavailable for change because a flat prepayment rate is used and the market variances are inconsequential. With the prepayment table method, however, Market Rate Definition options are required fields since they may depend on certain market fluctuations.

To create a new Prepayment ID, complete the following steps:

1. From the File menu, choose New/Prepayment ID. The New Prepayment ID screen appears.
2. Use the drop-down menus to choose the Group and Leaf Type. (Pressing Tab moves the cursor from one field to the next.)
3. Enter a descriptive name for the ID.
4. Enter a description for the ID. This is an optional field.
5. Read/Write is the only available option. The Read Only permission level is currently under development for future releases, and has no current value. Check the Read/Write option.
6. Choose OK.

The Prepayment ID screen appears with the name of the ID shown on the top of the screen and a floating Tree Bar next to it.
Use a constant annual prepayment rate (CPR) format for all prepayment rates entered into a Prepayment ID. Prepayment rates are deannualized when applied to individual transactions during processing. One exception is the 100% Rule. A special case has been devised when the prepayment rate of 100% is entered. When you input a prepayment rate of 100%, this triggers prepayment in full.

Prepayment Calculation Methods

In addition to the three calculation method options to choose from, there is also the default method of <None>. It is also listed on the Calculation Method drop down menu. When a given product leaf is not effected by prepayment assumptions, an active None option notifies the system to bypass processing prepayments for the individual leaf.

Prepayment assumptions within an individual leaf can vary based on origination date ranges.

Constant Calculation Method

This method calculates a flat percentage of the current balance. Constant rate origination date ranges require one input per origination date range, effecting all instruments with origination dates within that range.

Defining the Constant Calculation Method

Once the Prepayment ID is created, the Constant method of calculation is selected and assumptions for specified products are defined.

To define the Constant calculation method, complete the following steps:

1. From the Tree Bar, choose the product leaf you want define prepayment assumptions on.

2. In the Calculation Method section, choose Constant from the drop-down menu.
3. In the Cash Flow Treatment section, choose either Refinance or Curtailment.

**Refinance:** Choose refinance to keep payment amounts after prepayment consistent with a portfolio-based assumption. This reduces the scheduled payment amount on each loan and maintains the same maturity term.

**Curtailment:** Choose curtailment to effect a change in the periodic payment amounts due. The prepayments are treated as accelerated payments, with a payoff earlier than the originally scheduled terms.

**Defining the Market Rate**

With the Constant calculation method, the market rate has no relevance to the calculations and therefore Market Rate Definition is not available for input.

**Defining the Prepayment Rate**

The prepayment rate is defined as a Constant Annual Percentage (CPR), by origination date.

The first cell in the Start Origin Date column and all of the cells in the End Origin Date column are protected. This ensures that all the possible term origination dates are included in cash flow calculation runs. Each row in the End Origination Date column is filled in by the system when a new Start Origination Date is entered into the next row.

Define prepayment rates by completing the following steps.
1. Enter the number of origination date ranges you want to define in the first cell (upper left corner) of the Prepayment Rate Definition table.
   a. Highlight the default number of 1.
   b. Enter your new number or use the up/down arrows to scroll and choose a number. The minimum number to display is 2. The rows on the table increase as defined.

2. In the Percent column, enter the prepayment rate that you want applied to instruments in this range of origination dates.

The first Start Origination Date (in row 1) has a default of 01/01/1900. When you enter a Start Origination Date in the next row, the system inserts a date that is one day prior into the previous End Origination Date field.

For example, in the table shown below, row 4 identifies April 1st as the beginning date range for the assumption. After clicking on the cell in row 3, column End Origination Date, the system registered this date as March 31st; one day prior.

<table>
<thead>
<tr>
<th></th>
<th>Start Origination Date</th>
<th>End Origination Date</th>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01/01/1900</td>
<td>01/31/1977</td>
<td>1.0000</td>
</tr>
<tr>
<td>2</td>
<td>02/01/1977</td>
<td>02/28/1977</td>
<td>0.0000</td>
</tr>
<tr>
<td>3</td>
<td>03/01/1977</td>
<td>03/31/1977</td>
<td>0.0000</td>
</tr>
<tr>
<td>4</td>
<td>04/01/1977</td>
<td>04/30/1977</td>
<td>0.0000</td>
</tr>
<tr>
<td>5</td>
<td>05/01/1977</td>
<td>05/31/1977</td>
<td>0.0000</td>
</tr>
<tr>
<td>6</td>
<td>06/01/1977</td>
<td>12/31/1999</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

3. In the Start Origination Date column in the next row, enter the beginning date for the date range.

4. At any point after entering the second Start Origination Date date, you can click on a previous row in the End Origination Date column and the system fills in the End Origination Date date(s).

For example, if you are making six assumptions and enter all of your beginning dates in the Start Origination Date column, you can then click on any row.
within the End Origination Date column. All of the cells are populated by the system.

5. Repeat steps 2-4 for each of your rate definition assumptions.

6. If you have not already done so, click on any cell in the End Origination Date column to have the system refresh the dates.

7. Save the Prepayment ID.

**Seasonality**

Seasonality adjustments are made when, based on financial histories and experiences, you expect the amount of prepayments made on given instruments to increase in certain months and decrease in other months.

The default seasonality factor is 1.0000. When the seasonality function is active, these defaults are available for any changes, by month. When the function is disabled, the factors are greyed-out and cannot be adjusted. To input seasonality factors, complete the following steps:

1. Check the seasonality box. The default factors of 1.0000 become active.

2. Position the cursor on the factor you are changing.

3. Delete the default factor and enter the new factor, for each month that you want to change. The number cannot exceed 99.9999.

4. After adjusting all required seasonality factors, save the ID.

---

**Note:** Seasonality option acts as a toggle. A check in the Seasonality box indicates that the function is active. If you input new seasonality factors, then deactivate the function, all the factors that you updated are lost when you re-activate Seasonality.

---

**Prepayment Table Calculation Method**

You can create prepayment tables based on either age, term, or rate characteristics. These prepayment tables represent a base set of prepayment assumptions for the calculation process. You can assign a single prepayment table to number of different products for use in cash flow transfer pricing and cash flow forecasting. It also supports consistency in assumptions and minimizes data set-up within the two modules.
Prepayment table assignments can also vary by origination date ranges. You can assign different prepayment rates or prepayment tables for each range of origination date. (See Chapter 13, "Prepayment Table ID").

The prepayment function is structured to model the impact of multiple characteristics on prepayment expectations. Each of these characteristics are user-defined to reflect unique prepayment experiences, and then placed in prepayment tables.

**Defining the Prepayment Table Calculation Method**

Once the Prepayment ID is created, the Prepayment Table method of calculation is selected and assumptions for specified products are defined.

1. From the Tree Bar, choose the product leaf you want to define prepayment assumptions on.
2. In the Calculation Method section, choose Prepayment Table from the drop-down menu.
3. In the Cash Flow Treatment section, choose either Refinance or Curtailment.

**Refinance**: Choose refinance to keep payment amounts after prepayment consistent with a portfolio-based assumption. This reduces the scheduled payment amount on each loan and maintains the same maturity term.

![Prepayment Table Calculation Method](image-url)
Curtailment: Choose curtailment to effect a change in the periodic payment amounts due. The prepayments are treated as accelerated payments, with a payoff earlier than the originally scheduled terms.

Defining the Market Rate
The Market Rate is the forecasted rate representing the forecasted level of interest rates. To define the Market Rate, complete the following:

1. From the Index drop-down menu, choose an interest rate code.
2. Position the cursor on the Spread field, and enter your spread. A spread is the difference between the Customer Rate and the Market Rate.

Defining the Term
In the Associated Term section, you can choose one of the following:
- Remaining Term
- Reprice Frequency
- Original Term

Remaining Term: the number of months until the instrument matures.
Reprice Frequency: the frequency with which the instrument reprices. This defaults to original term on a fixed rate instrument.
Original Term: the number of months that was originally scheduled for the life of the instrument.

Check the box to the left of the term you want to define. This term indicates which point on the yield curve is used as the equivalent market rate.

Defining the Prepayment Table
The prepayment table is arranged by origination date.

The first cell in the Start Origination Date column and all of the cells in the End Origination Date column are protected. This ensures that all the possible origination dates are included in cash flow calculation runs. Each row in the End Origination Date column is filled in by the system when a new Start Origination Date is entered into the next row.

Define origination date ranges by completing the following steps:

1. Enter the number of origination date ranges you want to define in the first cell (upper left corner) of the Prepayment Rate Definition table.
Prepayment Calculation Methods

a. Highlight the default number of 1.

b. Enter your new number or use the up/down arrows to scroll and choose a number. The minimum number to display is 2. The rows on the table increase as defined.

2. The first Start Origination Date (in row 1) has a default of 01/01/1900. When you enter a Start Origination Date in the next row, the system inserts a date that is one day prior into the previous End Origination Date field.

For example, in the table shown below, row 4 identifies April 1st as the beginning date range for the assumption. After clicking on the cell in row 3, column End Origination Date, the system registered this date as March 31st; one day prior.

<table>
<thead>
<tr>
<th>#</th>
<th>Start Origination Date</th>
<th>End Origination Date</th>
<th>Coefficient</th>
<th>Prepayment Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01/01/1900</td>
<td>12/31/1985</td>
<td>1.000</td>
<td>PREPAYTABLE</td>
</tr>
<tr>
<td>2</td>
<td>01/01/1901</td>
<td>12/31/1990</td>
<td>0.800</td>
<td>PREPAYTABLE</td>
</tr>
<tr>
<td>3</td>
<td>01/01/1902</td>
<td>12/31/1991</td>
<td>0.600</td>
<td>PREPAYTABLE</td>
</tr>
<tr>
<td>4</td>
<td>01/01/1903</td>
<td>12/31/1992</td>
<td>0.400</td>
<td>PREPAYTABLE</td>
</tr>
<tr>
<td>5</td>
<td>01/01/1904</td>
<td>12/31/1993</td>
<td>0.200</td>
<td>PREPAYTABLE</td>
</tr>
<tr>
<td>6</td>
<td>01/01/1905</td>
<td>12/31/1994</td>
<td>0.000</td>
<td>PREPAYTABLE</td>
</tr>
</tbody>
</table>

In the Start Origination Date column in the next row, enter the beginning date for the date range.

3. In the Coefficient column, enter the number by which the prepayment rate (shown in the prepayment table) will be multiplied. This multiple is applied only to the origination dates displayed in the Start Origination Date/End Origination Date fields.

Example:
Assume the following Prepayment Table ID.
An instrument originating on 6/30/1992 with a term of 36 months is assigned a prepayment rate of 12.75%. The system determines the base prepayment rate of 15% from the original term Prepayment Table. It then applies only 85% of the rate, based on the origination date range.

4. From the drop-down list in the Prepay Table column, choose a pre-defined Prepayment Table to apply basic prepayment assumptions.

5. At any point after entering the second Start Origination Date date, you can click on a previous row in the End Origination Date column and the system fills in the End Origination Date date(s).
   
   For example, if you are making six assumptions and enter all of your beginning dates in the Start Origination Date column, you can then click on any row within the End Origination Date column. All of the cells are populated by the system.

6. Repeat steps 2-4 for each of your rate definition assumptions.

7. If you have not already done so, click on any cell in the End Origination Date column to have the system refresh the dates.

8. Save the Prepayment ID.

**Seasonality**

Seasonality adjustments are made when, based on financial histories and experiences, you expect the amount of prepayments made on given instruments to increase in certain months and decrease in other months.

The default seasonality factor is 1.0000. When the seasonality function is active, these defaults are available for any changes, by month. When the function is disabled, the factors are greyed-out and cannot be adjusted. To input seasonality factors, complete the following steps:

1. Check the seasonality box. The default factors of 1.0000 become active.
2. Position the cursor on the factor you are changing.
3. Delete the default factor and enter the new factor, for each month that you want to change. The number cannot exceed 99.9999.
4. After adjusting all required seasonality factors, save the ID.

**Arctangent Calculation Method**

The Arctangent Calculation Method uses the Arctangent mathematical function to describe the relationship between prepayment rates and spreads (coupon rate less market rate).

User-defined coefficients adjust this function to generate differently shaped curves. Specifically,

\[ \text{CPR}_t = k_1 - \left( k_2 \cdot \text{ATAN}(k_3 \cdot (-C_t/M_t + k_4)) \right) \]

where \( \text{CPR}_t \) = annual prepayment rate in period \( t \)

\( C_t \) = coupon in period \( t \)

\( M_t \) = market rate in period \( t \)

\( k_1 - k_4 \) = user-defined coefficients

A graphical example of the arctangent prepayment function is shown below, using the following coefficients:

\( k_1 = 0.3 \)
\( k_2 = 0.2 \)
\( k_3 = 10.0 \)
\( k_4 = 1.2 \)
Each coefficient affects the curve in a different manner. $K_1$ defines the mid-point of the prepayment curve, affecting the absolute level of prepayments. Adjusting the value creates a parallel shift of the curve up or down.

$K_2$ impacts the slope of the curve, defining the change in prepayments given a change in market rates. A larger value implies greater overall customer reaction to changes in market rates.
K₃ impacts the amount of torque in the prepayment curve. A larger K₃ increases the amount of acceleration, implying that customers react more sharply when spreads reach the hurdle rate.
K₄ defines the hurdle spread: the spread at which prepayments start to accelerate. When the spread ratio = k₄, prepayments = k₁.

![Impact of k₄](image)

### Defining the Arctangent Calculation Method

Once the Prepayment ID is created, the Arctangent method of calculation is selected and assumptions for specified products are defined. To define the arctangent calculation method, complete the following steps:

1. From the Tree Bar, choose the product leaf you want to define prepayment assumptions on.

2. In the Calculation Method section, choose Arctangent from the drop-down menu.
3. In the Cash Flow Treatment section, choose either Refinance or Curtailment.

**Refinance**: Choose refinance to keep payment amounts after prepayment consistent with a portfolio-based assumption. This reduces the scheduled payment amount on each loan and maintains the same maturity term.

**Curtailment**: Choose curtailment to effect a change in the periodic payment amounts due. The prepayments are treated as accelerated payments, with a payoff earlier than the originally scheduled terms.

**Defining the Market Rate**
The Market Rate is the forecasted rate representing your refinance option. To define the Market Rate, complete the following steps:

1. From the Index drop-down menu, choose an interest rate code option.
2. Position the cursor on the Spread field, and enter your spread. A spread is the difference between the Customer Rate and the Market Rate.

**Defining the Term**
In the Associated Term section, choose one of the following:

- Remaining Term
- Reprice Frequency
- Original Term
The Remaining Term is the number of months until the instrument matures. The Preprice Frequency is the frequency with which the instrument reprices. Finally, the Original Term is the number of months that was originally scheduled for the life of the instrument. Check the box to the left of the term you want to define.

**Defining the Prepayment Rate**

The prepayment rate is defined in percentages, by origination date.

The first cell in the Start Origination Date column and all of the cells in the End Origination Date column are protected. This ensures that all the possible term origination dates are included in cash flow calculation runs. Each row in the End Origination Date column is filled in by the system when a new Start Origination Date is entered into the next row.

Define prepayment rates by completing the following steps:

1. Enter the number of prepayment rate terms you want to define in the first cell (upper left corner) of the Prepayment Rate Definition table.
   a. Highlight the default number of 1
   b. Enter your new number or use the up/down arrows to scroll and choose a number. The minimum number to display is 2. The rows on the table increase as defined.

2. The first Start Origination Date (in row 1) has a default of 01/01/1900. When you enter a Start Origination Date in the next row, the system inserts a date that is one day prior into the previous End Origination Date field.

For example, in the table shown below, row 4 identifies April 1st as the beginning date range for the assumption. After clicking on the cell in row 3, column End Origination Date, the system registered this date as March 31st; one day prior.
Prepayment Calculation Methods

In the Start Origination Date column in the next row, enter the beginning date for the date range.

3. In the K1 through K4 columns, enter the coefficients for the Arctangent Formula, to define the shape of your curve.

4. At any point after entering the second Start Origination Date date, you can click on a previous row in the End Origination Date column and the system will fill-in the End Origination Date date(s).

For example, if you are making six assumptions and enter all of your beginning dates in the Start Origination Date column, you can then click on any row within the End Origination Date column, and all of the cells will be populated by the system.

5. Repeat steps 2-4 for each of your rate definition assumptions.

6. If you have not already done so, click on any cell in the End Origination Date column to have the system refresh the dates.

7. Save the Prepayment ID.

Seasonality

Seasonality adjustments are made when, based on financial histories and experiences, you expect the amount of prepayments made on given instruments to increase in certain months and decrease in other months.

The default seasonality factor is 1.0000. When the seasonality function is active, these defaults are available for any changes, by month. When the function is

<table>
<thead>
<tr>
<th>Prepayment Rate Definition</th>
<th>Start Origination Date</th>
<th>End Origination Date</th>
<th>K1</th>
<th>K2</th>
<th>K3</th>
<th>K4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01/01/1990</td>
<td>01/01/1997</td>
<td>0.3000</td>
<td>0.2000</td>
<td>10.6000</td>
<td>1.2000</td>
</tr>
<tr>
<td>2</td>
<td>02/01/1997</td>
<td>02/28/1997</td>
<td>0.3000</td>
<td>0.2500</td>
<td>9.6000</td>
<td>1.4000</td>
</tr>
<tr>
<td>3</td>
<td>03/01/1997</td>
<td>03/31/1997</td>
<td>0.3000</td>
<td>0.2200</td>
<td>9.9000</td>
<td>1.3000</td>
</tr>
<tr>
<td>4</td>
<td>04/01/1997</td>
<td>04/30/1997</td>
<td>0.3000</td>
<td>0.2000</td>
<td>9.8000</td>
<td>1.3000</td>
</tr>
<tr>
<td>5</td>
<td>05/01/1997</td>
<td>05/31/1997</td>
<td>0.3400</td>
<td>0.2300</td>
<td>9.9000</td>
<td>1.3000</td>
</tr>
<tr>
<td>6</td>
<td>06/01/1997</td>
<td>12/31/2017</td>
<td>0.3500</td>
<td>0.2400</td>
<td>10.0000</td>
<td>1.3500</td>
</tr>
</tbody>
</table>
disabled, the factors are greyed-out and cannot be adjusted. To input seasonality factors, complete the following steps:

1. Check the seasonality box. The default factors of 1.0000 become active.
2. Position the cursor on the factor you are changing. Delete the default factor and enter the new factor, for each month that you want to change. The number cannot exceed 99.9999.
3. After adjusting all required seasonality factors, save the ID.

**Edit a Prepayment ID**

To edit a Prepayment ID, complete the following steps.

1. Click on Open/Prepayment ID. The Select Prepayment ID dialog appears.

![Select Prepayment ID dialog](image)

2. Use the drop-down menus to choose the ID you want to edit and select Ok.
3. With the ID open, make your changes, as previously described.
4. Rename the ID using the Save As function in the File menu options.
Prepayment Tables are one of three methods for defining prepayment assumptions in a Prepayment ID. By accessing a Prepayment Table during the generation of prepayments, more complex prepayment structures are applied. This provides you with flexibility and control when forecasting cash flows.

Prepayment Tables hold dimensions (instrument and environment characteristics) that are accessed and calculated when a Prepayment ID is included in a processing run. There are nine available dimensions. One table can contain up to three dimensions.

Additionally, a single Prepayment Table can be shared across multiple products and multiple Prepayment IDs. This eliminates redundant data input and maintenance of assumptions.

Creating a New Prepayment ID Table

To create a new Prepayment ID Table, complete the following steps:

1. From the File menu, choose New/Prepayment ID Table. The New Prepayment ID Table screen appears.
2. Use the drop-down menu to choose the Group. Pressing Tab moves the cursor from one field to the next.
3. Enter a descriptive name for the ID in the Prepayment Table ID field.
4. Enter a description for the ID. This is an optional field.

5. Check the Read/Write option. Read/Write is the only available option. The Read Only permission level is currently under development for future releases, and has no current value.

6. Choose OK.

The shell of the table is now created. To complete the table for use in the calculation process, dimensions must first be defined and prepayment assumptions entered.

**Prepayment Table Structure and Drivers**

Prior to inputting your prepayment rate values, you must define the structure of the table.

**Table Structure**

The structure consists of the following:

- One to three dimensions
- The interpolation/range method(s)
- The dimension nodes

A dimension is a driver that influences prepayment behavior based on either an instrument characteristic or a measure of interest rates.

The interpolation method is that by which prepayment rates are determined. Interpolation requires the calculation of an exact value on an axis. When interpolation is not selected, the model assumes a range of values for calculation purposes.

The dimension node comprises individual values along any single dimension.

The table dimensions are designed to drive the calculation of prepayment runoff. The dimension types can be divided into two categories of drivers: Age/Term drivers and Interest Rate.

**Age/Term Drivers**

Age/Term drivers define term and repricing parameters in the table. All of the drivers are input in units of months. These drivers include:

- Original Term
Defining the Dimensions

Interest Rate Drivers
Interest rate drivers allow the forecasted interest rates to drive prepayment behavior to establish rate-sensitive prepay runoff. Interest Rate drivers include:

- Coupon Rate
- Market Rate
- Rate Difference
- Rate Ratio

Defining the Dimensions
To define dimensions in the table, complete the following steps:

1. From the Prepayment Table ID screen, choose Add. When defining the first dimension, you must define it as the row dimension, in the Dimension Along Rows section. The Dimension Definition dialog box appears.

2. Use the drop-down menu to select the dimension type. There are nine available dimensions/drivers:

- **Original Term**: The contractual term of the instrument.
- **Reprice Frequency**: The frequency (in months) at which the instrument will reprice.
- **Remaining Term**: The number of months until the instrument matures.
- **Expired Term**: The number of months since the instrument was originated. This term is also known as Age.
- **Term to Reprice**: The number of months until the next repricing of the instrument.
- **Coupon Rate**: The current gross rate on the instrument.
- **Market Rate**: The forecasted rate representing alternate funding.
Defining the Dimensions

- **Rate Difference**: The spread between the current gross rate and the market rate.
- **Rate Ratio**: The ratio of current gross rate to market rate.

Once a dimension type is chosen, an empty box appears in the area directly below the interpolation option. This is where the dimension nodes are defined.

3. Check the Interpolate box to have the prepayment rate interpolated for each value that falls between the node points.

Leave the box blank to have the rate applied to the range of values. In this instance, the prepayment rate "steps up". The interpolation box acts as a toggle: Check it once to turn it on, and again to turn it off.

**Example**: In the table shown, the interpolated prepayment rate of an instrument that has an age of 30 months is 12.5%. This is exactly half-way between the 10% and 15% rate.

<table>
<thead>
<tr>
<th>Age</th>
<th>Prepayment Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>5</td>
</tr>
<tr>
<td>24</td>
<td>10</td>
</tr>
<tr>
<td>36</td>
<td>15</td>
</tr>
<tr>
<td>60</td>
<td>20</td>
</tr>
</tbody>
</table>

If it is not interpolated, the prepayment rate is 10%, as this rate percentage would apply to the range from 24 months to 35.9999.
4. Position the cursor in the dimension variable box located directly below the interpolation option.

5. Enter a dimension node value. This value is a term or rate (depending on the Age/Term or Rate driver chosen).

6. Choose Add to add another term/rate. An additional dimension variable box appears.

7. Position the cursor in the new variable cell and add the new variable. The cursor is positioned in the cell when the grid lines of the cell appear in bold.

8. Continue adding values and variable boxes until the dimension structure is complete.

9. Choose OK.

   The Dimension Definition dialog box is removed from the screen and two columns appear on the Prepayment Table ID screen. The first column contains the terms/rates just entered. The second column contains the default value of 1.0000. This is where the prepayment rates are input.
The first dimension variables appear as rows on the table.

Adding a Second Dimension to the Table

If you are using second and third dimensions in your prepayment table, they must be added to the table structure and defined prior to inputting prepayment rates. Adding the dimensions after identifying prepayment rate percentages clears the percentage columns, requiring duplicated efforts to re-enter the numbers.

To add a second dimension to the prepayment table structure, complete the following steps.

1. From the Prepayment Table ID screen, choose Add, which is located next to the word "Column". The Dimension Definition dialog box appears.

2. A warning stating that all existing prepayment rates will erase once a new dimension is added. Choose Yes to add the next dimension.

3. Choose a dimension type and interpolation method. (See steps 2-3 in the "Defining the Dimensions" section of this chapter.)

4. Position the cursor in the dimension variable box located directly below the interpolation option.
5. Enter your term or rate (depending on the dimension type chosen). The cell frame is highlighted, indicating where to enter the term/rate variable.

6. Choose Add to add another term/rate. An additional dimension variable box appears.

7. Continue adding terms/rates and variable boxes until the dimension structure is complete.

8. Choose OK.

The second dimension variables appear as columns on the table.

Adding a Third Dimension to the Table

To add a third dimension to the prepayment table structure, complete the following steps:

1. From the Prepayment Table ID screen, choose Add, which is located next to the word "Page". This option is located under the Dimension For Pages heading. The Dimension Definition dialog box appears.
2. A warning stating that all existing prepayment rates will erase once a new dimension is add. Choose Yes to add the next dimension.

3. Choose a dimension type and interpolation method. (See steps 2-3 in the 'Defining the Dimensions' section of this chapter.)

4. Position the cursor in the dimension variable box located directly below the interpolation option.

5. Enter your term or rate (depending on the dimension type chosen). The cell frame is highlighted, indicating that you can enter the term/rate variable.

6. Choose Add to add another term/rate. An additional dimension variable box appears.

7. Continue adding terms/rates and variable boxes until the dimension structure is complete.

8. Choose OK.
Deleting Dimensions

The third dimension variables appear in a drop-down list, representing individual pages.

![Prepayment Table ID](image)

**Editing Dimensions**

You can edit a dimension either before or after prepayment rates are entered. The prepayment rates are not erased when you edit the dimension variables. To edit a dimension type, interpolation method or variable, complete the following steps:

1. Choose the dimension to be edited from the Dimension Along Rows, Along Columns, or For Pages columns. The Dimension Definition dialog box appears.

2. Position the cursor in the section to be edited and make the change. (See the section in this chapter titled "Defining the Dimensions" for more information on dimension types, interpolation methods and dimension variables.)

**Deleting Dimensions**

You can delete dimension variables at any time. All prepayment rates associated with that dimension variable are deleted at the same time. To delete dimension variables, complete the following steps:

1. Activate the Edit Dimension for its respective dimension column.
The variables that appear on the X axis is the Row dimension column. Those on the Y axis is the Columns dimension. The variables shown to the right of the table, is the Page dimension. The Dimension Definition dialog box appears.

2. Position the cursor in the cell to be edited and check the Delete button.

(See the section in this chapter titled "Defining the Dimensions" for more information on dimension types, interpolation methods and dimension variables.

3. Complete steps 1-2 until all desired changes are made.

4. To delete an entire dimension, set the dimension to None. To delete a row dimension, first delete the Page and then Column dimensions. To delete a Column dimension, first delete the Page dimension.

Adding Prepayment Rates to the Table

Once the structure of the table is defined, the prepayment rates are added. Default prepayment rates are 1.0000. To change the prepayment rates default, complete the following steps:

1. Position the cursor in the prepayment rate cell your are changing. Highlighted cells indicate an active prepayment cell. Only prepayment rates can be changed in this section. All dimension variables are fixed unless changed in the Edit Definition function.

2. Enter your prepayment value. Use the tab key to move the cursor from one cell to the next.

3. Continue to update the prepayment rates from the default of 1.0000 until all desired changes are made.
The purpose of the Rate Index ID is to establish a relationship between your risk-free interest rate codes (IRCs) and each of the other interest rate codes or indices. With this relationship established, you can forecast rates on any instrument tied to an IRC and as the risk-free rates change, the change in non risk-free interest rates will follow accordingly.

Examples of non risk-free interest rate codes include:

- Prime
- Libor
- Administered rates
- 11th District COFI

The Rate Index ID is used only in stochastic processing. For information on Monte Carlo calculations and risk-free rate calculations see the Oracle Financial Services Technical Reference Manual.

Create a Rate Index ID

To create a new Rate Index ID, complete the following steps:

1. From the File menu, select New -> Rate Index ID.
2. Select a folder.
3. Enter a descriptive name for the ID.
4. Enter a description for the ID. This is an optional field.
5. Click Read/Write.
6. Click OK.
Defining a Rate Index ID

The Rate Index ID screen appears with the name of the ID shown on the top of the screen.

![Rate Index ID Screen](image)

**Defining a Rate Index ID**

A formula must be defined for each index tied to an instrument. That formula takes the following form:

$$\text{Index Rate}_{\text{term}_m} = K_1 \text{ Risk Free Rate}_1^{x_1} + K_2 \text{ Risk Free Rate}_2^{x_2} + \ldots + K_8 \text{ Risk Free Rate}_8^{x_8} + \text{Spread}$$

To create your formula, you can select up to eight terms (elements) from the Risk Free curve, each multiplied by a user-defined coefficient and raised to the power of a user-defined exponent. Additionally, you can add a constant spread to the formula. It is not necessary to define any assumptions for the risk free curve. Any definition for this curve is ignored and does not affect processing.

Each of the elements you define consist of:

- A coefficient - A multiplier to weight each term selection.
- An exponent - An exponent to allow for polynomial curve-fitting.
- A term selection - A selection of rates associated with a term from the risk-free curve.

These elements define different rate forecast generated for each instrument, with a given IRC.

To define a Rate Index ID, complete the following steps:
1. Select an interest rate code. If the IRC chosen has term options available, the Index Term field is activated. If there are no terms associated with the IRC, the field is static.

2. If applicable, select an Index Term.

3. If you want to add a spread to the results of the term elements:
   a. Click the check mark in the box next to the word Spread.
   b. Enter a spread for the element. A spread is a firm and constant percentage added to the variable rate produced on the Monte Carlo calculations.

   You can apply one Spread percentage for each element.

4. Type the number of elements to apply to the IRC. As you increase the number of elements, the rows in the table appears as shown in the following example.

5. In the Elements table, type a Term for the first element.

6. Select a Term Multiplier. Term multipliers include days, months and years.

7. Type a coefficient.

8. Type an exponent.

9. Complete steps 5 through 8 for the remaining elements.

10. From the File menu, select Save.
Example: A Defined IRC

In this example, the IRC is defined as follows:

1. The IRC (Index) chosen is Prime Index.
2. Three Elements have been added to the current As-of-Date.
3. An additional Spread percentage of 2.5% is added to the derived rate.
4. The forecasted rate calculations are multiplied, respective of the three elements and displays as:
   \[ \text{Prime} = 0.25 \times (1 \text{ month rate}) + 0.50 \times (6 \text{ month rate}) + 0.25 \times (12 \text{ month rate}) + 2.5\% \]
5. From the File menu, select Save.
SQL Talk enables end users to view and write to the Oracle Financial Data Manager (FDM) database using Structured Query Language (SQL) statements and procedures.

This chapter presents the following topics:

- SQL Talk Privileges
- Using SQL Talk
- Limitations to the Spreadsheet Display and Processing Time

**Caution:** SQL Talk provides an easy-to-use SQL input dialog. If you are not an expert in SQL or not familiar with your database structure it is important to remember the following:

- SQL Talk is a direct link to the database and writes changes without prior confirmation. Misuse can severely damage your database.
- SQL statements and procedures must be compatible with the FDM database.

### SQL Talk Privileges

The database privileges assigned to a user also govern SQL Talk privileges, with the additional restriction that, by default, all users are restricted to select-only statements. The database owner must make changes in security levels to give a user the ability to write back to the database. See the *Oracle Financial Data Manager Administration Guide* for more information.
Using SQL Talk

To open the SQL Talk window, complete the following steps:

1. From the menu bar, select Process -> SQL Talk to display the SQL Talk window.
2. Type your SQL script in the top pane of the window, ending your statement with the standard SQL semi-colon.
3. Press Ctrl-Enter to run the SQL script.

During processing a “Fetching...” dialog appears.

If you want to interrupt the process click Cancel. The lower pane of the window displays data up to the point of interruption.

The completed process returns data in spreadsheet format to the bottom pane of the SQL Talk window.


Using Multiple SQL Talks Simultaneously

You can have more than one SQL Talk open at a time, however, too many open SQL Talk dialogs can overtax your system’s resources, resulting in a General Protection Fault error. The point at which an individual system fails depends on the client configuration, system environment, and resources required to process the SQL statements.
Creating Stored Procedures
To create stored procedures for processing against your database, use the SQL ID in Balance and Control. Refer to the SQL ID chapter in Oracle Financial Data Manager-Balance and Control Reference Guide for information on using this ID.

Limitations to the Spreadsheet Display and Processing Time
The following limitations apply to SQL Talk.

Maximum Number of Rows and Columns Displayed
These limitations apply to the spreadsheet display.

Maximum Number of Rows
The maximum number of rows that you can select through SQL Talk is 16,000. If you issue a select statement that reaches or exceeds this number the following error message appears: “Only 16,000 rows can be displayed...aborting.” Only the first 16,000 rows of your select statement appear in the spreadsheet display.

Maximum Number of Columns
SQL Talk displays a maximum of 252 columns. If you issue a select statement that returns more than that number of columns, only the first 252 columns appear.

Optimizing Processing Time
Since the query you process against the database is stored in RAM, the speed at which rows are returned depends on the number of columns you select. The greater the number of columns, the longer it takes to return data. Therefore, make sure you select only the columns you want to see.
A transfer pricing ID defines the transfer pricing method for each product leaf in your portfolio. Once all product leaves have an assigned methodology, select your transfer pricing ID in a transfer pricing processing ID, which allows you to launch the calculations that transfer price your balance sheet.

Assumptions should be reviewed periodically to ensure validity before processing of each new period. Adding new leaves to the database requires updating and reprocessing the ID.

The transfer pricing ID also contains dialogs for specifying certain parameters used in calculating option costs for each product leaf.

**Defining a Transfer Pricing ID**

To define a transfer pricing ID, click the New icon on the horizontal toolbar, then click the Transfer Pricing ID icon on the vertical toolbar. Alternatively, from the File menu, choose New, and select Transfer Pricing, Proceed as described in Chapter 5, "Overview of IDs". The Transfer Pricing ID dialog appears with the Floating Tree Bar.

On the Floating Tree Bar, select the account (or product) for which you would like to define a transfer pricing method. After you have selected an account you can close the Floating Tree Bar.

---

**Note:** The tree bar used here is a generic sample of products and codes used for testing and documentation purposes. The products and codes in your tree bar are unique to your institution.
Method Types

The first step is to choose a data source to use in transfer pricing the account (or product). Click the radio button for Instrument Tables or Ledger Stat.

If Instrument Tables is selected, the checkbox for Model With Gross Rates will be enabled. Modeling with gross rates applies only to Cash Flow Methods of transfer pricing (see below for a description of these). At run time, gross rate is substituted for net rate in the cash flow calculations.

The next step is to choose a transfer pricing method for the selected account. Click in the Method Type box to drop down the list of methods. If you have selected Instrument Tables as your data source, you will see this drop down list of transfer pricing methods:

<table>
<thead>
<tr>
<th>Method Code</th>
<th>Method Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No Product</td>
</tr>
<tr>
<td>100</td>
<td>Local peer common</td>
</tr>
<tr>
<td>101</td>
<td>Commercial Loan Fix</td>
</tr>
<tr>
<td>102</td>
<td>Commercial Loan Via</td>
</tr>
<tr>
<td>105</td>
<td>Tax Exempt</td>
</tr>
<tr>
<td>110</td>
<td>Commercial Loan Prov</td>
</tr>
<tr>
<td>111</td>
<td>Treasury Notes/Bond</td>
</tr>
<tr>
<td>121</td>
<td>MBS - Agency</td>
</tr>
<tr>
<td>122</td>
<td>abs - gms</td>
</tr>
<tr>
<td>130</td>
<td>Institutional Loan SI</td>
</tr>
<tr>
<td>141</td>
<td>Institutional Loan Ind</td>
</tr>
<tr>
<td>150</td>
<td>Home Equity Loan</td>
</tr>
<tr>
<td>151</td>
<td>Auto Loan</td>
</tr>
<tr>
<td>153</td>
<td>Consumer Loan Prime</td>
</tr>
</tbody>
</table>

- Cash Flow: Weighted Term
- Cash Flow: Duration
- Cash Flow: Zero Discount Factors
- Moving Averages
- Straight Term
- Spread from Interest Rate Code
- Spread from Note Rate
- Redemption Curve
Defining a Transfer Pricing ID

If you have selected Ledger Stat as your data source, you will see this drop down list of transfer pricing methods:

<table>
<thead>
<tr>
<th>Transfer Pricing Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;None&gt;</td>
</tr>
<tr>
<td>&lt;None&gt;</td>
</tr>
<tr>
<td>Moving Averages</td>
</tr>
<tr>
<td>Spread from Interest Rate Code</td>
</tr>
<tr>
<td>Unpriced Account</td>
</tr>
<tr>
<td>Redemption Curve</td>
</tr>
</tbody>
</table>

When you select a method, the relevant option boxes in the dialog become active. Following is description of each transfer pricing method, and its relevant options:

**Cash Flow Pricing**

Three methods are presented:

- Cash Flow Weighted Term
- Cash Flow Duration
- Cash Flow Zero Discount Factors

**Note:** For more complete information, see Chapter 3, "Transfer Pricing Methods".

**Cash Flow Weighted Term** Transfer Pricing generated cash flow is assigned a transfer rate, and the weighted average transfer rate, weighted by discounted cash flows, is assigned to the transaction record.

From the drop-down list, select the Transfer Pricing Interest Rate Code to be used for transfer pricing the account.

**Cash Flow Duration** Transfer Pricing generates all cash flows in computing a duration which is then used to determine the transfer rate.
From the drop-down list, select the Transfer Pricing Interest Rate Code to be used for transfer pricing the account.

**Cash Flow Zero Discount Factors** Transfer Pricing takes into account common market practices in valuing fixed rate amortizing instruments.

From the drop-down list, select the Transfer Pricing Interest Rate Code to be used for transfer pricing the account.

---

**Note:** The above three methods apply only to accounts that use Instrument Tables as the data source. Prepayment IDs are only used with these three methods. The Prepayment ID is chosen when defining a Transfer Pricing Processing ID. Also, a Calculation Mode (Standard or Remaining Term) can be selected in the Processing ID.

For more information on the Prepayment ID, see Chapter 12, "Prepayment ID". For more information on Cash Flow Calculations, see Chapter 3, "Transfer Pricing Methods".

---

**Moving Averages**

A user definable moving average of any point on the transfer pricing yield curve can be applied to the transaction record - such as, 12 month moving average of the 12 month rate. The following options become available with this method:

**Transfer Pricing Interest Rate Code** Select the Transfer Pricing Interest Rate Code to be used as the yield curve for transfer pricing the account.

**Yield Curve Term** The Yield Curve Term defines the point on the Transfer Pricing Interest Rate Code yield curve that will be used.

Select Days, Months, or Years from the drop-down list, and use the spinner arrows to set the number. If the Transfer Pricing Interest Rate Code is a single rate, the Yield Curve Term is irrelevant.

**Historical Term** The Historical Term defines the period over which the average is taken.
Select Days, Months, or Years from the drop-down list, and use the spinner arrows to set the number.

<table>
<thead>
<tr>
<th>Example</th>
<th>Yield Curve Term</th>
<th>Historical Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 Month Moving Average of 1 Year Rate</td>
<td>1 Year (or 12 months)</td>
<td>6 Months</td>
</tr>
<tr>
<td>3 Month Moving Average of the 6 Month Rate</td>
<td>6 Months</td>
<td>3 Months</td>
</tr>
</tbody>
</table>

The range of dates is based on the as of date minus the historical term plus one day, because the historical term includes the as of date. Oracle Transfer Pricing takes the values of the yield curve points that fall within that range and does a straight average on them.

For example, the as of date is May 31. The Yield Curve Term selected is Daily, and the historical term selected is “3 Days”. You want a 3-day moving average. The calculation “as of date minus historical term” results in an actual date four calendar days before the as of date, for example, May 28. However, since our calculation must include the as of date, the three-day moving average is calculated for May 29, 30, and 31. The same logic applies to monthly or annual yield terms.

**Note:** The Moving Averages method applies to either data source: Ledger Stat data or Instrument Table data.

---

**Straight Term**

Stated simply, when the Mid-Period Repricing option has not been selected, the transfer rate for the transaction record is derived from the last repricing date and next repricing date, such as, origination date / maturity date for fixed rate products, last repricing date/next repricing date for adjustables.

In detail, when Mid-Period Repricing has not been selected, Straight Term actually derives the transfer rate as follows:

1. **Standard Calculation Mode**
   
   a. Fixed Rate Products (i.e. Repricing Freq. = 0), use Yield Curve Date = Origination Date, Yield Curve Term = Maturity Date-Origination Date
Defining a Transfer Pricing ID

b. Adjustables (for example, Repricing Freq. > 0)
   * For loans still in tease period (tease end date > as of date, and tease end date > origination date), use Origination Date and Tease End Date - Origination Date
   * For loans not in tease period, use Last Repricing Date and Repricing Freq.

2. Remaining Term Calculation Mode
   a. Fixed Rate, use As of Date and Maturity - As of Date
   b. Adjustable, use As of Date and Next Repricing Date - As of Date

The following options become available with this method:

Transfer Pricing Interest Rate Code Select the Transfer Pricing Interest Rate Code to be used for Transfer Pricing the account.

Mid-Period Repricing Option Click the check box beside this option to invoke the Mid-Period Repricing option.

For further discussion of Mid-Period Repricing, see “More on Mid-Period Repricing” on page 11.

Note: The Straight Term method applies only to accounts that use Instrument Tables as the data source. Also, a Calculation Mode can be selected in the Transfer Pricing Processing ID.

Spread From Interest Rate Code
The transfer rate is determined as a fixed spread from any point on a Transfer Pricing Interest Rate Code yield curve. The following options become available with this method:
Transfer Pricing Interest Rate Code  Select the Transfer Pricing Interest Rate Code to be used for transfer pricing the account.

Yield Curve Term  The Yield Curve Term defines the point on the Transfer Pricing Interest Rate Code yield curve that will be used. If the Transfer Pricing Interest Rate Code is a single rate, the Yield Curve Term is irrelevant. Select Days, Months, or Years from the drop-down list, and use the spinner arrows to set the number.

Lag Term  In order to use a yield curve from an earlier date than the Assignment Date, the Lag Term allows you to specify a length of time prior to the Assignment Date.

Rate Spread  The transfer rate is a fixed spread from the rate on the transfer rate yield curve. The Rate Spread box allows you to specify this spread.

Assignment Date  The Assignment Date allows you to choose the yield curve in effect on the As of Date, Last Repricing Date or Origination Date.

Mid-Period Repricing Option  Click the check box beside this option to invoke the Mid-Period Repricing option.

For further discussion of Mid-Period Repricing, see “More on Mid-Period Repricing” on page 11 of this chapter.

Note:  The Spread From Interest Rate Code method applies to either data source: Ledger Stat data or Instrument Table data.
**Spread From Note Rate**

The transfer rate is a fixed spread from the coupon rate on the transaction record. The following options become available with this method:

**Rate Spread** You are required to define the Rate Spread.

Double-click in the box to locate the cursor, and enter the value. Make sure to define the Rate Spread as follows:

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Matched Spread</th>
<th>Sign of Rate Spread</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset</td>
<td>Positive (Profitable)</td>
<td>Negative</td>
</tr>
<tr>
<td>Asset</td>
<td>Negative (Unprofitable)</td>
<td>Positive</td>
</tr>
<tr>
<td>Liability or Equity</td>
<td>Positive (Profitable)</td>
<td>Positive</td>
</tr>
<tr>
<td>Liability or Equity</td>
<td>Negative (Unprofitable)</td>
<td>Negative</td>
</tr>
</tbody>
</table>

**Mid-Period Repricing Option** Click the check box beside this option to invoke the Mid-Period Repricing option.

For further discussion of Mid-Period Repricing, see “More on Mid-Period Repricing” on page 11 of this chapter.

---

**Note:** The Spread From Note Rate method applies only to accounts that use Instrument Tables as their data source.

---

**Unpriced Account**

The transfer rate for the account is defined as the weighted average (by General Ledger Average Balance) of the transfer rates of a list of defined accounts.

To define the accounts that are used for transfer pricing the Unpriced Account, click the Edit button to the right of the Selected Leaves selection list. The Unpriced Account Setup dialog appears:
In the Unpriced Account Setup dialog, click the leaves that you would like to use to transfer price the Unpriced Account, and then click the Add button. Those leaves that you have selected appear in the Selections box.

To remove a selected leaf, select it and click the Remove button. To exit without changing the leaf selections, click Cancel. When you are through defining the accounts to be used for transfer pricing, click OK. You return to the main ID dialog. The selected leaves now appear in the Selected Leaves box.

**Caution:** You should not base an unpriced account on another unpriced account, since the processing hierarchy does not properly allow for it.

**Across All Organizational Unit** Click the check box beside this option to take the weighted average transfer price across all Org Unit IDs for the matching product leaf number. When this switch is off, the transfer price is calculated from accounts only within that Org Unit ID.

**Note:** The Unpriced Account method applies only to accounts that use Ledger Stat as their data source.
Defining a Transfer Pricing ID

Redemption Curve
The transfer rate is determined by allocating the assumed runoff over as many points on the transfer pricing yield curve as desired. The following options become available with this method:

Transfer Pricing Interest Rate Code Select the Transfer Pricing Interest Rate Code to be used for Transfer Pricing the account.

Assignment Date The Assignment Date allows you to choose the yield curve in effect on the As of Date, Last Repricing Date or Origination Date.

Percentages/Term Points To define the points along the yield curve and the associated percentages, click the Edit button to the right of the Percentages/Term Points selection list. The Redemption Curve Setup dialog appears.

In the Transfer Pricing Yield Curve window, select a Transfer Pricing Yield Curve Point to be used in the percent distribution. Enter the percent you wish to assign to this point in the Current% box. Now click Add to move the point, and its associated percentage, into the Percentages/Selections box. Only one Yield Curve Point can be selected at a time.

To edit the associated percentage of any Yield Curve Point in the Percentages/Term Points box, first select the desired Yield Curve Point. Then change the Current% value. Finally, click the Edit button to update the associated percentage.

If the Current Defaults to 100% option is selected, the Current% always defaults to the amount necessary to total 100% on the next selection. The total allocated percentage is displayed in the Total% box.

To remove a Yield Curve Point from the Percentages/Term Points box, select the desired Yield Curve Point and click Remove.

To save the definition, click OK. The Total% must equal 100% or you will see an error message. You are returned to the main ID dialog. The Percentage Selections appear in the Percentages/Term Points box.

To exit without changing the Redemption Curve Setup, click Cancel.

Mid-Period Repricing Option Click the check box beside this option to invoke the Mid-Period Repricing option.

For further discussion of Mid-Period Repricing, see “More on Mid-Period Repricing” on page 11 of this chapter.
Note: The Redemption Curve method applies to either data source: Ledger Stat data or Instrument Table data.

More on Mid-Period Repricing

This option applies to Adjustable rate instruments only (for example, reprice_freq < 0) when the Calculation Mode is not Remaining Term (for example, the Remaining Term Calculation Mode is not selected in the Transfer Pricing Processing ID). For the Spread from Interest Rate Code and Redemption Curve methods, the Assignment Date must be set to Last Repricing Date in order to choose Mid-Period Repricing. For those two methods, when you select Mid-Period Repricing, Oracle Transfer Pricing changes the Assignment Date to Last Repricing Date if any other Assignment Date type has been selected.

If Mid-Period Repricing is not in effect, Transfer Pricing computes the transfer rate for an adjustable rate instrument based upon the last repricing date. The assumption driving this method of calculation is that the input transfer rate for the month should be the daily average transfer rate for that entire month. Consequently, all instruments repricing in that month would derive their transfer rates from the same (average) transfer pricing yield curve. In periods when the interest rate level has moved substantially since the last repricing, however, this will misstate the transfer rate.

Take the example of a 1-year adjustable rate loan. Suppose it reprices on the 15th of the month, and that transfer rates have moved up 200 basis points since the prior year. In such a case, the theoretically pure transfer rate for the first half of the month should be 200 basis points lower than the transfer rate for the second half of the month. In order to apply such theoretical accuracy to your transfer pricing results, you should select the Mid-Period Repricing option.

The Mid-Period Repricing option uses 2 columns in the instrument tables that are only used when the option is selected (Current- and Prior-Repricing-Period Average Daily Balance: CUR_TP_PER_ADB, PRIOR_TP_PER_ADB). These columns must be accurately populated for the Mid-Period Repricing answers to be accurate.

With the Mid-Period Repricing option selected, Oracle Transfer Pricing takes the following processing steps:

1. Compute Transfer Rate for current repricing period.
2. If the computed last repricing date > beginning of processing month, roll back to prior repricing date.
Specifying Option Cost Calculation Methods

3. Compute Prior Period Transfer Rate.
4. Repeat steps 2 - 3 as necessary.
5. Compute the Final Transfer Rate by weighting the results (from current and previous repricing periods) by average balances and days.
6. Apply the Final Transfer Rate to the instrument record.

For more calculation details, See Chapter 3, "Transfer Pricing Methods".

Specifying Option Cost Calculation Methods

To specify the Option Cost Calculation Method for a particular product leaf, select the Leaf in the Floating Tree Bar. Select Instrument Tables as your data source. The Option Cost Method box will become active. Click in the box to drop down the list of methods. At this time, there is only one method available, Monte Carlo. Select Monte Carlo.

The Target Balance box will now become active. Click in the box to drop down the list of Target Balance choices: Par Balance, Book Balance or Market Price.

<table>
<thead>
<tr>
<th>Target Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Par Balance</td>
</tr>
<tr>
<td>Book Balance</td>
</tr>
<tr>
<td>Market Price</td>
</tr>
</tbody>
</table>

Select one. This is the balance that Oracle Transfer Pricing will use as it iterates through successive stochastic rates paths in arriving at an Option Adjusted Spread that will equate the present value of future cash flows to the Target Balance. For a detailed description of this methodology see the chapter on Option Cost Calculations in the Oracle Transfer Pricing Technical Reference Manual.

Edit a Transfer Pricing ID

To edit a Transfer Pricing ID, click the Open icon on the horizontal toolbar, then click the Transfer Pricing ID icon on the vertical toolbar. Alternatively, from the File menu, choose Open, and select Transfer Pricing ID. The Select Transfer Pricing ID dialog appears. Select the ID you want to edit. With the ID open, make your changes following the principles described earlier in Define a Transfer Pricing ID.
Be sure to save your ID after you make your edits. Click the Save icon on the horizontal toolbar. You can use the Save As option in the File menu to save your edited ID under a new name.

Transfer Pricing ID Examples

In the Other Investments Leaf, a Transfer Rate is assigned using the 6 month Moving Average of the 1 Year rate from the Treasury Index Yield Curve. Recall that the Moving Average method of Transfer Pricing may be applied to an account that uses either Instrument Tables or Ledger Stat as the data source.

The Capital Surplus Leaf is assigned a Transfer Rate using the Unpriced Account method. It will be assigned the weighted average Transfer Rate of the Common Stock, Retained Earnings, and Equity in Subs Profit Leaves. The completed Unpriced Account Setup dialog box for this Leaf is displayed:
The Mortgage Fixed Leaf is assigned a Transfer Rate using the Cash Flow Weighted Term method. It will be transfer priced using the Treasury Index Interest Rate Code as the Transfer Pricing Yield Curve and modeled with Gross Rates. In addition, if Option Cost Calculation is selected in the Transfer Pricing Processing ID, its Option Adjusted Spread will be calculated using the Monte Carlo Method with Par Balance as its Target Balance:
A Transfer Pricing Processing ID is used to launch a transfer pricing process. It incorporates a Processing Filter ID, which defines which data the processing request operates against, and also the combinations of assumptions that go into the processing request.

**Defining a Transfer Pricing Processing ID**

To define a Processing ID click the New icon on the horizontal toolbar, then click the Processing ID icon on the vertical toolbar. Alternatively, from the File menu choose New, and select Process ID. Proceed as described in Chapter 5, "Overview of IDs". The Transfer Pricing Processing ID dialog appears.
The ID is divided into five pages. Each page controls a different aspect of the process:

**Calculations Page**

The Calculation Page allows you to select the scope of the Transfer Pricing and Option Cost and Option Cost Calculation processes by selecting from a menu of options.

To select one of the following options, click the check box to the left of it.

- Transfer Rate
- Option Cost
- Calculation Mode

**Transfer Rate Section**

This section contains the following options:

- **Propagate Rates**  Select Propagate Rates if you would like to update all term-related instrument records for which you have instrument-level history with the transfer rate that applied in that prior period of history.

- **Calculate Rates**  Select Calculate Rates to transfer-price Instrument data.

- **Migrate Rates**  Select Migrate Rates to migrate transfer rates to the LEDGER_STAT table.

Previous releases of Transfer Pricing included a bulk processing option to increase processing speed for certain records. In Release 4.5 this option is invoked automatically when it is advantageous.

**Option Cost Section**

The following options are contained in the Option Cost section:

- **Propagate Option Costs**  Select Propagate Option Costs if you would like to update all term-related instrument records for which you have instrument-level history with the option cost data that applied in that prior period of history.

- **Calculate Rates**  Select Calculate Rates to calculate option costs for Instrument data.
Migrate Rates  Select Migrate Rates to migrate option costs to the LEDGER_STAT table.

Calculation Mode Section
The Calculation Mode option applies only to Cash Flow Methods and the Straight Term Method. It does not apply to other non-cash flow methods.

Standard Calculation Mode  Select Standard Calculation Mode to calculate transfer rates for Instrument records based on the origination date or last repricing date of the instrument, or to calculate option costs based on the origination date.

For all transfer pricing methods, Standard Calculation Mode will write Instrument results to the Transfer_Rate column and a matched spread will be calculated.

For all option cost calculation methods, Standard Calculation Mode will write Instrument results to Cur_OAS and Cur_Static_Spread (Option Cost = Static Spread - Option Adjusted Spread).

Remaining Term Calculation Mode  Select Remaining Term Calculation Mode to calculate transfer rates and option costs for Instrument records based on the remaining term of the instrument from the as of date of the data, rather than the origination date or last repricing date of the instrument. This option treats your portfolio as if you acquired it on the as of date of your data.

For all transfer pricing methods, Remaining Term Calculation Mode will write Instrument results to Tran_Rate_Rem_Term; and no matched spread will be calculated.

For all option cost calculation methods, Remaining Term Calculation Mode will write Instrument results to Historic_OAS and Historic_Static_Spread (OptionCost = Static Spread - Option Adjusted Spread).

Inputs Page

Transfer Pricing ID and Prepayment ID
At the bottom of the page, select the IDs that contain your assumptions for Transfer Pricing and Option Cost Calculations. These assumptions are contained in the Transfer Pricing ID and the Prepayment ID.

To select from the drop-down list of available IDs, click in the box or click the arrow at the end of the box.
Defining a Transfer Pricing Processing ID

Option Cost-Related Selections
If you have selected Calculate Option Cost on the Calculations page, inputs will be enabled for Stochastic Processing Parameters and Random Number Generation Method.

Valuation Curve From the drop-down list, select the Valuation Curve that will be used to generate the forward rates used in the calculation of the static spread, and to generate the one-month stochastic rates used in calculating the option adjusted spread.

Term Structure Model From the drop-down list, select the Term Structure Model that will govern the generation of one-month stochastic rates, discount factors for each scenario, and discrete rates for any maturity used in calculating the option adjusted spread.

Rate Index ID From the drop-down list, select the Rate Index ID that will be used to define the rates used to index adjustable rate instruments under the different rate paths generated by stochastic processing. Rates will be defined automatically in terms of the Valuation Curve.

Smoothing Method From the drop-down list, select the Smoothing Method to be used to interpolate rates on the valuation curve for terms that fall between given points. The preferred method is Cubic Spline of Yields.
Number of Rate Paths  Enter a number of rate paths (1-2000) or use the spinner. The default number is 200. Greater numbers of rate paths increase accuracy but also increase processing time. You can experiment to find the optimal level for your institution’s portfolio.

Random Number Generation Method  Random number generation determines how the Monte Carlo process selects random numbers. Select either of these two methods by clicking the button beside it:

- Low-discrepancy sequences, also known as quasirandom sequences, are designed to fill the space uniformly. This achieves better accuracy than pseudorandom sequences when applying them to numerical problems, integration in high dimension, and so on.

- Pseudorandom sequences are the traditional random numbers generated by most compilers. They are designed to do well on some statistical tests: low autocorrelation, high period before the sequence repeats itself.

For a fuller discussion of the effects that these options have on stochastic processing, see the Oracle Financial Services Technical Reference Manual.

Process Tables Page

The Process Tables page enables you to select the table or tables you want to process.
Defining a Transfer Pricing Processing ID

**Processing Tables**
Click the name of the table or tables you want. Use the scroll bar to see the full list.

**Filter Type**
Select Data Filter, Group Filter, Tree Filter, or None from the drop-down list. For more information on filtering, see Chapter 8, "Data Filter ID" and Chapter 11, "Group Filter ID".

**Filter Name**
You can change the set of data to be transfer-priced by changing the filter that is to be applied during processing. Select the Data, Group, or Tree Filter you wish to apply when transfer-pricing your data. The drop-down list is a display of all filter IDs of the type you selected in Filter Type.

---

**Note:** When you change filter types within a Transfer Pricing Processing ID, the filter defaults to the first one on the list.

---

**Propagation Page**
Transfer Pricing theory suggests that a single transfer rate should apply to an instrument record throughout its entire life (for fixed rate instruments) or repricing term (for adjustable rate instruments). The Propagate Rates option allows you to move forward (propagate) the transfer rate and matched spread on any applicable instrument record from a prior period of history.

To use the Propagate Rates option, you must have fully transfer-priced detailed (non-aggregated) Instrument data from an As of Date prior to the As of Date that you are currently processing.

**Why Use Rate Propagation?**
Rate Propagation is available for performance reasons. Because Rate Propagation uses a bulk update statement, it provides a significant performance improvement over processing instruments with a row-by-row approach. Although precise performance numbers may vary depending on your hardware and database configuration, updating a set of instrument records via rate propagation is several times faster than updating the same set of records via a row-by-row process.

In the absence of Rate Propagation, most term-related instruments are, in fact, processed via a row-by-row process. What this implies, then, is that Rate Propagation will result in significant performance improvements for all fixed-rate
Defining a Transfer Pricing Processing ID

term-related instruments that existed in the prior period (for example, everything except new originations) and all adjustable rate instruments that have not repriced or were not originated since the prior period. This may be over 80% of your term-related portfolio.

As cash flow data correction rules are only required on those records that you are transfer-pricing via a cash flow method (not those that you update via Rate Propagation), you may elect not to process the cash flow edits against all Instrument Records whose transfer rates are populated via Rate Propagation.

**Note:** This may result in some inconsistency between the cash flow columns in the current period and those in a prior period for selected instrument records. To use this approach, you should do the Rates Propagation, then process Balance and Control Cash Flow Edits on all instrument records with Transfer Rate = 0, and then transfer-price the rest of your portfolio using the Skip Non-Zero Rates option.

**Propagating Rates**

Begin by defining the tables for which you want to propagate rates.

1. On the Calculation Page, in either the Transfer Rate or the Option Cost Section, select Propagate.
2. On the Process Tables Page, select the Instrument tables that you want to update.

**Note:** Select only the instrument tables you want to update. Do not select tables from a prior period that are used as source tables for the Rate Propagation process.

3. On the Propagation page, define source tables and the prior period source dates for rate propagation. Do the following for each table:

   a. Choose your source table from the Source Tables drop-down list. The source table for any rate propagation process can be either the same table (if you store multiple periods of instrument data in the same instrument table) or a separate table (if you store history records in a separate instrument table).

   b. Specify the historical lag between the target and source tables. The prior period source date for each source table is defined in relation to the current As of Date specified in the Configuration ID. For instance, if you transfer-price on a monthly basis, you should specify the historical lag between the target and source tables as 1M. The Source Date column is automatically updated from the As of Date in your Configuration ID minus Historical Lag (as specified by Frequency/Multiplier). This eliminates the need to update the Processing ID when the As of Date changes.

**Rate Propagation Rules**

When a table is updated via the rate propagation technique, an instrument record must satisfy the following criteria in order to receive a transfer rate.

First, it must be an instrument record whose ID number exists in both the Target Table (with the current As of Date) and the Source Table (with the prior period As of Date).

In addition, the instrument must be fixed-rate (Reprice Freq = 0 in Target Table), or it must be adjustable-rate (Reprice Freq <> 0 in Target Table), but with the Target Last Reprice Date <= Prior Period As of Date. (In other words adjustable rate instruments that have not repriced since the prior period).

Note that the matched spread is migrated from the prior period record, not recomputed from the transfer rate and current rate on the target table record. Also,
Option Cost data is propagated for all specified records since it is not affected by these criteria.

**Additional Processing Options**

**Skip Non-Zero Option Costs**  Select Skip Non-Zero Option Costs if you want to skip recalculating static spreads and option adjusted spreads that were populated in the Option Cost Propagation step. This option applies only to instrument data. To select this option, you must also select the Calculate Option Cost option on the Calculation page.

**Skip Non-Zero Transfer Rates**  Select Skip Non-Zero Transfer Rates if you want to skip recalculating all transfer rates that were populated in the Rates Propagation step. This option applies only to Instrument data. To select this option, you must also select the Calculate Rates option on the Calculation Page.

**Process Mode Page**

The Process Mode Page is divided into three sections:

- Location
- Cash Flows
- Rates
Location Section
This section has two options.

Client  Select Client to have the computations performed on the client.

Server  Select Server to have the computations performed on the server. This usually produces faster results.

Note: To take advantage of multithreading on the server, the server must be correctly configured. See the Oracle Financial Services Installation and Configuration Guide.

Cash Flows Section
Select Detail Cash Flow to record all the events (cash flows or repricings) that occur for five separate records (the first five records processed). Each of the records will have all the financial elements populated in the OFSA_PROCESS_CASH_FLOWS table. The data in this table uses the Result_Sys_ID, which identifies the Processing ID used, as one of the main identifying keys. This table enables you to recreate your Transfer Pricing results in a spreadsheet. For more details, see Chapter 3, "Transfer Pricing Methods".

Rates Section
Previous releases of Transfer Pricing included a Model With Gross Rates option in the Processing ID. In release 4.5 this option is invoked more flexibly, on a product-by-product basis in the Transfer Pricing ID.

These options apply to the Option Cost calculations:

Forward Rates  Select Forward Rates to audit the Static Spread calculations by writing out calculated forward rates to the OFSA_INTEREST_RATES_AUDIT table.

1 Month Rates  Select 1 Month Rates to audit the Option Adjusted Spread calculations by writing out the different paths of one-month rates to the OFSA_INTEREST_RATES_AUDIT table. Since 360 one-month rates are written out for each rate path, the process might be lengthy.

Processing a Transfer Pricing Processing ID

To process the Transfer Pricing Processing ID:

Note: To take advantage of multithreading on the server, the server must be correctly configured. See the Oracle Financial Services Installation and Configuration Guide.
1. Do one of the following:
   - Click the Run icon on the horizontal toolbar.
   - From the Process menu, choose Run.
   
   A confirmation dialog will ask you to confirm that you wish to process the ID.

2. Choose OK to continue or Cancel to exit the action without processing.

During a Transfer Pricing process on the client, the Processing Status dialog resets the counter display for each type of operation performed.

This dialog tracks the progress of all the steps performed during a Transfer Pricing process. The final screen displays the total number of records updated during the entire process, including only the updates to the Instrument tables and the LEDGER_STAT table. During Server processing similar information is displayed.

**Editing a Transfer Pricing Processing ID**

To edit a Transfer Pricing Processing ID:

1. Select one of these options:
   - Click the Open icon on the horizontal toolbar, then click the Transfer Pricing Processing ID icon on the vertical toolbar.
   - From the File menu, choose Open and select Process ID.

   The Select Transfer Pricing Processing ID dialog appears.

2. Select the name of the Folder under which this predefined ID was created. (Click the arrow to drop down a list of folders.)

3. Select a Transfer Pricing Processing ID from the drop-down list.

   If you know the name of the ID you want to open, you can type the first letter of the ID to reach that portion of the alphabetized list and then click to select it.

4. Choose OK to continue.

   The ID dialog appears.

5. Choose Cancel at any time to cancel the Select operation before the ID is selected.

6. With the ID open, make your changes.

7. Save your changes by clicking the Save icon on the horizontal toolbar, or choose Save from the File menu.
In Oracle Financial Services (OFS) applications, a Tree Filter ID narrows the focus of the tree hierarchy for processing and reporting. For example, if you want to report on only the products that roll up to the commercial loans portion of a product tree, you identify them with the Tree Filter ID.

A Tree Filter ID must have a predefined Tree Rollup ID as part of its definition, and it must be in the same group as the Tree Rollup ID. Tree Filter IDs are available only for data correction, transfer pricing, performance analyzer processing, and risk management processing.

For more information about Tree Filter IDs and IDs in general, see Chapter 5, "Overview of IDs".

This chapter presents the following topics:

- Creating a New Tree Filter ID
- Using the Tree Filter ID Window
- Editing a Tree Filter ID
- Example: Creating and Defining a New Tree Filter ID
Creating a New Tree Filter ID

To create a new Tree Filter ID, perform the following steps:

1. From the File menu, click New.
   A list of the IDs that are available for the product you are using appears.
2. Select Tree Filter ID.
   The New Tree Filter ID dialog box appears.
3. Select Folder, Leaf Type, and Tree Rollup ID.
4. Type in the Tree Filter ID and Description fields, as required.
5. Select the permission level of the ID, as required.
   Read/Write is the default.
6. Click OK to continue.
   The Tree Filter ID window appears.
Using the Tree Filter ID Window

Like the Tree Rollup ID window, the Tree Filter ID window comprises the Rollup Tree and Display Level panes. Also like the Tree Rollup ID window, it provides access to the Edit, Options, and Tree menus. Unlike the Tree Rollup ID window, the Tree Filter ID window has red and green flags that indicate nodes excluded from or included in the definition of the Tree Filter ID.

Rollup Tree Pane

The Rollup Tree pane enables you to see and manipulate the tree structure at any level of the hierarchy.

Branch Expansion Indicators

Each node is represented by a description and an Indicator that indicates whether or not a branch can be expanded. The Expansion Indicator is a + (plus sign) if the branch can be expanded to display nodes at the next lower level, a - (minus sign) if the branch has already been expanded and all lower nodes are displayed. It is blank if no lower nodes are attached.

Node Inclusion Indicator

Node Inclusion Indicators appear as green or red flags. If any nodes at lower levels of the branch are included in the Tree Filter ID, the Node Inclusion Indicator is
green. If no nodes at lower levels of the branch are included in the Tree Filter, it is red.

**Current Level Name**
The name of the level currently selected in the Rollup Tree pane appears after *Rollup Tree* in the menu bar. The level name changes as different levels are selected.

**Display Level Pane**
The Display Level pane enables you to see all the nodes attached to the selected node in the Rollup Tree at a specific level below the selected node. To set the level of the hierarchy that you want to display, select the Tree menu -> Set Display Level.

**Edit Menu**

**Search**
If you want to locate a specific node within a Tree structure, you can use the Search option in the Edit menu. The Tree Rollup Search dialog box appears.

![Tree Rollup Search](image)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Field</td>
<td>Select the Node Number or Description for which you are searching.</td>
</tr>
<tr>
<td>Search String</td>
<td>Type the Node Number or Description.</td>
</tr>
</tbody>
</table>
Using the Tree Filter ID Window

Search fails if the value you want is not within the 16,000 leaves range. The following message appears: "The tree is too large to show entirely. Collapse branches or use Search and Focus to view more." See the Tree Menu for more information about Collapse Branch.

Search Again

The Search Again option is available in the Edit menu and enables you to continue your search using the same criteria that you defined in Search.

Search and Focus

The Search and Focus option is available in the Edit menu. It uses the same dialog box as the Search option and takes you to the value itself.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>Select the Level of the node in the Tree. If you do not know the level, leave the default entry of All Levels.</td>
</tr>
</tbody>
</table>

Search Options

- Case Sensitive: This option provides exact string matches when searching on descriptions only.
- Wrap Search: This option performs the search of both node numbers and descriptions starting from the current cursor location on the Tree structure and continuing at the top of the Tree structure.

Match

- Beginning: This option searches node numbers or descriptions beginning with the string entered in the Search String field.
- Contains: This option searches node numbers or descriptions containing the string entered in the Search String field.

Note: Trees can show as many as 16,000 leaves and nodes at a time.

Note: Search and Focus and Search and Focus Again are specifically for use on trees having more than 16,000 leaves.
**Search and Focus Again**

Like the Search and Focus option, the Search and Focus Again option is available in the Edit menu. It uses the same dialog box as the Search option and takes you to the value itself.

Search and Focus Again shows only the node or leaf for which you are searching. It does not show context or hierarchy. It is the only option that you can use with a large tree, that is, one containing more than 16,000 leaves.

**Options Menu**

You can use the Options menu to format the appearance of your Tree Rollup ID. The Options menu provides the following functions:

- Select Font
- Show Node Numbers on Left
- Show Node Numbers on Right
- Show Include Attribute

**Select Font**

You can change the typeface in which your tree is displayed on your window. To try a new font:

1. Click Set Font.
   
   The default font is Font: System, Font Style: Bold, Size: 10. Each font is previewed in the Sample window at the bottom of the dialog box.

2. Select an appropriate Font, Font Style, Size, and Script, and then click OK.
   
   You select a smaller font to view more information within one window or a larger font to display less information per window but to view it more clearly.
Show Node Numbers on Left
You can select Show Node Numbers on Left if you are familiar with your Node Numbers and want to view them. This option displays the Node Numbers before the Node Descriptions.

This option is a toggle. To turn off the Node Numbers, select the option again.

Show Node Numbers on Right
You can select Show Node Numbers on Right if you are familiar with your Node Numbers and want to view them. This option displays the Node Numbers after the Node Descriptions.

This option is a toggle. To turn off the Node Numbers, select the option again.

Show Include Attribute
You can select Show Include Attribute to activate the Node Inclusion Indicators and display the filter status of a node as you navigate through the hierarchy. A red flag indicates that the node has not been filtered. A green flag indicates that the node has been filtered.

Show Include Attribute is the default.
Using the Tree Filter ID Window

Tree Menu

To change how the tree structure is viewed and to specify which branches are to be included in the filter, select an option from the Tree menu.

```
<table>
<thead>
<tr>
<th>Tree Menu</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree</td>
<td>Tools</td>
<td>Window</td>
<td>Help</td>
</tr>
<tr>
<td>Expand One Level</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expand Branch</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expand All</td>
<td>Ctrl+*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse Branch</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus on Branch</td>
<td>Ctrl+F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus To Top</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo Focus</td>
<td>Ctrl+U</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Display Level...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tree Level...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Include Branch in Filter</td>
<td>Ctrl+D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exclude Branch from Filter</td>
<td>Ctrl+H</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toggle In/Out of Filter</td>
<td>Ctrl+T</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Expand One Level**

Expand One Level displays the branch and nodes attached one level below the selected node. You can also expand a branch by one level by selecting a node in the Tree Rollup and typing + (plus sign) or by double clicking the Branch Expansion Indicator when the indicator displays a + (plus sign).

**Expand Branch**

Expand Branch displays all levels of nodes attached under the node selected in the Tree Rollup. You can also expand a branch to show all lower levels of attached nodes by selecting a node in the Tree Rollup and typing Shift + * (plus sign and asterisk). This option is available only when the Branch Expansion Indicator displays a + (plus sign).

**Expand All**

Expand All displays every level of the entire Tree Rollup above and below the selected node. This option is available only when the Branch Expansion Indicator displays a + (plus sign).
Using the Tree Filter ID Window

---

**Note:** Expand All expands only the first 16,000 leaves and nodes. A Rollup ID can display a maximum of 16,000 leaves and nodes at a time.

---

**Collapse Branch**
Collapse Branch hides all levels of nodes attached under the selected node from the Rollup Tree pane. You can also collapse a branch by one level by selecting a node in the Tree Rollup and typing - (minus sign), or by double clicking the Branch Expansion Indicator when the indicator displays a - (minus sign).

---

**Note:** Focus on Branch, Focus to Top, and Undo Focus are specifically for use on trees having more than 16,000 leaves.

---

**Focus on Branch**
Focus on Branch changes the Rollup Tree pane from displaying the whole tree to displaying only the tree structure below the selected node.

**Focus to Top**
Focus to Top returns you directly to the top of the Rollup Tree pane. You do not need to return level by level.

**Undo Focus**
Undo Focus turns off the focus on a branch. This enables you to display all branches of the total Tree Rollup when you no longer want to focus on an individual branch.

**Set Display Level**
Set Display Level enables you to change the level that is displayed in the Display Level pane. Click this option to open the display level dialog box:
To change the Display Level, select the level you want to be displayed from the menu.

**Set Tree Level**
Set Tree Level enables you to change the level that is displayed in the Rollup Tree pane. Click this option to open the display level dialog box.
Include Branch in Filter
Include Branch in Filter selects an entire branch for inclusion in the Tree Filter ID window. To include an entire branch of a Rollup in the Tree Filter ID window, select the node at the top of the desired branch, and then select Include Branch in Filter.

If a node is included in the Tree Filter, then the Node Description is displayed in bold print. Otherwise, it is displayed in gray print.

Exclude Branch from Filter
Exclude Branch from Filter selects an entire branch to be excluded from the Tree Filter ID window if it has already been selected. To exclude an entire branch of a Rollup in the Tree Filter ID window, select the node at the top of the desired branch, and then select Exclude Branch from Filter.

Toggle In/Out of Filter
Toggle In/Out of Filter enables you to select or deselect a single node from an entire branch without changing the selection status of any other nodes in the branch. To include an individual node in a branch that is excluded or to exclude an individual node in a branch that is included, select the node to be toggled, and then select Toggle In/Out of Filter.

Save the ID
Save the ID by clicking the Save icon on the horizontal toolbar, or choose Save from the File menu.

Editing a Tree Filter ID
To edit a Tree Filter ID, complete the following steps:

1. From the File menu, click Open.
   A list of the IDs that are available for the product you are using appears.

2. Select Tree Filter ID.
   The Select Tree Filter ID dialog box appears.

3. Select Folder, Leaf Type, Tree Rollup, and Tree Filter IDs, as required.

4. Click OK.
   The Tree Filter ID window appears.
5. Click in the pane that you want to search, either Rollup Tree or Display Level.
6. From the Edit menu, click Search to search for the Tree Filter ID that you want to edit.
   The Tree Rollup Search dialog box appears.

   **Note:** Trees can show as many as 16,000 leaves and nodes at a time.

7. Select either Node Number or Description in Search Field.
8. Type the Search String.
9. Select Level, Search Options, and Match, as appropriate.
10. Click OK.
    The Tree Filter ID appears if your search is within 16,000 leaves. Search fails if the value you want is not within the 16,000 leaves range. The following message appears: “The tree is too large to show entirely. Collapse branches or use Search and Focus to view more.”
11. Click on the Tree Filter ID.
12. With the Tree Filter ID selected, edit it as appropriate.
13. When your editing is complete, select File -> Save to save your Tree Filter ID, or select File -> Save As to save your edited Tree Filter ID under a new name.

**Example: Creating and Defining a New Tree Filter ID**

This example explains how to create and define a new Tree Filter ID named Checking. The example uses the Rollup Tree ID named Product that was created in the Chapter 19, "Tree Rollup ID" chapter. To create the Tree Filter ID, perform the following steps:

1. From the File menu, select New.
   A list of the IDs that are available for the product you are using appears.
2. Select Tree Filter ID.
   The New Tree Filter ID dialog box appears.
3. Select All for Folder.
Now everyone in the folder has access.

4. Select Common COA ID for Leaf Type.

5. Select Product for Tree Rollup ID.

6. Type **CHECKING** in the Tree Filter ID name box.

7. Type **This filter is for checking profitability analysis** in the Description box.

8. Select Read/Write for Security.

9. Click OK.

The Tree Filter ID window appears.

10. Click Checking at level 2.

11. Select Include Branch in Filter from the Tree menu.

   The Node(s) Inclusion Indicators turn green for all the Level 2 Checking branches.

12. Save the Tree Filter ID.
Tree Rollup IDs define a hierarchical structure of detailed data in the Oracle Financial Data Manager (FDM) database. For example, you can build a model of the various levels into which products roll up and use cost centers as the base level of the institution. You use a Tree Rollup ID to define these hierarchical structures.

With a Tree Rollup ID, you can define multiple organizational, product, account, and other hierarchies by using leaves as the lowest level of detail in the hierarchical structure. Each row in the FDM database contains a leaf value for each dimension of profitability. These leaves serve as the lowest level in constructing Tree Rollup IDs.

For more information about Tree Rollup IDs and IDs in general, see Chapter 5, "Overview of IDs".

This chapter presents the following topics:

- Creating a New Tree Rollup ID
- Using the Tree Rollup ID Window
- Editing a Tree Rollup ID
- Example: Building a Product Tree
Creating a New Tree Rollup ID

To create a Tree Rollup ID, perform the following steps:

1. From the File menu, click New.
   A list of the IDs that are available for the product you are using appears.

2. Select the Tree Rollup ID.
   The New Tree Rollup ID dialog box appears.

   ![New Tree Rollup ID dialog box](image)

3. Select Folder and Leaf Type.

4. Type in the Tree Rollup ID and Description fields, as required.

5. Select the permission level of the ID, as required.
   Read/Write is the default.

6. Click OK to continue.
   The Tree Rollup ID window appears.
Using the Tree Rollup ID Window

The Tree Rollup ID window comprises the Rollup Tree and Display Level panes. It also provides access to the Edit, Options, and Tree menus.

Rollup Tree Pane

The Rollup Tree pane enables you to see and manipulate the tree structure at any level of the hierarchy.

Branch Expansion Indicators

Each node is represented by a description and an Indicator that indicates whether or not a branch can be expanded. The Expansion Indicator is a + (plus sign) if the branch can be expanded to display nodes at the next lower level, a - (minus sign) if the branch has already been expanded and all lower nodes are displayed, and blank if no lower nodes are attached.

Current Level Name

The name of the level currently selected in the Rollup Tree pane appears after Rollup Tree in the menu bar. The level name changes as different levels are selected.
Using the Tree Rollup ID Window

Display Level Pane

The Display Level pane enables you to see all the nodes attached to the selected node in the Rollup Tree at a specific level below the selected node. To set the level of the hierarchy that you want to display, select the Tree menu -> Set Display Level.

Edit Menu

Search

If you want to locate a specific node within a Tree structure, you can use the Search option in the Edit menu. The Tree Rollup Search dialog box appears:

![Tree Rollup Search dialog box]

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Field</td>
<td>Select the Node Number or Description for which you are searching.</td>
</tr>
<tr>
<td>Search String</td>
<td>Type the Node Number or Description.</td>
</tr>
<tr>
<td>Level</td>
<td>Select the Level of the node in the Tree. If you do not know the level, leave the default entry of All Levels.</td>
</tr>
</tbody>
</table>

Search Options

- **Case Sensitive**: Provides exact string matches when searching on descriptions only
- **Wrap Search**: Performs the search of both node numbers and descriptions starting from the current cursor location on the Tree structure and continuing at the top of the Tree structure

Match
Search fails if the value you want is not within the 16,000 leaves range. The following message appears: “The tree is too large to show entirely. Collapse branches or use Search and Focus to view more.” See the Tree Menu for more information about Collapse Branch.

**Search Again**

The Search Again option is available in the Edit menu and enables you to continue your search using the same criteria that you defined in Search.

**Note:** Search and Focus and Search and Focus Again are specifically for use on trees having more than 16,000 leaves.

**Search and Focus**

The Search and Focus option is available in the Edit menu. It uses the same dialog box as the Search option and takes you to the value itself.

**Search and Focus Again**

Like the Search and Focus option, the Search and Focus Again option is available in the Edit menu. It uses the same dialog box as the Search option and takes you to the value itself.

Search and Focus Again shows only the node or leaf for which you are searching. It does not show context or hierarchy. It is the only option that you can use with a large tree, that is, one containing more than 16,000 leaves.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginning</td>
<td>Searches node numbers or descriptions beginning with the string entered in the Search String field.</td>
</tr>
<tr>
<td>Contains</td>
<td>Searches node numbers or descriptions containing the string entered in the Search String field.</td>
</tr>
</tbody>
</table>

**Note:** Trees can show as many as 16,000 leaves and nodes at a time.
Options Menu

You can use the Options menu to format the appearance of your Tree Rollup ID. The Options menu provides the following functions:

- Select Font
- Show Node Numbers on Left
- Show Node Numbers on Right

Select Font

You can change the typeface in which your tree is displayed on your window. To try a new font:

1. Click Set Font.
   
   The default font is Font: System, Font Style: Bold, Size: 10. Each font is previewed in the Sample window at the bottom of the dialog box.

2. Select an appropriate Font, Font Style, Size, and Script, and then click OK.
   
   You select a smaller font to view more information within one window or a larger font to display less information per window but to view it more clearly.

Show Node Numbers on Left

You can select Show Node Numbers on Left if you are familiar with your Node Numbers and want to view them. This option displays the Node Numbers before the Node Descriptions.
Using the Tree Rollup ID Window

This option is a toggle. To turn off the Node Numbers, select the option again.

**Show Node Numbers on Right**
You can select Show Node Numbers on Right if you are familiar with your Node Numbers and want to view them. This option displays the Node Numbers after the Node Descriptions.

This option is a toggle. To turn off the Node Numbers, select the option again.

**Tree Menu**

To change how the structure of a tree is viewed and to specify which branches are to be included in the rollup, you select Tree from the menu bar.

<table>
<thead>
<tr>
<th>Tree</th>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand One Level</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expand Branch</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Expand All</td>
<td>Ctrl+ +</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collapse Branch</td>
<td>+</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus on Branch</td>
<td>Ctrl+F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo Focus</td>
<td>Ctrl+U</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus To Top</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Levels Maintenance</td>
<td>Ctrl+L</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Display Level</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Tree Level</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Focus on Branch, Undo Focus, and Focus to Top are specifically for use on trees having more than 16,000 leaves.

**Expand One Level**
Expand One Level displays the branch and nodes attached one level below the selected node. You can also expand a branch by one level by selecting a node in the
Using the Tree Rollup ID Window

Tree Rollup and typing + (plus sign) or by double clicking the Branch Expansion Indicator when the indicator displays a + (plus sign).

**Expand Branch**

Expand Branch displays all levels of nodes attached under the node selected in the Tree Rollup. You can also expand a branch to show all lower levels of attached nodes by selecting a node in the Tree Rollup and typing Shift + * (plus sign and asterisk). This option is available only when the Branch Expansion Indicator displays a + (plus sign).

**Expand All**

Expand All displays every level of the entire Tree Rollup above and below the selected node. This option is available only when the Branch Expansion Indicator displays a + (plus sign).

---

**Note:** Expand All expands only the first 16,000 leaves and nodes. A Rollup ID can display a maximum of 16,000 leaves and nodes at a time.

---

**Collapse Branch**

Collapse Branch hides all levels of nodes attached under the selected node from the Rollup Tree pane. You can also collapse a branch by one level by selecting a node in the Rollup Tree pane and typing - (minus sign), or by double clicking the Branch Expansion Indicator when the indicator displays a - (minus sign).

---

**Note:** Focus on Branch, Undo Focus, and Focus to Top are specifically for use on trees having more than 16,000 leaves.

---

**Focus on Branch**

Focus on Branch changes the Rollup Tree pane from displaying the whole tree to displaying only the tree structure below the selected node.

**Undo Focus**

Undo Focus turns off the focus on a branch. This enables you to display all branches of the total Tree Rollup when you no longer want to focus on an individual branch.
Focus to Top
Focus to Top returns you directly to the top of the Rollup Tree pane. You do not need to return level by level.

Levels Maintenance
Levels Maintenance enables you to manipulate the level structure of a tree. Using this option, you can add, subtract, and rename levels of the Tree Rollup. Selecting this option opens the Rollup Level Maintenance dialog box.

- **Insert Level** enables you to insert a level into the hierarchy. To insert a new level, select the level in the Level Description box above which you want to add a level, and click Insert Level.
  
Enter the name of the new level in the New Level Name box, and click OK. For more information, refer to the *Oracle Financial Services Installation and Configuration Guide*.

- **Delete Level** enables you to remove a level from the hierarchy. To remove a level, select the level you want to remove in the Level Description box and click Delete Level. You are prompted to confirm your decision to delete the level.

- **Rename Level** enables you to rename an already existing level. To rename a level, select the level you want to rename in the Level Description box and click Rename Level.

Enter the new name in the New Level Name box, and click OK.

When you have finished with Levels Maintenance, click OK to return to the main ID window. Click Cancel at any time to exit without changes.
Set Display Level
Set Display Level enables you to change the level that is displayed in the Display Level pane. Click this option to open the display level dialog box:

<table>
<thead>
<tr>
<th>Region</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affiliate</td>
</tr>
<tr>
<td>Division</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Cost Center</td>
</tr>
<tr>
<td>Orphan Leaves</td>
</tr>
</tbody>
</table>

To change the Display Level, select the level you want to be displayed from the menu.

Set Tree Level
Set Tree Level enables you to change the level that is displayed in the Rollup Tree pane. Click this option to open the display level dialog box.

Insert Node
Insert Node enables you to add an additional node to the Tree Rollup. To insert a node, select a node in the Tree Rollup under which you want to add a node, and click Insert Node. You can place new nodes anywhere in the Rollup Tree except below the leaf level or orphan node.

The Insert Node dialog box appears:

- **Parent Level** is the level of the parent node under which the new node is being added.
- **Parent Name** is the name of the parent node under which the new node is being added.
- **New Node Level** is the level at which the new node is being added.
- **New Node Name** enables you to enter the name of the new node.

  If you leave the New Node Name field blank, the new node appears in the Tree Rollup display, without a descriptive tag.

- **New Node ID** enables you to define the ID number that will be associated with the new node. This field does not require input because a unique default ID
number is supplied by the system. If you decide to enter an ID number for the new node manually, however, this number must be unique.

Click OK when you have finished. Click Cancel at any time to exit without saving changes.

**Rename Node**

Rename Node enables you to rename or renumber an existing node. Select the desired node from the Tree Rollup, and select this option. The Rename/Renumber dialog box opens.

- **Name**
  Enter the new name in the Name box.

- **Number**
  Enter the new number in the Number box.

Click OK when you have finished. Click Cancel at any time to exit without changes.

**Delete**

Delete enables you to delete a node from the Tree Rollup. To delete a node, select the node you want to delete from the Tree Rollup and click Delete. The selected node and all nodes below it are deleted. The leaves that are attached below the deleted node become orphan leaves in the orphan branch of the tree.

**Copy**

Copy enables you to copy an orphan leaf or group of orphan leaves from the orphan branch into another node in the Tree Rollup. To copy a single orphan leaf from the orphan branch, select the orphan leaf in the Tree Rollup or set the Display Level to Orphan Leaves and select the desired Orphan Leaf. Next, click Copy. Now select the node to which the orphan leaf is to be copied in the Tree Rollup, and use Paste to attach the leaf to the new node.

To copy several orphan nodes at one time to a single node in the Tree Rollup, hold the Shift key while selecting successive nodes. Then use Copy and Paste to attach the block of nodes at the new location.

**Cut**

Cut enables you to cut a leaf, a group of leaves, or a branch from the Tree Rollup.
To cut a portion of a Tree Rollup, select the leaf or node from the Tree Rollup, or set the Display Level. Next, click Cut. To reattach the cut portion of the tree to a different part of the tree, select the node to which the portion is to be copied in the Tree Rollup, and click Paste to attach it to the new node.

To cut several orphan nodes at one time, hold the Shift key while selecting successive nodes. Then click Cut if you want to reattach the nodes at a new location. Click Delete to cut the block of nodes permanently.

If a node that has leaves attached at a lower level is cut, or if leaves from the Tree Rollup are cut, the leaves are automatically placed at the end of the orphan leaves. If the leaves are reattached, or the node to which the leaves were attached are moved to a different part of the tree, the leaves that were placed at the end of the orphan branch are automatically moved.

**Paste**

Paste enables you to attach cut or copied orphan leaves, leaves, nodes, and branches to new nodes in the Tree Rollup. After you Cut or Copy, select the node to which you want to attach the data, and click Paste.

You can only perform a Paste after a Cut or Copy action has been performed. Paste can only be performed on the leaves or nodes copied or cut in the immediately previous cut or copy. If cuts are performed without a paste the node information from the first cut is lost and the leaves are placed at the end of the orphan leaves.

You can perform a Paste only after a Cut or Copy has been performed. Paste can be performed only on the leaves or nodes copied or cut in the immediately previous cut or copy. If you cut without a paste, the node information from the first cut is lost and the leaves are placed at the end of the orphan leaves.

**Node Up**

Node Up enables you to move a node up the list of nodes if more than one node is attached to a parent node. In order move a node above another node in the Tree Rollup window, select the node to move and click Node Up.

**Node Down**

Node Down enables you to move a node down the list of nodes if more than one node is attached to a parent node. In order move a node below another node in the Tree Rollup window, select the node to move and click Node Down.
Transform Rollup
Transform Rollup transforms the current Tree Rollup ID into a hierarchy table within the Oracle Financial Data Manager Reporting Data Mart. The new hierarchy table has the same name as the Tree Rollup ID. This table makes information available to the Reporting Data Mart user and for reporting purposes through Oracle Discoverer and other reporting tools.

Save the ID
Save the ID by clicking the Save icon on the horizontal toolbar, or choose Save from the File menu.

Editing a Tree Rollup ID
To open an existing Tree Rollup ID, perform the following steps:
1. From the File menu, click Open.
   A list of the IDs that are available for the product you are using appears.
2. Select Tree Rollup ID.
   The Select Tree Rollup ID dialog box appears.
3. Select Folder, Leaf Type, and Tree Rollup ID, as required.
4. Click OK.
   The Tree Rollup ID window appears.
5. Click in the pane that you want to search, either Rollup Tree or Display Level.
   If you select the Rollup Tree pane, you see the leaves in the context of the tree. If you select the Display Level pane, you see only the leaves.
6. From the Edit menu, click Search to search for the Tree Rollup ID you want to edit.
   The Tree Rollup Search dialog box appears.

Note: Trees can show as many as 16,000 leaves and nodes at a time.

7. Select either Node Number or Description in Search Field.
8. Type the Search String, such as Corporate.
9. Select Level, Search Options, and Match, as appropriate.
10. Click OK.
   
   The Tree Rollup ID appears if your search is within 16,000 leaves. Search fails if
   the value you want is not within the 16,000 leaves range. The following
   message appears: “The tree is too large to show entirely. Collapse branches or
   use Search and Focus to view more.”
11. Click on the Tree Rollup ID.
12. With the Tree Rollup ID selected, copy or paste it as appropriate.
    
    For example, you want to cut one leaf, Regional Corporate, from Wholesale and
    move it to Branch Administration.
13. When your cutting or pasting is complete, select File -> Save to save your Tree
    Rollup ID, or select File -> Save As to save your edited Tree Rollup ID under a
    new name.

Example: Building a Product Tree

In this example, you use the Tree Rollup ID to build a product tree with five
hierarchy levels. The tree structure is as follows:

<table>
<thead>
<tr>
<th>Levels</th>
<th>Product Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>LEVEL I</td>
<td></td>
</tr>
<tr>
<td>Business Type</td>
<td>Personal</td>
</tr>
<tr>
<td>LEVEL II</td>
<td></td>
</tr>
<tr>
<td>Market Family</td>
<td>Checking, Savings, Retirement</td>
</tr>
<tr>
<td>LEVEL III</td>
<td></td>
</tr>
<tr>
<td>Market Type</td>
<td>Interest, Non-Int., Liquid, Time, IRAs</td>
</tr>
<tr>
<td>LEVEL IV</td>
<td></td>
</tr>
<tr>
<td>Market Product</td>
<td>Regular, Money Market</td>
</tr>
<tr>
<td>LEVEL V</td>
<td></td>
</tr>
<tr>
<td>Product Description</td>
<td>Money Mkt I, Money Mkt II</td>
</tr>
</tbody>
</table>
You must set the levels of the tree before you can build it.

**Set the Levels of a Tree**

To set the levels of a tree, perform the following steps:

1. Click New on the horizontal toolbar.
   
   A list of the IDs that are available for the product you are using appears.

2. Select the Tree Rollup ID.
   
   The New Tree Rollup ID dialog box appears.

3. Select All for Folder.
   
   Now everyone in the folder has access.

4. Select Common COA ID for Leaf Type.
   
   This is the Leaf Type that contains the information for products.

5. Type **PRODUCT** as the Tree Rollup ID name.

6. In Description, type **This Product Tree is for Deposits Only**.

7. Select Read/Write for Security.

8. Click OK.
   
   The Tree Rollup ID window appears.

9. Select Levels Maintenance from the Tree menu.
   
   The Levels Maintenance dialog box appears: The default names are the level numbers.
Example: Building a Product Tree

10. Set the tree levels to define the structure of the tree.

11. To change the numbers to names, select each level, click Rename Level, and type the new name.

   The default number of levels for a new tree is set at five. You can add or subtract levels by clicking the Insert Level or Delete Level buttons. For this example, the number of levels is left at five. The maximum number of levels available is 15.

12. When you have finished naming the levels, click OK.

13. After setting the levels, build the tree.

**Build a Tree**

To build a tree, perform the following steps:

1. Highlight the parent branch into which you are going to insert the new branch.

2. Insert a new branch.

   You insert the first level of the sample, Business Type, by highlighting Total Rollup.

3. Click Insert Level (or select Insert Node from Tree menu).

   The Insert Node dialog box appears.

4. In the New Node Name box, type the description for this example, *Personal*, and click OK.
5. Repeat procedures 1 and 2 to insert all Level Two, Three, and Four branches.

6. The lowest level, Level Five, is the leaf level.
   For new trees, Leaves are under the Orphan branch.

7. Attach the leaves to each branch by one of two methods:
   - Use Copy and Paste from the Tree menu to copy the leaf from the Orphan branch to the target branch.
   - Use the mouse to drag the selected leaf from the Orphan branch and drop it on the appropriate branch.

   After the leaves are attached, the Tree Rollup ID window appears:

   ![Tree Rollup ID Window](image)

8. Save the new Tree Rollup ID.

9. Click the Exit icon at on the horizontal toolbar to exit the new ID.
Example: Building a Product Tree
The User-Defined Payment Pattern provides a method to customize amortization of specific products and instruments. In a payment pattern, you can assign a unique amortization code to a set of payment phases, which may include some of the following customized features:

- Changes in payment frequency
- Seasonal payment dates
- Non-standard or variable payment amounts

Once you create a payment pattern, you can use it by entering the payment pattern code as the amortization type code for the instrument.

This chapter provides information and instruction on:

- Payment Pattern Structure
- Defining a Payment Pattern
- Editing a Payment Pattern
- Deleting a Payment Pattern

Payment Pattern Structure

You define a payment pattern with a payment term of either absolute or relative. The payment term determines whether the phases of the pattern are focused on calendar dates or time periods. Absolute patterns are defined with sets of payment characteristics scheduled on specific calendar dates. Relative patterns are defined with sets of payment characteristics scheduled for certain periods of time.
You can define a payment pattern with both absolute and relative payment terms. This type of pattern is called a Split Pattern which is discussed separately because of its unique applications.

The user interface for payment patterns is in the form of grids. Each grid contains a set of columns that define payment patterns and their phases. These columns represent the payment characteristics of the payment pattern. The payment characteristics of the phases vary depending upon what payment type and term are selected for the payment pattern.

You define all payment patterns in the payment pattern grid first. Then, you define the phases of the pattern in another grid.

The columns on the payment pattern grid are as follows:

<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>The code is a numeric internal identifier for the payment pattern, also known as an amortization code. Valid codes are 1000 through 29999.</td>
</tr>
</tbody>
</table>
Payment Pattern Structure

<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
</table>
| Description      | The description helps identify the payment pattern. This description appears in the Data Filter ID, Leaf Characteristics ID and Transaction Strategies ID, under the choices for amortization type codes. Additionally, the description is used when reporting on the amortization type code column from the instrument tables.  
  **Note:** Keep the description for payment patterns concise. The Data Filter ID can only display the first 15 characters of the description. |
| Split            | When checked, this option designates the pattern code as a split pattern. For information on how to set up a split pattern, see "Splitting a Payment Pattern".  
  The pattern attributes listed in the next two columns, Payment Term and Payment Type, are grayed out if this option is checked. The pattern attributes for these codes are defined for each timeline individually, rather than for a pattern as a whole. |
| Payment Term     | The payment term determines what payment characteristics are available when defining the payment phases, such as month and day or frequency and value. |
| Payment Type     | The payment type determines the available characteristics for defining the payment amount. A payment type must be assigned for each pattern. The payment types are:  
  - Conventional  
  - Level Principal  
  - Non-Amortizing. |

**Note:** The payment pattern interface is single-user. If you attempt to open the interface when another user has access, you are restricted from access until the other user has closed it.

Payment Phases

You must define one or more payment phases to be complete a payment pattern. A payment phase is a set of payment characteristics which define the timeline of the payment phase.

Though the characteristics change based on whether you are defining an absolute or relative pattern, there are two characteristics that appear for both patterns: Payment Method and Value.
Payment Method

The payment methods determine the behavior of the Value (or payment amount) of the payment phase. There are six different methods:

- **% of Original Balance**: This method calculates the payment as the original balance multiplied by the input percent. This method is useful for apportioning the starting balance on a level principal instrument over several payments. This method is only available for payment patterns defined with a payment type of Level Principal.

- **% of Current Balance**: This method calculates the payment as the current balance prior to payment multiplied by the input percent. This method is only available for payment patterns defined with a payment type of Level Principal.

- **% of Original Payment**: This method calculates the payment as the original payment column from the detail instrument data multiplied by the input percent. For new business, it is based on the original payment amount calculated at the origination of the instrument is used.

  **Caution**: Do not use the % of Original Payment method for an instrument that initially pays interest only for new business. In this case, the original payment amount is zero, and all payments described as a % of the Original Payment would therefore, also be zero.

- **% of Current Payment**: This method calculates the payment as the previous payment multiplied by the input percent. This payment is calculated on the payment date, according to the characteristics of the instrument at the time of the payment, including the current rate, current balance, and current payment frequency. The input percent is applied to the calculated payment amount.
Absolute Payment
This is an input payment amount. This amount represents both principal and interest for a conventional payment type, represents principal only for a level principal payment type. For both types of patterns, absolute value payment amounts are entered as gross of participations.

Caution: Do not use this method for new business. If you assign a pattern which includes absolute value to new business, the pattern is ignored during processing.

Interest Only
This is an input payment amount. An interest-only payment is calculated during processing as balance times rate times accrual factor.

Value
The value reflects the percentage or payment amount based on the method chosen for the payment phase. Value is disabled for phases using the payment method Interest Only.

Payment amounts for conventional pattern phases must reflect both principal and interest payments. Payment amounts for level principal pattern phases only reflect the principal portion of the payment. For level principal pattern phases, the total cash flow on a payment date is the principal amount stored as the payment plus the calculated interest.

Note: The Payment Method and Value columns are not displayed for patterns defined with a Non-Amortizing payment type. All payments are assumed to be interest only for this type of pattern.

Absolute Patterns
Absolute payment patterns are commonly used for instruments that are on a seasonal schedule, such as agricultural or construction loans that require special payment handling based on months or seasons.
The example shown in the illustration demonstrates a loan that follows a seasonal pattern. The payment for the months of January, February and March are scheduled for interest-only payments. As revenues for the customer increase, the payment amount also increases. Therefore, the payments for April and May is 80% of the original payment, and June through September is 100% of the original payment. The payment decreases as the production season slows. The payment in October is decreased to 80% of the original payment, and the payments for November and December are decreased again to 50% of the original payment.

**Note:** You can only define up to a full year of payments. This is because all entries are automatically ordered by date order and are scheduled in a single year rotation.

There are two payment characteristics in addition to Payment Method and Value:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
<td>The month of the payment phase being defined is entered here. A drop-down list of months is provided from which to choose.</td>
</tr>
<tr>
<td>Day</td>
<td>The day of the month the payment is due.</td>
</tr>
</tbody>
</table>
Relative Patterns

You can create relative payment patterns for instruments that have irregular scheduled payments.

The example shown in the illustration is a four year loan. The payment for the first 12 months is interest only. The following 35 payments are scheduled for 50% of the currently scheduled payment, and the last payment is a balloon payment for the balance of the loan.

There are three additional payment characteristics in addition to Payment Method and Value:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq</td>
<td>The frequency of the payment.</td>
</tr>
<tr>
<td>Mult</td>
<td>The time frame in which the payment phase should be repeated. The choices are:</td>
</tr>
<tr>
<td></td>
<td>- Days</td>
</tr>
<tr>
<td></td>
<td>- Months</td>
</tr>
<tr>
<td></td>
<td>- Years</td>
</tr>
<tr>
<td>Repeat</td>
<td>The number of times the payment phase should be repeated.</td>
</tr>
</tbody>
</table>
Split Patterns

A split pattern contains multiple sets of payment phases under a single amortization code. You use a split pattern for financial instruments that make principal payments along two concurrent amortization schedules. Each separate amortization schedule is termed a timeline and assigned a percentage of the balance.

You create a payment phase (or timeline) for each separate amortization schedule and assign a percentage of the whole balance.

The example shown in the illustration is a model of customer behavior for payment of credit card balances. This example is discussed in more detail in "Splitting a Payment Pattern".

The columns for the payment pattern grid are as follows:

<table>
<thead>
<tr>
<th>Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pmt Term (Payment Term)</td>
<td>The payment term determines what payment characteristics should be available for determining future payment dates. The payment terms are Absolute or Relative.</td>
</tr>
</tbody>
</table>
Defining a Payment Pattern

To define a payment pattern, complete the following steps:

1. Open the payment pattern grid by choosing the Payment Pattern icon on the vertical toolbar, or by selecting User-Defined Payment from the Setup menu.

2. Add a new row by choosing the up arrow in the top left corner of the grid.
   - If this is the first payment pattern, the new row appears beginning with ‘1’.
   - Otherwise, the new row appears at the bottom of the existing list with the next available number.
   - The number next to the arrows in the top left corner controls the number of rows of payment pattern codes displayed.

   **Caution:** When editing the interface to add new pattern codes, avoid typing numbers into the box next to the arrows. For example, if you type in “25” to increase the number of patterns from 24 to 25, you lose many of your patterns. As you initially type in the “2,” patterns 3 - 24 are deleted. When you type in the “5,” rows 3 - 25 are added back in as blank rows.

3. Enter a code and description for the new payment pattern.
   - It must be in the range of 1000 - 29999. If you enter an invalid code, the cell containing the code turns blank and a message displays in the bottom left corner of the screen:
     
     Code value must be greater than 999 and less than 30000

---

**Column Heading** | **Description**
--- | ---
Pmt Type (Payment Type) | The payment type determines the available drivers for defining the payment amount. Each pattern must have a payment type. The payment types are Conventional, Level Principal, and Non-Amortizing.
Percent | The percent value represents the percentage weight of the timeline being defined within the payment pattern.
You cannot enter duplicate values. If you attempt to enter a duplicate code, the cell containing the code is deleted and a message appears at the bottom left corner of the screen:

Duplicated code value

4. Check Split if you are defining a split payment pattern.

If you check the Split box, the columns for Payment Term and Payment Type are disabled.

5. Select the appropriate Payment Term.

If you select Relative, set up the payments using with a numeric term, a multiplier, and the number of payments at this frequency. If you select Absolute, assign a specific month and day for each payment.

You must assign a payment term to each pattern. If you change a pattern from Absolute to Relative, or from Relative to Absolute, the phases of the pattern are deleted.

6. Select the appropriate Payment Type.

7. Set up the payment phases for the payment pattern.

Follow the instructions in "Creating Payment Phases for an Absolute Payment Pattern" or "Creating Payment Phases for a Relative Payment Pattern" to complete the payment phase grid for the appropriate payment pattern.

8. Choose OK to accept the payment pattern and exit, or choose Cancel to exit without saving.

Creating Payment Phases for an Absolute Payment Pattern

To create payment phases for an absolute payment pattern, complete the following steps:

1. Highlight the payment pattern on the payment pattern grid.

   The selected code is designated by an arrow in the leftmost column of the row.

2. Choose Edit Pattern.

   The grid for entering the payment phases appears.

3. Add the required number of rows by selecting the up arrow in the top left corner of the grid.
For Absolute payment patterns, it is only necessary to set up payments for a year. If the term of the instrument is longer than one year, the pattern repeats itself until the maturity date.

4. Select the month for each payment phase.
5. Enter the day for each payment phase.
6. Select the appropriate payment method for each payment phase.
7. Enter the payment amount or percentage amount as appropriate for the selected payment method.
8. Choose OK when you finish entering all payment phases, or Cancel to exit without saving.

When you save, the payment dates are sorted in calendar order. Re-ordering the rows in the grid has no effect on processing because of this sorting arrangement.

When a detail instrument using a relative payment pattern is processed for as-of-date cash flow processing, the next payment date is internally calculated to determine which payment phase should be used. The calculated next payment date is only used for this purpose. The next payment date stored in the instrument table is the date used for any other processing.
Creating Payment Phases for a Relative Payment Pattern

To create payment phases for a relative payment pattern, complete the following steps:

1. Highlight the payment pattern on the payment pattern grid.
   The selected code is designated by an arrow in the leftmost column of the row.
2. Choose Edit Pattern.
   The grid for entering the payment phases appears.
3. Add the required number of rows by selecting the up arrow in the top left corner of the grid.
   Each row represents a payment phase.
4. Enter the frequency for each payment phase.
5. Select the appropriate multiplier for each payment phase.
6. Enter the number of payments at this frequency in the Repeat column for each payment phase.
7. Select the appropriate payment method for each payment phase.
8. Enter the payment amount or percentage amount as appropriate for the selected payment method.
9. Choose OK when you finish entering all payment phases, or Cancel to exit without saving.

Unlike absolute payment patterns, relative patterns can represent multiple payments within a single row of the interface.

It is not necessary to set up the pattern for the complete term of the instrument. The pattern automatically repeats until maturity date. For example, suppose a pattern is created to make monthly payments for the first year and quarterly payments for the next three years. If you apply this pattern to an instrument record with an original term of five years, the pattern wraps around and the fifth year is scheduled for monthly payments.
Defining a Payment Pattern

Splitting a Payment Pattern

To split a payment pattern, complete the following steps:

1. Highlight the payment pattern on the payment pattern grid.
   The selected code is designated by an arrow in the leftmost column of the row.

2. Choose Edit Pattern.
   The Record Split Percent dialog box appears.

3. Add the required number of rows by selecting the up arrow in the top left corner of the grid.
   Each row represents an individual payment pattern for the split pattern.

4. Select the desired Pmt Term for each phase.

5. Select the desired Pmt Type for each phase.

6. Enter the percent apportioned to each phase.
   As new business or detail records are processed, the initial balance must be allocated across the various timelines. To ensure that the sum of all balance allocations equals 100%, the last timeline defaults to the remaining percentage balance.

7. Enter the payment phases for each payment pattern.
   Follow the instructions provided in "Creating Payment Phases for an Absolute Payment Pattern" or "Creating Payment Phases for a Relative Payment Pattern" as appropriate.

8. Choose OK when you finish entering all payment phases, or Cancel to exit without saving.

Note: An easy way to set up patterns for instruments with varying original terms is to use the repeater of 999 in the last row of the pattern. A pattern that pays monthly for the first year and quarterly thereafter, can be set up with two rows. The first row shows 12 payments at one month. The second row shows 999 payments at three months. When this pattern is processed, the pattern repeats the three month payment frequency until the maturity date is reached.
Split Pattern Example

The following model of customer behavior for payment of credit card balances assumes there are three determined behaviors:

- Customers that pay the minimum payment every month (5% in this example)
- Customers that pay the entire balance every month
- Customers that pay the minimum payment every month and pay the entire balance once a year

These customers are represented in the order mentioned. It is also determined that 50% of the credit card customers belong to the first group, 20% belong to the second, and 30% belong to the third. The Split Record grid illustration that follows demonstrates this division.

The first payment pattern in this split is set up as a relative payment pattern and has only one payment phase. This payment phase is set up to schedule a payment of 5% of the balance on a monthly basis.
The second payment pattern is relative as well, and has only one payment phase. However, this payment phase is set up to schedule a payment of 100% of the balance on a monthly basis.

The third payment pattern is defined as an absolute payment pattern with each month scheduled for payments of 5%, except for April. The payment for April is scheduled for 100% payment of the balance.
This split pattern can be assigned to both credit card portfolios by assigning the amortization code in the Leaf Characteristics ID.

**Editing a Payment Pattern**

To edit a payment pattern, complete the following steps:

1. Highlight the desired payment pattern.

   The selected code is designated by an arrow in the leftmost column of the row.

2. Make desired changes.

3. Choose OK to save the changes, or choose Cancel to exit without saving.

You can change anything you want on a payment pattern. However, you should proceed with caution if this pattern has already been used by instruments. Some modifications trigger warnings. For example, the following message appears if you change the code of the payment pattern:

   This Payment Pattern Code may be referred to elsewhere (instrument data, Leaf Characteristics or Transaction Strategies IDs.) You should update all uses of the code or define another pattern for old code. Change code and save all changes to pattern?

   You can select Yes to continue, or No to cancel the change.
Deleting a Payment Pattern

To delete a payment pattern, complete the following steps:

1. Highlight the desired payment pattern in the payment pattern grid.
   The selected code is designated by an arrow in the leftmost column of the row.
2. Choose Delete.
   A message displays asking for verification of this request with the question “Delete selected pattern definition data?” If you want to proceed with the deletion, choose Yes, otherwise choose No.
Deleting a Payment Pattern
The User Defined Repricing Pattern provides a mechanism to control the repricing structure of instruments whose rates change according to complex schedules. The User Defined Repricing feature allows you to define multiple changes to various elements including:

- Rates
- Margins
- Frequency

This chapter describes the structure of a repricing pattern and includes instructions on how to define, edit and delete such a pattern.

Repricing Pattern Structure

There are two parts of a repricing pattern:

- User Defined Repricing Pattern
- User Defined Repricing Event

User Defined Repricing Pattern

The User Defined Repricing Pattern provides you with the ability to define a series of repricing events that describe the interest rate adjustment characteristics over the life of a cash flow instrument. One repricing pattern can be assigned to many cash flow instruments.

There are two types of repricing patterns that you can define: Absolute or Relative. Absolute is date driven where a repricing event occurs on given dates. Relative is a series of repricing events that are driven by user-defined timelines.
The repricing pattern interface is single-user. If you attempt to open the interface when another user has access, you are restricted from access until the other user has closed it.

Repricing Pattern User Interface

The user interface of the repricing pattern is in the form of a grid.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Pattern Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>530 UDR 630</td>
<td>Relative</td>
</tr>
<tr>
<td>2</td>
<td>540 UDR 640</td>
<td>Relative</td>
</tr>
<tr>
<td>3</td>
<td>550 UDR 650 5 - Year Step</td>
<td>Relative</td>
</tr>
<tr>
<td>4</td>
<td>560 UDR 660</td>
<td>Absolute</td>
</tr>
<tr>
<td>5</td>
<td>570 UDR 670</td>
<td>Absolute</td>
</tr>
<tr>
<td>6</td>
<td>590 UDR 680 Varied pattern</td>
<td>Relative</td>
</tr>
<tr>
<td>7</td>
<td>590 UDR 680 3 - month step</td>
<td>Relative</td>
</tr>
<tr>
<td>8</td>
<td>590 UDR 690</td>
<td>Relative</td>
</tr>
<tr>
<td>9</td>
<td>590 UDR 690 3 - month step</td>
<td>Relative</td>
</tr>
<tr>
<td>10</td>
<td>777 3 - Year Step GRM</td>
<td>Relative</td>
</tr>
<tr>
<td>11</td>
<td>751 UDR 751</td>
<td>Relative</td>
</tr>
</tbody>
</table>

The columns are as follows:

- **Code**: The user-defined numeric code for the repricing pattern; valid codes are from 500 to 998
- **Description**: The description of the repricing pattern; can be up to 80 characters in length
- **Pattern Type**: Absolute or Relative

**User Defined Repricing Event**

The events of a repricing pattern define all the changes to the interest rates of the instrument during its life. Every pattern begins with an initial period. The first event describes the behavior for the initial period. The second event describes the
change in behavior after the initial period is over. A third event describes the next change in behavior and so on.

Repricing Event User Interface

The columns on the event grid are determined by the pattern type. You list each event on the Repricing Events grid. Then, you enter the detail for each event in a separate dialog box (see "Event Detail" for more information.) You can define up to 999 events per pattern.

Absolute Pattern  The absolute repricing pattern is used for instruments that are date dependent. Each specific date is a separate event.

You may have up to one year of defined events that repeat for the life of the instrument. For example, you may have a pattern that experiences rate changes at the end of every quarter. In this case, you set up events for March 31, June 30, September 30 and December 31. However, you could not define another event for March 31. If you attempted to add another event for a date already defined, a message appears:

"Duplicate dates not allowed."
**Relative Pattern**  The relative repricing pattern is used for instruments where the repricing is determined by elapsed time since origination. Each defined timeline is a separate event.

The columns are as follows:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>The frequency of the repricing; how often the repricing occurs.</td>
</tr>
<tr>
<td>Multiplier</td>
<td>The unit of time applied to the frequency. The choices are:</td>
</tr>
<tr>
<td></td>
<td>- Days</td>
</tr>
<tr>
<td></td>
<td>- Months</td>
</tr>
<tr>
<td></td>
<td>- Years</td>
</tr>
<tr>
<td>Repeat</td>
<td>The number of times the repricing event should be repeated.</td>
</tr>
</tbody>
</table>
For example, an event can be defined with a frequency of 1, a multiplier of Months, and a repeater of 3. This translates into an event that reprices every month for a duration of 3 months.

You may have a graduated rate mortgage that requires three rate changes over the life of the instrument. You will have three events following the initial event. If you wish the instrument to retain the behavior defined for the last event, the repeater should be set to 999. This prevents "wrapping", or the repetition of all the defined events until the life of the instrument runs out.

**Event Detail**

You define each event with a repricing type of flat rate or indexed rate. These classes determine what characteristics are available when selected. When a characteristic is checked, the appropriate fields are enabled for data entry.

**Flat Rate** Selecting Flat Rate allows you to set the rate of the instrument to a hard value, such as 6%.
When Flat Rate is selected, the available detail characteristics are as follows:

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Rate</td>
<td>The new net rate value to assign</td>
</tr>
<tr>
<td>Gross Rate</td>
<td>The new gross rate value to assign</td>
</tr>
<tr>
<td>Transfer Rate</td>
<td>The new transfer rate to assign</td>
</tr>
</tbody>
</table>

Flat Rate always overrides the caps and floors defined in the instrument record or for new business. Caps and floors for new business (forecast balance and transaction strategy) are defined in Leaf Characteristics.

**Indexed Rate** Selecting Indexed Rate allows you to set the rate of the instrument to an adjustable value, defined as the index rate plus a margin.

When Indexed Rate is selected, the available detail characteristics are as follows:
Defining a Repricing Pattern

To define a repricing pattern, complete the following steps:

1. Enter a code number or advance spinner to next available number for the pattern. Valid codes are between 500 and 998. A new line appears at the bottom of the grid.

2. Type in the description of the pattern.

3. Select the type of pattern.

4. Select the entire pattern by clicking once on the line number and select Edit to create the repricing events for this pattern.

5. Advance spinner to the number of events you are defining for this pattern.

6. Define the events by completing the columns on the grid. The columns are different based on the type of pattern defined.

7. Define the details of each event.
   a. Select the event by clicking once on the line number of the event.
   b. Select Edit and the dialog box for defining the event details appears.

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRC (Interest Rate Code)</td>
<td>Reference interest rate used to determine rates; the list of the interest rate codes is pulled from the current Historical Rates database; used as the index rate to set Gross Rate and Net Rate</td>
</tr>
<tr>
<td>Transfer Rate IRC</td>
<td>Interest rate used to determine transfer rates; used to calculate Transfer Rate</td>
</tr>
<tr>
<td>Net Margin</td>
<td>Added to index rate to get Net Rate</td>
</tr>
<tr>
<td>Gross Margin</td>
<td>Added to index rate to get Gross Rate</td>
</tr>
<tr>
<td>Transfer Margin</td>
<td>Added to index rate to get Transfer Rate</td>
</tr>
<tr>
<td>Rate Cap Life</td>
<td>Maximum for Gross Rate set by this event</td>
</tr>
<tr>
<td>Rate Floor Life</td>
<td>Minimum for Gross Rate set by this event</td>
</tr>
<tr>
<td>Rate Set Lag</td>
<td>Period by which the date of the interest rate used for calculation precedes the event date; set with a value and a multiplier</td>
</tr>
<tr>
<td>Yield Curve Term</td>
<td>Term used in interest rate code lookups; if left blank, defaults to the term until the next repricing; set with a value and multiplier</td>
</tr>
</tbody>
</table>
Editing a Repricing Pattern

To edit a repricing pattern, complete the following steps:

1. Highlight the desired payment pattern by clicking on the row number.

   The selected code is designated by an arrow in the leftmost column of the row.

2. Make desired changes.

3. Choose OK to save the changes, or choose Cancel to exit without saving.

You can change anything you want on a repricing pattern. However, you should proceed with caution if this pattern has already been used by instruments. Some modifications will trigger warnings. For example, the following message appears if you change the code of the repricing pattern:

   This Repricing Pattern Code may be referred to elsewhere (instrument data, Leaf Characteristics or Transaction Strategies IDs.) You should update all uses of the code or define another pattern for the old code. Change code?

   Select Yes to continue, or No to cancel the change.

Deleting a Repricing Pattern

To delete a repricing pattern, complete the following steps:

1. Highlight the desired repricing pattern in the repricing pattern grid by clicking on the row number.

Caution: When editing the interface to add new pattern codes, avoid typing numbers into the spinner. For example, if you try to type in "25" to increase the number of patterns from 24 to 25, you risk losing many of your patterns. As you initially delete the "4," the interface displays a warning message asking you to confirm that you wish to delete rows 3 - 24. If you choose "Yes," all of these patterns are removed.
The selected code is designated by an arrow in the leftmost column of the row.

2. Choose Delete.

A message displays asking for verification of this request with the question “Delete selected pattern definition data?” If you want to proceed with the deletion, choose Yes, otherwise choose No.
Transfer Pricing utilizes a cash flow engine to ensure modeling consistency across OFS applications. This chapter describes the calculations performed by the OFSA cash flow engine.

The understanding of key concepts is vital in forming a complete understanding of the capabilities of the cash flow engine. The following key concepts are defined:

- **Instrument Level Modeling**
- **Modeling Flexibility Defined by Instrument Data**
- **Daily Cash Flows**
- **Event-Driven Logic**
- **Financial Elements**

### Instrument Level Modeling

Several processes within the OFS applications require cash flows in order to produce results, including:

- Transfer Pricing
- Market Valuation
- Income Simulation

OFSA generates cash flows at the individual instrument level. Each individual instrument record processed generates a unique set of cash flows as defined by that instrument record’s product characteristics. This provides an optimum level of accuracy. Cash flows on individual instrument records are used. The cash flows produced are then manipulated to produce the required results.
Modeling Flexibility Defined by Instrument Data

Specific cash flow characteristics defined in an instrument record determine the cash flow results for each instrument. Each instrument record has:

- Payment information (dates, frequencies, amounts)
- Balance information (current balance, original balance)
- Rate information (gross rate, net rate, transfer rate)

There are over 50 cash flow columns that drive the results. Depending on the information in these columns, you can model an unlimited number of unique instruments.

Daily Cash Flows

Cash flows can occur on any date, and with any frequency thereafter. Not only does this provide accurate results, but you also have the ability to change the modeling buckets without having to worry about an impact on the cash flows.

Event-Driven Logic

OFSA generates cash flows as a series of events. On any day, and with any frequency thereafter, depending on the instrument characteristics, any of the following events can occur:

- Payment
- Repricing
- Payment recalculation
- Prepayment

This guide explains the calculations that occur for each event.

Financial Elements

On an event date, OFSA computes the results of that event, the financial elements. For example, on a payment event, it can compute the following:

- Interest
- Principal runoff
Cash Flow Calculation Process

- Total cash flow
- Ending balance

The OFSA cash flow engine generates over 50 financial elements that can be used in analysis.

Conventions Used in This Chapter

As a cash flow instrument is modeled through time, the data associated with this instrument changes due to payments, repricings, or other circumstances. These changes apply only in memory and do not affect the information stored in the instrument tables.

A subscript notation of \([m]\) for memory and \([r]\) for detail record differentiates between the forecasted data and the actual data. For example, current payment\(_r\) refers to the current payment stored in the instrument table. Current payment\(_m\) refers to the current payment in memory that is updated each time a payment recalculation occurs.

Cash Flow Calculation Process

The following steps summarize the cash flow calculation process:

1. Initialize modeling data and parameters for instrument to be modeled.
2. Process modeling event(s) until current date equals the maturity date or the modeling end date, or the current balance equals zero:
   - Calculate changes to underlying instrument
   - Calculate financial elements associated with event
   - Increment forward event dates
3. Generate secondary results:
   - Deferred amortization recognition
   - Market values
   - Duration
   - Gap
4. Accumulate daily information into appropriate time buckets.
Initialization of Data

The first step in the process is to gather the information necessary to model the current instrument. This information is available from several sources, including:

- The instrument table
- Schedule table
- The active Configuration ID
- Payment Pattern interface
- The IDs specified in the Process ID

Determine Account Type of Instrument

Account types classify instruments by their use in financial statements and determine how the cash flow engine processes an individual instrument. The Common COA ID value determines the account type of an individual record. The Leaf Setup interface classifies each Common COA ID leaf as an account type. Based on these account types, there are five categories of cash flow processing, as shown in the following table.

<table>
<thead>
<tr>
<th>Cash Flow Category</th>
<th>Process Description - Detail</th>
<th>Process Description - New Business</th>
<th>Associated Account Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail cash flow</td>
<td>Process daily cash flow events and generate necessary financial elements.</td>
<td>Process daily cash flow events and generate necessary financial elements.</td>
<td>Interest-Earning Asset</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Interest-bearing Liability</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Off Balance Sheet</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Receivable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Off Balance Sheet Payable</td>
</tr>
<tr>
<td>Balance Only</td>
<td>Process the record originating on the origination date and running off on the maturity date.</td>
<td>Show ending balances equal to the forecasted amounts in each bucket.</td>
<td>Other Asset Other Liability</td>
</tr>
<tr>
<td>Interest Only</td>
<td>Process the instrument as a single interest payment covering the time from the origination date to the maturity date. Recognize the current balance as an interest cash flow on the maturity date, but accrue interest from the origination date to the maturity date.</td>
<td>Show interest cash flows/accruals equal to forecasted amounts in each bucket.</td>
<td>Interest Income</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Interest Expense</td>
</tr>
</tbody>
</table>
Cash Flow Calculation Process

Data retrieved from the interface impacts how an instrument is processed. There are three pieces of interface data that affect processing:

- **Interest Credited**
- **Rate Compounding Basis**
- **User Defined Payment Patterns**
- **User Defined Repricing Patterns**

**Interest Credited**

The interest credited switch resides in the Leaf Characteristics ID used by the Oracle Risk Manager application. The switch can be enabled for any leaf. However, it only affects the cash flows of Simple/Non-Amortizing instruments.

When the switch is enabled for a non-amortizing instrument, interest cash flows are added to the principal balance at each payment prior to maturity. On the maturity date, the initial principal balance plus the accumulated interest cash flows are reflected as principal runoff at maturity. When the switch is enabled for amortizing instruments, it is ignored by the cash flow engine.

<table>
<thead>
<tr>
<th>Cash Flow Category</th>
<th>Process Description - Detail</th>
<th>Process Description - New Business</th>
<th>Associated Account Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Interest Only</td>
<td>Process the instrument as a single non-interest payment covering the time from the origination date to the maturity date. Recognize the current balance as a non-interest cash flow on the maturity date.</td>
<td>Show non-interest financial elements equal to forecasted amounts in each bucket.</td>
<td>Non-Interest Income Non-Interest Expense</td>
</tr>
<tr>
<td>Special Autobalancing</td>
<td>Detail information is only used to update the current position.</td>
<td>Generate results as needed during the autobalancing process if account is specified as autobalancing account.</td>
<td>Taxes Dividends</td>
</tr>
</tbody>
</table>

**Note:** See the Financial Element Calculations table for more information about financial element output by account type.
Rate Compounding Basis
Rate Compounding Basis is defined in the Configuration ID used by both the Risk Manager and Transfer Pricing applications. The rate compounding basis defines how rates are quoted in the database. Rates can be quoted on an annual basis or on a semiannual compounding basis.

If you choose the Semi-Annual compounding option, all rates used by the system are adjusted appropriately for internal calculations. The formula to make this adjustment is as follows, for a payment frequency specified in months:

\[
\text{Annual Rate} = \left(1 + \frac{\text{rate}}{2}\right)^{\left(\frac{\text{payment frequency}}{12} \times 2\right)} - 1 \times \left(\frac{12}{\text{payment frequency}}\right)
\]

User Defined Payment Patterns
Payment pattern data is retrieved when the cash flow engine must process an instrument with an amortization code in the payment pattern range from 1000 to 29999. The amortization code from the detail instrument record is matched to the set of pattern data with the same code. If no match is found to the amortization code from the detail record, the record is processed as a non-amortizing instrument.

User Defined Repricing Pattern
Repricing pattern data is retrieved when the cash flow engine must process an instrument with an adjustable type code in the repricing pattern range from 500 to 998. If no match is made, the engine defaults to the record characteristics in the repricing frequency column and processes the instrument as a standard adjustable instrument.

When a match is made, the instrument is modeled based on the repricing pattern. The cash flow engine first evaluates what the status of the instrument is as of the starting date of the cash flow process. The current repricing date is determined by rolling forward from the origination date to the next repricing date that follows the process start date. If that date does not correspond to the next repricing date, the repricing date from the record is used.

A repricing event is triggered when the period of time between events has elapsed. When this occurs, the defined rates are assigned to the detail record of the instrument. If the repricing type is Flat Rate, the rate from the event detail of the repricing pattern is applied to the detail record of the instrument. If the repricing type is Indexed Rate, a rate lookup is triggered for the customer rate and the transfer pricing rate. If the interest rate code (IRC) is a yield curve, the point on the yield curve used is the repricing term associated with the current repricing information, unless the IRC term has been specified in the repricing pattern event.
This rate, plus the specified margin, is the new fully indexed rate. Rate caps and floors are applied after this calculation occurs.

**Initialize Cash Flow Data**

The cash flow engine gathers cash flow data for the instrument to be processed, representing a subset of the information stored in the instrument tables for this record. The Detail Cash Flow Data Table lists the columns referenced in this process.

Cash flow data provides current information about the characteristics of a cash flow instrument. This information must be consistent to ensure consistent output. Prior to processing cash flows, cash flow edit checks should be run to avoid producing unreasonable results.

Cash flow data can be classified into categories defining its use during the processing of an event:

- **Static characteristics**
- **Dynamic characteristics**
- **Triggers**

**Static Characteristics**

Static characteristics provide information to the cash flow engine about how the instrument should be modeled. For non-pattern and non-schedule instruments, all of the following characteristics remain constant during the modeling process.

- **Event frequencies**
  - Repricing
  - Payment
  - Payment change
- **Financial code values**
  - Accrual basis code
  - Amortization type code
  - Rate change round code
- **Leaf values**
  - Product leaf
  - Common COA ID
- **Repricing parameters**
  - Margin
  - Rate caps
  - Rate increase period
  - Rate change minimum

For pattern and schedule instruments, the payment frequency can vary throughout the life of the instrument.

**Dynamic Characteristics**
Dynamic characteristics are updated each time an event occurs, as a result of what has occurred during the event. They include:

- **Balances**
  - Current
  - Current deferred

- **Rates**
  - Current net
  - Current gross
  - Current transfer

- **Event counters** (remaining number of payments)

**Triggers**
Triggers signal the cash flow engine, indicating it is time to model a particular event and can therefore change their value during the modeling horizon:

- Event dates
  - Next payment
  - Next reprice
  - Payment change

- Negative Amortization balance in conjunction with neg-am limit
Initializing Schedule Records

Processing of scheduled amortization instruments requires gathering additional data from the PAYMENT_SCHEDULE table. An amortization code of 800, 801, or 802 signals to the cash flow engine that this instrument record is a schedule record. To properly model schedule instruments, the cash flow engine must retrieve payment dates and payment amounts from the Schedule table. A match is made between the ID number and Instrument type code from the instrument record to the same data in the Schedule table. If no match is found, the instrument is processed as a non-amortizing record.

Amortization Code 800

The different schedule amortization codes relay to the cash flow engine what type of payment is stored in the schedule table. An amortization code of “800” signifies that payment amounts are principal and interest amounts. On payment dates, these payments are processed as conventional amortization payments.

Amortization Code 801

An amortization code of “801” is used for level principal payment schedules. On the schedules for these instruments, the payment amount represents the principal portion of the payment only. For 800 and 801 schedules, the payment amounts should be expressed gross of any participations.

Amortization Code 802

Instruments with amortization codes of “802” do not reference the payment amount column in the schedule tables. These instruments are processed as interest only records, with all principal, with the exception of prepayments, running off on the maturity date.

The data in the maturity date, next payment date, last payment date, remaining number of payments, and current payment columns from the instrument record should coincide with the same information in the schedule table. When this information is inconsistent, the information in the detail record supersedes the data in the schedule table.

In this case, the payment on the next payment date occurs on the date defined in the next payment date column of the instrument record, for the amount defined in the current payment column of the instrument record.

All payments after this date and prior to the maturity date are made according to the payment date in the schedule table. On the maturity date, the date from the
maturity date column of the instrument record is used to pay off the remaining balance of the instrument record. If payment dates exist in the schedule beyond this date, they are ignored.

**Initializing Pattern Records**

The following logic applies to both User Defined Payment Patterns and User Defined Repricing Patterns. Applicability to repricing is indicated in parenthesis.

**Single Timeline Patterns**

To initialize an instrument record whose payment (or repricing) characteristics are defined by a single timeline pattern, the cash flow engine must synchronize the detail instrument record with the payment (or repricing) pattern. Synchronization determines the current payment of the instrument within the payment (or repricing) pattern.

The synchronization process depends on whether the pattern is relative or absolute. To synchronize a relative pattern, the cash flow engine calculates the payment (or repricing) dates for the instrument record by rolling the origination date forward by the pattern frequencies. Once it calculates a payment (or repricing) date greater than the as-of-date, it stops. The number of times it was necessary to roll the date forward determines the current payment (or repricing event) number for the record.

**Example**

An instrument record processed on an as-of-date of 03/31/1996 with an origination date of 01/01/1996, and a next payment (or repricing) date of 05/15/1996 is matched to the following pattern:

<table>
<thead>
<tr>
<th>Row #</th>
<th>Frequency</th>
<th>Repetitions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1 M</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>3 M</td>
<td>3</td>
</tr>
</tbody>
</table>

The origination date is rolled forward in the following manner:

- Starting point -- 01/01/1996
  - Add first monthly payment (or repricing) frequency -- 02/01/1996
  - Add second monthly payment (or repricing) frequency -- 03/01/1996
  - Add third monthly payment (or repricing) frequency -- 04/01/1996
After the third roll forward, the payment (or repricing) date is greater than the as-of-date. The cash flow engine interprets that the record is on its third payment (or repricing), which is the final monthly payment (or repricing). It models this payment (or repricing) on the next payment (or repricing) date from the detail record, in this case, 05/15/1996. The next payment (or repricing) is scheduled for 8/15/1996, using the three month frequency from the fourth payment (or repricing) in the schedule.

Absolute patterns do not require the same rolling mechanism for synchronization. The next payment (or repricing) date from an absolute pattern is determined by the first month and day after the as-of-date. If this date does not correspond to the next payment (or repricing) date from the detail record, the next payment (or repricing) date of the detail record supersedes the date of the pattern. From that point on in the process, the payment (or repricing) dates from the pattern are used.

The cash flow engine has been designed in this manner to allow greater flexibility in modeling payment and repricing patterns. However, this flexibility increases the importance of detail data accuracy to ensure that when discrepancies exist between detail data and patterns, the differences are intended.

**Multiple Timeline Patterns (Payment Patterns Only)**

To initialize a detail instrument record tied to a split pattern, the cash flow engine must generate a separate record for each split. The current balance for each split record is calculated using the percentage apportioned to that split, as defined through the payment pattern interface. The original balance, original payment, and current payment columns are also apportioned according to the percent defined through the interface.

For each timeline resulting from the split of a detail instrument record, the current payment date must be determined. The method for determining the payment date is the same as described for single timeline patterns with one exception. For these instruments, the next payment date from the original instrument record does not override the calculated next payment date. The date derived from rolling the origination date forward for relative timelines or locating the next date for absolute timeliness is assumed to be the correct payment date.

**Modeling Start and End Dates**

Modeling start and end dates are determined by the type of processing (Risk Manager or Transfer Pricing) and the instrument being processed, as shown in the following table:
Cash Flow Calculation Process

Only records that have a value in the As of Date column of the database equal to the as of date in the active Configuration ID are processed.

Additionally Derived Data

Initialization of Adjustable Rate Instruments for Transfer Pricing

For transfer pricing of adjustable rate instruments, data is reset to values consistent with the last reprice date. The next payment date is rolled back by the payment frequency to the first payment date after the last reprice date. The remaining number of payments is increased by the number of payments added in the rollback process.

The field Last Reprice Date Balance is used in place of the current balance in a transfer pricing process. If the balance as of the last reprice date is not available, update this column with the current balance. The transfer pricing program has a special feature that re-amortizes the current payment if the following conditions are met:

- The last reprice date equals the current balance
- Payments occur between the last reprice date and the as-of-date
- The instrument is not tied to an amortization pattern or an amortization schedule

These three conditions signal to the transfer pricing engine that the balance as of the last reprice date was not available and the current balance should be used as a proxy.
### Percent Sold Adjustment

Balances must be adjusted for participations:

- Current net balance = current par balance \( \times (100 - \text{percent sold}) \)
- Current payment net = current payment \( \times (100 - \text{percent sold}) \)
- Original net balance = original par balance \( \times (100 - \text{percent sold}) \)
- Last reprice balance net = last reprice balance \( \times (100 - \text{percent sold}) \)
- Original payment net = original payment \( \times (100 - \text{percent sold}) \)

### Process Modeling Events

There are four events modeled in the cash flow engine:

- Payment
- Payment change
- Reprice
- Prepayment

When multiple events occur on the same day the order of processing is as follows:

**Interest in Arrears**

1. Payment calculation
2. Payment
3. Prepayment
4. Reprice

**Interest in Advance**

1. Reprice
2. Payment
3. Prepayment

For interest in advance instruments, payment calculation is not applicable. Payment calculation only occurs on conventionally amortizing instruments.

Processing of an event includes these steps:

- Dynamic information is updated
Financial elements summarizing the event is generated
- Event dates are incremented to the next event date

## Payment Calculation Event

Cash flow data characteristics are:

### Static Information - Conventional Adjustable and Payment Patterns
- Current gross rate
- Current par balance
- Amortization term and multiplier
- Amortization type
- Adjustable Type Code
- Compounding Basis Code

### Additional Information - Adjustable Neg-Am:
- Payment increase cycle
- Payment increase life
- Payment decrease cycle
- Payment decrease life
- Payment change frequency and multiplier
- NGAM Equalization frequency and multiplier
- Original payment amount
- Dynamic Information
- Current payment

### Event Trigger - Transfer Pricing
- Cash flow transfer pricing of an Adjustable instrument

### Event Triggers - Conventional Adjustable and Conventional Payment Patterns
- Reprice Event
Event Triggers - Adjustable Neg Am
- Next payment change date
- NGAM balance > NGAM limit
- NGAM Equalization date

Payment Calculation Steps

Step One: Calculate New Current Payment
Conventionally Amortizing Payment =

\[
\frac{1}{\text{Current Rate}_C} \times \left( 1 + \frac{\text{Current Rate}_C}{\text{rem pmts}_a} \right)^{\text{rem pmts}_a} - 1
\]

where \(\text{Current Rate}_C\) = Current compounded customer rate per payment.
\(\text{rem pmts}_a\) = remaining number of payments based on amortization
\(\text{Current Par Balance}_m\) = current balance at time of payment recalculation

For conventional schedules that reprice, payment recalculation does not occur. For patterns which reprice, payment recalculation does not occur during the repricing event. For these instruments, the payment is calculated at the time of payment. See the Payment Event section for more details.

Current Compounded Customer Rate per Payment
The customer rate must be adjusted to a rate per payment. If no compounding occurs, the rate can be divided by the payments per year.

Example: Current customer rate is 7.5%.

<table>
<thead>
<tr>
<th>Payment Frequency</th>
<th>Calculation</th>
<th>Rate per Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>monthly</td>
<td>7.5 ÷ 12</td>
<td>0.625</td>
</tr>
<tr>
<td>quarterly</td>
<td>7.5 ÷ 4</td>
<td>1.875</td>
</tr>
<tr>
<td>yearly</td>
<td>7.5 ÷ 1</td>
<td>7.5</td>
</tr>
</tbody>
</table>
Cash Flow Calculation Process

If the instrument compounds, the rate must be adjusted for compounding. For monthly rates that compound daily, an average number of days assumption of 30.412 is used.

**Remaining Number of Payments Based on Amortization**

If the amortization term is equal to the original term, then the remaining number of payments is used.

If the amortization term <> original term, the remaining number of amortized payments are calculated by adding the amortization term to the origination date to determine the amortization end date. The remaining number of payments are calculated by determining how many payments can be made from and including the next payment date and this date.

The remaining number of payments is calculated for patterns based on the payment frequency at the time of repricing. As with conventional instruments, the amortization end date is used for payment recalculation. The remaining term is calculating using the difference between this date and the next payment date. This term is divided by the active payment frequency and one additional payment is added to it for the payment on the next payment date.

**Step Two: Apply Periodic Payment Change Limits**

Periodic payment change limits restrict the amount the payment can increase over its previous value. These limits are only applied when the payment recalculation is triggered by a payment adjustment date or a negative amortization limit. Because of these limits, principal may continue to negatively amortize when the negative amortization limit has been reached.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Increasing Payment</th>
<th>Decreasing Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Newly Calculated Payment &gt; (1 + (Payment Increase Life_r / 100)) * Original Payment_r</td>
<td>Newly Calculated Payment &lt; (1 + (Payment Decrease Life_r / 100)) * Original Payment_r</td>
</tr>
<tr>
<td>Adjustment if True</td>
<td>Current Payment&lt;sub&gt;m&lt;/sub&gt; = (1 + (Payment Increase Life_r / 100)) * Original Payment_r</td>
<td>Current Payment&lt;sub&gt;m&lt;/sub&gt; = (1 + (Payment Decrease Life_r / 100)) * Original Payment_r</td>
</tr>
</tbody>
</table>
**Step Three: Apply Lifetime Payment Change Limits**

Lifetime payment caps and floor set a maximum and a minimum amount for the payment. These limits are only applied when the payment recalculation is triggered by a payment adjustment date or a negative amortization limit. Because of these limits, principal may continue to negatively amortize when the negative amortization limit has been reached.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Increasing Payment</th>
<th>Decreasing Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newly Calculated Payment &gt; (1 + (Payment Increase Life, /100)) * Original Payment</td>
<td>Newly Calculated Payment &lt; (1 + (Payment Decrease Life, /100)) * Original Payment</td>
<td></td>
</tr>
<tr>
<td>Adjustment if True</td>
<td>Current Payment&lt;sub&gt;m&lt;/sub&gt; = (1 + (Payment Increase Life, /100)) * Original Payment&lt;sub&gt;r&lt;/sub&gt;</td>
<td>Current Payment&lt;sub&gt;m&lt;/sub&gt; = (1 + (Payment Decrease Life, /100)) * Original Payment&lt;sub&gt;r&lt;/sub&gt;</td>
</tr>
</tbody>
</table>

**Step Four: NGAM Equalization**

If the payment recalculation is triggered by a NGAM equalization date, payment change limits do not apply. If the newly calculated payment is greater than the lifetime payment cap or less than the lifetime payment floor, the appropriate lifetime payment limit (cap/floor) is set equal to the newly calculated payment.

**Step Five: Update Current Payment Field**

Once all payment limits have been applied, the new current payment is updated in memory for processing of future events.

**Payment Event**

Cash flow data characteristics are:

- **Static Information**
- **Dynamic Information**
- **Event Triggers**
- **Additional Assumption Information**

**Static Information**

- Amortization type
- Current Payment
Cash Flow Calculation Process

- Accrual Basis code
- Current gross rate
- Current net rate
- Current transfer rate
- Origination Date
- Payment Frequency and multiplier
- Interest Type
- Compounding Basis Code
- Last Payment Date

Dynamic Information
- Current Par Balance
- Remaining Number of Payments
- NGAM Balance

Event Triggers
- Next Payment Date
- Maturity Date

Additional Assumption Information
- Interest credited switch
- Compounding Method

Payment Event Steps

The following are descriptions of the Payment Event Steps:

1. Calculate interest cash flow(s).

   The amount of interest to be paid on a payment date is calculated as follows:

<table>
<thead>
<tr>
<th>Interest Cash Flow</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interest cash flow gross</td>
<td>Current net par balance * gross rate per payment</td>
</tr>
</tbody>
</table>
Cash Flow Calculation Process

**Rate per Payment -- Accrual Adjustment**

The annual coupon rate must be adjusted to a rate per payment. The accrual basis code defines how this adjustment should be made.

**Accrual Factor Codes**

Example: rate per payment for a June 30 payment (annual rate = 6.0%, payment frequency = 3 months)

<table>
<thead>
<tr>
<th>Accrual Basis Code</th>
<th>Payment Adjustment</th>
<th>Rate per Payment</th>
</tr>
</thead>
<tbody>
<tr>
<td>30/360</td>
<td>(3*30)/360 * 6.0</td>
<td>1.500%</td>
</tr>
<tr>
<td>30/365</td>
<td>(3*30)/365 * 6.0</td>
<td>1.4795%</td>
</tr>
<tr>
<td>30/Actual</td>
<td>90/365 * 6.0</td>
<td>1.4795%</td>
</tr>
<tr>
<td>Actual/Actual</td>
<td>(30+31+30)/365 * 6.0</td>
<td>1.4959%</td>
</tr>
<tr>
<td>Actual/365</td>
<td>(30+31+30)/365 * 6.0</td>
<td>1.4959%</td>
</tr>
<tr>
<td>Actual/360</td>
<td>(30+31+30)/360 * 6.0</td>
<td>1.5167%</td>
</tr>
</tbody>
</table>

This formula assumes a single rate per payment period. If an instrument reprices multiple times within a payment period, only the last repricing event affects the interest cash flow.

**Rate per Payment -- Compounding Adjustment**

Compounding is applied to the rate used in interest calculation if the compounding frequency is less than the payment frequency. The compounding formula that is applied to the current rate is as follows:

Interest cash flow net = Current net par balance * net rate per payment
Interest cash flow transfer rate = Current net par balance * t-rate per payment

---

**Note:** Rule of 78's Exception: The Rule of 78's loans have a pre-computed interest schedule.
Rate per Payment - Stub and Extended Payment Adjustment

An adjustment may be made if the expected days in the payment are different than the actual days in the payment.

The number of days between the next payment date and the last payment date is compared to the payment frequency, specified in days. The payment frequency specified in days depends on the month the payment occurs. If these numbers are not equal, the interest cash flow is adjusted by the ratio (next payment date - last payment date) / payment frequency in days.

On the last payment processed in the modeling horizon, the number of days between the maturity date and the last payment prior to the maturity date is compared to the payment frequency specified in days. The payment frequency specified in days depends on the month in which the maturity date occurs. If these numbers are not equal, the interest cash flow is adjusted by the ratio (maturity date - last payment date) / payment frequency in days.

2. Calculate current payment for patterns and schedules.

For amortization patterns, the payment amount can be defined independently for each payment date. Therefore, on each payment, the payment amount must be calculated according to the characteristics defined for that date. Payment amounts can be driven by several different factors. These following factors are each explained:

Percent of Original Payment

Oracle Risk Manager

On the first modeled payment on a detail instrument record, the amount in the current payment column is assumed to accurately represent the payment amount as of the next payment date. If this instrument record is
partially sold, the current payment is multiplied by (100- percent sold) to get the net payment amount.

If this is the first payment made by a new business record, the payment amount is calculated using the original balance, original rate, and original number of payments. The original number of payments is calculated by using the amortization term, as specified through the Maturity Strategies ID or Transaction Strategies ID, and the original payment frequency.

On subsequent payment dates, OFSA calculates the amount paid by multiplying the pattern percent by the amount in the original payment amount column, adjusted for percent sold, if applicable. The pattern percent is the percent of original payment specified in the interface for that payment.

Oracle Transfer Pricing

For standard transfer pricing, the model calculates the payment amount for each payment that falls between the last reprice date and the next reprice date (adjustable rate instruments) or between the origination date and maturity date (fixed rate instruments) by using the original payment from the instrument record, and applying the pattern percent from the interface.

For remaining term transfer pricing, the model calculates the payment amount in the same manner as described above for Oracle Risk Manager.

Percent of Current Payment

Oracle Risk Manager and Oracle Transfer Pricing

On the payment date, OFSA determines the amount to be paid by first calculating a new payment according to the “active” characteristics, including the current balance, current rate, current payment frequency, and calculated remaining number of payments. The remaining number of payments is calculated by determining the amount of time remaining in the amortization term and dividing this term by the current payment frequency.

After the payment has been calculated, the pattern percent is applied.

Percent of Current Balance

Oracle Risk Manager

Percent of Current Balance is only applicable for Level Principal payment patterns. On the first modeled payment, the amount in the current payment
column is assumed to accurately represent the payment amount as of the next payment date. If the instrument is partially sold, the amount should be multiplied by (100 - percent sold) to get the net payment amount.

For all subsequent payments, the payment amount should be calculated at the time of payment by multiplying the outstanding balance by the pattern percent.

- **Oracle Transfer Pricing**

Calculations for Oracle Transfer Pricing works similarly to Oracle Risk Manager. However, for fixed rate instruments, modeling begins at the origination date, using the original balance. For adjustable rate instruments, modeling begins at the last reprice date, using the last reprice date balance.

### Percent of Original Balance

- **Oracle Risk Manager and Oracle Transfer Pricing**

Percent of Original Balance is only applicable for Level Principal payment patterns. On the first modeled payment, the amount in the current payment column is assumed to accurately represent the payment amount as of the next payment date. If the instrument is partially sold, the amount should be multiplied by (100 - percent sold) to get the net payment amount.

For all subsequent payments, the payment amount should be calculated at the time of payment by multiplying the original balance, net of participations, by the pattern percent.

### Absolute Value

- **Oracle Risk Manager**

Absolute value is only available for detail instruments; it cannot be used for new business instruments. On the first modeled payment, the amount in the current payment column is assumed to accurately represent the payment amount as of the next payment date. If the instrument is partially sold, the amount should be multiplied by (100 - percent sold) to get the net payment amount.

For all subsequent payments, the absolute value amount from the pattern is used. If the instrument has a percent sold, the percent sold is applied to the absolute payment amount.

- **Oracle Transfer Pricing**
For standard transfer pricing, the absolute payment amount is used, adjusted for the participation percent.

**Interest Only**

- Oracle Risk Manager and Oracle Transfer Pricing
  
  On all interest only payments, the payment amount is calculated as the interest due on that date. No reference is made to the current payment column from the detail instrument record. Any payments in the current payment column are ignored.

3. Calculate principal runoff.

Principal runoff is a function of the amortization type of the instrument and the current payment. The current payment on a conventionally amortizing record represents the total P&I payment, while the current payment on a level principal record represents the principal portion of the total payment.

**Simple Amortization (code = 700, 802, and any Non-Amortizing Pattern Codes)**

- General case: Principal Runoff = 0
- Interest Credited: -1 * interest cash flow gross

**Conventional Amortization (code = 100, 500, 600, 800, and any conventionally amortizing pattern codes)**

- Principal Runoff = current payment, - interest cash flow gross

**Level Principal Amortization (code = 820, 801, and any level principal amortizing pattern codes)**

- Principal Runoff = current payment,

**Rule of 78’s (code = 710)**

- Principal Runoff = current payment, - interest cash flow gross

4. Special negative amortization check.

If principal runoff is negative and the instrument record is adjustable neg-am, then additional checks must be made to ensure that the record is not exceeding neg-am limits. The check that is made is the following:

-1 * principal runoff + neg am balance, > neg am limit, /100 * original balance,
If this condition is true, the payment is not made. The payment is recalculated (see payment calculation event). After the new payment has been calculated, the scheduled principal runoff is recalculated, based on the new payment information.

5. Maturity date case.

If the payment date is also the maturity date, then the remaining balance must be paid off.

\[
\text{Principal At Maturity} = \text{Current Balance}_n - \text{Scheduled Principal Runoff}
\]


The current balance must be updated to reflect the principal portion of the payments and any interest credited.

\[
\text{Current Balance}_n = \text{Current Balance}_n - \text{Principal Runoff} - \text{Principal At Maturity} + \text{Interest Credited}
\]

7. Update remaining number of payments.

After a payment has been made, the underlying information must be updated in preparation for the next event.

The remaining number of payments is reduced by 1. If remaining number of payments is zero, the modeling for this instrument is complete.

\[
\text{Remaining Payments}_n = \text{Remaining Payments}_n - 1
\]

8. Update next payment date.

For standard amortization instruments, the next payment date is set equal to the current payment date plus the payment frequency.

\[
\text{Next payment date}_n = \text{Current payment date} + \text{payment frequency}
\]

If instrument is an amortization schedule, the next payment date is determined from the dates in the schedule table.

If the instrument is an amortization pattern, the next payment date is determined by incrementing the current payment date by the current payment frequency for relative patterns. For absolute patterns, the next payment date is determined by the next consecutive date in the pattern.

If the remaining number of payments is equal to 1, or the next payment date is greater than the maturity date, the next payment date is set equal to the maturity date.
Interest in Advance Calculations

The following steps are applicable to interest in advance records only. Interest in advance instruments make their first payment on the origination date. The last payment, on the maturity date, is a principal only payment.

1. Determine new current payment on schedules and patterns.
   
   Current payment is calculated as described in Step 2 above.

2. Calculate principal runoff.
   
   For interest in advance records, the principal runoff occurs before the interest cash flow is calculated. Because conventionally amortizing instruments cannot have interest in advance characteristics, amortizing interest in advance instruments are always level principal. Therefore, the principal runoff equals the current payment amount.

   For the payment on the maturity date, all remaining principal is also paid off.

   
   Prior to calculating the interest cash flow, the current balance must be updated for the amount of principal runoff. If the payment is the maturity date, the balance is set to zero, and no further calculations are necessary.

4. Calculate interest cash flow.
   
   If the payment date is not the maturity date, an interest cash flow is made. The interest cash flow calculation for interest in advance instruments is similar to the interest in arrears calculation. The calculation differs in the count for number of days. Rather than counting from the last payment date to the current payment date, the number of days is counted from the current payment date to the next payment date.

5. Update remaining number of payments.
   
   After a payment has been made, the underlying data must be updated in preparation for the next event. The remaining number of payments is reduced by 1.

6. Update next payment date.
   
   For standard amortization instruments, the next payment date is set equal to the current payment date plus the payment frequency.

   \[ \text{Next payment date}_m = \text{Current payment date} + \text{payment frequency} \]
If the instrument is an amortization schedule, the next payment date is determined from the dates in the schedule table.

If the instrument is an amortization pattern, the next payment date is determined by incrementing the current payment date by the current payment frequency for relative patterns. For absolute patterns, the next payment date is determined by the next consecutive date in the pattern.

If the remaining number of payments is equal to 1, or the next payment date is greater than the maturity date, the next payment date is set equal to the maturity date.

**Prepayment Event**

Cash flow data characteristics are:

**Static Information**
- Current gross rate
- Current net rate
- Payment frequency and multiplier
- Origination date
- Original Term
- Next Reprice Date
- Reprice Frequency
- Maturity Date

**Dynamic Information**
- Current Par Balance
- Current Payment

**Additional Assumption Information**
- Prepayment Assumption ID
- Prepayment Table ID
- Forecast Rates ID
Event Trigger

- Next Payment Date

Prepayment Event Steps

Perform the following in order to execute prepayment event steps:

1. Update value of prepayment dimensions.

   Depending on the prepayment assumptions for the product leaf, values for the prepayment dimensions may need to be updated. The prepayment assumptions for the product leaf are defined in a Prepayment ID, which is then selected for the current processing run.

   If the prepayment method is Constant Rate, these updates are not necessary. If the prepayment method is Arctangent, only the rate ratio is necessary to calculate. For Prepayment Table method, the required updates depend on the dimension within the table for the proper origination date range.

   Listed below are all possible prepayment dimensions and their calculations:

- **Market Rate**

  The market rate is selected per product within the Prepayment ID. You must choose an IRC from the list of IRCs contained in the active Historical Rates database. The chosen IRC provides the base value for the market rate.

  Additionally, you must specify the term point you want to use for IRCs which are yield curves. There are three possible methods for you to select:

  - **Original Term**

    The calculation retrieves the forecasted rate from the term point equaling the original term on the instrument.

  - **Reprice Frequency**

    The calculation retrieves the forecasted rate from the term point equaling the reprice frequency of the instrument. If the instrument is fixed rate and, therefore, does not have a reprice frequency, the calculation retrieves the forecasted rate associated with the term point equaling the original term on the instrument.

  - **Remaining Term**
The calculation retrieves the forecasted rate from the term point equaling the remaining term of the instrument. See the description of the remaining term calculation listed below for more details.

The market rate is determined by retrieving the proper forecasted rate and adding the user-input spread.

\[
\text{Market Rate} = f(\text{Current Date, IRC, yield curve term}) + \text{spread}
\]

**Coupon Rate**

The coupon rate is the current gross rate of the instrument record (as of the current date in the forecast).

**Rate Difference**

The rate difference is the spread between the coupon rate and the market rate. Prior to calculating this dimension, the market rate must be retrieved.

\[
\text{Rate Difference} = \text{Coupon Rate} - \text{Market Rate}
\]

**Rate Ratio**

The rate ratio is the proportional difference between the coupon rate and the market rate. Prior to calculating this dimension, the market rate must be retrieved.

\[
\text{Rate Ratio} = \frac{\text{Coupon Rate}}{\text{Market Rate}}
\]

**Original Term**

The original term is retrieved from the original term of the instrument. If the original term is expressed in months, no translation is necessary. Otherwise, the following calculations are applied:

\[
\text{Original Term}_{\text{months}} = \text{ROUND}((\text{Original Term}_{\text{days}})/30.412)
\]

\[
\text{Original Term}_{\text{months}} = \text{Original Term}_{\text{years}} \times 12
\]

**Reprice Frequency**

The value for reprice frequency depends on the adjustable type code and the tease characteristics of the instrument data.

- **Fixed Rate**

If the instrument is fixed rate, as designated by an adjustable type code = fixed (code value = “0”), the original term, as defined above, is used as the reprice frequency.

\[
\text{Reprice Frequency} = \text{Original Term (months)}
\]
Non-Tease Floating

If the adjustable type of the instrument is floating (code value of “30” or “50” and not in a tease period), the reprice frequency is assumed to be one day, which when rounded to a month value, becomes 0 months.

Reprice Frequency = 0 months

Non-Tease Adjustable

If the adjustable type of the instrument is adjustable (code value of “250”) and not in a tease period, the reprice frequency columns is used. All cases where terms are not expressed in months should be translated into months, calculated as follows:

\[ \text{Reprice Frequency}_{\text{months}} = \text{Reprice Frequency}_{\text{years}} \times 12 \]

\[ \text{Reprice Frequency}_{\text{months}} = \text{Round} \left( \frac{\text{Reprice Frequency}_{\text{days}}}{30.412} \right) \]

Teased Loans

The tease period is identified by a tease end date > current date. The reprice frequency during the tease period is calculated as follows, rounded to the nearest whole number of months.

\[ \text{Reprice Frequency} = \text{ROUND}((\text{Tease End Date} - \text{Origination Date}) / 30.412) \]

Remaining Term

The remaining term value represents the remaining number of months until maturity. The value is rounded to the nearest whole number of months.

\[ \text{Remaining Term} = \text{ROUND}((\text{Maturity Date} - \text{Current Date}) / 30.412) \]

Expired Term (Age)

The expired term represents the age of the instrument. It represents the time elapsed since the origination of the instrument. The value is rounded to the nearest whole number of months.

\[ \text{Expired Term} = \text{ROUND}((\text{Current Date} - \text{Origination Date}) / 30.412) \]

Term to Reprice

As with reprice frequency, the calculation of term to reprice depends on the adjustable type code and tease characteristics of the instrument characteristics.

Fixed Rate
If the instrument is fixed rate, as designated by an adjustable type code = fixed (code value = “0”), the term to reprice is calculated in the same manner as remaining term. The value is rounded to the nearest whole number of months.

Term to Reprice = Round (Maturity Date - Current Date/30.412)

- **Non-Tease Floating**
  
  If the adjustable type of the instrument is floating (code value of “30” or “50”), and is not in its tease period, the reprice frequency is taken as 1 day. The term to reprice is assumed to be one day, which when rounded to a month value, becomes 0 months.

  Term to Reprice = 0 months

- **Non-Tease Adjustable**
  
  If the adjustable type of the instrument is adjustable (code value of “250”) and not in its tease period, the term to reprice is calculated as the difference between the current date and the next reprice date. The value is rounded to the nearest whole number of months.

  Term to Reprice = ROUND((Maturity Date - Current Date)/30.412)

- **Teased Loans**
  
  The tease period is identified by a tease end date > current date. The term to reprice, while in this period, is calculated as the difference between the current date and the tease end date. The value is rounded to the nearest whole number of months.

  Term to Reprice = ROUND((Tease End Date - Current Date)/30.412)

2. **Determine Base Annual Prepayment Rate.**

   The method for determining the annual prepayment rate depends on the prepayment method.

   **Constant Rate**

   Constant prepayment rates can vary for different origination date ranges. The rate is determined by finding the proper range of origination dates and using the constant rate from this range.

   Base Annual PP Rate = Constant Rate

   **Arctangent**
The arctangent formula describes the relationship between prepayments and the ratio of coupon rate to market rate. Four coefficients you enter define the shape of the curve. These coefficients can vary by origination date range.

\[
\text{Base Annual PP Rate} = \text{Coeff1} - \text{Coeff2} \cdot \text{ARCTANGENT}(\text{Coeff3} \cdot (\text{Coeff4} - \text{Rate Ratio}))
\]

Prepayment Table

Under the Prepayment Table method, a Prepayment Table ID is referenced within the Prepayment ID for a particular product and origination date range. This prepayment table may be factored by a coefficient to scale the prepayment rates which reside in the table up or down. The prepayment table factor is also defined per product and origination date.

The Prepayment Table ID contains a table of prepayment rates dimensioned by other characteristics, as listed in Step 1 above. The Prepayment Table ID can hold a maximum of three dimensions. For each dimension, you can define the lookup method along that dimension, either range or interpolate.

Range Lookup

Range Lookups treats the nodes within the dimension as a starting value for a range which extends to the next node dimension. For example, take an original term dimension with node values of 0, 12, and 24. The range lookup treats these values as three sets of ranges: 0 to 11, 12 to 23, and \( \geq 24 \).

Interpolation Lookup

If the interpolation method is selected, the lookup applies straight line interpolation to determine the proper prepayment rate for values which fall between nodes.
Lookups Outside the Given Range

For both lookup methods, lookup for values less than the lowest node value receives the prepayment rate associated with the lowest node. Values greater than the highest node receive the prepayment rate associated with the highest node.

Along each dimension of the table, range lookup or interpolation is performed to pinpoint the proper prepayment rate from the table. Once the prepayment rate is retrieved from the prepayment table, the prepayment table factor is applied to this rate.

\[
\text{Base Annual PP Rate} = \text{PPTableFactor} \times \text{PPTableLOOKUP}(\text{dimension}_x, \text{dimension}_y, \text{dimension}_z)
\]

3. Adjust for Seasonality.

For each prepayment method, seasonality factors can be applied to adjust the prepayment rate. The seasonality factors are defined per month. The month of the current date is used to determine the proper seasonality factor to use.

\[
\text{Annual PP Rate} = \text{Seasonality Factor (Current Month)} \times \text{Base Annual PP Rate}
\]

4. Check Prepay in Full Option.

If the adjusted final prepayment rate is equal to 100%, the instrument is paid off in full.

5. Unannualize the Prepayment Option.

The annual prepayment rate is adjusted to a rate per payment. The formula is as follows:

\[
\text{Prepay Factor} = (1-(1-\text{Annual PPRate})^{1/\text{payments per year}})
\]

6. Adjust Prepay Rate for Stub or Extended Payments.

The prepayment rate per payment is adjusted if the payment is a stub or extended payment. This adjustment is made in the same manner that interest cash flows are adjusted, as follows:

\[
\text{Adjusted prepay factor} = \text{Prepay Factor} \times (\text{next payment date} - \text{last payment date}) / (\text{pmt frequency in days})
\]

7. Determine prepayment amount.

The amount of runoff due to prepayments is calculated. The prepay factor is applied to the current balance.
Cash Flow Calculation Process

Prepay Runoff = Current Balance * prepay factor

8. Update current balance.

   The current balance must be reduced by the amount of prepay runoff.
   
   Current Balance = Current Balance - Prepay runoff

9. Apply prepay factor to current payment.

   An option exists in the Prepayment ID to reduce the payment proportionally to reflect the amount of principal that has been prepaid. If the prepayment treatment is “Refinance”, the current payment is reduced as follows:
   
   Current Payment = Current Payment * (1 - prepay factor)

   If the payment treatment is “Curtailment”, the current payment will remain constant, effectively reducing the term of the instrument.

Reprice Event

Cash flow data characteristics are:

**Static Information:**
- Adjustable type code
- Interest rate code
- Transfer Rate Interest Rate code
- Net Margin
- Net Margin Code
- Gross Margin
- Transfer Rate Margin
- Reprice frequency and multiplier
- Rate cap life
- Rate floor life
- Rate increase period
- Rate decrease period
- Rate set lag and multiplier
- Rate change minimum
Cash Flow Calculation Process

- Rate change rounding code
- Rate change rounding factor

**Dynamic Information**
- Current gross rate
- Current net rate
- Current transfer rate

**Event Triggers**
- Bucket start date
- Tease end date
- Next reprice date

**Additional Assumption information**
- Forecast Rates ID

**Notes About Reprice Event**

**Transfer Pricing**
The modeling of adjustable rate instruments in TP begins at the last reprice date and ends at the next reprice date, with the next repricing date treated like a maturity date for funding purposes. Therefore, no repricing events occur during a transfer pricing process.

**Customer Rate Definition**
Repricing characteristics (rate caps, floors, periodic change limits) are based on the customer rate. In a standard processing run, the current net rate is defined as the customer rate. However, when the Modeling with Gross Rates option is used, the customer rate is defined as the current gross rate.

**Reprice Steps**
1. Determine new IRC value(s).
   - The raw customer rate (Raw Rate,) is determined from the set of forecasted IRC values contained in the Forecast Rates ID chosen within the processing ID.
Additionally, a raw transfer rate (Raw Rate,\(_t\)) is derived if the Modeling with Transfer Rates option is used. The variables used to determine the raw rates are:

\[
\text{Raw Rate,}_c = f(\text{Rate set date, IRC, yield curve term})
\]

\[
\text{Raw Rate,}_t = f(\text{Rate set date, transfer rate IRC, yield curve term})
\]

**Rate Set Date**

The rate set date is the date from which the IRC value is taken. The date is determined as follows:

\[
\text{Rate Set Date} = \text{Next Reprice Date}_m - \text{Rate Lag}_r
\]

If the rate set date is less than the As of Date, the rate from the As of Date is used.

**Yield Curve Term**

If the IRC is a single point IRC (Prime, LIBOR), then the forecasted rate is used. If the IRC is a yield curve (Treasury Yield Curve), the point on the yield curve equivalent to the repricing frequency is used. If no such point exists, straight line interpolation is used between the two nearest terms.

**Example:**

An instrument has a repricing frequency of 18 months, which does not exist on the yield curve. The two nearest points are the 12 month point and the 24 month point.

The 18 month point is determined as follows:

<table>
<thead>
<tr>
<th>Term</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 months</td>
<td>6.00%</td>
</tr>
<tr>
<td>24 months</td>
<td>9.00%</td>
</tr>
</tbody>
</table>

\[
\text{Interpolated Rate} = \text{Rate}(\text{Begin}) + (\text{Rate}(\text{End}) - \text{Rate}(\text{Begin}))*(\text{Term}(\text{interpolated rate})-\text{Term}(\text{Begin}))/(\text{Term}(\text{End})-\text{Term}(\text{Begin}))
\]

\[
\text{Rate}(18 \ M) = 6.00\% + (9.00\%-6.00\%)*(24 \ M - 18 \ M) / (24 \ M - 12 \ M) = 6.00\% + 3.00\% * (6 \ M) / (12 \ M) = 6.00\% + 1.50\% = 7.50\%
\]

**2. Add applicable margin to raw customer rate.**

The margin of the customer is added to the raw customer rate. If using the Modeling with Gross Rates option, the gross margin is used. Otherwise,
repricing depends on the Net Margin Flag. If the Net Margin Flag is set to floating net rate, the net margin is used. If the Net Margin Flag is set to fixed net rate, no repricing occurs.

\[ \text{Raw Rate}_c = \text{Raw Rate}_c + \text{Margin}_c \]

3. Update current transfer rate if modeling transfer rates.

At this point the current transfer rate (Current Rate,) can be updated. Unlike the customer rates, no further adjustments are necessary.

\[ \text{Current Rate}_c = \text{Raw Rate}_c + \text{margin}, \]

4. Apply rounding codes.

The raw customer rate is adjusted using the method defined by the rounding codes and to the precision specified by the rounding factor. If the rounding factor is set equal to zero, no rounding occurs.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Example (Raw rate = 5.123; rounding factor = 0.01)</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Rounding</td>
<td>Rate is not rounded.</td>
<td>5.123</td>
</tr>
<tr>
<td>Round Up</td>
<td>Rate is rounded to the nearest value greater than the Raw rate with the specified precision.</td>
<td>5.13</td>
</tr>
<tr>
<td>Round Down</td>
<td>Rate is rounded to the nearest value less than the Raw rate with the specified precision.</td>
<td>5.12</td>
</tr>
<tr>
<td>Truncate</td>
<td>Rate is truncated to whole value.</td>
<td>5.000</td>
</tr>
<tr>
<td>Round Nearest</td>
<td>Rate is rounded to nearest value to the Raw rate with the specified precision.</td>
<td>5.12</td>
</tr>
</tbody>
</table>

5. Apply rate change minimum.

The raw customer rate including margin is compared with the current customer rate (Current Rate,). If the amount the current customer rate would change by is less than the rate change minimum then the rate does not change. Therefore, raw customer rate is set equal to the current customer rate.
6. Set value of fully indexed rate(s).

The fully indexed rates are updated after rate change minimums and rounding codes are applied, and before caps and floors are applied to the raw rate.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Absolute Value (Raw Rate - Current Rate) &lt; Rate Change Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment if True</td>
<td>Raw Rate = Current Rate</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customer Rate Definition</th>
<th>Floating Net Rate</th>
<th>Fixed Net Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Rate</td>
<td>Fully Indexed Rate = Raw Rate</td>
<td>Fully Indexed Rate = Raw Rate</td>
</tr>
<tr>
<td></td>
<td>Fully Indexed Rate = Raw Rate</td>
<td>Fully Indexed Rate = Current Rate</td>
</tr>
<tr>
<td></td>
<td>- Margin + Margin</td>
<td>Rate</td>
</tr>
<tr>
<td>Net Rate</td>
<td>Fully Indexed Rate = Current Rate</td>
<td>Fully Indexed Rate = Raw Rate</td>
</tr>
<tr>
<td></td>
<td>Rate</td>
<td></td>
</tr>
</tbody>
</table>

7. Calculate tease effect financial elements for instruments in a tease period.

For instruments in a tease period, determined by tease end date > current date in modeling horizon, no adjustments are made to the current rate. However, the effect of the tease is recorded in two financial elements that are used at the next payment to calculate the income effect of the tease. On a tease record, the processing of a repricing event is complete at this point.

<table>
<thead>
<tr>
<th>Financial Element</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>tease rate</td>
<td>Fully Indexed Rate - Raw Rate</td>
</tr>
<tr>
<td>tease balance</td>
<td>Current Balance</td>
</tr>
</tbody>
</table>

8. Check periodic caps and floors.

The customer rate cannot change by more than the amount specified by the periodic change limits (periodic floor and periodic cap). If the raw customer rate would effect a change to the current customer rate that exceeds the periodic change limitations, the current customer rate is only adjusted by the amount specified by the periodic change limit. If periodic limits are applied to the raw customer rate, then this adjustment occurred should be recorded in the periodic cap/floor financial elements.
9. Check lifetime caps and floors.

The customer rate cannot be greater than the lifetime cap or less than the lifetime floor. If the raw customer rate fails either of these conditions, the raw customer rate is set equal to the appropriate value.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Decreasing Rate Environment</th>
<th>Increasing Rate Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Rate(_C) &lt; Current Rate(_C) and Current Rate(_C) - Raw Rate(_C) &gt; periodic floor</td>
<td>Raw Rate(_C) &gt; Current Rate(_C) and Raw Rate(_C) - Current Rate(_C) &gt; periodic cap</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjustment if True</th>
<th>Decreasing Rate Environment</th>
<th>Increasing Rate Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Rate(_C) = Current Rate(_C) - periodic floor</td>
<td>Raw Rate(_C) = Current Rate(_C) + periodic cap</td>
<td></td>
</tr>
</tbody>
</table>

10. Update current rates.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Decreasing Rate Environment</th>
<th>Increasing Rate Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Rate(_C) &gt; Rate Floor Life</td>
<td>Raw Rate(_C) &gt; Rate Cap Life</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjustment if True</th>
<th>Decreasing Rate Environment</th>
<th>Increasing Rate Environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Rate(_C) = Rate Floor Life</td>
<td>Raw Rate(_C) = Rate Cap Life</td>
<td></td>
</tr>
</tbody>
</table>

11. Update next repricing date.

The next reprice date is rolled forward in preparation for the next repricing event. If the adjustable type code is “Adjustable”, the next reprice date is calculated as:

Next reprice date = Current reprice date + reprice frequency

If the adjustable type code is “Floating” or “Variable,” the next reprice date is set equal to the first date in the next modeling bucket.

12. Trigger payment recalculation.
If the amortization type is a standard conventional amortization, the current payment on the instrument data is updated based on the new rate. (See payment Calculation Event.)

**Additional Processing Events**

**Deferred Amortization Calculation Steps**

1. Determine the flat rate scenario.
   - a. The process may already have a flat rate scenario. If the change from the base rates is zero for all buckets and all interest rate codes, then there is a flat rate scenario.
   - b. If there is not a flat rate scenario, then a flat rate scenario should be created. This scenario can be created by reading in the base rates and applying a zero change for all buckets.

2. Determine if a record needs to have deferred amortization records calculation applied to it.
   Deferred amortization records are instrument or new business records where the column cur_deferred_bal is not equal to zero. We may want to have some tolerance around this, such as +/- $1.

3. Calculate cash flows for instrument from as-of-date until maturity using the flat rate scenario.
   - a. If one of the scenarios within the process is a flat rate scenario, further cash flows do not need to be generated. The cash flows from the flat rate scenario can be used.
   - b. If the instrument is not rate-sensitive, further cash flows do not need to be generated. The cash flows from any scenario can be used.
   - c. In all other cases, cash flows in a flat rate scenario must be generated.

4. Calculate the internal rate of return.
   - a. Calculate the market value of the instrument using the coupon rate, the cur_net_rate, as the discount rate from as-of-date to maturity date. The principal and interest cash flows from the as-of-date to the maturity date should be used in all cases.
b. Use the following simple market value calculation:

\[
\text{Market Value} = \sum_{n=1}^{N} \frac{C F_n}{(1 + c)^n}
\]

c = coupon rate (cur_net_rate) from instrument record
n = payment number
N = remaining number of payments
CF_n = cash flow at payment n = total runoff plus interest cash flow net

c. Calculate the duration of the instrument using the same discount rate.

\[
\text{Duration} = \frac{\sum_{n=1}^{N} \frac{C F_n \times n}{(1 + c)^{n+1}}}{\sum_{n=1}^{N} \frac{C F_n}{(1 + c)^n}}
\]

d. Find the amount necessary to add to the coupon rate to more closely approximate the internal rate of return, using the following formula:

\[
\text{Rate Change} = \frac{MV - (\text{ParBal} + \text{Deferred})}{\text{duration} \times MV}
\]

e. Using a new discount rate equal to the coupon plus the rate change calculated above, recalculate the market value and duration.
f. Repeat steps 4 and 5 until the rate change is very small (less than 0.001% in absolute value). The discount rate used when this state is reached is the internal rate of return. It is negative if:

$$\sum_{n=1}^{N} CF_n < ParBal + Deferred$$

5. Calculate the spread to use in each scenario.
   a. The calculation is:

$$spread = (IRR - c)$$

b. The value for the coupon, c, in the formula above is the cur_net_rate after the first true repricing event. A true repricing event is a non-tease repricing event.

c. If the instrument is fixed rate, the cur_net_rate from the record is sufficient.

6. Calculate the deferred financial elements in each bucket and each scenario.
   a. The deferred runoff must be calculated first.

For each modeling bucket, calculate the amount of total income to be recognized as:

$$\text{Total Income} = (ParBal + Deferred) \times \frac{c_b + spread}{a}$$

$$\text{Total Income} = DeferredRunoff + InterestAccrued$$

$$\text{Deferred Runoff} = \left( ParBal + Deferred \right) \times \frac{c_b + spread}{a} - InterestAccrued$$

a = accrual factor, see description below
\[ c_b = \text{Average Rate} \]
\[ \text{ParBal} = \text{Average Balance} \]
\[ \text{Deferred} = \text{Deferred End Balance in previous bucket, Cur_defer_bal in bucket 1} \]
\[ \text{InterestAccrued} = \text{Interest Accrual Net for Current Bucket} \]

- The value “a” in the formula above is the accrual factor associated with that bucket. The accrual factor is the portion of the year which the modeling bucket represents. This calculation varies according to the accrual basis code associated with the instrument.
- The financial element 140, Average Balance should be used for ParBal in the formula above.
- The financial element 160, Average Rate should be used for \( c_b \) in the formula above.
- In the bucket in which the instrument matures, if this bucket falls within the modeling horizon, the deferred runoff should be set equal to the remaining deferred balance. This is to ensure that the entire deferred balance is run off by the maturity date.

b. Calculate the change in the deferred balance as:

\[ \text{Deferred Balance}_{\text{end}} = (\text{Deferred Balance}_{\text{beginning}} - \text{Deferred Runoff}) \]

c. Assume that the average deferred balance is equal to the beginning deferred balance.

**Market Value Calculation**

**Cash Flow Inputs**
- Interest Cash Flow Net
- Total Runoff
- Repricing Balance
- Deferred Runoff
Interface Inputs

Discount Rates ID
Forecast Rates ID

Market Value Calculation Steps

1. Define components of cash flow.

Within the interface, you must define what components make up the cash flow that is discounted to derive the market value. The standard components of a cash flow are the following:

- Interest Cash Flow Net
- Scheduled Principal Runoff
- Principal At Maturity
- Prepayments

Choosing special options in the Discount Rates ID adjusts the cash flow definition in the following manner:

<table>
<thead>
<tr>
<th>Cash Flow Switches</th>
<th>Effect on Cash Flow</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interest Cash Flow</td>
<td>Value interest component of cash flow only</td>
</tr>
<tr>
<td>Mature At Reprice</td>
<td>Value instrument as if it matured on the first repricing date after the start date</td>
</tr>
</tbody>
</table>

Future Originations Adjustment

Instruments that originate after a designated start date can be included in the market value for that start date if the issue date is less than or equal to the start date. In this case, the negative flow of funds on the origination date is considered to be a cash flow for discounting purposes.

2. Determine discount rate for cash flow.

Within the Discount Rates ID, you specify an IRC and a discount method. The methodology determines whether current or forecasted rates are referenced and which yield curve point from the chosen IRC is used.

<table>
<thead>
<tr>
<th>Discount Method</th>
<th>Date of IRC</th>
<th>Yield Curve Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spot Input</td>
<td>not applicable</td>
<td>not applicable</td>
</tr>
</tbody>
</table>
3. Calculate market value of cash flow.

For the market value of an instrument as of a particular start date, the present value of each cash is calculated for all cash flows that occur after the start date. The variables in this formula are:

\[ t = \frac{(\text{cash flow date} - \text{start date})}{\text{payment frequency}} \]
\[ r = \frac{\text{discount rate}}{\text{number of payments per year}} \]
\[ n = \text{payment number} \]
\[ CF = \text{predefined cash flow} \]

The present value of each cash flow is calculated as follows:

\[ MV_{cf} = \frac{CF_n}{(1 + r)^t} \]

4. Treat reprice date as maturity where necessary.

For repricing instruments, the cash flows is evaluated from the start date up to the reprice date, affecting a maturity on the reprice date for duration calculation. For market values, this method is used if the “Mature At Reprice” option is enabled in the Discount Rates interface.

If this methodology is used and the reprice date falls mid-payment, an extra interest cash flow must be calculated. This interest cash flow represents the portion of the next interest cash flow that applies from the last payment date prior to the reprice date and the reprice date.

5. Sum market values of cash flows.

The market value per payment are summed to arrive at a total market value number.
Total Market Value = \[ \sum_{n=1}^{n} (M \cdot V_{cf}) \]

6. Calculate duration of instrument.

The duration of the instrument is calculated by weighting the market value of each payment by time.

\[ \text{Total Duration} = \frac{\sum_{n=1}^{n} (M \cdot V_{cf} \cdot t)}{\sum_{n=1}^{n} M \cdot V_{cf} \cdot \frac{pmts}{year}} \]

7. Update instrument data.

Within the interface you can choose to write the market value for a specified start date back to the instrument table. If this option has been chosen, the market value price is written to the Market Value price column in the instrument table. To calculate the price, the calculated market value is divided by the instrument’s balance as of the specified start date.

Market Value price = Total Market Value / Balance,

Accumulation Methods

Accumulation Methods for Financial Elements

Accumulation methods are applied to the summary financial information calculated at each event in order to generate financial element data for each modeling bucket. There are five different accumulation methods:

- Average Method
- Accrual Method
- Sum Method
Accumulation Methods

- At First Method
- At Last Method

Each of these methods is described in detail in the following section.

**Average Method**

The average method is used to calculate an average value (e.g. Average Balance, Average Net Rate) over a bucket. The calculation sums up the daily values and divided by the number of days in the bucket.

\[
\text{Daily Average Balance} = \frac{\sum (\text{Daily Balance})}{\text{days in bucket}}
\]

All simulated events (originations, payments, prepayments, and repricings) are assumed to happen at the end of the event date. This implies that the balance and rate on the day of an event is counted as the value prior to any changes made by the event. Changes made impact the value of the next day.

**Accrual Method**

The accrual method is used to determine how much accrual has occurred over the modeling bucket. The accrual method is determined by the code value in the detail record. Interest in advance instruments calculate interest accruals from the current payment date to the next payment date. Interest in arrears instruments calculate interest accruals from the current payment date to the previous payment date.

The interest cash flow is divided by the number of days between these two dates to determine a daily accrual for each day within the modeling term. Daily interest accruals are summed by modeling bucket.

\[
\text{Daily Interest Accrual} = \frac{\text{Interest Cash Flow}}{\text{number of days in payment}}
\]

The example below demonstrates an interest accrual for an arrears record:

<table>
<thead>
<tr>
<th>Payment Date</th>
<th>Interest Cash Flow</th>
<th>Days in Payment</th>
<th>Daily Accrual</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 15</td>
<td>950</td>
<td>31</td>
<td>30.64</td>
</tr>
<tr>
<td>February 15</td>
<td>900</td>
<td>31</td>
<td>29.03</td>
</tr>
<tr>
<td>March 15</td>
<td>850</td>
<td>28</td>
<td>30.36</td>
</tr>
</tbody>
</table>

Modeling Start Date = January 1
Sum Method

Summed financial element values are calculated by adding together all values associated with events occurring during the modeling bucket.

\[
\text{Principal Runoff} = \sum (\text{Principal Runoff})
\]

At First Method

At First accumulation method determines the value from the first event within a modeling bucket (for example, Beginning Balance).

At Last Method

At Last accumulation method determines the value from the last event within a modeling bucket (for example, Ending Balance).

### Detail Cash Flow Data

<table>
<thead>
<tr>
<th>Bucket End Date</th>
<th>Accrual Calculation</th>
<th>Interest Accrual</th>
</tr>
</thead>
<tbody>
<tr>
<td>January 31</td>
<td>15 days @ 30.64 + 16 days @ 29.03</td>
<td>924.08</td>
</tr>
<tr>
<td>February 28</td>
<td>13 days @ 29.03 + 15 days @ 30.36</td>
<td>832.79</td>
</tr>
</tbody>
</table>

### Column Description

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
<th>Column Type</th>
<th>Event use</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID_NUMBER</td>
<td>Unique identifier.</td>
<td>static</td>
<td>I</td>
</tr>
<tr>
<td>COMMON_COA_ID</td>
<td>Leaf value used to determine financial account type of detail instrument.</td>
<td>static</td>
<td>I</td>
</tr>
<tr>
<td>ADJUSTABLE_TYPE_CD</td>
<td>Determines whether reprice occurs, and, if it occurs, whether it occurs according to reprice dates or bucket dates.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>ACCRUAL_BASIS_CD</td>
<td>Method of accrual used in determining the rate per payment.</td>
<td>static</td>
<td>P</td>
</tr>
<tr>
<td>AMRT_TERM &amp; AMRT_TERM_MULT</td>
<td>Determines time over which principal is amortized; used in payment recalculation.</td>
<td>static</td>
<td>P, PC</td>
</tr>
<tr>
<td>AMRT_TYPE_CD</td>
<td>Determines method for amortizing principal. Will be used to match to payment pattern data.</td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>Column Name</td>
<td>Column Description</td>
<td>Column Type</td>
<td>Event use</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-----------</td>
</tr>
<tr>
<td>CUR_PAYMENT</td>
<td>Amount of current payment, meaning depends on amortization type code.</td>
<td>dynamic P, PC</td>
<td></td>
</tr>
<tr>
<td>CUR_PAR_BAL</td>
<td>Balance on which principal runoff, interest cash flows, deferred runoff are based.</td>
<td>dynamic P, PC, PP</td>
<td></td>
</tr>
<tr>
<td>CUR_NET_RATE</td>
<td>Interest rate than the financial institution pays/receives.</td>
<td>dynamic P, R, PC, PP</td>
<td></td>
</tr>
<tr>
<td>CUR_GROSS_RATE</td>
<td>Interest rate that the customer pays/receives; used in determining payments and prepayments.</td>
<td>dynamic P, R, PC, PP</td>
<td></td>
</tr>
<tr>
<td>DEFERRED_CUR_BAL</td>
<td>Holds current unamortized premium, discount, fees, costs, etc.</td>
<td>dynamic D</td>
<td></td>
</tr>
<tr>
<td>ISSUE_DATE</td>
<td>Date instrument is recognized as “on-the-books”. Used in dynamic gap and market value calculations.</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>INTEREST_RATE_CD</td>
<td>Code value which determines the forecasted rate to base repricing on.</td>
<td>static R</td>
<td></td>
</tr>
<tr>
<td>INT_TYPE</td>
<td>Determines how interest is calculated and accrued.</td>
<td>static P</td>
<td></td>
</tr>
<tr>
<td>INSTR_TYPE_CD</td>
<td>Used to match a schedule instrument record to its scheduled payment dates and amounts.</td>
<td>static I</td>
<td></td>
</tr>
<tr>
<td>LAST_PAYMENT_DATE</td>
<td>Date of last payment before the as-of-date, used to calculate days in first payment for interest in arrears instruments and to calculate accruals prior to first payment in interest in advance instruments.</td>
<td>static P</td>
<td></td>
</tr>
<tr>
<td>LRD_BALANCE</td>
<td>Balance as of last reprice date</td>
<td>static I</td>
<td></td>
</tr>
<tr>
<td>LAST_REPRICE_DATE</td>
<td>Last date instrument rate repriced.</td>
<td>static I</td>
<td></td>
</tr>
<tr>
<td>MARGIN</td>
<td>Pricing spread added to the IRC value for current net rate.</td>
<td>static R</td>
<td></td>
</tr>
<tr>
<td>MATURITY_DATE</td>
<td>Date of final payment.</td>
<td>static P, PP</td>
<td></td>
</tr>
<tr>
<td>NEG_AMRT_AMT</td>
<td>Amount of current balance due to negative amortization of interest payments.</td>
<td>dynamic P</td>
<td></td>
</tr>
<tr>
<td><strong>Column Name</strong></td>
<td><strong>Column Description</strong></td>
<td><strong>Column Type</strong></td>
<td><strong>Event use</strong></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>NEG_AMRT_EQ_DATE</td>
<td>Date that instrument fully re-amortizes, irrespective of payment caps.</td>
<td>event trigger</td>
<td>PC</td>
</tr>
<tr>
<td>NEG_AMRT_EQ_FREQ &amp;</td>
<td>Frequency of neg am equalization events. 0 denotes neg-am equalization never occurs.</td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>NEG_AMRT_EQ_MULT</td>
<td></td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>NEG_AMRT_LIMIT</td>
<td>Maximum amount that instrument can negatively amortize, stored as a percent of original balance.</td>
<td>event trigger</td>
<td>PC</td>
</tr>
<tr>
<td>NEXT_PAYMENT_DATE</td>
<td>Date of next payment.</td>
<td>event trigger</td>
<td>P, PC</td>
</tr>
<tr>
<td>NEXT_REPRICE_DATE</td>
<td>Date of next rate change.</td>
<td>event trigger</td>
<td>R, PP</td>
</tr>
<tr>
<td>ORG_PAYMENT_AMT</td>
<td>Payment used for cash flow transfer pricing of fixed rate records. Used by pattern instruments to calculate payment amount.</td>
<td>static</td>
<td>PC, I</td>
</tr>
<tr>
<td>ORG_PAR_BAL</td>
<td>Used in conjunction with neg am limit to determine the maximum amount that instrument can negatively amortize. Used for Rule of 78% schedules. Used by pattern instruments to calculate payment amount.</td>
<td>static</td>
<td>PC, I</td>
</tr>
<tr>
<td>ORG_TERM &amp; ORG_TERM_MULT</td>
<td>Time from origination date to maturity date. Used in determining whether an instrument balloons for payment recalculation purposes.</td>
<td>static</td>
<td>PC, PP</td>
</tr>
<tr>
<td>ORIGINATION_DATE</td>
<td>Determines age of instrument for prepayments. Used in calculating remaining amortization term. Used in determining payment number in pattern records.</td>
<td>static</td>
<td>PP, PC</td>
</tr>
<tr>
<td>PERCENT_SOLD</td>
<td>Determines net balance.</td>
<td>static</td>
<td>I</td>
</tr>
<tr>
<td>PMT_ADJUST_DATE</td>
<td>Date of next scheduled payment recalculation for neg am instruments.</td>
<td>event trigger</td>
<td>PC</td>
</tr>
<tr>
<td>PMT_CHG_FREQ &amp; PMT_CHG_FREQ_MULT</td>
<td>Frequency of regular payment change calculation for neg-am instruments only. 0 denote payment never changes.</td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>PMT_DECR_CYCLE</td>
<td>Maximum percent payment can decrease from its previous value.</td>
<td>static</td>
<td>PC</td>
</tr>
</tbody>
</table>
### Column Name and Description

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
<th>Column Type</th>
<th>Event use</th>
</tr>
</thead>
<tbody>
<tr>
<td>PMT_DECR_LIFE</td>
<td>Minimum payment amount; stored as a percent of original payment amount; can be overwritten on ngam equalization dates.</td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>PMT_FREQ &amp; PMT_FREQ_MULT</td>
<td>Frequency of payments; should be set equal to original term if instrument is bullet (principal and interest at maturity date) or account type of other asset, other liability, interest income, interest expense, non-interest income, non-interest expense.</td>
<td>static</td>
<td>P, PC, PP</td>
</tr>
<tr>
<td>PMT_INCR_CYCLE</td>
<td>Maximum percent payment can increase from previous value.</td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>PMT_INCR_LIFE</td>
<td>Maximum payment amount; stored as a percent of original payment amount; can be overwritten on ngam equalization dates.</td>
<td>static</td>
<td>PC</td>
</tr>
<tr>
<td>RATE_CAP_LIFE</td>
<td>Maximum value to which current rate can reprice.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_CHG_MIN</td>
<td>Minimum amount that current rate must change before a rate change occurs.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_CHG_RND_CD</td>
<td>Type of rounding to be applied to current rate.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_CHG_RND_FAC</td>
<td>Precision of rounding; 0 denotes no rounding.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_DECREF_CYCLE</td>
<td>Maximum amount rate can decrease within a repricing period.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_FLOOR_LIFE</td>
<td>Minimum value to which current rate can reprice</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_INCR_CYCLE</td>
<td>Maximum amount rate can increase within a repricing period.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>RATE_SET_LAG &amp; RATE_SET_LAG_MULT</td>
<td>Time lag used when repricing. Used to determine rate set date on reprice event.</td>
<td>static</td>
<td>R</td>
</tr>
<tr>
<td>REMAIN_NO_PMTS_C</td>
<td>Number of payments left to be made on the instrument from the As of Date to the maturity date.</td>
<td>dynamic</td>
<td>P, PC</td>
</tr>
<tr>
<td>REPRICE_FREQ &amp; REPRICE_FREQ_MULT</td>
<td>Frequency that instrument reprices; 0 denotes fixed rate.</td>
<td>static</td>
<td>R, PP</td>
</tr>
</tbody>
</table>
### Column Name | Column Description | Column Type | Event use
---|---|---|---
ORG_PAYMENT_AMT | Payment used for cash flow transfer pricing of fixed rate records. | static | I
TEASER_END_DATE | Date that teased instrument begins repricing. | event trigger | R, PP
MARGIN_GROSS | Pricing spread added to IRC for current gross rate. | static | R
MARGIN_T_RATE | Pricing spread added to IRC for current transfer rate. | static | R
T_RATE_INT_RATE_CD | Interest rate code used for determining transfer rate. | static | R
NET_MARGIN_CODE | Defines relationship between gross rate and net rate; 0 denotes floating net rate; 1 denotes constant net rate. | static | R

### Event Use Code Values

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Initialization of record</td>
</tr>
<tr>
<td>P</td>
<td>Payment</td>
</tr>
<tr>
<td>PC</td>
<td>Payment Recalculation</td>
</tr>
<tr>
<td>PP</td>
<td>Prepayment</td>
</tr>
<tr>
<td>R</td>
<td>Reprice</td>
</tr>
<tr>
<td>D</td>
<td>Deferred amortization</td>
</tr>
</tbody>
</table>
### Financial Element Calculations

<table>
<thead>
<tr>
<th>Financial Element Description</th>
<th>Financial Element Number</th>
<th>Averaging Type</th>
<th>Weighting Factor</th>
<th>Account Type Processing *</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Reprice Balance</td>
<td>255</td>
<td>At Last</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>After Reprice Gross Rate</td>
<td>290</td>
<td>At Last</td>
<td>After Reprice Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>After Reprice Net Rate</td>
<td>300</td>
<td>At Last</td>
<td>After Reprice Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>After Reprice Transfer Rate</td>
<td>310</td>
<td>At Last</td>
<td>After Reprice Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Average Balance</td>
<td>140</td>
<td>Daily average</td>
<td></td>
<td>B, DCF</td>
</tr>
<tr>
<td>Average Gross Rate</td>
<td>150</td>
<td>Daily average</td>
<td>Average Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Average Net Rate</td>
<td>160</td>
<td>Daily average</td>
<td>Average Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Average Transfer Rate</td>
<td>170</td>
<td>Daily average</td>
<td>Average Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Before Reprice Balance</td>
<td>250</td>
<td>At First</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Before Reprice Gross Rate</td>
<td>260</td>
<td>At First</td>
<td>Before Reprice Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Before Reprice Net Rate</td>
<td>270</td>
<td>At First</td>
<td>Before Reprice Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Before Reprice Transfer Rate</td>
<td>280</td>
<td>At First</td>
<td>Before Reprice Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Beginning Balance</td>
<td>60</td>
<td>At first</td>
<td></td>
<td>B, DCF</td>
</tr>
<tr>
<td>Beginning Gross Rate</td>
<td>70</td>
<td>At first</td>
<td>Beginning Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Beginning Net Rate</td>
<td>80</td>
<td>At first</td>
<td>Beginning Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Beginning Transfer Rate</td>
<td>90</td>
<td>At first</td>
<td>Beginning Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Deferred Average Balance</td>
<td>530</td>
<td>Daily average</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Deferred Ending Balance</td>
<td>520</td>
<td>At last</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Deferred Runoff</td>
<td>540</td>
<td>Accrual</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Dividends</td>
<td>940</td>
<td>Sum</td>
<td></td>
<td>A</td>
</tr>
<tr>
<td>Ending Balance</td>
<td>100</td>
<td>At last</td>
<td></td>
<td>B, DCF</td>
</tr>
<tr>
<td>Ending Gross Rate</td>
<td>110</td>
<td>At last</td>
<td>Ending Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Ending Net Rate</td>
<td>120</td>
<td>At last</td>
<td>Ending Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Ending Transfer Rate</td>
<td>130</td>
<td>At last</td>
<td>Ending Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Fully Indexed Gross Rate</td>
<td>320</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Financial Element Description</td>
<td>Financial Element Number</td>
<td>Averaging Type</td>
<td>Weighting Factor</td>
<td>Account Type Processing *</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------------</td>
<td>----------------</td>
<td>-----------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Fully Indexed Net Rate</td>
<td>330</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Interest Accrual - Gross</td>
<td>445</td>
<td>Accrual</td>
<td></td>
<td>DCF, I</td>
</tr>
<tr>
<td>Interest Accrual - Net</td>
<td>440</td>
<td>Accrual</td>
<td></td>
<td>DCF, I</td>
</tr>
<tr>
<td>Interest Accrual - Transfer Rate</td>
<td>450</td>
<td>Accrual</td>
<td></td>
<td>DCF, I</td>
</tr>
<tr>
<td>Interest Cash Flow Gross</td>
<td>435</td>
<td>Sum</td>
<td></td>
<td>DCF, I</td>
</tr>
<tr>
<td>Interest Cash Flow Net</td>
<td>430</td>
<td>Sum</td>
<td></td>
<td>DCF, I</td>
</tr>
<tr>
<td>Interest Cash Flow Transfer Rate</td>
<td>437</td>
<td>Sum</td>
<td></td>
<td>DCF, I</td>
</tr>
<tr>
<td>Interest Credited</td>
<td>480</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Lifetime Cap Balance</td>
<td>580</td>
<td>Daily Average</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Lifetime Cap Effect</td>
<td>600</td>
<td>Accrual</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Lifetime Cap Rate</td>
<td>590</td>
<td>Daily Average</td>
<td>Lifetime Cap Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>New Add Balance</td>
<td>340</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>New Add Gross Rate</td>
<td>350</td>
<td>Sum</td>
<td>New Add Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>New Add Net Rate</td>
<td>360</td>
<td>Sum</td>
<td>New Add Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>New Add Transfer Rate</td>
<td>370</td>
<td>Sum</td>
<td>New Add Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>NGAM Balance</td>
<td>640</td>
<td>Daily Average</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>NGAM Interest</td>
<td>650</td>
<td>Accrual</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Non-Interest Income</td>
<td>455</td>
<td>Sum</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Non-Interest Expense</td>
<td>457</td>
<td>Sum</td>
<td></td>
<td>N</td>
</tr>
<tr>
<td>Periodic Cap Balance</td>
<td>550</td>
<td>Daily Average</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Periodic Cap Effect</td>
<td>570</td>
<td>Accrual</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Periodic Cap Rate</td>
<td>560</td>
<td>Daily Average</td>
<td>Periodic Cap Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Prepay Balance</td>
<td>515</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Prepay Rate (Annual)</td>
<td>510</td>
<td>Sum</td>
<td>Prepay Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Prepay Runoff</td>
<td>180</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
</tbody>
</table>
## Financial Element Calculations

<table>
<thead>
<tr>
<th>Financial Element Description</th>
<th>Financial Element Number</th>
<th>Averaging Type</th>
<th>Weighting Factor</th>
<th>Account Type Processing *</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepay Runoff</td>
<td>182</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Roll Add Balance</td>
<td>380</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Roll Add Gross Rate</td>
<td>390</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Roll Add Net Rate</td>
<td>400</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Roll Add Transfer Rate</td>
<td>410</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Scheduled Principal Runoff</td>
<td>190</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Taxes - Federal</td>
<td>930</td>
<td>Sum</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>Taxes - Local</td>
<td>935</td>
<td>Sum</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>Tease Balance</td>
<td>610</td>
<td>Daily Average</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Tease Effect</td>
<td>630</td>
<td>Accrual</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Tease Rate</td>
<td>620</td>
<td>Daily Average</td>
<td>Tease Balance</td>
<td>DCF</td>
</tr>
<tr>
<td>Timing of Prepay Runoff (positive)</td>
<td>181</td>
<td>Sum</td>
<td>Prepay Runoff (positive)</td>
<td>DCF</td>
</tr>
<tr>
<td>Prepay Runoff (negative)</td>
<td>182</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Timing of Prepay Runoff (negative)</td>
<td>183</td>
<td>Sum</td>
<td>Prepay Runoff (negative)</td>
<td>DCF</td>
</tr>
<tr>
<td>Timing of Total Runoff (positive)</td>
<td>211</td>
<td>Sum</td>
<td>Total Runoff (positive)</td>
<td>DCF</td>
</tr>
<tr>
<td>Total Runoff (negative)</td>
<td>212</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Timing of Total Runoff (negative)</td>
<td>213</td>
<td>Sum</td>
<td>Total Runoff (negative)</td>
<td>DCF</td>
</tr>
<tr>
<td>Total Runoff</td>
<td>210</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Total Runoff (negative)</td>
<td>212</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Total Runoff Gross Rate</td>
<td>220</td>
<td>Sum</td>
<td>Total Runoff</td>
<td>DCF</td>
</tr>
<tr>
<td>Total Runoff Net Rate</td>
<td>230</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Total Runoff Transfer Rate</td>
<td>240</td>
<td>Sum</td>
<td></td>
<td>DCF</td>
</tr>
<tr>
<td>Weighted Average Term</td>
<td>500</td>
<td>Sum</td>
<td>Ending Balance</td>
<td>DCF</td>
</tr>
</tbody>
</table>
* This specifies for which account types the financial elements will be processed. The code values are B = Balance only; I = Interest only; DCF = Detail Cash Flow; A = Autobalancing; N = Non Interest

**Rule of 78’s Example**

Example: 12 month loan with current payment of $93.33 and original balance = $1,000.00

1. Sum all principal and interest payments made over the life of the instrument:

\[ \sum \text{Cash Flow} = \text{current payment} \times \text{total number of payments} \]
\[ = \$93.33 \times 12 \]
\[ = \$1,120.00 \]

2. Determine total amount of interest paid over the life of the instrument.

\[ \sum \text{Interest} = \sum \text{cash flow} - \text{original par balance} \]
\[ = \$1,000.00 - \$1,120.00 \]
\[ = \$120.00 \]

3. Sum the payment numbers.

\[ \sum \text{Payments} = \text{total no. payments} \times (\text{total no. payments} + 1)/2 \]
\[ = 12 \times 13/2 \]
\[ = 78 \]

4. Calculate principal and interest amount at each payment.

\[ \text{Interest} = \sum \text{interest} \times (\text{payments remaining}/\sum \text{pmts}) \]
\[ \text{Principal} = \text{current payment} - \text{interest} \]

<table>
<thead>
<tr>
<th>Month</th>
<th>Interest Calculation</th>
<th>Interest</th>
<th>Principal</th>
<th>Remaining Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12/78 * 120</td>
<td>$18.46</td>
<td>$74.87</td>
<td>$925.13</td>
</tr>
<tr>
<td>2</td>
<td>11/78 * 120</td>
<td>$16.92</td>
<td>$76.41</td>
<td>$848.72</td>
</tr>
<tr>
<td>3</td>
<td>10/78 * 120</td>
<td>$15.38</td>
<td>$77.95</td>
<td>$770.77</td>
</tr>
<tr>
<td>4</td>
<td>9/78 * 120</td>
<td>$13.85</td>
<td>$79.48</td>
<td>$691.29</td>
</tr>
<tr>
<td>5</td>
<td>8/78 * 120</td>
<td>$12.31</td>
<td>$81.02</td>
<td>$610.27</td>
</tr>
<tr>
<td>6</td>
<td>7/78 * 120</td>
<td>$10.77</td>
<td>$82.56</td>
<td>$527.71</td>
</tr>
</tbody>
</table>
### Rule of 78's Example

<table>
<thead>
<tr>
<th>Month</th>
<th>Interest Calculation</th>
<th>Interest</th>
<th>Principal</th>
<th>Remaining Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>6/78 * 120</td>
<td>$9.23</td>
<td>$84.10</td>
<td>$443.61</td>
</tr>
<tr>
<td>8</td>
<td>5/78 * 120</td>
<td>$7.69</td>
<td>$85.64</td>
<td>$357.97</td>
</tr>
<tr>
<td>9</td>
<td>4/78 * 120</td>
<td>$6.15</td>
<td>$87.18</td>
<td>$270.79</td>
</tr>
<tr>
<td>10</td>
<td>3/78 * 120</td>
<td>$4.61</td>
<td>$88.72</td>
<td>$182.07</td>
</tr>
<tr>
<td>11</td>
<td>2/78 * 120</td>
<td>$3.08</td>
<td>$90.25</td>
<td>$91.82</td>
</tr>
<tr>
<td>12</td>
<td>1/78 * 120</td>
<td>$1.54</td>
<td>$91.79</td>
<td>$0.00</td>
</tr>
</tbody>
</table>
This chapter explains the migration to LEDGER_STAT of transfer pricing (TP) rates, option costs, and charges/credits. It includes these topics:

- Essential components of, and steps toward, successful TP migration
- Process map and description
- Troubleshooting techniques

Assumptions

It is assumed that the LEDGER_STAT table has a calendar year definition. For more information on Fiscal Year definitions, please refer to Appendix B, "Fiscal Year Information".

This chapter concentrates on the actual creation of Transfer Rate, Option Cost and Charge/Credit rows in the LEDGER_STAT table (Financial Elements 170/172, 171/173, and 450/451/452/453, respectively). It must be assumed, therefore, that all rows in the relevant INSTRUMENT Table(s) have already been transfer-priced or assigned an option cost, and contain a valid rate in one of these columns:

- Transfer_Rate
- Tran_Rate_Rem_Term
- Cur_OAS
- Historic_OAS

It is common for INSTRUMENT Table transfer pricing, option cost calculation, and TP migration to be executed consecutively in a single operation. In this circumstance, the mechanics described in this chapter occur just after INSTRUMENT Table transfer pricing or option cost calculation have been
completed successfully and just before TP rate migration starts. For example, valid transfer rates exist on the INSTRUMENT Table but the WATR (Weighted Average Transfer Rate) and Charge/Credit rows in LEDGER_STAT have not been updated.

For greater clarity, a detailed discussion of option cost migration is deferred until the end of the chapter. Keep in mind that migration of option costs works analogously to migration of transfer rates.

Requirements for Successful Migration

Several components must be correctly configured for TP migration to work successfully. Together they determine the way transfer pricing and option cost calculations are carried out for every account in the organization.

The following is an explanation of these components, their roles, and issues specific to their configuration:

- **TP Configuration ID**
- **Product Leaf**
- **Transfer Pricing ID**
- **Data Filter ID**
- **Migration and Leaf Setup**
- **Offset Org Unit**
- **Transfer Pricing Processing ID**

**TP Configuration ID**

The TP Configuration ID determines some of the parameters of transfer pricing. Although many TP Configuration IDs may be defined, only one may be active at any time and therefore only one set of rules may be in effect at any one time. TP Configuration IDs may be defined in OracleTransfer Pricing. When defining a TP Configuration ID, pay attention to the following items:

**As of Date**  Must match period for which you are trying to migrate TP rates and option costs.

**Activate Check Box**  Must be active if this TP Configuration ID is to be enforced.
Requirements for Successful Migration

**Product Leaf**  Determines which leaf type is used for TP and option cost methodology.

**Charge/Credit Accrual Factor**  If no selection is made, an Accrual Factor of 30/360 will be substituted. If Accrual Factor = “Leaf Basis”, the Accrual Factor in Common COA Leaf Setup will be used (defaulting to 30/360 if no Accrual Factor is selected for that leaf).

---

**Product Leaf**

The leaf type you select in the TP Configuration ID definition for Product Leaf must remain constant for all components of the TP and option cost process. The best way to ensure this is to define the TP Configuration ID first and make sure that the Activate box is checked. All subsequent dependent operations default to the specified Product Leaf type. In this guide, Product Leaf means whichever leaf type you have selected in the TP Configuration ID.

**Transfer Pricing ID**

The Transfer Pricing ID is used to define the transfer pricing and option cost methodology for each leaf in the selected leaf type (also known as Product Leaf), and may be defined in OracleTransfer Pricing. Note that the Leaf Type selected here should match the Product Leaf type selected in the TP Configuration ID.
When defining TP methodology, ensure that any required supporting data for the method actually exists. For example, if the selected method is Spread from Interest Rate Code, ensure that the corresponding yield curve has been properly defined in Oracle Rate Manager and has been populated with rates. Also, remember that spreads are expressed in units of percentage, not basis points. For example, if you want a spread of 150 basis points, the number to input is 1.5, not 150 or 0.0150.

**Data Filter ID**

Calculating and migrating transfer prices and option costs for the whole portfolio can be a very time-consuming process. To alleviate this, many users define a data filter so that only a subset of the portfolio is transfer priced or migrated at a time. Although this is an acceptable practice, you should be aware that data filters built below the ORG_UNIT_ID/COMMON_COA_ID level may not transfer price or migrate correctly due to required rows being excluded by the filter. This is likely when LEDGER_STAT contains accumulator (signified with Product Leaf = -9) or Unpriced Account rows. Unless the Data Filter ID specifically includes all necessary rows for calculation of these items, resulting TP calculations in LEDGER_STAT will be incorrect. It is highly recommended that Data Filters only be built at the ORG_UNIT_ID/COMMON_COA_ID level.

Also, only a single data filter (or group filter) can be used in any given TP processing run. Therefore, if the TP Processing ID is used for transfer pricing multiple tables (for example, several INSTRUMENT Tables and/or LEDGER_
requirements for successful migration

The Migration Process

For TP migration to be successful, the following leaf setup issues must be addressed. (For more information, see Creating a Leaf Setup in Chapter 5, Overview of IDs).

**Product Leaf Setup**

When data is extracted from client systems, the extract processes create mappings between a given COMMON_COA_ID and one or more Product Leaf IDs in the LEDGER_STAT and INSTRUMENT tables. TP Migration uses these mappings exclusively to relate Product Leaf IDs to Common COA IDs, regardless of any mapping of Product Leaf ID to Common COA ID in Product Leaf Setup. If the mapping is incorrect, changing Common COA ID mappings in Product Leaf Setup has no effect and the extract process needs to be revised.
Common COA Leaf Setup
You should review the COMMON_COA_ID leaves to which your product leaves are linked. If the TP Configuration ID Accrual Factor equals Leaf Basis, these leaves must contain a valid accrual factor for TP Migration to calculate the Charge/Credit properly.

The following examples show how the COMMON_COA_ID Leaf, linked to the product leaf in the sample transfer Pricing ID above, is set up with a valid accrual factor.
Org Unit Leaf Setup

Transfer pricing aims to transfer interest rate risk from business units to a central facility and to provide appropriate charges/credits for funds in return. In order for this process to take place, the central facility that receives the interest risk and provides the balancing entry for charge/credit for funds must be declared for each Org Unit in Leaf Setup.

![Image of Leaf Setup](image1)

![Image of Edit Leaf Info](image2)
Offset Org Unit

Changing the Offset Org Unit in Leaf Setup during the processing for a given period will not automatically transfer all offset amounts to the new Offset Org Unit. In addition, OFSA Transfer Pricing does not make adjustments for the prior Offset Org Unit when you reprocess with the new Offset Org Unit. Results will therefore be misleading. If you need to change the Offset Org Unit during a monthly process, then you should undo all results for the old Offset Org Unit before making the switch.

Transfer Pricing Processing ID

The TP Processing ID collects all the previous components together as a TP processing job. The TP Processing ID determines:

- Which tables undergo transfer pricing or option cost calculations
- What Data Filter is applied to the rows in each table (by selecting a Transfer Pricing ID)
- What TP or option cost methodology is used

The active TP Configuration ID also plays a role in determining what happens in a TP processing run. Specifically:

- The period to be processed (As of Date)
- COMMON_COA_ID mapping to be used (Product Leaf)
- Default Accrual Factor for calculation of Charge/Credit for funds

Release 4.5 of Oracle Transfer Pricing gives the user more flexibility in controlling rate migration than existed in prior releases. It is now possible to specify migration in a TP Process ID without automatically triggering direct transfer pricing of LEDGER_STAT accounts that use LEDGER_STAT itself as a data source. This will occur if Migration is checked in the TP Process ID, but LEDGER_STAT is not specified as a table to be processed.

Caution: Under these circumstances, if a Common_COA_ID in LEDGER_STAT contains product IDs that are transfer priced directly using LEDGER_STAT as their data source, and those product IDs have not been directly transfer priced already in another processing run, then the accumulation phase of migration will produce incorrect results at the Common_COA_ID level.
Two pages from a sample TP Processing ID follow. Note that both an INSTRUMENT table (in this case, DEPOSITS) and LEDGER_STAT are processed, so the selected data filter should include criteria for both tables. Also, the TP methodology to be used is the one defined in a Transfer Pricing ID earlier in this chapter (ACN_TP_ID_TEST).

Standards for the LEDGER_STAT Table

Great care should be taken when editing LEDGER_STAT directly. If you ever get unexpected results in LEDGER_STAT after TP migration, then review the data you entered.

TP Migration looks only at rows with CONSOLIDATION_CD = 100. The following standards apply.

**FinElem 140 Rows (Average Balance)**

The Product Leaf column selected in the Configuration ID (for example, GL_Acct_ID) must contain either of the following:

- A valid Product Leaf ID number. In other words, a leaf ID that exists in the leaf type specified as the product leaf in the TP Configuration ID.
A value of -9. This signifies a mapping to several Product IDs.

**COMMON_COA_ID and Product Leaf Relationship**

A Product Leaf ID (except -9) may be a member of one COMMON_COA_ID only, although the COMMON_COA_ID may be linked to several ORG_UNIT_IDs. A COMMON_COA_ID may be linked to one or more product leaves.

This example is correct:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product Leaf ID</th>
<th>FINANCIAL_ELEM_ID</th>
<th>table continues...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>350</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>20</td>
<td>351</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>20</td>
<td>-9</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>21</td>
<td>450</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>21</td>
<td>451</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>21</td>
<td>452</td>
<td>140</td>
<td>...</td>
</tr>
</tbody>
</table>

This example is incorrect:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product Leaf ID</th>
<th>FINANCIAL_ELEM_ID</th>
<th>table continues...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>350</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>20</td>
<td>351</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>20</td>
<td>-9</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>21</td>
<td>350</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>21</td>
<td>451</td>
<td>140</td>
<td>...</td>
</tr>
<tr>
<td>1</td>
<td>21</td>
<td>452</td>
<td>140</td>
<td>...</td>
</tr>
</tbody>
</table>

**WATR and Charge/Credit Rows**

The Weighted Average Transfer Rate (WATR) and the resulting Charge/Credit for Funds are represented in LEDGER_STAT by the Financial Elements 170 and 450, respectively (or 172 and 452 if Transfer Pricing is on a Remaining Term basis). These rows are automatically created by TP Migration if they do not exist in the table, and you do not need to perform a manual setup. However, previous versions of Transfer Pricing handled these elements slightly differently. If you have been running such a version, or you feel that Leaf mappings have previously been incorrect, then check
Migration Mechanics and the Virtual Memory Table

all occurrences of Financial Elements 170, 172, 450, and 452 in LEDGER_STAT to confirm that the following conditions are met.

**FinElem 170/172 (Weighted Ave Tfr Rate) Rows**
ORG_UNIT_ID & COMMON_COA_ID columns must contain valid Leaf IDs. All other ID columns must contain -1 only.

If the TP Processing ID specifies “Remaining Term Pricing Basis”, then FINANCIAL_ELEM_ID should be 172. If not, then FINANCIAL_ELEM_ID should be 170.

Only one 170/172 row should exist for a given combination of ORG_UNIT_ID & COMMON_COA_ID.

**FinElem 450/452 (Chg/Credit) Rows**
ORG_UNIT_ID & COMMON_COA_ID columns must contain valid Leaf IDs. All other ID columns must contain -1 only.

If the TP Processing ID specifies “Remaining Term Pricing Basis”, then FINANCIAL_ELEM_ID should be 452. If not, then FINANCIAL_ELEM_ID should be 450.

Only one 450/452 row should exist for a given combination of ORG_UNIT_ID & COMMON_COA_ID.

Migration Mechanics and the Virtual Memory Table

Although it is sometimes challenging to understand the output of TP migration, the underlying process is much more straightforward. In Oracle Transfer Pricing, LEDGER_STAT is assumed to carry the authentic balances. However, in order to calculate appropriate transfer rates at the COMMON_COA_ID level, all rows in the INSTRUMENT table must be accumulated to arrive at an appropriate Product ID-specific weighted average transfer rate (WATR).

To combine these two items, all data used in TP Migration passes through a table built in the memory of the processing computer called the Virtual Memory Table (VMT). This table exists only for the lifetime of the migration process and is never written to disk. Thus it cannot be examined for problem-solving processes. Understanding the operation of the VMT, however, is the key to understanding TP Migration.
The VMT consists of three parts:

- ORG_UNIT_ID, COMMON_COA_ID and Product ID columns which uniquely identify each row.
- Balance and WATR columns to hold data accumulated from the client data table (CD).
- Balance and WATR columns to hold data accumulated from LEDGER_STAT (LS) and also CD calculations.

Example of Transfer Rate Migration

To illustrate the operation of the TP Migration process in general—and the VMT in particular—the following example includes all possible variations of Transfer Rate Migration processing. The process for option cost migration is quite similar. Also, it is assumed that the TP Process ID would list both an INSTRUMENT table and LEDGER_STAT as tables to be processed, and that Transfer Rate Calculation and Migration would both be selected. An accrual factor of 30/360 and standard pricing, not remaining term pricing, are being used. The starting data for this example is as follows.

**INSTRUMENT (Deposits)**

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CUR_BOOK_BAL</th>
<th>TRANSFER_RATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>100</td>
<td>4.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125</td>
<td>4.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200</td>
<td>3.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200</td>
<td>2.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300</td>
<td>3.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500</td>
<td>4.25</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>200</td>
<td>3.00</td>
</tr>
</tbody>
</table>
As you compare the INSTRUMENT and LEDGER_STAT tables, notice the following:

- Product IDs 3, 4 & 5 match in both tables. These Product IDs represent the simplest case of TP Migration.

- Product ID -9 signifies that all Product IDs with Common COA ID of 3 present in the INSTRUMENT table, but not present in LEDGER_STAT, should be included when calculating the Weighted Average Transfer Rate (FinElem 170/172) and the Charge/Credit for Funds (FinElem 450/452) in LEDGER_STAT, even though they cannot be directly matched to rows in LEDGER_STAT. (In this example, -9 means include Product IDs 6, 7 & 8).

- Product ID 10 does not exist in INSTRUMENT. For the purposes of this exercise, assume it is a ledger-only account that is transfer priced directly using an acceptable LEDGER_STAT only method. (This would be defined in the TP ID).

- Product ID 100 does not exist in INSTRUMENT. For the purposes of this exercise, assume it is a ledger-only account that will be transfer priced using Unpriced Account methodology, based on Product IDs 4, 5, 7 & 10. (This would be defined in the TP ID).

**LEDGER_STAT**

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>FINANCIAL_ELEM_ID</th>
<th>MONTHxx</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>140</td>
<td>250.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>140</td>
<td>200.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>140</td>
<td>100.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-9</td>
<td>140</td>
<td>150.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>10</td>
<td>140</td>
<td>200.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>100</td>
<td>140</td>
<td>990.00</td>
</tr>
</tbody>
</table>
**Phase One: INSTRUMENT Table Accumulation**

The first operation in TP Migration is to accumulate all individual detail rows from the INSTRUMENT table into a single row for each unique combination of ORG_UNIT_ID, COMMON_COA_ID and Product ID in the VMT.

In this example, CDBal_x_TfrRate for ProductID 3 is calculated as follows:

\[(100 \times 4.00) + (200 \times 3.00) = 1,000.00 = CDBal_x_TfrRate\]

After accumulation, the VMT looks like the following examples. The most recent update is shown in **bold**.

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CDBal</th>
<th>CDBal_x_TfrRate</th>
<th>LSBal</th>
<th>LSBal_x_TfrRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>300.00</td>
<td>1,000.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125.00</td>
<td>562.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200.00</td>
<td>600.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200.00</td>
<td>500.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300.00</td>
<td>1,050.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500.00</td>
<td>2,125.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The INSTRUMENT table accumulation does not populate the LS columns. These are populated from balances in LEDGER_STAT.

**Phase Two: LEDGER_STAT Accumulation and Processing**

**Clear LEDGER_STAT**

The first step in Ledger_Stat processing is to clear all 170 and 450 rows (172 and 452 if remaining term pricing is being used). For all rows satisfying the active Data Filter criteria, the relevant As of Date month is set to zero and all subsequent YTDs are adjusted to reflect the zeroing of the period being processed.

**Basic Accumulation**

The first step in LEDGER_STAT accumulation is to populate the VMT with data from LEDGER_STAT where ORG_UNIT_ID, COMMON_COA_ID and Product ID can all be matched. First, LEDGER_STAT balances are migrated (see corresponding rows in the preceding LEDGER_STAT).
Example of Transfer Rate Migration

The VMT appears as follows:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CDBal</th>
<th>CDBal_x_TfrRate</th>
<th>LSBal</th>
<th>LSBal_x_TfrRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>300.00</td>
<td>1,000.00</td>
<td>250.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125.00</td>
<td>562.50</td>
<td>200.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200.00</td>
<td>600.00</td>
<td>100.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200.00</td>
<td>500.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300.00</td>
<td>1,050.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500.00</td>
<td>2,125.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Then, the LEDGER_STAT WATR is calculated by pro-rating the CD WATR by the ratio between INSTRUMENT and LEDGER_STAT balances as follows:

\[(\text{CDBal}_x\_\text{TfrRate} / \text{CDBal}) \times \text{LSBal} = \text{LSBal}_x\_\text{TfrRate}\]

For example, WATR for Product ID 3 is calculated as follows:

\[(1,000.00 / 300.00) \times 250.00 = 833.33\]

The VMT appears as follows:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CDBal</th>
<th>CDBal_x_TfrRate</th>
<th>LSBal</th>
<th>LSBal_x_TfrRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>300.00</td>
<td>1,000.00</td>
<td>250.00</td>
<td>833.33</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125.00</td>
<td>562.50</td>
<td>200.00</td>
<td>900.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200.00</td>
<td>600.00</td>
<td>100.00</td>
<td>300.99</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200.00</td>
<td>500.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300.00</td>
<td>1,050.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500.00</td>
<td>2,125.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Product ID = -9**

As previously mentioned, within each Org_Unit_ID/ Common_COA_ID combination, LEDGER_STAT also carries an Average Balance (Financial Element 140) row with Product ID = -9. This row in LEDGER_STAT carries the accumulated balance for all Product IDs in INSTRUMENT for that Org_Unit_ID and Common_COA_ID that have not been specifically declared in LEDGER_STAT. In order to transfer price correctly, however, a WATR must be known. TP Migration accomplishes this by allocating the LEDGER_STAT balance back to the component Product IDs and then using their individual WATRs in the final WATR and Charge/Credit calculations.
Example of Transfer Rate Migration

In this example, LEDGER_STAT Product ID -9 stands as a proxy for INSTRUMENT Product IDs 6, 7 & 8. Its balance (150.00) is allocated back proportionately as follows:

\[
\text{LEDGER_STAT } \text{Monthxx } \times \frac{\text{CDBal}}{\sum \text{CDBal}} = \text{LSBal}
\]

For example, balance allocation for Product ID 6 is calculated as follows:

\[
150.00 \times \frac{200.00}{(200.00 + 300.00 + 500.00)} = 30.00
\]

The VMT appears as follows:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CDBal</th>
<th>CDBal_x_TfrRate</th>
<th>LSBal</th>
<th>LSBal_x_TfrRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>300.00</td>
<td>1,000.00</td>
<td>250.00</td>
<td>833.33</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125.00</td>
<td>562.50</td>
<td>200.00</td>
<td>900.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200.00</td>
<td>600.00</td>
<td>100.00</td>
<td>300.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200.00</td>
<td>500.00</td>
<td>30.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300.00</td>
<td>1,050.00</td>
<td>45.00</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500.00</td>
<td>2,125.00</td>
<td>75.00</td>
<td></td>
</tr>
</tbody>
</table>

Once the LEDGER_STAT balance has been allocated back, LS WATR is calculated as described above:

\[
(CDBal_x_TfrRate / CDBal) \times \text{LSBal} = \text{LSBal}_x_TfrRate
\]

For example, WATR for Product ID 6 is calculated as follows:

\[
(500.00 / 200.00) \times 30.00 = 75.00
\]

The VMT appears as follows:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CDBal</th>
<th>CDBal_x_TfrRate</th>
<th>LSBal</th>
<th>LSBal_x_TfrRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>300.00</td>
<td>1,000.00</td>
<td>250.00</td>
<td>833.33</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125.00</td>
<td>562.50</td>
<td>200.00</td>
<td>900.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200.00</td>
<td>600.00</td>
<td>100.00</td>
<td>300.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200.00</td>
<td>500.00</td>
<td>30.00</td>
<td>75.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300.00</td>
<td>1,050.00</td>
<td>45.00</td>
<td>157.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500.00</td>
<td>2,125.00</td>
<td>75.00</td>
<td>318.75</td>
</tr>
</tbody>
</table>
Direct TP Migration

At this stage, all rows in LEDGER_STAT that relate (directly or indirectly) to rows in INSTRUMENT have been accumulated into the VMT. However, the accumulation process still needs to deal with account types that are transfer priced using LEDGER_STAT as their Data Source (as specified in the Transfer Pricing ID). When the accumulation process finds a Product ID in LEDGER_STAT that uses LEDGER_STAT itself as the Data Source, it transfer prices the account directly. When the transfer rate is obtained (assume 5% in this case), then a row is simply added to the VMT for the Product ID.

In this example, Product ID 10 is a Direct Transfer Price product with a LEDGER_STAT balance of 200.00.

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>CDBal</th>
<th>CDBal_x_TfrRate</th>
<th>LSBal</th>
<th>LSBal_x_TfrRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>300.00</td>
<td>1,000.00</td>
<td>250.00</td>
<td>833.33</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>125.00</td>
<td>562.50</td>
<td>200.00</td>
<td>900.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>200.00</td>
<td>600.00</td>
<td>100.00</td>
<td>300.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>6</td>
<td>200.00</td>
<td>500.00</td>
<td>30.00</td>
<td>75.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>7</td>
<td>300.00</td>
<td>1,050.00</td>
<td>45.00</td>
<td>157.50</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>8</td>
<td>500.00</td>
<td>2,125.00</td>
<td>75.00</td>
<td>318.75</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>10</td>
<td>-</td>
<td>-</td>
<td>200.00</td>
<td>1,000.00</td>
</tr>
</tbody>
</table>

Unpriced Accounts

Accounts using the Unpriced Account method are a special case of direct transfer pricing in LEDGER_STAT. The Unpriced Account methodology uses the WATR from other accounts to derive a WATR for the Unpriced Account. This is accomplished by averaging the WATR for the component accounts, weighted by their relative LS Balances. (Yes, a weighted, weighted average).
Example of Transfer Rate Migration

In this example, Product ID 100 is an Unpriced Account, based on Product IDs 4,5,7 & 10. First, a new row is added to the VMT and populated with the LEDGER_STAT balance:

Then, the WATR for Product ID 100 is calculated by computing the weighted average of the WATRs of Product IDs 4,5,7 & 10. As each Product ID’s WATR is already expressed as \(LSBal \times TfrRate\), all that is necessary is to divide the sum of WATR by the sum of \(LSBal\):

\[
\frac{(900.00 + 300.00 + 157.50 + 1,000.00)}{(200.00 + 100.00 + 45.00 + 200.00)} = 4.3257... = \text{Product ID 100 WATR}
\]

The VMT is then updated with the standard form of WATR for Product ID 100:

\[
(990.00 \times 4.3257...) = 4,282.43 = \text{LSBal} \times \text{TfrRate}
\]
**WATR (FinElem 170)**

Once all INSTRUMENT and LEDGER_STAT rows have been accumulated in the VMT, the overall WATR can be calculated for each ORG_UNIT_ID/COMMON_COA_ID combination and posted to LEDGER_STAT. The WATR is simply the sum of all component WATRs (represented in the VMT as LSBal_x_TfrRate). As Product IDs are meaningless at this stage, this column is set to -1.

For example, WATR is calculated as follows:

\[
833.33 + 900.00 + 300.00 + 75.00 + 157.50 + 318.75 + 1,000.00 + 4,282.43 = 7,867.01 = \text{WATR}
\]

The LEDGER_STAT appears this way:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>FINANCIAL_ELEM_ID</th>
<th>MONTHxx</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>140</td>
<td>250.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>140</td>
<td>200.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>140</td>
<td>100.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-9</td>
<td>140</td>
<td>150.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>10</td>
<td>140</td>
<td>200.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>100</td>
<td>140</td>
<td>990.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-1</td>
<td>170</td>
<td>7,867.01</td>
</tr>
</tbody>
</table>

**Charge/Credit for Funds (FinElem 450)**

Once the WATR is known, the Charge/Credit for funds in any period is given by the formula:

\[
\text{WATR} \times \text{Balance} \times \text{Accrual Factor} = \text{Charge/Credit for Funds}
\]

As OFSA Transfer Pricing already stores WATR as WATR * Balance, this reduces to:

\[
\text{WATR} \times \text{Accrual Factor} = \text{Charge/Credit for Funds}
\]

For example, Charge/Credit for Funds is calculated as follows:

\[
7,867.01 \times \left(\frac{30}{360}\right) = 655.58 = \text{Charge/Credit for Funds}
\]
Migration of Option Costs

The LEDGER_STAT:

<table>
<thead>
<tr>
<th>ORG_UNIT_ID</th>
<th>COMMON_COA_ID</th>
<th>Product ID</th>
<th>FINANCIAL_ELEM_ID</th>
<th>MONTHxx</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3</td>
<td>3</td>
<td>140</td>
<td>250.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4</td>
<td>140</td>
<td>200.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>5</td>
<td>140</td>
<td>100.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-9</td>
<td>140</td>
<td>150.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>10</td>
<td>140</td>
<td>200.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>100</td>
<td>140</td>
<td>990.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-1</td>
<td>170</td>
<td>7,867.01</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>-1</td>
<td>450</td>
<td>655.58</td>
</tr>
</tbody>
</table>

Migration of Transfer Rates Under Remaining Term Methodology

The TP Migration process is identical except FINANCIAL_ELEM_IDs 452 and 172 are substituted for FINANCIAL_ELEM_IDs 450 and 170 respectively in LEDGER_STAT. Note that under the Remaining Term methodology, the transfer rate source in the INSTRUMENT table is Tran_Rate_Rem_Term.

Migration of Option Costs

Migration of option costs is similar to the transfer rate migration process previously described. However, there are no steps for calculating option costs directly on LEDGER_STAT, since calculation of option costs is a cash flow based method that requires INSTRUMENT data. Normally, option cost is represented in the INSTRUMENT record as the difference between two columns: HISTORIC_STATIC_SPREAD and HISTORIC_OAS (Option Adjusted Spread): Option cost = HISTORIC_STATIC_SPREAD - HISTORIC_OAS. It is expressed as a rate, in percent. If Option Cost Migration is specified in the TP Process ID, option cost will be accumulated in the the Virtual Memory Table and written to LEDGER_STAT as Financial Element 171, Average Historical Option Cost. The corresponding Charge/Credit for Funds is written to LEDGER_STAT as Financial Element 451, Historical Option Cost Charge/Credit.

Under the Remaining Term methodology, the option cost migration process is nearly identical, except that FINANCIAL_ELEM_IDs 453 and 173 are substituted for FINANCIAL_ELEM_IDs 451 and 171, respectively, in LEDGER_STAT.
Note that under the Remaining Term methodology, the option cost source in the INSTRUMENT table is the difference between the Cur_Static_Spread and Cur_OAS columns.

**Migration Tips**

To facilitate the migration process, consider the following.

**General Filtering Rules**
Filtering on ORG_UNIT_ID and COMMON_COA_ID is the lowest acceptable level for practicing “safe” TP Migration if you want to ensure that all components of a given ORG_UNIT_ID/COMMON_COA_ID combination is included in the calculation of WATR and Charge/Credit for Funds. Including Product Leaf IDs in a Data Filter is not recommended as there is a risk of distorting WATR and Charge/Credit rows, for example, if Product IDs 123, 456 and 789 all map to Common COA ID 555, then a Data Filter including Product Leaves 123 and 789 only distorts the resulting WATR and Charge/Credit rows as the contribution of Product 456 is excluded.

**Transfer Pricing INSTRUMENT Data Only**
If you transfer price INSTRUMENT data only, this updates the MATCHED_SPREAD_C (if you are using standard pricing) and TRANSFER_RATE columns in the INSTRUMENT table but does not migrate transfer rates to LEDGER_STAT or create Charge/Credit for Funds rows. To migrate rates after this process, you must run another TP Processing ID with a Transfer Pricing ID in which you have specified only migration of transfer rates. To avoid confusion and/or miscalculation, you should make sure you use the same Data Filter (if any) as you used in the first stage.

**Transfer Pricing LEDGER_STAT Data Only**
Be mindful that Unpriced Accounts in LEDGER_STAT may be based on other LEDGER_STAT accounts that derive their transfer rates from INSTRUMENT data. If you transfer price LEDGER_STAT alone, without having first migrated the data to these other accounts, the Unpriced Account transfer rates that depend on them will be incorrect.

**Use of Identity Code in Transfer Pricing**
Each Transfer Pricing processing ID that updates Ledger/Stat does so with a unique identity code. Subsequent processes with the same processing ID use the same
identity code, but each unique processing ID is assigned a unique identity code. If you use multiple processing IDs to update Ledger/Stat, you may find multiple Transfer Rate (170) and Chg/Credit (450) records for a given Org Unit, Common Chart of Accounts combination in your Ledger/Stat table. To correctly interpret your results you must view the sum of these values within each Org Unit, Common Chart of Accounts combination.
The following messages occur during processing and appear in the Process_Errors table in the Error_Description column. The ID_Number and the Process_Sys_ID of the record also appear on the same record with all messages.

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>105</td>
<td>[ID_Name]:[ID_Name] not found in database.</td>
<td>One or more assumption IDs chosen in the Process ID has been deleted or corrupted in the database.</td>
</tr>
<tr>
<td>110</td>
<td>No match for IRC.</td>
<td>There is no IRC selected for the specific product leaf within the Transfer Pricing ID.</td>
</tr>
<tr>
<td>115</td>
<td>No data for IRC.</td>
<td>The Historical Rates ID chosen in the TP Configuration ID has no values for the IRC chosen in the Transfer Pricing ID.</td>
</tr>
<tr>
<td>120</td>
<td>Leaf Types mismatch: COL vs. Cnfg ID.</td>
<td>The Product Leaf defined in the active Configuration ID is different than the Product leaf used in the methodology assignments in the Transfer Pricing ID.</td>
</tr>
<tr>
<td>505</td>
<td>Negative [rate type] Rate for leaf: [number].</td>
<td>An instrument has been repriced at a negative rate due to lookup rate + margin is less than 0.</td>
</tr>
<tr>
<td>540</td>
<td>Prepayment tier not selected, zero prepayment rate used.</td>
<td>Either Prepayment Table or Prepayment Rate is undefined for a specific Prepayment ID.</td>
</tr>
<tr>
<td>545</td>
<td>Last payment date is before origination date.</td>
<td>The last payment date is before the origination date for a specific record in the instrument table.</td>
</tr>
<tr>
<td>550</td>
<td>No reprice frequency for adjustable record.</td>
<td>The instrument record is an Adjustable Security (adjustable_type_cd &lt;&gt; 0), and has a 0 Reprice Frequency (reprice_freq = 0).</td>
</tr>
<tr>
<td>Error Code</td>
<td>Error Message</td>
<td>Explanation</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| 555        | No schedule found for record. | This error could occur in two different situations:  
1. The instrument record has a Schedule Amortization Code (amrt_type_cd = 800, 801, or 802) and has no matching record in the Payment Schedule table (payment_schedule).  
2. The Prepayment Method is set to a Prepayment Table which does not exist or has no dimensions set up. |
<p>| 560        | Pattern data can not be found for AMRT_TYPE: [number]. | An instrument record with Custom Amortization Codes (amrt_type_cd &gt; 999) has no User-Defined Payment Pattern defined. |
| 565        | No pattern information found for record. | An invalid Adjustable Type Code was found in the instrument record. |
| 570        | Maturity date from record does not match schedule data. | For an instrument record with Schedule Amortization Code (amrt_type_cd = 800, 801, or 802), the remaining number of payments (remain_no_pmt_c) does not match the schedule of payments defined in the Payment Schedule Table (payment_schedule). |
| 575        | Conv amrt with interest in advance defaulted to arrears. | An instrument record with one of the following Amortization Codes: 100, 400, 500, 600, 710, have implicit interest in arrears method. For Forward Interest Type (int_type = 2) for an instrument record with implicit interest in arrears method, then this error is recorded and the Interest Type is set to arrears (int_type = 1) for cash flow generation purposes. |
| 585        | Invalid Amrt.Type detected. Defaulted to Simple Int. | The instrument record has an Amortization Code that is outside of the reserved custom range, or is a non-standard Amortization Code. |
| 710        | Insufficient memory to read [ID Name],[ID Name]. | The Historical Rates ID, Prepayment ID, and Transfer Pricing ID are all loaded into memory when processing on the client. If several other applications are active on the machine, there may not be enough available memory to load any or all of these IDs. |
| 715        | Transfer Method not implemented. | The transfer pricing methodology selected is listed but not yet available. |
| 725        | 1st point used. | The origination date and term of the instrument fall before the first date on the IRC. |
| 730        | Last point used. | The origination date and term of the instrument is in the future after the last date on the IRC. |
| 740        | TP ID out of sync on leaf [number]. | The Transfer Pricing ID still has methodology defined for a leaf that no longer is defined in Leaf Setup. |</p>
<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>745</td>
<td>COL table empty; Leaf Type [leaf number] used.</td>
<td>Only leaves with detail information can be used in the Transfer Pricing ID. Some key leaves defined in the Catalog_of_Leaves have associated detail information tables. This error occurs if a leaf of a Transfer Pricing ID does not have associated detail information, like account type or offset account.</td>
</tr>
<tr>
<td>755</td>
<td>Leaf key not found in Migration Table.</td>
<td>The combination of Common_COA_ID and Org_Unit_ID on the instrument data does not exist in Ledger_Stat.</td>
</tr>
<tr>
<td>760</td>
<td>Negative Transfer Rate.</td>
<td>Negative transfer rates can only occur with cash flow transfer pricing methodology. If the cash flow fields on the instrument have bad data that create negative transfer rates.</td>
</tr>
<tr>
<td>775</td>
<td>Not Ledger/Stat method used: [number].</td>
<td>An invalid transfer pricing method has been assigned to the Transfer Pricing ID used in the Process ID. There are only three valid methods for use on the Ledger_Stat table: Moving Averages, Redemption Curve, and Spread from Interest Rate Code.</td>
</tr>
<tr>
<td>780</td>
<td>Account type not defined for leaf [number], Earning asset used.</td>
<td>The Leaf Setup does not have an account type selected for a particular leaf.</td>
</tr>
<tr>
<td>785</td>
<td>0 Instrument Table rows processed.</td>
<td>There is no instrument data, or a filter is excluding all instrument data defined in the active Transfer Pricing ID.</td>
</tr>
<tr>
<td>790</td>
<td>Invalid cash flows generated for this row or divide by zero.</td>
<td>One or more of the cash flow fields for detailed instrument data have bad data or missing data.</td>
</tr>
<tr>
<td>795</td>
<td>Invalid duration generated for this row.</td>
<td>One or more of the fields used for duration calculations from the instrument tables have bad or missing data.</td>
</tr>
<tr>
<td>800</td>
<td>Org Unit leaf not defined, default offset used.</td>
<td>The Organizational Unit number is not defined in the Leaf setup.</td>
</tr>
<tr>
<td>805</td>
<td>Org Unit offset not defined, default offset used.</td>
<td>The offset is not defined in the Leaf setup.</td>
</tr>
<tr>
<td>810</td>
<td>Divide by zero.</td>
<td>Internal arithmetic calculation error encountered when there is a division by zero.</td>
</tr>
<tr>
<td>820</td>
<td>Not an instrument table.</td>
<td>The instrument table is missing required cash flow fields.</td>
</tr>
</tbody>
</table>
Oracle Financial Services (OFS) applications support either a calendar or fiscal year configuration. If your organization has implemented a fiscal year configuration this appendix provides technical information on how a fiscal year configuration affects the LEDGER_STAT table and as-of-date and year-to-date calculations.

Note that, in the context of this appendix, fiscal year denotes a non-calendar financial year.

This appendix presents the following topics:

- FISCAL_YEAR_INFO Configuration for a Fiscal Year
- Year-To-Date Calculations Affected by a Fiscal Year Configuration
- Viewing the Start_Month and Fiscal_Period Values in the FISCAL_YEAR_INFO Table
- Examples of Calendar and Fiscal Year Configurations
- Using the Undo Function with a Fiscal Year Configuration

**FISCAL_YEAR_INFO Configuration for a Fiscal Year**

In the FISCAL_YEAR_INFO table, the values in the Start_Month and Fiscal_Period columns set the beginning month and duration of your financial year, respectively, for the LEDGER_STAT table. The values in these two columns convert the Month_XX and YTD_XX columns in the LEDGER_STAT table from a calendar year to a fiscal year configuration.

**Start_Month Column**

This column holds the value that represents the first month of your financial year. For a calendar year, the value in this column is always 1, which equates to January.
A fiscal period generally has a value between 2 and 12. For example, this column would have a value of 3 if your fiscal year began in March and a value of 7 if your fiscal year began in July.

For OFS applications, the default setting is a calendar year and the value in this column is 1.

Note that a value of less than 1 or greater than 12 in this column generates an error message.

**Fiscal_Period Column**

This column holds the value that represents the duration of the financial period. For a calendar year, this value is always 12 (for 12 months) and, for a fiscal year, this value is typically 12.

The fiscal year configuration also gives you the flexibility to set shorter financial periods within a 12-month period. For example, if your organization has two 6-month fiscal periods over a 12-month span, then the value in this column would be 6. The only restriction on using a period shorter than a year is that the period must be a factor of 12 (1, 2, 3, 4, or 6).

If you set your start month at 1 and the fiscal period at 6, the system automatically treats this setting as a fiscal year configuration.

For OFS applications, the default setting is a calendar year and the value in this column is 12.

Note that a value of less than 1 or greater than 12 in this column generates an error message.

**Year-To-Date Calculations Affected by a Fiscal Year Configuration**

Year-to-date calculations begin at the start date of the fiscal period rather than January of the year in which the calculations are performed. For example, if July is the start date for your organization’s fiscal period and you process year-to-date calculations through September, the system returns data from the three months from July through September and not from January through September.

This is an important consideration for the following calculations:

- Updating the LEDGER_STAT table when either processing or undoing an Allocation ID
Performing calculations when ledger data is loaded through the Oracle Financial Data Manager (FDM) (see the Import Ledger subsection in the Overview of IDs chapter in this guide for load options with a fiscal year configuration)

Performing calculations when transfer rates are migrated from instrument tables to the LEDGER_STAT table through Oracle Transfer Pricing

Viewing the Start_Month and Fiscal_Period Values in the FISCAL_YEAR_INFO Table

To view the Start_Month and Fiscal_Period values, open a SQL Talk window and complete the following steps:

1. From the menu bar, select Process -> SQL Talk to display the SQL Talk window.
2. Type the following script in the top pane of the window:

   `SELECT * FROM fiscal_year_info;`

3. Press Ctrl-Enter to run the script. The FISCAL_YEAR_INFO table appears in the bottom pane of the window.

   If your organization is using a calendar year configuration the Start_Month column displays a value of 1 and the Fiscal_Period column displays a value of 12. For a fiscal period the values in one or both columns will be different from the calendar year configuration.


---

**Note:** Oracle Portfolio Analyzer does not have SQL Talk. If you are using this product, ask your DBA or System Administrator to access the table for you.

---

Examples of Calendar and Fiscal Year Configurations

The following examples show different configurations in the FISCAL_YEAR_INFO table and how these configurations affect the LEDGER_STAT table.
Examples of Calendar and Fiscal Year Configurations

Using a Calendar Year Configuration

In this example, the FISCAL_YEAR_INFO table holds the following values:

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start_Month</td>
<td>1</td>
</tr>
<tr>
<td>Fiscal_Period</td>
<td>12</td>
</tr>
</tbody>
</table>

This is the default setting for OFS applications.

In the LEDGER_STAT table, the calendar months correspond to the monthly buckets, as shown in the following table:

<table>
<thead>
<tr>
<th>year_s</th>
<th>month_01</th>
<th>month_02</th>
<th>month_03</th>
<th>month_04</th>
<th>month_05</th>
<th>month_06</th>
<th>month_07</th>
<th>month_08</th>
<th>month_09</th>
<th>month_10</th>
<th>month_11</th>
<th>month_12</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999</td>
<td>JAN</td>
<td>FEB</td>
<td>MAR</td>
<td>APR</td>
<td>MAY</td>
<td>JUN</td>
<td>JUL</td>
<td>AUG</td>
<td>SEPT</td>
<td>OCT</td>
<td>NOV</td>
<td>DEC</td>
</tr>
</tbody>
</table>

If you want to process a current month Balance Sheet report and you set the as-of-date in your Configuration ID to June 30, 1999, the data for the report comes from the Month_06 bucket.

Similarly, if you want to process an Allocation ID, undo an Allocation ID, or migrate transfer rates to the LEDGER_STAT table, the system updates year-to-date buckets that are affected by the Allocation ID and the Month_06 bucket.

The YTD_XX buckets in the LEDGER_STAT table correspond to the calendar months in the same way as the monthly buckets. For example, YTD_01 contains year-to-date values for January and YTD_06 contains year-to-date values from January through June.

Using a Fiscal Year Configuration with a 12-Month Duration

In this example, the FISCAL_YEAR_INFO table holds the following values:

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start_Month</td>
<td>7</td>
</tr>
<tr>
<td>Fiscal_Period</td>
<td>12</td>
</tr>
</tbody>
</table>

In the LEDGER_STAT table, the calendar months correspond to the monthly buckets, as shown in the following table:
Examples of Calendar and Fiscal Year Configurations

In this example, the first month of the fiscal period is July, 1999, and January through June are in the year 2000. The OFS system determines the year of the fiscal period record by the year in which the first month occurs. Therefore, the system treats the months January through June as part of the 1999 record.

If you want to process a current month Balance Sheet report and you set the as-of-date in your Configuration ID to January 31, 2000, the data for the report comes from the Month_07 bucket.

Similarly, if you want to process an Allocation ID, undo an Allocation ID, or migrate transfer rates to the LEDGER_STAT table the system updates the year-to-date buckets that are affected by the Allocation ID and the Month_07 bucket.

### Using a Fiscal Year Configuration with a 6-Month Duration

In this example, the FISCAL_YEAR_INFO table holds the following values:

<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start_Month</td>
<td>4</td>
</tr>
<tr>
<td>Fiscal_Period</td>
<td>6</td>
</tr>
</tbody>
</table>

In the LEDGER_STAT table, the calendar months correspond to the monthly buckets, as shown in the following table:

<table>
<thead>
<tr>
<th>year_s</th>
<th>month_01</th>
<th>month_02</th>
<th>month_03</th>
<th>month_04</th>
<th>month_05</th>
<th>month_06</th>
<th>month_07</th>
<th>month_08</th>
<th>month_09</th>
<th>month_10</th>
<th>month_11</th>
<th>month_12</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999</td>
<td>JUL</td>
<td>AUG</td>
<td>SEP</td>
<td>OCT</td>
<td>NOV</td>
<td>DEC</td>
<td>JAN</td>
<td>FEB</td>
<td>MAR</td>
<td>APR</td>
<td>MAY</td>
<td>JUN</td>
</tr>
</tbody>
</table>

In this example, the first month of the fiscal period is April, 1999, and January through March are in the year 2000. The OFS system determines the year of the fiscal period record by the year in which the first month occurs. Therefore, the months January through March are treated as part of the 1999 record.

If you want to process a current month Balance Sheet report and you set the as-of-date in your Configuration ID to January 31, 2000, the data for the report comes from the Month_10 bucket.
Year-to-Date Calculations with a 6-Month Duration

When performing year-to-date calculations and the fiscal period value is 6, the OFS system segments the financial year into two 6-month periods. Therefore, if you select August, 1999, for year-to-date calculations your data comes from the months of April, 1999, through August, 1999 (five months). If you select December for year-to-date calculations then your data comes from October, 1999 through December, 1999 (three months).

Using the Undo Function with a Fiscal Year Configuration

The undo function backs out records one period at a time. This is important if you have chosen a fiscal period duration that is less than 12. For a calendar year or 12-month fiscal year you can set the as-of-date anywhere within the 12-month span and undo the allocation for the entire fiscal period.

If your organization uses a fiscal period shorter than 12-months, however, then you need to set the as-of-date within the period for which you want to undo an allocation. For example, if you have set your Fiscal_Period to 6 and you want to undo an allocation that you posted in the first six-month period then you must set the Configuration ID as-of-date to a date within that period.
As-of-Date
The date when the data is current.

Asset/Liability Management Committee
The Asset/Liability Management Committee (ALCO) is an organization within a financial institution whose charter is to manage interest rate risk.

At-Risk Period
The time period for value-at-risk. That is, the difference between the future date when portfolio loss is evaluated and the as-of-date.

Base Rates
A section in Oracle Risk Manager that stores the interest rates associated with the as-of-date of the data.

Basis Points
1/100th of a percent. Abbreviated as bp.

Breakage Charges
A charge assigned to an account whose actual cash flows are significantly different from the expected cash flows when the account funded.

Business Area
A conceptual grouping of tables or views represented as folders, items, conditions, filters, joins, and hierarchies. Each business area is grouped within the same End User Layer (EUL) that the current session is connected to.
**Cash Flow Table**
An instrument table that contains all of the Oracle Financial Services (OFS) cash flow columns.

**Cash Flow Column**
A column in an instrument table that is used by the OFS cash flow engine to perform cash flow analysis on a record.

**Configuration ID**
An ID that stores system default information that has been customized for the user and/or the institution.

**CPR (Constant Prepayment Rate)**
A method of measuring an annualized prepayment rate.

**Credit Risk**
The risk that a loan holder will not be able to repay some portion of a loan.

**Current Rate Risk Profit**
Component of funding center rate risk results attributed to current mismatches of assets and liabilities.

**Data Correction Processing ID**
An ID that enables you to simultaneously correct multiple columns in a database table in one pass through the database, using a previously defined Correction Rule ID.

**DDA (Demand Deposit Account)**
An account paying on demand, with no notice of withdrawal required, for example, a checking account.

**De-annualize**
To compute the monthly equivalent rate of an annual rate.

**Duration**
The rate of market value change with respect to discount rate changes. A measure of market value sensitivity: the lower the value, the less sensitive the market value to changes in interest rates.
**Embedded Rate Risk Profit**
A portion of funding center rate risk result attributed to prior rate bets.

**End User Layer (EUL)**
A metalayer that contains data about other tables in a database. Conceptually, the EUL shields the end user from the complexity of the database. The database tables are modified by the Oracle Discoverer Administration Edition and Oracle Financial Data Manager/Discoverer Integrator. Business areas are defined within the EUL and then used in the Oracle Discoverer End User Edition.

**Floating Tree Bar**
A window that enables you to choose the appropriate branch or leaf in the Tree ID that is currently active.

**Funding Center**
An area in a financial institution that receives the transfer pricing charge and credit for funds.

**General Ledger (GL)**
The main data source that defines the financial reality for an institution. The general ledger reflects all accounting entries.

**Historical Rates Table**
The OFS table that holds all historical actual interest rates.

**Instrument**
Legally enforceable agreements about types of financial security. See *Instrument Table*.

**Instrument Table**
A type of table in the Oracle Financial Data Manager (FDM) database that is used to store account-level information.

**Instrument Records**
Rows in the Oracle Financial Data Manager (FDM) database that contain account information for each customer. Examples are checking accounts, mortgage accounts, or installment debt accounts for a given customer.
Interest Rate Code
User-defined code to reference a yield curve or single rate index for historical analysis and transfer pricing and interest rate forecasting purposes.

Last Repricing Date
The date of the last rate change for an adjustable-rate instrument and the origination date for a fixed-rate instrument.

Leaf Fields
Oracle Financial Data Manager (FDM) database fields that are used to define hierarchical segmentations of data (trees). They also define the relationship between the instrument data and the general ledger data in the LEDGER_STAT table.

Leaf ID
A column in the Oracle Financial Data Manager (FDM) database that provides for the creation of hierarchical trees for use in assumptions and reporting. Leaf ID columns also define the relationship between instrument data and ledger data.

Leaf Values
Values that compose the leaf fields.

LEDGER_STAT
A table in the Oracle Financial Data Manager (FDM) database that stores all general ledger as well as statistical information for current and historical periods.

Liquidity Premiums
A charge levied on a long-term instrument to compensate for the illiquidity of the funds.

Long Run Rate
One of the user-defined parameters for the Vasicek (discrete-time) term structure model. It represents the equilibrium value of the one-month annually compounded rate.

Market Price of Risk
In financial economic theory, the market price of risk is a measure of intertemporal risk-aversion of the aggregate investor. For example, a high market price of risk during some future period means that investors will be more risk-averse, and that rates for that term should be higher to compensate for the risk. In practical terms, the market price of risk is the plug that makes the price of risk-free bonds correct.
**Market Value**
In Monte Carlo, the average of the (scenario specific) present values.

**Matched Rate Transfer Pricing**
A method of transfer pricing where all accounts have transfer rates that reflect their specific maturity and repricing characteristics.

**Matched Spread**
The interest profit margin for any account. For asset accounts, measured as the note rate minus the transfer rate and, for liability and equity accounts, the transfer rate minus the note rate.

**Monthly Rate**
The yield on a loan contracted at the beginning of the month for a period of one month, assuming a continuous compounding basis. The monthly rate is a function of time and scenario. The rate generator also computes rates for terms other than a month.

**Next Repricing Term**
The repricing frequency for an adjustable-rate instrument and the original term to maturity for a fixed-rate instrument.

**Operating Cost**
The non-interest related cost of running a business.

**Option Costs**
The costs assigned to measure the value of any customer option on an instrument. For example, prepayments on a mortgage loan.

**Portfolio Fields**
Fields in the Oracle Financial Data Manager (FDM) database that are common to multiple instrument tables. Portfolio fields are determined by the OFS system administrator.

**Prepayment**
A reduction in the principal balance of a transaction record prior to the contracted schedule date.
Present Value
In Monte Carlo, the sum of cash flows paid by a security along a particular rate scenario, discounted by the stochastic discount factor.

Processing Filter ID
Filter ID used to define which data can go into a processing run.

PSA (Public Securities Association)
A prepayment specification method established by the Public Securities Association that relates a CPR to the age of an instrument.

Reconciliation
The process of comparing information in one data source to information in another data source.

Record
Usually a single account or transaction, or aggregation of accounts, stored in the database (also called a row).

Remote User
A user who is not connected to the client/server environment. A remote user needs to transmit information to the budget administrator using computer files.

Single Rate
An interest rate code with only one point defined. For example, prime rate or LIBOR.

Speed of Mean Reversion
One of the user-defined parameters for the Vasicek and Extended Vasicek (discrete-time) term structure models. Speed of mean reversion represents the long-run drift factor.

Spreadsheet Control Bar
A dialog box that facilitates the definition of a series of input values (dates or numbers) by providing several methods for defining structured patterns in the data.

SQL (Structured Query Language)
The standard method of accessing the Oracle Financial Data Manager (FDM) database.
**Stochastic Discount Factor**
Present value (along a rate scenario) of one dollar received at some future time. It is a function of future time, option adjusted spread (OAS), and scenario

**Transfer Pricing**
A method for valuing all sources and uses of funds for a balance sheet.

**Transfer Pricing ID**
An ID used to specify the method for transfer pricing all balance sheet accounts.

**Transfer Pricing Table**
An instrument table that contains all of the columns required to run transfer pricing.

**Tree ID**
Hierarchical structure for leaf fields in OFS products, for example, organization or product type.

**UPR (Unscheduled Principal Runoff)**
In addition to prepayments, a source of runoff in Risk Manager cash flow calculations. UPR is not applicable for Oracle Transfer Pricing.

**Volatility**
One of the user-defined term parameters of all (discrete-time) term structure models. It represents a standard deviation of the one-month annually compounded rate.

**Yield Curve**
The curve of annually compounded zero-coupon bond yield.
## A
Accrual Method, 5-11, 22-46
Accumulation Methods, 5-10, 22-45
Activate, 7-3
Actual, 7-4
Add
to by Percent, 5-28
to by Value, 5-28
Aggregation, 4-6
Arctangent, 12-11
As of Date, 4-6, 7-2, 8-6, 16-5, 17-8
Assignment
Date, 16-7
Assumptions, 23-1
At
First Method, 22-47
Last Method, 22-47
Average
Method, 5-10, 22-46
Average(s)
Moving, 16-4

## B
Basic Accumulation, 23-14
Basis Points (BPS), 2-4
Batch
Process, 6-2
Branch
Collapse, 18-9, 19-8
Expand, 18-8, 19-8
Focus on, 18-9, 19-8
Orphan, 19-11
Breakage Charges, 4-9
Build Date, 10-7
Bullets, xxiii

## C
Calendar, 10-7
Cash Flow
Duration, 16-3
Method Notes, 16-4
Pricing, 16-3
Weighted Term, 16-3
Zero Discount Factors, 16-4
Cash Flow(s)
Calculations, 22-1
Daily, 22-2
CE CodeExInd, xxiii
Charge/Credit Accrual Factor, 7-4
Clear, 10-11
Client, 5-23
Close an ID, 5-4
Code(s)
Description, 9-4
Invalid, 9-4
Value, 8-4, 9-4
Collapse Branch, 18-9, 19-8
Column(s)
From/To, 5-28
Output, 10-10, 10-11
Report, 10-1
Common Chart Of Accounts
ID, 4-9
Common Chart of Accounts
Leaf ID, 4-4
Compounding (Method), 7-4
Configuration
   ID, 5-2, 7-1, 17-8
Constant, 10-10
Control Bar, 1-8
Conventions, 22-3
Copy an ID, 5-4
create an prepayment table ID, 13-1
Current
   Level Name, 18-4, 19-3
   Rate Risk, 2-8
Customer
   Rate, 22-34
   Support Information, xxiv

D
Daily Cash Flows, 22-2
Data
   Directory, 7-3
   Element(s), 4-3, 10-11
   Filter ID, 4-6, 23-4
   Initialization, 22-4
   Instrument, 4-7
   Ledger, 4-7
   Verification ID, 3-14
Date
   As of, 4-6, 8-6
   Assignment, 16-7
Date(s)
   As of, 7-2
   Build, 10-7
   End, 6-2
   Start, 6-2
Defined
   Filter, 8-7
Delete, 10-11
   a Column, 9-3
   a Group of IDs, 5-5
   an ID, 5-5
   Group, 1-4
Deleting a Payment Pattern, 20-17, 21-8
Dependencies, 5-22
Dependent ID Import/Export, 5-15
Description, 5-3, 5-10
   Level(s), 19-9
Detail
   Cash Flow Data, 22-47
Display
   Level Window, 18-4
Dynamic
   Characteristics, 22-8

E
Edit, 10-11
   Menu, 1-6
Embedded Rate Risk Profit, 2-7
End
   Date, 5-27, 6-2
   Value, 5-28
Error
   Messages, A-1
Event Driven Logic, 22-2
Event Use Code Values, 22-51
Exclude Branch from Filter, 18-10
Expand
   All, 18-8, 19-8
   Branch, 18-8, 19-8
   One Level, 18-8, 19-7
Expansion Indicators, 18-3, 19-3

F
Field(s)
   Leaf, 4-3
File(s)
   Menu, 1-4
Filter(s)
   Criteria, 8-2
   Data, 4-6
   Defined, 8-7
   Name, 17-6
   Type, 8-4, 17-6
Financial
   Elements, 22-2
Fiscal Year
   examples, B-3 to B-6
   calendar year, B-4
fiscal year (12-month duration), B-4
fiscal year (6-month duration), B-5
Fiscal_Period column, B-2
FISCAL_YEAR_INFO table, B-1 to B-2
Start_Month column, B-1
undo function, B-6
using SQL Talk, B-3
FISCAL_YEAR_INFO table, B-1 to B-2
Fiscal_Period column, B-2
Start_Month column, B-1
using SQL Talk to view, B-3
Floating Tree Bar, 1-8, 16-1
Focus
  on Branch, 18-9, 19-8
  Undo, 18-9, 19-8, 19-9
Font, 18-6, 18-7, 19-6
Formula, 8-2, 8-4
  ID, 10-1
foundation
  OFSA, 1-2
From/To
  Column(s), 5-28

G
General Ledger, 4-6
Gomonth, 10-7
Group, 5-2, 5-3
  Import/Export, 5-16
  Name, 7-3
Group Filter ID
  creating and defining, 11-1 to 11-2
  editing, 11-3

H
Hierarchy, 18-1
Historical
  Rates Table, 4-1
  Term, 16-4
Host, 5-25

I
ID
  Close an, 5-4
  Copy an, 5-4
  Delete a Group of, 5-5
  Delete an, 5-5
  Information Dialog, 6-2
  Process an, 5-23
  Rename an, 5-4
  Save As..., 5-4
If, Then, 10-9
Implied
  Filter Criteria, 8-6
Increment
  by Percent, 5-28
  by Value, 5-28
Individual ID Import/Export, 5-14
Initialization
  of Data, 22-4
Initialize
  Cash Flow Data, 22-7
  Interface Data, 22-5
Insert, 10-11
  Constant, 10-10
  Level, 19-9
  Node, 19-10
Instrument
  Data, 4-7
  Level Modeling, 22-1
  Table(s), 23-1
Interest
  Credited, 22-5
  Rate, 2-1
  Rate Code(s), 4-1, 16-3, 16-4
Interpolate, 5-28
Invalid Code(s), 9-4
IRC
  Value(s), 22-34

J
Job
  Return Status, 5-25

K
Key
Shift, 5-5, 19-11

L
Lag Term, 16-7
Leaf
  Basis, 7-4
  Field(s), 4-3
  Level, 5-6
  Product, 16-1
  Setup, 5-6, 23-5
  Type, 1-7, 5-6
  Value(s), 1-7, 4-5, 5-6, 19-1
Ledger Data, 4-7
Ledger/Stat
  Table(s), 10-13, 23-9
Level(s), 18-5, 19-4
  Description, 19-9
  Insert, 19-9
  Leaf, 5-6
  Maintenance, 19-9
  New Name, 19-9
  Parent, 19-10
Liquidity Premiums, 4-9
List(s)
  Numbered, xxiii
Logic
  Event Driven, 22-2
Login, 1-3
Lookup, 10-10

M
Market
  Value(s)
    Calculation, 22-42
Matched Rate Transfer Pricing, 1-1
Menu(s), 1-4
  Edit, 1-6
  Options, 1-7, 1-8
  Process, 1-6
  Setup, 1-7
Method
  Type(s), 16-2
Mid-Period Repricing, 3-19, 16-6
  Processing steps, 16-11
Migrate Rate Only, 16-11
Migration
  Mechanics, 23-11
  Process, 23-1
  Tips, 23-21
Modeling
  Flexibility, 22-2
  Instrument Level, 22-1
  Start, End Dates, 22-11
Month, 10-8
Moving Average(s), 16-4
Multiple
  IDs, 5-5
  Table(s), 8-2, 8-7

N
Negative
  Amortization Check, 22-23
New
  Node ID, 19-10
  Node Level, 19-10
  Node Name, 19-10
NGAM Equalization Event, 22-17
Node(s)
  Copy, 19-11
  Cut, 19-11
  Delete, 19-11
  Description, 18-10
  Down, 19-12, 19-13
  Inclusion Indicator, 18-3
  Insert, 19-10
  Name, 19-11
  Number(s), 18-7, 19-6, 19-11
  Paste, 19-12
  Rename, 19-11
  Up, 19-12
None, 7-4
Note Rate, 16-8
Null Values, 8-6, 10-12
Numbered Lists, xxiii

Index-4
OFSA foundation, 1-2
Open
  an Existing ID, 5-3
Operand(s), 10-3
Operator(s), 10-3
Option(s)
  Costs, 4-9
Options
  Menu, 1-7, 1-8
Order
  of Process Arrows, 6-2
order of processing, 8-6
Organizational Leaf ID, 4-5
Organizational Unit Leaf, 7-3
Orphan
  Branch, 19-11
  Leaf, 19-11
Output
  Column(s), 10-11

Parameters, 10-7
Parent
  Level, 19-10
  Name, 19-10
Parenthesis, 10-3
Password
  Change, 1-7
Payment
  Calculation Event, 22-14
Payment Pattern icon, 20-9
Payment Pattern Interface, 20-3, 21-2
PC, 5-23
Per Item, 7-5
Percent
  Sold Adjustment, 22-13
Percentages, 16-10
Permission, 5-3
Settings, 7-3
Points
  Term, 16-10
Portfolio, 8-2

preface
  conventions table sample, xxiii
heading
  PH PrefaceHead, xix
  PT PrefaceTitle, xix
Prepayment
  Event, 22-26
  ID, 12-1
Prepayment ID, 4-7, 16-4
Prepayment Table ID, 13-1
prepayment table structure, 13-2
Prior Periods, 17-8
Priority, 5-27
Process, 5-24
  an ID, 5-23
  Menu, 1-6
Processing
  Assumption IDs, 17-3
  Data Filter ID, 4-6
  Error Message Limits, 7-5
  Filter ID, 17-1
  Option(s), 17-2, 17-9
  Table(s), 17-5
processing
  order, 8-6
Preprocessing ID, 5-22
Product
  Leaf, 7-4, 16-1, 23-3
  Leaf ID, 4-4
Propagated Rates, 17-6
Propagated Rates, 17-9
PT PrefaceTitle, xix

Range(s), 8-4
Rate
  Compounding Basis, 22-6
Rate(s)
  Note, 16-8
  Propagated, 17-9
  Propagation, 17-6
  Single, 4-2
  Spread, 16-7
Read Only, 5-3
Read/Write, 5-3
Reconciliation, 4-6
Record, 5-25
Redemption Curve, 16-10
Remaining Term
  Basis, 4-9
  Transfer Rate, 4-9
Remove, 8-3, 16-10
  All, 5-6, 8-3
Rename, 5-4
  Node, 19-11
Renumber, 1-7, 5-6, 5-9
Replace, 10-12
Report(s)
  Column, 10-1
Reprice Event, 22-33
Request
  Date, 5-26
Rollup
  Level Maintenance, 19-9
  Tree Window, 19-3
Rounding Codes, 22-36
Row(s)
  Level Security, 8-6
Rule of 78’s, 22-55

S
Save
  As..., 5-4
Search, 1-6, 18-4, 18-5, 18-6, 19-4, 19-5
    Field(s), 18-4, 19-4
    Option(s), 18-5, 19-4
  String, 18-4, 19-4
See
  All Jobs, 5-24
  Your Jobs, 5-24
Select
  All, 5-6
  Multiple IDs, 5-5
Selected
  IDs, 6-2
Server
  Polling Indicator, 5-25
  Status, 5-23, 6-3
Set
  Display Level, 18-9, 19-10
  Tree Level, 18-9, 19-10
Setup
  Leaf, 5-6
  Menu, 1-7
Shift Key, 5-5, 19-11
Single Rate(s), 4-2
Source Tables, 17-8
Specific Value(s), 8-4
Spreadsheet, 9-1
SQL Talk
  limitations, 15-3
    columns displayed, 15-3
    processing time, 15-3
    rows displayed, 15-3
  multiple open windows, 15-2
  security (SQL Talk privileges), 15-1
  stored procedures, creating, 15-3
  using, 15-2
Standard Processing Filter ID, 4-9
Start
  Date, 5-26
  Date(s), 6-2
  Time, 5-27
  Value, 5-28
  Value Box, 5-30
Static Characteristics, 22-7
Status, 5-25
Stop Job, 5-24
Straight Term, 16-5
Sum
  Method, 22-47

T
table dimensions
  define, 13-3
Table(s)
  and Output Columns, 10-10
  Instrument, 23-1
  Ledger/Stat, 23-9
  Multiple, 8-2
  Name, 5-25, 8-7
  Processing, 17-5
Term
   Historical, 16-4
   Lag, 16-7
   Points, 16-10
   Straight, 16-5
Title, 5-25
Toggle
   In/Out of Filter, 18-10
Total, 7-5
Transfer
   Pricing, 22-34
   Pricing ID, 4-7, 16-1
   Pricing Processing ID, 4-6, 4-7, 16-1, 17-1, 23-8
   Pricing Yield Curve, 4-1
   Pricing, Matched Rate, 1-1
   Rate(s), 1-1
   Rate(s0, 2-1
Tree
   Bar, Floating, 1-8, 16-1
   Menu, 18-4, 18-6, 18-8, 19-4, 19-6, 19-7
   Rollup ID, 5-3, 19-1
   Structure, 19-14
Tree-Related IDs, 5-13
Triggers, 22-8
TSER/RQ, 5-23

U
   Undo Focus, 18-9, 19-8, 19-9
   Unpriced Account, 16-8
   User, 5-25

V
   Value(s)
     Code, 8-4, 9-4
     Virtual Spreadsheet, 9-1

W
   Warning, 10-12
   Weighted Average Transfer Rate (WATR), 23-10

Y
   Year, 10-8
   Yield Curve, 2-4